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Software License

The Centracs® SOFTWARE and its documentation are protected by copyright laws and international
copyright treaties, as well as other intellectual property laws and treaties. The SOFTWARE is licensed,
not sold.

This Centracs Software License Agreement grants you the following rights:



* You may install and use the Centracs Core, Device Manager, Communications, and other Server
components of the SOFTWARE on computers located on City/Agency premises communicating
with the maximum number of field devices set by the license key included with the SOFTWARE.

* You may install and use the Centracs Client/Workstation SOFTWARE on any number of
workstations located on the premises of City/Agency or agency partners/consultants. The
Centracs Client/Workstation SOFTWARE may only be used with the City/Agency Centracs system.
Use of the Centracs Client/Workstation SOFTWARE with other City/Agency Centracs systems is
expressly prohibited.

* You may not reverse-engineer, decompile, or disassemble the SOFTWARE, except and only to the
extent that such activity is expressly permitted by applicable law, notwithstanding this limitation.

* You may not sell, lease, license, sublicense, distribute, or otherwise transfer in whole or in part
the SOFTWARE or any parts thereof to another party.

Without prejudice to any other rights, Econolite may terminate this Software License if you fail to
comply with the terms and conditions of the License Agreement. In such event, you must destroy all
copies of the SOFTWARE and all of its component parts.

Warranty

Econolite warrants that the media, if any, on which the SOFTWARE is delivered and documentation
supplied is free from defects in material and workmanship under normal use and service and that the
SOFTWARE will substantially conform to the description contained in the documentation for a period
of one-year beginning upon completion of acceptance testing of the SOFTWARE. In the event of
notification within the warranty period of defects in material or workmanship, or if the SOFTWARE does
not substantially conform to the description contained in the documentation, Econolite, at its sole
option, will repair or replace the defective media or documentation or correct the defects in the
SOFTWARE. The foregoing is the only warranty of any kind expressed or implied. There are no implied
warranties of merchantability and fitness for a particular purpose. In no event shall Econolite, or its
suppliers be liable for any damages whatsoever (including, without limitation, damages for loss of
property, injury, life, business profits, business interruption, loss of information, or other pecuniary
loss) arising out of the use of or inability to use this SOFTWARE.

Econolite agrees to provide City/Agency with one year of technical support via phone or email for the
SOFTWARE beginning upon completion of acceptance testing of the SOFTWARE. This technical support
will cover all SOFTWARE components provided by Econolite. SOFTWARE components provided by
others, (including any and all area maps and intersection graphics) will not be included in this technical
support.

Copyright Notices

Under the copyright laws of the United States of America, the Centracs SOFTWARE and this user
manual MAY NOT be copied, photocopied, reproduced, translated, or reduced to any electronic
medium or machine-readable form, in whole or part, without prior written permission from Econolite.
The SOFTWARE is developed and marketed by Econolite in part under a license of certain copyrighted
works of others as to certain elements and in part as the copyrighted work of Econolite. Econolite also
has or may have patents, patent applications, and owns all associated trademarks, copyrights, or other
intellectual property rights covering subject matter in this document. Except as expressly provided in a
written license agreement from Econolite, the furnishing of this notice does not give any entity or



individual (the user) any license to the patents, trademarks, copyrights, or other intellectual property.
The United States Code, Title 17, protects the Software and this Document (the Copyright Act). ANY
SUCH ACTIVITY OR PRODUCT BECOMES THE ABSOLUTE PROPERTY OF THE COPYRIGHT HOLDER.

Restricted Rights Legend

Any SOFTWARE which is provided for or on behalf of the United States of America or for or on behalf of
Licensee, their agencies and/or instrumentalities (“U.S. Government”) is provided with Restricted
Rights. Use, duplication, or disclosure by the U.S. Government is subject to restrictions as set forth in
Federal Acquisition Regulations subparagraph (c)(1)(ii) of the Rights in Technical Data and Computer
SOFTWARE clause at DFARS 252.227-7013 or subparagraphs (c)(1) and (2) of the Commercial
Computer SOFTWARE - Restricted Rights at 48 CFR 52.227-19, as applicable. The manufacturer is
Econolite, 3360 E. La Palma Ave, Anaheim, CA 92806, (714) 630-3700. ANY RIGHTS NOT EXPRESSLY
GRANTED HEREIN ARE RESERVED.

Trademarks

The Econolite logo is a registered trademark of Econolite Control Products, Inc. in the United Stated
and/or in other countries. All other trademarks are the property of their respective owners.

Oasis, ASC3, ASC2, Cobalt, Eos, Centracs, and Centracs Local Edition are products with trademarks or
registered trademarks owned by Econolite Control Products, Inc.

Autoscope is a registered trademark of Image Sensing Systems, Inc. (ISS).

“Microsoft”, “Windows”, “Bing”, “Microsoft Windows”, “Windows Server”, and “Microsoft SQL Server”
are either registered trademarks or trademarks of Microsoft Corporation in the United States and/or
other countries. The Bing Maps service is offered under the Microsoft Service Agreement.

“Genetec” and “Omnicast” are trademarks of Genetec Inc., either registered or pending registration in
several jurisdictions.

WA4IKS is a product of Wapiti Microsystems Inc.
Synchro is a registered trademark of Trafficware, Ltd.
“VLC” and “VLC Media Player” are registered trademarks of VideoLAN.

NAVTEQ Map Data End-User License Terms

The NAVTEQ map data (“Data”) supplied with Centracs is provided for your internal use only and not for
resale. It is protected by copyright, and is subject to the following terms and conditions which are
agreed to by you, on the one hand, and Econolite and its licensors (including their licensors and
suppliers) on the other hand.

© 3/16/18 NAVTEQ - All rights reserved.

The Data for areas of Canada includes information taken with permission from Canadian authorities,
including: © Her Majesty the Queen in Right of Canada, © Queen’s Printer for Ontario, © Canada Post
Corporation, GeoBase.

NAVTEQ holds a non-exclusive license from the United States Postal Service® to publish and sell
ZIP+4® information.



© United States Postal Service® 3/16,/18. Prices are not established, controlled or approved by the
United States Postal Service®. The following trademarks and registrations are owned by the USPS:
United States Postal Service, USPS, and ZIP+4.

Terms and Conditions

Personal Use Only. You agree to use this Data together with Centracs solely for the purposes for which
you were licensed, and not for service bureau, time-sharing, or other similar purposes. Accordingly, but
subject to the restrictions set forth in the following paragraphs, you may copy this Data only as
necessary for your personal use to (i) view it, and (ii) save it, provided that you do not remove any
copyright notices that appear and do not modify the Data in any way. You agree not to otherwise
reproduce, copy, modify, decompile, disassemble, or reverse-engineer any portion of this Data, and
may not transfer or distribute it in any form, for any purpose, except to the extent permitted by
mandatory laws. This Data is provide as part of the Centracs license terms and conditions and may not
be transferred or resold without express written permission from Econolite.

Restrictions. Except where you have been specifically licensed to do so by Econolite, and without
limiting the preceding paragraph, you may not (a) use this Data with any products, systems, or
applications installed or otherwise connected to or in communication with vehicles, capable of vehicle
navigation, positioning, dispatch, real-time route guidance, fleet management or similar applications;
or (b) with or in communication with any positioning devices or any mobile or wireless-connected
electronic or computer devices, including without limitation cellular phones, palmtop and handheld
computers, pagers, and personal digital assistants (PDAs).

Warning. The Data may contain inaccurate or incomplete information due to the passage of time,
changing circumstances, sources used and the nature of collecting comprehensive geographic data,
any of which may lead to incorrect results.

No Warranty. This Data is provided to you “as is”, and you agree to use it at your own risk. Econolite
and its licensors (and their licensors and suppliers) make no guarantees, representations, or
warranties of any kind, express or implied, arising by law or otherwise, including but not limited to,
content, quality, accuracy, completeness, effectiveness, reliability, fitness for a particular purpose,
usefulness, use or results to be obtained from this Data, or that the Data or server will be uninterrupted
or error-free.

Disclaimer of Warranty. ECONOLITE AND ITS LICENSORS (INCLUDING THEIR LICENSORS AND
SUPPLIERS) DISCLAIM ANY WARRANTIES, EXPRESS OR IMPLIED, OF QUALITY, PERFORMANCE,
MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE OR NON-INFRINGEMENT. Some States,
Territories, and Countries do not allow certain warranty exclusions, so to that extent the above
exclusion may not apply to you.

Disclaimer of Liability. ECONOLITE AND ITS LICENSORS (INCLUDING THEIR LICENSORS AND
SUPPLIERS) SHALL NOT BE LIABLE TO YOU: IN RESPECT OF ANY CLAIM, DEMAND, OR ACTION,
IRRESPECTIVE OF THE NATURE OF THE CAUSE OF THE CLAIM, DEMAND, OR ACTION ALLEGING ANY
LOSS, INJURY, OR DAMAGES, DIRECT OR INDIRECT, WHICH MAY RESULT FROM THE USE OR
POSSESSION OF THE INFORMATION; OR FOR ANY LOSS OF PROFIT, REVENUE, CONTRACTS OR
SAVINGS, OR ANY OTHER DIRECT, INDIRECT, INCIDENTAL, SPECIAL, OR CONSEQUENTIAL DAMAGES
ARISING OUT OF YOUR USE OF OR INABILITY TO USE THIS INFORMATION, ANY DEFECT IN THE
INFORMATION, OR THE BREACH OF THESE TERMS OR CONDITIONS, WHETHER IN AN ACTION IN



CONTRACT OR TORT OR BASED ON A WARRANTY, EVEN IF [CLIENT] OR ITS LICENSORS HAVE BEEN
ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. Some States, Territories, and Countries do not allow
certain liability exclusions or damages limitations, so to that extent the above may not apply to you.

Export Control. You agree not to export from anywhere any part of the Data provided to you or any direct
product thereof except in compliance with, and with all licenses and approvals required under,
applicable export laws, rules, and regulations.

Entire Agreement. These terms and conditions constitute the entire agreement between Econolite (and
its licensors, including their licensors and suppliers) and you pertaining to the subject matter hereof,
and supersedes in their entirety any and all written or oral agreements previously existing between us
with respect to such subject matter.

Governing Law. The above terms and conditions shall be governed by the laws of the State of lllinois,
without giving effect to (i) its conflict of laws provisions, or (ii) the United Nations Convention for
Contracts for the International Sale of Goods, which is explicitly excluded. You agree to submit to the
jurisdiction of the State of lllinois for any and all disputes, claims, and actions arising from or in
connection with the Data provided to you hereunder.

Government End Users. If the Data is being acquired by or on behalf of the United States government
or any other entity seeking or applying rights similar to those customarily claimed by the United States
government, the Data is a “commercial item” as that term is defined at 48 C.F.R. (“FAR”) 2.101, is
licensed in accordance with these End-User Terms, and each copy of Data delivered or otherwise
furnished shall be marked and embedded as appropriate with the following “Notice of Use”, and shall
be treated in accordance with such Notice:

NOTICE OF USE

Contractor (Manufacturer/Supplier) Name:
NAVTEQ

Contractor (Manufacturer/Supplier) Address:
425 West Randolph Street, Chicago, lllinois 60606

This Data is a commercial item as defined in FAR 2.101 and is subject
to the End-User Terms under which this Data was provided.

© 3/16/18 NAVTEQ - All rights reserved.

If the Contracting Officer, federal government agency, or any federal official refuses to use the legend
provided herein, the Contracting Officer, federal government agency, or any federal official must notify
NAVTEQ prior to seeking additional or alternative rights in the Data.
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Overview of Centracs

Introduction

Centracs is an Intelligent Transportation System (ITS) application that offers a central
integrated platform for traffic signal system control, Closed-Circuit TV (CCTV) monitoring
and control, information management, graphical data display, center-to-center
operations, and much more. Centracs uses client/server architecture and distributed
processing to achieve a flexible and scalable system. System data processing is distributed
across multiple servers and applications such that system functions are accomplished
most effectively considering cost, communications implications, security, redundancy
(back-up), and network interface capabilities. National and international protocol
standards are used to make sure that the system can adapt to changes in technology and
increase functionality over time with minimal impact on individual system components.
Centracs uses intelligent interface protocols for distribution of real-time data between
workstations, which increases system performance and multi-user responsiveness.

The Centracs monitoring screens represent data graphically, and make it easy for you to
quickly keep tabs on what is occurring in the system. In addition to showing system alerts
graphically, Centracs can send alerts immediately to specific online users, to all online
users, or to offline recipients via email or SMS.

Unlike the user interfaces of many traditional traffic management systems, which
separate operator control and text reporting functions from graphic display functions, the
Centracs user interface integrates these operations. This lets you easily move between
contexts in an intuitive point-and-click manner.
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= Modular Architecture

n Management Reports Window Help

e s o e

=]
- -
» J» Group New Signals in Testing
URL COS Traffic Cams

Colorado Springs Trafic Cam Website:
j# 4 Section S 1-25

Database Statistics

Drive Free Space Total Space Used Space
11824 MB 51197 MB

Timestamp
121042010 10-29:45 4
121102010 10-29:55 4
12/22/2010 10-25:30 4
12/23/2010 9:26:51 Al

Modular Architecture

Centracs is a client-server application. The server side maintains the database, controls
device communications, performs periodic functions, and so on. The client gives users an
interface to the database. You can configure Centracs to have all components on one
computer or to distribute them across multiple servers and multiple client workstations.
The client-to-server communication is very efficient, even across a wide-area network.

Centracs is extremely modular and scalable because of its distributed processing
architecture. High system performance can be maintained when the system is expanded,
because system software processes can be distributed across various system processor
components. The system software architecture does not require that one central
processor perform all real-time functions. This protects your systems hardware/software
investment and allows the system to be easily and incrementally expanded to handle any
functions and features that are added afterwards. The Centracs system architecture
provides for modular cost-effective expansion. The architecture has three main hardware
components: workstations, communication servers, and traffic control/database servers.
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Container Technology

Centracs has a flexible screen organization feature called containers. The default
container layout, which has containers to hold six different windows, is shown below:

@®

File View Monitoring Control Configuration Management Reports Window Help D m
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= System Flexibility and Configurability

You can arrange the main window container layout and windows into your own
customized display. You decide which windows to show, and in what arrangement. For

example, if you use the Entity Tree, Map, and Alerts windows most frequently, you can set
up your containers like this:

(C]

File View Monitoring Control Configuration Management Reporis Window Help

Entity Tree Critical Alert List

‘  Ack Selected ‘ | J Ack All ‘ | X Close Selected | | X Close New | | X Close Acked | ‘ X Close All |

Search tree..

Criticality Trigger Device Name Acknowledge State Created
T (L
COS Demo System

5 5 New .0
‘:3 1 5 1 EOS Sig 104 Flash Ack Cl 20112018 12:0¢
» M Section North Colorade Springs Fh '9 e e | X Close

COS Demo Management Seclion i Acknowledged

v ¥ Region Colorado Springs Maintenance (] " Signal EOS Sig 104 Class Test Flash AcKd GUnAck | X Close  2/1/2018 12:0¢

Region COS Signalized Intersections
Sub-Region for Traffic Signals

Region COS Vehicles

Maintenance Vehicles

Map Viewer
= Warehouse COS Signal Shop
Main Warehouse

# Region COS School Flashers
Wi Group BlueTOAD™
w, Group Autoscope Cameras
Group RTMS Simulators
WA s

Wy Scrap Recycle
Asset and Inventory Trash

You can open multiple main windows (for use on multiple monitors), each with its own
customized container layout. The use of “hidden” containers lets you open even more
windows at the same time — these windows are hidden from view to save screen space
until you need them.

System Flexibility and Configurability

Centracs is developed with the latest programming language and software development
tools, and offers the highest level of system flexibility and configurability. It uses a
standard, ODBC-compliant SQL database system (Microsoft® SQL Server) to store,
retrieve, and manage all system data and parameter files. System reports and display
presentations retrieve information from data stored in the database. Client (system user)
workstations access network servers that perform traffic management, database
management, and real-time traffic control and communications functions. Centracs
interfaces to many different field devices and operates via any type of communications

media, including twisted pair and leased line cable, wireless, and single or multi-mode
fiber optic cable.
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Field Devices =

Field Devices

Centracs supports traffic signal controllers and other field devices (such as Dynamic
Message Signs) that comply with the National Transportation Communications for ITS
Protocol (NTCIP) protocol standards. Our total commitment to the NTCIP standard, and
our continued involvement with the standards development process, puts Econolite in a
unique position to deliver a fully-functional end-to-end communication system that can
be maintained to the most current version of the standard. Centracs also supports
protocols other than NTCIP, and offers an upgrade path for users of Oasis (2070L
controller software) and W4IKS (170-type controller software) controllers. Also, because
of the open architecture of Centracs, other protocols and device types may be added in
the future, as necessary.

Device Manager

All connected traffic signal controllers are polled by a Device Manager connected to the
Centracs Traffic Management System (TMS) local area network. Centracs servers
currently support serial or Ethernet protocols (depending on the communication media
used) of individual local intersection controllers, or other devices, interconnected by
multi-dropped twisted-pair wire, wireless, or fiber optic cable circuits. The typical
Centracs interface to a local intersection, or channel of intersections, is as follows: a
Device Manager computer is connected to a controller via the provided interconnects
(serial or Ethernet). The system will support NTCIP versions of Econolite ASC/2, ASC/2S,
ASC/3 (1000, 2100, 2070, or RackMount) NEMA TS1/TS2 controllers, 2070 (E, L, or LN)
controllers running the Econolite ASC/2070, ASC/3 2070, or Oasis firmware, 170-type
controllers running specific versions Wapiti Microsystems W4IKS firmware, or possibly
any NTCIP 1202 compliant NEMA controller or 2070 software. With optional software
modules, Centracs can communicate with CCTV cameras, the traffic control systems of
neighboring agencies, and more.

Maps
Centracs workstations use an advanced map-based Graphical User Interface. Each
workstation user sees an on-screen map of the system area as the main user interface
with Centracs. GIS-based maps (in their natural form) are required for real-time display of
data.
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= Maps

Dynamic icons superimposed on the map indicate the type, status, and location of each

active field device. For example, the screen below shows how a signal icon looks if the
signal is in flash:

@ Map Viewer

E ‘Woodmen Rd

E Wioodmen By

Eir g

You can specify how icons look and change based on status information. You can zoom
and scroll the map to show more or less detail for specific areas. You can also click any
device icon to see more details about that field device, to show live video feeds (with the
optional CCTV module), or to send commands to the device. Centracs uses graphics and
colors extensively to make the map displays easy to understand.

Pr.

026 - Meadows Blvd @ Coachline Rd - 50511 on .22
Meadows Blvd @ Coachline Rd

Jurisdiction General
Type ASC/3
Pfil‘tern_ FLSH ~ Meadows Plwy @ Meadows Bhwd
=1 Zg'::':;'ﬂ 0s § Jurisdiction General
= “7 . Type ASCP3
i3 Veh Detector - Girir Ref: 1- Mo Activity Fault " Ped Phase 4

A

Pattern 1
TimeDrift

o4

|
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Events, Alerts, and Actions

In Centracs you can choose which events to log, which to trigger alerts for, and which to
ignore. For example, you can choose for Centracs to write a log entry each time a signal
changes patterns, but to alert you if communications to a controller are lost.

Alerts are shown graphically in the Centracs user interface. Each alert is categorized as
Informational, Warning, or Critical. Centracs can also forward alerts automatically to
specific online users, to all online users, or to specific offline recipients. Online users are
notified by a pop-up window accompanied by an optional audible alert; offline recipients
are notified by email or SMS text message.

For cases in which an alert is not acknowledged or closed within a reasonable period of
time, you can configure the Alert Escalation feature of Centracs to automatically send the
alert to a different recipient or set of recipients. You can set up multiple levels of
escalation, such that an alert continues to escalate until someone acknowledges or closes
it.

Just as you can configure events to generate alerts, you can also configure them to trigger
one or more actions, such as to generate a report or initiate a CCTV preset.

Closed-circuit TV (CCTV)

CCTV (Closed-Circuit TeleVision) is a video camera monitoring system that broadcasts a
signal to one or more specific monitors (as opposed to a public broadcast). You can use
the CCTV features in Centracs to see intersections and field devices via live video streams.
You can show more than one video display at the same time, and you can dock them in
containers like any other Centracs window. When configured, each camerais shown as an
icon on the Map Viewer and in the Entity Tree for easy on-demand access. Specific camera
views (called “presets”) can be configured to automatically launch if a specific event
occurs. You can also launch presets by manual commands and schedule entries.

Centracs supports Autoscope cameras as well as cameras from vendors such as Axis, Cohu,
ACTI, VCS, and Pelco. If supported by the camera type, Centracs includes PTZ (pan, tilt, and
zoom) capabilities to control the camera position.

Remote Controller Configuration

You can configure controllers locally in the field or remotely from Centracs, via the Signal
Editor feature or via the Remote Front Panel Emulator. For more information, refer to
Maintaining Controller Settings Remotely on page 15-1.
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= Security

Security

Reports

Access to data in Centracs is strictly controlled. Centracs offers multiple levels of security
that you can use to permit or prevent access to specific data and functions on a user-by-
user basis. These levels are:

m Jurisdictions

m Jurisdiction Roles
m  Application Roles
m User Roles

m  UserIDs

For more information, refer to Overview of Security on page 20-11.

In Centracs you can generate a number of useful reports. You can run these reports on
demand or on a schedule — for example, you may choose to schedule the System Activity
report to run at the end of each day. With each report, you can format it, print it, save it
to afile, and/or email it to a recipient. If you frequently run the same report with the same
parameter settings, you can save your settings as a “configurable report” so you never
have to enter them again. For more information, refer to Generating Reports on

page 10-1.

Optional Modules

Advanced Closed-Circuit Television (CCTV) Module

1-8

In addition to the standard CCTV module, Centracs offers an advanced CCTV video
monitoring system as an optional module. The CCTV system is an IP-based interface to a
Genetec server, and provides for network-based switching of digitized video streams. The
system supports multiple camera types and manufacturers. IP cameras or analog cameras
with digital encoders are required for this feature.

With the CCTV features in Centracs, you can monitor all your intersections and field
devices via live video streams from closed-circuit TV cameras. Each camera is shown in the
Entity Tree and the Map Viewer as an icon. Simply double-click a CCTV icon to open a real-
time video display from that camera. You can pan, tilt, and zoom the camera, as well as
set and recall preset views. You can show more than one video display at the same time,
either in independent windows or docked in “containers”.
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Advanced Closed-Circuit Television (CCTV) Module =

In addition to manual, real-time control of cameras in Centracs, you have the option to
digitally archive video streams to permanent storage on a disk drive via the Genetec
Omnicast user interface. This feature is flexible:

m you can schedule archiving during specific times of the day
®  movement in the video frame can activate it
® analarm input can activate it

Centracs puts no limit on the number of cameras in the system or the number that you
can have open at the same time. The total number of cameras is limited by the Genetec
license and the bandwidth of the network; the number of camera displays is limited only
by screen resolution and processor bandwidth.

Video is digitally encoded at the source via low-cost digital encoders or IP cameras from
vendors such as Axis, Cohu, ACTi, VCS, and Pelco. The CCTV module also shows digital
video from Autoscope® Terra™ video-detection cameras. The Genetec server manages and
distributes the encoded video to transmit video to many viewing clients at the same time.
Access to the CCTV system is controlled by privileges associated with user IDs.
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Dynamic Message Signs (DMS)

You can use Centracs to monitor your dynamic message signs (DMS) and to send new
messages to the signs. Messages can be uploaded to Centracs from the sign, configured
in Centracs and downloaded to the sign, or a combination of the two. You can activate
messages on demand, you can schedule them to run on certain days and times, and you
can configure Centracs to send messages when certain events occur.

Each defined DMS has a status display that shows the current message on the sign, the
state of communications between Centracs and the sign, the state of the beacons (on or
off), the current control mode of the sign (remote or local), and any errors being reported
by the DMS (such as climate control errors and message syntax errors):

[] DMS Sign @ Eastwood Transit Center - Skyline (VariableMessageSign) 1s B (<

T FT T
# N
N
saan

Current Message: Controd Mode Central  Brightness: 25
Runtime Priority: 1 Display Type: LED
Message Type: Changeable Voltage: 14.2
Message D 1 Line Voltage: 110

Stored Messages: Time
Permanent 12

Last 1B:45:15 Last Update: 1854518

Changeable: 5 Error: 1s

Cuick Wessage [Biank signf ol JSNETNT

Temperature Warning Door Open

You can also use the Map Viewer to keep an eye on your DMS devices. Each DMS is shown
as anicon on the map. Because the icons are color-coded, you can quickly get information
about the status of the DMS with just a glance at the map. If you hold your mouse pointer

over the DMS icon on the map, Centracs shows a miniature representation of the current
message shown on the sign.
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Centracs Adaptive =

You can issue DMS commands manually (from the DMS Status display, from the map,
from the Entity Tree, or via a manual command), or you can schedule them to run at
specific times via the scheduler. You can also use triggers to configure Centracs to send
specific messages when certain events occur.

Centracs Adaptive

You can use the Centracs Adaptive system to automatically respond to changing traffic
conditions by adjusting offsets and splits on the signal controllers. You can configure
multiple Adaptive algorithms; each controls a specific corridor of intersections. Because
you can use the Centracs scheduler to turn Adaptive on and off, you can configure
Adaptive to run at specific times of the day, on specific days of the week, for specific date
ranges, etc. This gives you flexibility in your operations.

Measures of Effectiveness (MOEs)

The optional MOE (Measure of Effectiveness) reports feature calculates detailed statistics
about the performance of traffic signals and shows these calculations graphically for easy
interpretation by the user. Calculations are made from data collected by ASC/3 and Cobalt
signal controllers. The MOE reports include:

m  MOE Cycle Length Report — graphs the actual length of each cycle run by the controller
during the day.

m  MOE Flow Rate Report —graphs the volume of vehicles detected per hour during each
time of the day for each phase.

m  MOE Green Times Report — graphs the actual length of the green time for each cycle
during the day for each phase.

m  MOE PCD Report — graphs the arrival time of each vehicle in relation to the actual
green, red, and yellow times for the selected phase.

m  MOE Percentage Pedestrian Calls Report — graphs the percentage of cycles during
which a pedestrian call occurred.

m  MOE Split Failures Report — graphs the number of times during the day that the
volume-to-capacity ratio was larger than or equal to the user-specified Failure
Threshold.

m  MOE Volume-to-Capacity Report — graphs the volume-to-capacity ratio for each time
of the day for each phase. Centracs uses this ratio to determine when split failures
occur.
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Travel Time Links

1-12

BlueTOAD™ (Bluetooth™ Travel-time Origination And Destination) by TrafficCast provides
real-time Bluetooth™ detection of current travel times and speeds for specific sections of
road. BlueTOAD detects anonymous Bluetooth™ signals broadcasted from wireless
mobile devices (such as phones, headsets, and music players) inside moving vehicles.
When a particular Bluetooth device in a moving vehicle passes a BlueTOAD checkpoint
(called a Data Collection Station), BlueTOAD records the current time; when the same
device/vehicle passes the next checkpoint, BlueTOAD records the travel time, and uses
the distance between the two checkpoints to calculate the speed of the vehicle.

Though BlueTOAD is a separate system, Centracs offers an optional Travel Time module
that allows you to integrate your BlueTOAD data into the user interface of your Centracs
system. Centracs communicates with your BlueTOAD web server to retrieve the latest
information, then shows it in maps, reports, and status displays in Centracs.

With the Travel Time module, you can quickly see the current status of your roadways at
a glance:

@ Map Viewer

[T
i
b

* IVlanor

reeline Avi

Centracs User Manual
Software Version 2.x - March 2018



Overview of Centracs

Data Collection Management System (DCMS) =

Data Collection Management System (DCMS)

The Data Collection Management System (DCMS) module collects real-time vehicle
detection data from Autoscopes and RTMS devices, and allows users to:

view streaming video and snapshot images from the Autoscope video vehicle
detectors (if supported by the device type)

view the locations of the field devices on a map
monitor real-time communications between Centracs and the field devices
generate reports and graphs to analyze the detection data

compare the data for different devices, different detectors, and/or different dates

The Entity Tree shows a hierarchical view of all your Autoscope and RTMS devices, and
their associated detectors. Your devices can also be added to the map view. If supported
by the device type, you can hold the mouse over the entity on the map to see the latest
snapshot image or live video feed:

@ Map Viewer
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= Data Collection Management System (DCMS)

Several monitoring screens allow you to quickly see the status of your devices in Centracs:

@ Device Status

Name Description Type
Local Beacon Street @ Filmore Street @'s 4 &7 Fillmore Street @ Beacon Street S Detect e 1000% . 0 0
Local Centennial Bivd @ Fillmore Street, 172.22.22 91 Centennial Bivd. @ Fillmore Street \-,. Detect e 1000%, . 0 0
Local Beacon Street @ Filmore Street @'s 2 &5 Fillmore Street @ Beacon Street “e Detect e 1000%, . 0 0
Local Beacon Street @ Filmore Street @'s 6 & 1 Fillmore Street @ Beacon Street S Detect 0 0
Local Mesa @ Fontmore, 172.22.22 92 Mesa Road @ Fontmore Street \,

Local Autoscope - Woodmen Rd @ Union
Local SB Union Bivd @ Woodmen Rd

Local East Colorado Ave @ MNorth Wasatch
NB Union Bivd @ Woodmen Rd
WB Woodmen at Union
Beacon Street @ Filmore Street @'s &

Beacon Street @ Filmore Street @'s 8 & 3 det 148

3det2

2/28/2018 14:30:00  Beacon Street @ Filmore Street @'s 4 & 7 det 145

2/28/2018 14:35:00  EB Woodmen Rd @ Union Blvd det 134

2i28/2018 14:30:00 Mesa @ Fontmore, 172.22.22.92 det 111

2/28/2018 14:30:00  Beacon Street @ Filmore Street @'s 2 & 5 det 146
Time Last Updates

Status:

Snapshokt 0:19 PM

Last Poll Data:  1:27:41 PM

Last 14:30:46
Eror: 125

2/28/2018 14:35:00  'WB Woodmen at Union det 140

GABBOTTABENE  Acscemy Bt © Lovas Sest Det 3

DCMS supports these device types:
m Autoscope Solo Pro II®

m Autoscope RackVision™ Pro

m  Autoscope 2020™

m Autoscope Solo Terra™

m Autoscope RackVision Terra™

m  Autoscope System-16 Terra™

m  Autoscope ENCORE™

m  Autoscope Duo™

m  RTMS (G4, X3, or SX-300)
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In addition to the standard Centracs reports, the Detector Group Chart allows you to
generate various graphs and data tables to organize, display, and compare your detector
data:

(® Detector Group Chart
¥ | “» Beacon Street @ Filmore Street @'s 4 & T Fillmore Street @ Beacon Street

Comparison Graph for Solo Pro 11-5B Phases 2 and 5
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Mewest Timestamp: 2/21/2018 00:00:00 Last Updated: 2/28/2018 13:41:26

Local Edition

Centracs Local Edition (or LE for short) is a streamlined version of Centracs for technicians
to manage intersections locally at the cabinet. These intersections may or may not be
directly connected to a Centracs central database through normal communication
mechanisms. With LE, technicians can do uploads and downloads between a laptop and
locally-connected controllers in the field. It also permits the exchange of data (entities,
controller settings, log data, etc.) between the laptop and the main Centracs database, or
between two Local Edition laptops.

LE offers a subset of the tools available in the full Centracs software — only the ones
necessary when connected locally to one controller. These include such tools as manual
commands, controller database editors, the signal status display, and the detector fault
status monitor. It also includes tools for technicians to synchronize their changes with the
main Centracs database when they go back to the office.

LE offers the same basic user interface as Centracs, including containers, the Entity Tree,
preference sets, and so on. As a result, experienced Centracs users can start working in LE
immediately, with little to no training.
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Features

m Standard Centracs user interface

m  Two-way synchronization between Centracs and LE

m Direct connect from laptops to controllers via serial connection or Ethernet

m NEMA & 170/2070 support in one system

m Database editing, uploading, and downloading for all Centracs-supported controllers
m Easy device configuration

m Flexible device hierarchy, groupings, and jurisdictions

m  Manual commands and action sets

m  Graphical signal status display

m Detector fault monitor

®  Management of controller and system logs (including uploading, viewing, archiving,
purging, and restoring)

m User-definable roles and privilege settings

Communications and Device Support

LE supports Ethernet and serial communication connections between the laptop and a
controller, and supports TCP/IP, UDP/IP, RS-232 serial, ACT, and PMPP protocols. Traffic
signal device support includes: Econolite’s NTCIP-based ASC/2, ASC/2S, and ASC/3 (1000,
2100, 2070, or Rack Mount), NEMA TS1/TS2 controllers, 2070 (E, L, or LN) controllers
running ASC/2070, ASC/3 2070, or Oasis firmware, Siemens EPAC/SEPAC controllers
running EPAC version 4.01D, 170-type controllers running specific versions of Wapiti
WA4IKS firmware, and NTCIP1202-compliant controllers.

Database Synchronization

From Local Edition, a technician can copy data from the main Centracs database for use
on the laptop in the field. Later, after the technician is done working in the field, the new
data on the laptop can be selectively merged with the data in the Centracs central
database, or with a different LE database on a separate laptop or workstation. The
synchronization tool inspects the data on the two systems and indicates which system has
the newest data for each object. The user can then select which data to merge. The
feature used to merge entity data permits technicians to manage field assets using the
same structures, permissions, and jurisdictions defined in the Centracs database. When
you use LE in conjunction with Centracs, the main Centracs database acts as the master
copy of all controller configuration data, regardless of whether the controllers are
connected to the central system.
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Maintenance Management System (MMS)

Centracs MMS (Maintenance Management System) is an automated GIS-based system
that manages and tracks ITS and signal equipment assets, trouble tickets, work orders,
and preventive maintenance activities performed by technicians. It is offered as a stand-
alone system or as an add-on module to the Centracs ATMS system or Centracs DCMS
system.

File View Monitoring Control Configuraion Management Reporis Window Help

[() Table of Contents
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Signal Status
cotv
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;" CCTV Location 2nd & Main
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SBrennod 01 g poc

(@) Liniec Crosswalk Cimarron @ 213t
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19892 ZL:145
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™ D Colorado Springs System System 1/23/2014 16:3
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Features

m Real-time asset tracking through the entire asset life cycle

m Asset life-cycle history, including in-service time, failures, repairs, movement to
another location, PM activities, depreciation, and replacement value

m User-definable asset types and properties
m User-definable Preventative Maintenance (PM) plans, activities, and schedules

m Tracking and reporting of work order and trouble ticket activity
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m Dispatch scheduling and on-call notification planning
B Real-time GIS maps highlight active trouble tickets and work orders at a glance
m Location-based storage and retrieval of drawings, manuals, and other documents

m  Mobile web interface for technicians to record equipment transfers, preventive
maintenance activities, and trouble ticket resolution using a smart phone, tablet
device, or laptop in the field

m Real-time data logging, display, archiving, reporting, and alert notifications

m Scheduled email report delivery to keep users informed even when they are not
logged into the system

m Automatic generation of trouble tickets based on alarm and alert conditions

m Sorting and filtering of assets and locations in the Entity Tree

Center-to-Center Interface Module

Centracs also has an optional NTCIP center-to-center interface that uses published NTCIP
objects to transmit and exchange data objects that are necessary to interface with other
NTCIP central software. Data is securely exchanged between centers and shown on each
system.

O S oS’

Advanced Transportation Management System

Layered Architecture

[ Remote Client ]

( RichCIient J( RichClient ] (Terminal Services )

v {

( “Core” Server Data

External
Center

Abstraction
Layer

Scheduler, Traffic Responsive, Other Services

Standard or Custom
C2C Protocol

ASC Device Device WA4IKS Device Device
Manager Manager Manager Manager Database

[ NTCIP cCcTV OASIS / Other... —

[ Devices ]
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Server-to-Server Interface Module

Because Centracs systems use the same database configurations, if two or more agencies
use Centracs, you can use the Server-to-Server interface module to exchange real-time
traffic data. This module offers fuller data exchange than the Center-to-Center module.
For more information, refer to Configuring Server-to-Server (S2S) on page 12-1.

CF oS’
i Transportation System
Layered Architecture ( Rem‘;‘;;”e"t )
( RichClient | ([ RichcClient ][ RichClient ] (Terminal Services )
o “Core” Server Data
Core” Server Scheduler, Traffic Responsive, Other Services Abstraction
Server-to- Layer
Server

Protocol ¢ ¢ ¢ ¢
NTCIP ccTV OASIS / Other... C

ASC Device ASC Device Device WA4IKS Device Device
Manager Manager Manager Manager Manager Database
[ Devices ] [ Devices ]
Centracs User Manual 1-19

Software Version 2.x - March 2018



Overview of Centracs

= Synchro™ UTDF Interface Module

Synchro™ UTDF Interface Module

1-20

Centracs offers an optional module to interface with the Synchro™ phase timing and
coordination analysis software by Trafficware®, Ltd. Synchro models traffic flow in order
to optimize traffic signal timing. You can use the optional Synchro add-on module for
Centracs to exchange traffic controller parameter data with Synchro.

For NTCIP controllers, the UTDF interface is accessed through the Signal Editor. For ACT
controllers, the UTDF interface is accessed through the Entity Tree or Map Viewer. You
can use the UTDF interface to export controller timing plans and phase data from the
system into the Universal Traffic Data Format (UTDF), which is compatible with Synchro.
After the data has been saved in this format, you can open it in Synchro for analysis and
optimization. You can also use the UTDF interface to import timing plans and coordination
data from Synchro back into Centracs.

Note ¢ You cannot import phase timing data from Synchro into Centracs. You must
manually enter phase timing data into the Signal Editor, then download it to the controller.
Also, the UTDF interface does not support split and offset values that are calculated as a
percentage of cycle length. During export, percentage-based splits and offsets will be
changed to seconds; during import, they will be changed back into percentages, if
necessary. As part of these conversions, the split and offset values may undergo some
rounding.

The Synchro UTDF interface supports ASC/2 controllers (both standard and NTCIP), ASC/3
and Cobalt NTCIP controllers, Eagle controllers, Oasis controllers, and W4 controllers.

For instructions on how to export and import controller data, refer to Using the UTDF
Interface Module on page 15-24.

For more information on Synchro, visit the Trafficware website.
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General System Architecture

Local and Wide Area Network

Centracs supports the concurrent use of multiple workstations (Rich Clients) over local
and wide-area network connections. The number of workstations that can connect is only
limited by the capacity of the network and the system servers, which you can increase if
necessary. Centracs uses a password-based security system for users to log into the
system; this security system prevents unauthorized workstations on the same network
from accessing the traffic system. Centracs uses jurisdictional access and user-group
permissions to ensure database integrity.

Also, the optional Center-to-Center (C2C) interface module allows the limited exchange of
data across jurisdictional boundaries using NTCIP C2C protocols. For a more complete
exchange of data, two or more agencies that use Centracs can use the optional Server-to-
Server interface module to connect their systems together.

CFE S’
Advanced Transportation Management Sysren; .

. Remote Client
Layered Architecture [ / ]

[ RichcClient )( RichClient ] (Terminal Services )

{ { {

“Core” Server
Scheduler, Traffic Responsive, Other Services

NTCIP [ CCTV] OASIS/ Other... —

Data

Abstraction
Layer

ASC Device Device WA4IKS Device Device
Manager Manager Manager Manager Database
Dewces ]

Communications

Usually, the user workstation reads data from the database on the Core (file/application)
Server, which is populated in real time directly by the Device Manager. You can configure
the Device Manager to communicate serially (RS-232) or via Ethernet (UDP/IP)
communications to the controllers and other field devices. Centracs supports fiber optics
(multi or single mode), twisted pair, leased lines, and wireless communication modems.
Serial-based media usually support a communications data rate of 9600 to 19,200 bps;
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Ethernet supports up to 100 mbps. Direct full-time interconnect is usually necessary to
connect the Device Manager computer to the local intersections in the field, but Centracs
is designed to communicate remotely to permit intersection control from a central office.
Device Manager and communication channel capacity are different based on the type of
interconnect that is used. But because Device Manager computers are designed to
support a minimum of 250 devices serially (or more via Ethernet), Centracs can manage
more devices each time a Device Manager computer is added.

Device Managers

Centracs uses Device Managers to manage all system communications. The Device
Manager supports NTCIP protocols to Econolite ASC/2, ASC/2S, ASC/3 (1000, 2100, or
RackMount) NEMA TS1/TS2 controllers, 2070 (E, L, or LN) controllers running the
Econolite ASC/2070, or non-NTCIP controllers such as 2070s with Oasis firmware and 170-
type controllers running specific versions of Wapiti Microsystems W4IKS firmware. Other
NTCIP 1202-compliant NEMA controllers or 2070 software may be added in the future.
The communication process uses a polled-response type of communications to the field
devices. The Device Manager software does all of the low-level communications functions
necessary to interface with the different field controllers for traffic signal control, status
monitoring, and data upload/download. Low-level functions include device polling,
message input/output buffering, message sequencing and prioritization of tasks, error
checking/correction, data filtering, and short-term data storage. This distributed
processing architecture in the system relieves the traffic application/file server from doing
these processing-intensive tasks and also prevents these functions from becoming a
bottleneck on the local area network.

You can configure multiple Device Managers. Device Managers isolate the knowledge of
specific device types into separate executable applications, which allows modularity and
scalability.

Core Applications

1-22

Centracs uses a Core File and Application Server to operate and manage devices and user
interfaces. All data shown on displays or entered on local workstations is managed by the
Core Server and directed to Device Managers, a Center-to-Center interface, a Server-to-
Server interface, or directly to the SQL database through a Data Abstraction Layer. For
more system efficiency and scalability of operation, it is recommended that you run the
SQL database manager on a different computer.
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Traffic Signal Management and Control

In addition to control and monitoring displays, you can use formatted data-entry screens
to store and edit parameter data for different system elements. For example, you can use
traffic controller data screens to easily edit local controller parameters and to upload and
download these parameters to/from local controllers in the field. During system
operation, user alerts are shown in the graphical user interface (GUI), with an alert
indicator on the toolbar and a separate alert window that you can keep on-screen to
continually monitor alerts.

The main display has a toolbar near the top of the window that contains menus and other
controls to configure container windows, set session parameters, or enable another
action or activity that affects the entire session. Actions supported by and pertaining to a
single window or container are enabled through that window’s action bar or controlled
inside that window.

Centracs has many ITS functions, of which traffic signal management and control is one of
the primary applications. Centracs is a powerful management tool for engineers, with:

m Intersection database management

m Flexible central scheduling of events

m Detailed system, signal, and detector, and efficiency reports
m Alert paging and emailing

m  Powerful analysis tools, such as system detector “link” displays, Time-Space diagrams,
Split Monitor graphs, Synchro™ Interface, etc.

Traffic Signal Monitor

Centracs uses windows called “Signal Status displays” to represent each of your
intersection configurations. The display has graphic representations for up to 16 phases
(red, yellow, and green indications), 16 pedestrian movements (Hand and Man symbols),
16 overlaps (red, yellow, and green indications), and up to 32 detectors and status
symbols such as Communication Failure, Preemption, Coordinator Alarm, Detector Fault,
and Cabinet Flash. An integrated graphics editor allows you to add symbols to the display
to represent each of the movements, detectors, and status indicators.

Custom graphics are also available. These graphics are usually based on an aerial
photograph of the intersection or an actual CAD-type drawing. After it has been
configured in Centracs, the graphic display accurately shows the intersection geometry,
lane configuration, and other important elements. As with the template-based graphics,
you can add symbols to represent each of the movements, detectors, and status
indicators specifically for each intersection.
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Traffic Signal Control Modes
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Main Server Features

The Centracs main server computer(s) provides for system-wide signal database control,
communications, coordination, and continuous monitoring of system performance from
the central location. The system is designed for unattended operations 24 hours per day,
seven days a week, without requiring an operator to be logged on. The central facility has
the capacity for continuously monitoring and exercising plan selection control for all
controllers and/or other devices. The central system monitors the operation of all field
devices and automatically reports detected failures and malfunctions. With requisite
licensing and interface equipment, you can attach any number of workstations (desktops
or laptops) to the Centracs network, each capable of different functions, which include:

m Traffic control and management functions
m Historical data analysis
m Traffic engineering operations analysis

You can configure intersections in any number of control Sections, each running Traffic
Responsive, time-of-day, or manually-selected timing plans.

Central and Local Control

Centracs continuously transmits and receives status data from each intersection via
communications media. Centracs also supports data parameter upload, download, and
time/date communications requests on a periodic request-driven basis.

Centracs distributes actual low-level traffic signal control responsibilities to the local
intersection controller. Maintenance of coordination is managed locally and only requires
that timing plan parameters be available at the controller and that controller firmware
keeps an accurate time base. Local time base clocks are synchronized with the central
system periodically via regularly-scheduled time/date update communications functions.

When operating under centrally-selected Traffic Responsive (TR), Time-of-Day (TOD), or
Manual Mode (MM), the communications system sends a plan number to the local
controller, which specifies the selected plan of operation necessary for that controller. In
TOD Local mode (Plan 0), plan selection occurs locally according to the TOD/DOW (Day-
of-Week) schedule that resides on each controller.

The central system continuously monitors local controller operations for malfunctions for
all controllers that communicate with the central system (regardless of the current plan
selection mode).

A minimum of 48 locally-stored coordination-timing plans can be supported at each local
controller through NTCIP commands. (Per the TS2 Standard, ASC/2 controllers have 64
coordination plans; ASC/3 and Cobalt controllers have 120 coordination plans.) Each plan
has a cycle length, an offset, and a split set. Timing plans also activate phase omits, phase
calls, special function outputs, and phasing sequences as set by the parameters in the
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local plan on the controller. A plan input can also command Free, Flash, and local Time-
Based Coordination (TBC) control plans.

System Control Modes

Centracs accommodates system control modes that are based on operator commands,
TOD schedules, and device status monitoring. You can use these modes at several levels:
System, Section, Subsection, Group, and Signal.

For details about how commands are prioritized and how conflicting commands are
resolved, refer to Overview of Scheduling and Manual Commands on page 7-1.

Programmed Free and Flash operations are selected by invoking special plan numbers
that correspond to these operations. You can implement MAN plan selection on a System,
Section, Group, or Signal basis.

Intersection Controller Manual Override selection(s) take precedence over Group-based
selections, which in turn take precedence over Section or System-wide selections. It is
possible for you to set independent termination time frame(s) for MAN mode selections
at any level.

Local controllers will always go back to a designated local TOD (Local) mode when not
being commanded into one of the other system control modes by the central. The
controller also goes into this mode if it is in TR mode but there is not sufficient detector
data for TR to run, and no other central mode is available. The local controller parameter
settings affect the local TOD mode to cause the controller to be in the Free State or
operate in a locally-determined TOD/DOW plan.

Group, Section, and System Control

Optionally, you can assign controllers and other ITS devices to “Sections” for plan
implementation of Traffic Responsive, time-of-day, and manual control. In addition, you
can command central flash on a Group-wide (a combination of individual devices and
Sections), Section-wide, or System-wide basis. You can configure intersections in any
number of control Sections, each running Traffic Responsive, time-of-day, or manually-
selected timing plans. All control Sections that operate on a common cycle length are
automatically synchronized because they use the same master cycle timer.

System Time Reference Synchronization

You can specify when the Device Manager synchronizes the clocks. At the specified time,
the server synchronizes the local time clocks in each of the controllers it supports. The
server computer clocks are synchronized with each other with a standard protocaol,
Network Time Protocol (NTP). You can also synchronize the workstation clocks with this
protocol. An internet time source is usually included as part of the system hardware to
associate all system clocks with a traceable time source. The cycle-reference time used by
traffic controllers is a function of the traffic controller software. Per the TS2 standard, the
start of main street green is defined as the local zero point.
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Main User Interface

Menus

The main user interface of Centracs is intuitive and easy to use. There are three main
functional areas of the user interface:

m Menus
m  Containers

m Status Bar

The sections below explain these three functional areas.

The main menu in Centracs includes these submenus:

Submenu Options For details, refer to...

File Log Out Logging Out on page 1-39
Settings Administrative Settings on page 20-1
Exit Logging Out on page 1-39

View Entity Tree Using the Entity Tree on page 3-1
Favorites Bookmarking Your Favorite Entities on page 3-16
Map Using Maps on page 5-1
CCTV Tours Using CCTV Tours on page 8-13
Notes Adding Notes to Entities on page 3-14
Edit Preset Maps Edit Preset Maps Option on page 5-7
Preference Sets Using Preference Sets on page 2-19
Save Preference Set As Using Preference Sets on page 2-19
Skins Changing the Color Theme on page 2-18
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Submenu Options For details, refer to...
Monitoring Comm Statistics Communication Statistics on page 6-51
Comm Test Testing Comms between Centracs and a Controller on
Device Status page 6-16
Detector Group Chart Viewing the Device Status Window on page 6-23
Detector Log Status Using the Detector Group Chart on page 17-33
Split Monitor Viewing Detector Log Status on page 17-28
Time Space Analysis Using Split Monitor on page 6-26
Detector Fault Status Using the Time Space Analysis on page 6-33
Device Collection Monitor Monitoring Detector Faults on page 6-48
Real-Time Detector Status Using the Device Collection Monitor on page 6-19
Real-Time Link Status Real-Time Detector Status on page 6-42
Alerts Real-Time Link Status on page 6-45
Current Users Using the Alert List on page 4-22
Server-to-Server Status Monitoring Users on page 20-31
MOE Reports Viewing S2S Systems Status on page 12-9
Adaptive Monitor Using the MOE Reports on page 11-1
Threshold Traffic Monitoring Adaptive Status on page 18-29
Responsive Monitor Monitoring Real-time TR Calculations on page 13-16
Control Manual Commands Issuing Manual Commands on page 7-8
Scheduler Using the Scheduler on page 7-11
Holidays/Special Days Specifying Holidays and Special Days on page 7-18
Preventive Maintenance Using the PM Checklist Scheduler on page 19-64
Checklist Scheduler
Scheduled Preventive Scheduled PM Checklists on page 19-71
Maintenance Checklists
Tickets Working With Tickets on page 19-51
On-Call Scheduler Using the On-Call Scheduler on page 19-27
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Submenu

Options

For details, refer to...

Configuration

Master Inventory

Type and Field Definitions
Shared Field Definitions

Manufacturers

Preventive Maintenance

Checklist Items

Preventive Maintenance

Checklists
Detection Devices
Street Names
Detector Groups
Servers/Comms
Polling Packets
Traffic Algorithms

Alerts and Events

Maintaining the Master Inventory List on page 19-13

Using the Type and Field Definitions Window on
page 19-5

Defining Shared Fields on page 19-8
Defining Manufacturers on page 19-12
Adding PM Checklist Items on page 19-60

Adding PM Checklists on page 19-62

Configuring & Deleting Autoscope Entities on
page 17-14

Using the Street Names Editor on page 20-88
Maintaining Detector Groups on page 17-39
Setting Up Communications on page 20-32
Configuring Polling Packets on page 20-50
Creating a Traffic Algorithm on page 13-5

Action Sets Configuring Events, Alerts, and Triggers on page 4-1
Map Layers Running Action Sets on page 7-21
Editing Map Layer Settings on page 20-83
Management | Users Defining Users on page 20-24
User Groups Defining User Groups on page 20-30
Change Password Changing Your Password on page 1-39
User Roles Defining User Roles on page 20-23
Application Roles Defining Application Roles on page 20-19
Jurisdiction Roles Defining Jurisdiction Roles on page 20-14
Jurisdictions Defining Jurisdictions on page 20-12
Recipients Defining Recipients on page 20-73
Global Settings Overview of Global Settings on page 20-54
Local Settings Overview of Local Settings on page 20-53
Merge Data Merging Entity Data on page 16-1
Purge Data Purging Report Data from the System on page 20-94
Merge Logs Merging Log Data on page 16-8
Server-to-Server Configuring Server-to-Server (52S) on page 12-1
External Connections Configuring Server-to-Server (52S) on page 12-1
1-28 Centracs User Manual

Software Version 2.x - March 2018



Overview of Centracs

Menus =

Submenu Options For details, refer to...

Reports all Centracs reports Generating Reports on page 10-1
Data Collection Reports on page 17-42
MMS Reports on page 19-88

Tools n/a Adding Shortcuts to the Tools Menu on page 2-14

Window New Container Window Using Multiple Monitors on page 2-13
New Auto-Hide Container | Using Hidden Containers on page 2-11
Main Container Window Selecting a Container Layout on page 2-2

Active Windows Viewing Active Windows on page 2-28

Use the Help menu to access the online help system, or to see the client/server version
information for your current installation. (You can also press F1 from any screen to open
the help topic associated with that screen. For more information about the online help
system, refer to Using the Online Help on page 1-40.)
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Containers

The main screen layout of the Centracs application is flexible — you can make your own
arrangement of windows. When the application is launched for the first time, the main
screen shows a set of empty boxes, as shown below. Each of these boxes is a container for
a window. To quickly and easily make your own customized view of Centracs, you can
open the windows you use most, then drag and drop them into these containers. When

you exit the application, your container layout is kept in the database, and is recalled the
next time you log in.

File View Monitoring Control Configuration Management Reports Window Help D |
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You can arrange the main window container layout and windows into your own
customized display. You decide which windows to show, and in what arrangement. For
example, if you use the Entity Tree, Map, and Alerts windows most frequently, you can set
up your containers like this:

@
File View Monitoring Control Configuration Management Reporis Window Help
Entity Tree Critical Alert List
Q- 7k
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| Status Bar

The status bar gives you a picture of the overall health of the Centracs system and
provides information about the database, the application, and existing alerts.

Icon Description

E Mobile/Touch Mode. Toggle this icon to increase or decrease the display
fonts for mobile applications.

n Feedback. Clicking on this icon opens the Centracs UserVoice window from
where you can submit ideas or provide suggestions on how to improve the
Centracs experience.
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Icon Description

Core Status. Hovering over this icon displays the percentage of CPU and
Memory resources used by Centracs. Clicking on this icon opens the
Application Monitoring window. For details, refer to Viewing Application
Statistics on page 20-97

Database. Hovering over this icon displays the status of the database.
Clicking on the icon opens the Database Statistics window. For details, refer
to Viewing Database Statistics on page 20-99.

Tickets. Provides a quick indicator of how many tickets have been created
and displays Dispatched, Accepted, Started, Arrived, and Closed Work
Pending status. Clicking on this icon opens the Tickets window.

Scheduled Preventative Maintenance. Provides a quick view of how many
maintenance tasks have been Assigned, are In Progress, and are Past Due.
Clicking on this icon opens the Scheduled Preventative Maintenance
Checklists.

Alerts (Information, Warning, Critical): Displays the number of alerts.

The number in each circle shows the count of current alerts for that type (in
this example, six alerts are shown). If there are no alerts of a specific type,
no number is shown in the corresponding circle, and the circle is dark.

When there are unacknowledged alerts, and after all of the alerts of a
specific type have been acknowledged, that indicator stops blinking.
Informational alerts are considered to be acknowledged on receipt, so
the Informational indicator does not blink. To manually stop an indicator
from blinking, right-click it.

To see details about the alerts, click the alert status bar to open the Alert
List. For more information, refer to Using the Alert List on page 4-22.
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| Centracs UserVoice:

From this window, you can submit your idea to improve the Centracs experience or vote

on

ideas submitted by others.

From the main menu, click the Feedback D icon; the Centracs UserVoice window opens.

To

i & W N =

-

(o]

i A W N =

O = QS‘”
UserVoice

Your ldea, Your Vote.

Do you have an idea for how to improve the Centracs experience? If 5o,
submit your idea here on this site. And, because you can vote for ideas submitted
by others, you always have a say in what gets prioritized for insertion in the next
Centracs software release.

No idea is too trivial or too grande - if you feel that a specific feature or

vote or add a comment to a previously submitted idea:
Click on a previously submitted idea or comment.

Click Vote on the left side of the message.
Enter you email address, your name, and agree to the terms of service.
Click 1 vote, 2 votes, or 3 votes (you have 10 total votes).

You can also add a comment in the “comments” field and then click Post comment.

enter your idea or suggestion:
Scroll down and click | suggest you ... to open the suggestion field.

Enter your idea in the “l suggest you...” field.
Select a Category from the pull down menu and describe your idea.
Click Post idea to submit your suggestion.

To go back to the main window, click Your Idea, Your Vote under General (top left).
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| Glossary of Terms

The table below identifies some of the transportation terms, Centracs-specific terms, and
acronyms used in this manual.

ACT Advanced Computing Technologies, Inc.
ATMS Advanced Traffic Management System.
BIU Bus Interface Unit.

BlueTOAD  Bluetooth™ Travel-time Origination And Destination.

c2C Center-to-Center. For more information, refer to Center-to-Center
Interface Module on page 1-18.

CAD Computer-Aided Design.

ccrv Closed-Circuit TeleVision. A video camera monitoring system that
broadcasts a signal to one or more specific monitors (as opposed to a
public broadcast). For more information, refer to Using CCTV Displays on

page 8-1.
DCMS Data Collection Management System.
DMS Dynamic Message Sign. For more information, refer to Using Dynamic

Message Signs (DMS) on page 9-1.

DOW Day of Week.

ECPI Econolite Control Products, Inc.

EDI Eberle Design, Inc.

Entity A device or other object that is managed by Centracs (for example, a CCTV

camera or a Signal), or a collection of devices managed by Centracs (for
example, a System or Group).

An entity may be a device, a collection of devices, a collection of
collections, or a link to a website or program.

Entity Tree A hierarchical tree view of all the entities defined in the Centracs system.
For more information, refer to Using the Entity Tree on page 3-1.

GIS Geographical Information System. This integrates hardware, software,
and data used to capture, manage, analyze, and show all types of
geographically-referenced information.

GUI Graphical User Interface.

HAR Highway Advisory Radio.
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INTID Intersection ID or controller number.

IP Internet Protocol.

ITS Intelligent Transportation System.

LAN Local Area Network.

LE The Local Edition of the Centracs software. For more information, refer to

Exchanging Data with ‘Local Edition’ on page 16-1.

LOS Level of Service.

MMS Maintenance Management System.

MMU Malfunction Management Unit.

MOE Measure of Effectiveness.

MPH Miles Per Hour.

MSG Main Street Green. For more information, refer to Using the Status

Display for Sections/Subsections on page 6-10.

MULTI Mark-Up Language for Transportation Information (used with Dynamic
Message Signs).

NTCIP National Transportation Communications for ITS Protocol.

ODBC Open Data Base Connectivity.

oID Object IDentification.

OsSM Oasis On-Street Master.

PM Preventive Maintenance.

PMPP Point-to-Multi-Point Protocol.

POP Post Office Protocol.

PTZ Pan/Tilt/Zoom feature on CCTV cameras.

RTMS Remote Traffic Microwave Sensor.

RWIS Road Weather Information System.

S2S Server-to-Server. For more information, refer to Server-to-Server

Interface Module on page 1-19.

SDK Software Development Kit.
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SMS Short Message Service. Popularly known as “text messages” to and from
mobile phones and other mobile devices.

SMTP Simple Mail Transfer Protocol.

TBC Time-Based Coordination.

TCP Transmission Control Protocol.

TOD Time Of Day (refers to the time-based schedule configured locally on a
controller).

TR Traffic Responsive.

TSA Time Space Analysis. For more information, refer to Using the Time Space

Analysis on page 6-33.

uUDP User Datagram Protocol.

URL Uniform Resource Locator; the unique address for a website or file that is
accessible on the Internet.

UTDF Universal Traffic Data Format.
VoS Volume/Occupancy/Speed.
WMS Web Map Services.

XML eXtensible Markup Language.

* Some entries are adapted from the U.S. Department of Transportation Federal Highway
Administration definitions.
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Logging In

To log in to the Centracs application:

1 Launch the Centracs program (from the shortcut in your Microsoft Windows® Start
menu or on your Windows Desktop).

The Log In screen opens.

BlueTOAD™

C2C Plugin

Centracs Adapiive
Centracs MMS
Pagssword:
Cohwu CCTV
Data Collection Station
Dynamic Message Sign

Eagle EPAC »]

Eos Support

00« d -2

2 Enter the User Name and Password you received from your Centracs administrator.
Passwords are case-sensitive; user names are not.

3  If you want to connect to a different server, click Advanced [8] to show the Core field:

Modules .
B Centracs
BlusTOAD™
C2C Plugin
Centracs Adapfive

Core:
Cenfracs MMS

centracs. olite.com:81 v  Discover
Cohu CCTV
Data Collection Station

Dynamic e Sign

Eagle EPAC ’] x _(:}

/|
R
=
»
)]
5=

Eos Support

Click Discover. This finds all Core servers available on the network. From the
dropdown list, select the appropriate server, or enter a different one.

4 Click Log In.
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If you entered the user name and password correctly, a series of messages is shown as
you are authenticated and logged on.

If this is your first time to log in to the application, the first screen you see will be
similar to the screen shown below.

File View Monitoring Control Configuration Management Reports Window Help D m

The title bar of the window shows the first and last name of the user who is logged in,
followed by the preference set that is in use (refer to Using Preference Sets on
page 2-19).

Note e The system automatically logs you out after a period of inactivity in the interface
(as set by your system administrator).
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Logging Out

Note e When you log out of the application, the system saves your display settings.
Centracs uses these settings again the next time you log in.

To log out and close the application:
m  Click File » Exit.

Or

m Click the Edin the upper-right corner of the interface.

To log out and log back in:

m Click File » Logout. This logs out the current user and opens the Log In window so that
you can log in to a different account. Or you can click Close on the Log In window to
close the application entirely.

Changing Your Password

The first time you log in to the application, change your password.

Note e If you are an administrator, you can reset the password for another user, in the
event that they have forgotten their password. Refer to Defining Users on page 20-24.

To change your password:
1 From the main menu, select Management » Change Password...

The Change Password window opens.

® Change Password

Old Password | **®****

New Password |**®****®

Verify Password |"""'|

2 Enter your current password in the “Old Password” field, and enter your new
password in both the “New Password” and “Verify Password” fields.

3 Click OK.

The minimum password requirements (for example, password length, and whether
uppercase characters are required) are configured by your system administrator. If the
new password you entered does not satisfy these requirements, the system shows an
error message with details about why the new password is invalid, and you are asked
to enter a stronger password.
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Using the Online Help

The online help system is accessible from the Centracs application via the Help menu or
the F1 key.

To browse or search the online help:
1 From the Centracs main menu, select Help » Help Topics.
The online help system opens in a new window.

2 Use the Contents tab in the left pane of the window to navigate to a specific topic, or
use the Search tab to find topics that contain one or more specific keywords.

To use the Contents tab, click a book to expand its contents, then click a topic to open
it in the right pane of the window.

To show context-sensitive help for a specific window:
While the window is open in Centracs, press the F1 key. A help topic specific to that
window opens.

Technical Support

For more information or for assistance, please contact Econolite Technical Support, or
browse our website:

Phone: 1-800-225-6480
Email: support@econolite.com
Web: www.econolite.com

From the Econolite website, you can click SUPPORT for links to
Econolite’s support website and product training resources. You
can also scan this QR code to quickly access our Technical Support
site, the EGI Learning Center, Product Datasheets, and more:

Note e You must register in order to use the support site; after you have registered, you
can access the site directly at techsupport.econolite.com.

Give Feedback

1-40

Do you have an idea for improving your workflow in Centracs, or for enhancing the overall
Centracs experience? If so, submit your idea on the Centracs UserVoice website to share
it with the Centracs community. You can also vote for ideas submitted by others, add

comments, view comments from Econolite’s product steering group, and view the status
of each submitted idea (approved, declined, under review, etc.). To participate in Centracs
UserVoice, go to econolite.uservoice.com, or click the D icon in the Centracs status bar.
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Customizing the User Interface

Overview of Containers

With the versatile screen layout of Centracs, you can make your own arrangement of
windows. When the application is launched for the first time, the main window shows a
set of empty boxes, as shown below. Each of these boxes is a container for a window. To
quickly and easily make your own customized view of Centracs, you can open the windows
you use most, and drag and drop them into these containers. When you exit the
application, your container layout is kept in the database, and is recalled the next time you
log in.

File View Monitoring Control Configuration Management Reports Window Help D |
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Selecting a Container Layout

2-2

Centracs has a flexible screen organization feature called containers. You can arrange the
main window container layout and windows into your own customized display. You
decide which windows to show, and in what arrangement. For example, if you use the
Entity Tree, Map, and Alerts windows most frequently, you can set up your containers like

this:

(C]

File View Monitoring Control Configuration Management Reports Window Help

Entity Tree

Search tree...

e System Colorado Springs Demo
COS Demo System

» M Section North Colorado Springs

COS Demo Management Section

v ¥ Region Colorade Springs Maintenance

» ¥ Region COS Signalized Intersections
Sub-Region for Traffic Signals

# Region COS Vehicles

k Maintenance Vehicles

=m8 Warehouse COS Signal Shop
Main Warehouse
3 # Region COS School Flashers
WA Group BlueTOAD™
Group Autoscope Cameras

Group RTMS Simulators
G4

i" Scrap Recycle

Asset and Inventory Trash

Critical Alert List
| J Ack Selected || J Ack All || X Close Selected || X Close New || X Close Acked H X Close All |
Criticality Trigger Device Name Acknowledge State Created
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Centracs offers various pre-defined container layouts, and also offers you the ability to
make your own layout.

To select a pre-defined container layout:

IMPORTANT e When you select a new container layout, all windows that are currently
docked in your existing containers will be closed before the main window is replaced
with your new container layout.

1 From the main menu, select Window » Main Container Window.

A graphical list of your layout choices is shown:
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For example, there is only one container in the first pre-defined layout; the second
layout has two containers shown side-by-side; another layout has four square
containers of the same size; and so on.

2 Select alayout. For example, if you choose the sixth layout, you see this main window:

File View Monitoring Control Configuration Management Reports Window Help D [ |

To add a custom container layout:

IMPORTANT e When you select a new container layout, all windows currently docked
in your existing containers will be closed before the main window is replaced with your
new container layout.

1 From the main menu, select Window » Main Container Window. A graphical list of
the layout choices is shown.
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2 Select the last layout, identified by a question mark. The Custom Container Grid
window opens.

(® Main Container Window

Columns

|

3 Enter the dimensions for your custom layout. You must specify the number of rows
and columns of containers (between 1 and 10). For example:

1 row and 3 columns = three containers
2 rows and 2 columns = four containers

4 Click OK. The empty container window is changed to show the requested layout of
containers.

(C]

File View Monitoring Control Configuration Management Reports Window Help D |
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To resize a row or column of containers:

1 Move your mouse pointer over the container border until the pointer changes to a
double-sided arrow, as shown below.

2 Left-click, drag, and drop the border to the new size.
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Moving Windows Into and Out of Containers

2-6

After you have chosen or designed a container layout for your main window, you can
populate the containers with the windows you will use the most.

You can move and resize Centracs windows in the same way as any window in Microsoft

Windows®. To move a window, click the title bar, then drag and drop it. To resize a
window, click the window border and stretch or shrink it to a new size.

To dock a window in a container:

1 Open any window from one of the menus. For example, to open the map, select
View » Map. The Map window opens as a floating window.
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2 Click the title bar of the floating window and drag it to the center of the container. The
floating window becomes transparent, and as you move it over each container, a drop
target is shown in the center.

(C]

3 When your mouse is over the drop target (and the target lights up), release the mouse
button to drop the window into the container. Centracs automatically resizes and
moves the window to fit the container.
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In this example, you could then open a second window and dock it in the bottom
container.

If you dock the window in a container that already has a window docked in it, the drop
target gives you five options:

split the container )
horizontally; dock new
window in top part Y.

split the container
vertically; dock new
window on left side

add the new
window
as afab

split the container
vertically; dock new
window on nght side J

split the container
horizontally; dock new
window in bottom part

These options allow you to nest windows inside the containers, in any configuration you
wish.

Note ¢ To open and dock the status window for a specific entity, you can drag the entity
directly from the Entity Tree (page 3-1) or from the Favorites window (page 3-16) into a
container.
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To un-dock a window from a container:

P Right-click the title bar and click Float..
Or
» Pull the window out of the container (i.e., click the title bar then drag and drop it).

The window pops out of the container and becomes a floating window again.

To re-dock a window into its previous container:

» Click the title bar of the floating window and drag it to the center of the container.

The window pops back into its original container and is resized to fit.
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Using Tabbed Containers

Each container in Centracs can contain more than one window. For example, if you have
multiple Signal Status display windows open, you can add them all to the same container.

To add a tabbed container:

» Drag multiple windows into the same container and drop them on the drop target, one
at a time.

The example below shows a one-container layout with two tabs:

@®

File View Monitoring Control Configuration Management Reports Window Help D |

ap Ve
ﬁ" 5 B T

BINg: @ Ogengtreet\ﬂag contributors ,5’

Container tabs permit you to put any number of windows in a container, and then click
the tabs to quickly switch between them. For example, you can use this feature of
Centracs to have multiple maps open, each with a different zoom level and/or pan. (To
learn how to give your multi-tabbed windows useful names, refer to Renaming Windows
on page 2-13.)

Tips:
m To pull a tab out of the container into its own floating window, left-click the tab and
drag it out or right-click the tab and click Float.

m To close a tab, click the X beside the tab name.
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Using Hidden Containers

If it is necessary to have multiple windows open, but you do not want to clutter your
container window, you can use hidden containers. With this feature you can hide some of
your windows, but still keep them easily accessible via a tab on the left, right, or bottom
of the main container window.

File View Monitoring Control Configuration Management Reports Window Help D - il

aa1] fug

uoipenByuony Aug

hidden containers

Device Status  Main Map Tickets Alerts  Scheduler

To configure a hidden container:
1 From the main menu, select Window » New Auto-Hide Container.

2 Specify whether to hide the new container on the left edge, right edge, or bottom
edge of the main container window. A new tab is added in the location specified.

3 To populate the hidden containers, use the procedure in Moving Windows Into and
Out of Containers on page 2-6. The only difference is that when you drag the window
to be docked, drag it over the tab name first, then drag it onto the drop target of the
hidden container.

4 Torename the hidden container, right-click the tab name and click Rename. Type the
new name over the old name and click OK.

If desired, you can have multiple tabs on each edge (left, right, and bottom) of the main
container window.

IMPORTANT e If you change the main window layout, all hidden container tabs close.
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To use your hidden containers:
m To view a hidden container, click the tab, and the hidden container slides into view.
Click the tab again to hide the container.

m  To move a hidden container, right-click the tab and select one of the Move options.

m To temporarily “pin” a hidden container so that it remains in view while you do your

work, or so that you can view multiple hidden containers at the same time, click the ]
icon.

m  To permanently close a hidden container tab, right-click the tab name and select
Close, or click the E4.

File View Monitoring Control Configuration Management Reports Window Help D - _||||

Enfity Tree

ECT] T Ve

Entity Tree X

Q- 7~ ¥~

npeanbiyuosy fiu3

LIt

hidden container is Plum Creek, CO Cenfiracs® ATMS

in view, and BlueTOAD™
pinned to the

window Cameras

LOS Links
Maintenance

DCMS RTMS

Device Status  Main Map Tickets Alerts Scheduler
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Renaming Windows

When you have multiple windows of the same type open, they are given generic names
by default, such as Map Viewer and Map Viewer(2). But these can easily be given more
meaningful names.

Note e Not all windows can be renamed.

To rename a window:

1 Ifthe window is docked in a container with other windows, you must first pull it out of
the container. You can either drag and drop the window outside of the container, or
you can right-click the tab and select Float.

2 Right-click the window name in the title bar and select Edit Title.
3 Type the new name over the old name and click OK.

If the “Save Preference Set on Logout” setting is set to true, then as long as you do not
close the renamed window before you log off, your custom window name will be saved
when you log back into Centracs. But if you close the window, or if you select a new
container layout, the custom name is discarded. For information about preference sets,
refer to Using Preference Sets on page 2-19.

Using Multiple Monitors

If you have multiple monitors on your client workstation, you can open multiple container
windows to make Centracs even more powerful and efficient for your operations.

To open multiple container windows to be shown on more than one monitor:
1 From the main menu, select Window » New Container Window.

A graphical list of your layout choices is shown:

2 Select a layout, or make a custom layout. For details, refer to Selecting a Container
Layout on page 2-2.

3 Drag and drop windows into the new containers. For details, refer to Moving
Windows Into and Out of Containers on page 2-6.
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4 Drag the new container window to your second monitor and maximize it.

®
e o e apeuernent I cprt File View Monitoring Control Configuration Management Rep
Entty Tree

Criical Alert List

[ /Ackselsctad || /ckAl [ X Closs Selected || X Close New || X ClaseActed || X Close i | BISES NGRERIS ]
Search tree. [x]

oy last 081047
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Map Viewer
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» Jf Region COS School Flzshers

) Group BleTOAD™

Wi Group Auoscope Cameras
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W mvertony Tash

Now you have a full multi-monitor view of your Centracs operations. Centracs permits you

to open as many windows on as many monitors as Windows® and your workstation
hardware can support.

Adding Shortcuts to the Tools Menu

Optionally, you can configure a “Tools” menu on the client interface, where you can add
shortcuts to frequently used applications, links, and files (such as a conflict monitor
application, a calculator application, Notepad, an MS-DOS command prompt, log files, or
any third-party application you use in your transportation management operations).

By default, shortcuts added to the Tools menu are available to all users system-wide

(unless you only permit access to those users who are assigned to a specific Jurisdiction).
You can also add shortcuts as icons on the Map Viewer.

Note e When Centracs is first installed, it does not show the Tools menu. You can see this
menu after the first shortcut is configured (refer to the procedure below).

To add a Tools shortcut:
1 From the main menu, select View P Entity Tree.

Search tree__

System Colorado Sprini
COS Demo System
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2 Right-click the name of the parent entity (such as a System) and select Add
Entity » URL, as shown below:

(@ Entity Tree
- H LT 14
@ v ur 0* Y ity AR

Search tree...

System Colorado Springs Demo
COS Demo System

Show Status...

Manual Command...
Schedule...

Notes...

Device Collection Monitor...
Detector Group Chart ..
Edit Properties...

Add Entity

Remove Entity

CCTV Location

»
& Count Station

DMS

Expand ltems i
DMS Location

Collapse ltems .
. Flashing Beacon
4 Group

m HAR

Intersection

The Entity Configuration window opens.
3 Enter a name and description to identify the new shortcut.

4 |nthe Mode field:

® For an executable application (like Calculator, Notepad, Internet Explorer, etc.),
select “Exe”.

Or
® For alink to an address on the web, select URL.

5 If you selected “Exe”, the Executable and Arguments fields are shown:

® For Executable, enter the path and executable name. (For standard Windows® tools
like Calculator, it is not necessary to enter the path.) Refer to the examples below.

® For Arguments, enter any optional arguments to pass to the application. Refer to
the examples below.

6 If youselected “Url”, enter the internet address of the website. Refer to the examples
below.

7 Enable the Show in Tools Menu checkbox.
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8 Optionally, change the Jurisdiction for this shortcut so that only specified users have
access to it. For more information, refer to Defining Jurisdictions on page 20-12.

9 Optionally, to add notes for this shortcut, click [ to the right of the Notes field. For
more information, refer to Adding Notes to Entities on page 3-14.

10 Click OK. The new shortcut is added to the Entity Tree and to the Tools menu.

Examples:

Motepad
Shortcut to Motepad application

Motepad.sxe

COS5 Trafiic Cams

Celorado Springs Traffic Cam Website
Urd

hitp:fwww springsgov.comidtrafficeng
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Sample Tool Configurations

Add a shortcut to... ‘ Mode | Executable / Arguments / URL

...open a log file in Notepad Exe |Executable: Notepad.exe

Arguments: filepath\filename
(suchasc:\1log.txt)

...print a log file via Notepad | Exe |Executable: Notepad.exe

Arguments: /P rilepath\filename
(suchas /P C:\log.txt)

...launch the calculator Exe | Executable: Calc.exe

...launch a third-party tool Exe | Executable: varies
(such as C:\ThirdPartyTool\XYZ.exe)

...launch a website Url | URL: varies
(such as http://techsupport.econolite.com/)

For more information about the Entity Tree, refer to Using the Entity Tree on page 3-1.

For fast and easy access to your new URL entity, you can also add it to the map. To do so,
select View » Map or View P Preset Map from the main menu and zoom in on the
location for the URL. Drag and drop it from the Entity Tree onto the desired position on
the map. The Map Editor opens so that you can define and configure how the URL will be
shown on the map. You can choose one of three generic URL icons:

~

The computer icon is available in these three colors so that you can distinguish one URL
entity on the map from another.

You can also choose one of two CCTV icons if your shortcut is to a web-based camera feed:

<
QTI“""\*;E

“a |or
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Or you can use the Static Text option in the Map Editor to label the URL entity with text
and/or numbers (either on its own, or paired with a computer icon or CCTV icon):

Econolite.com

For details about how to use the Map Editor, refer to Editing the Map View on page 5-18.

Changing the Color Theme

Optionally, you can change the color settings for the Centracs user interface. The
application comes loaded with two pre-defined color themes: Dark and Light.

To select a different theme:
1 From the main menu, select View » Themes.

(® Themes

MNamsa I Comment |

DarkThemexaml  Dark

LightThemexaml|  Light

Cancel

2 Click a theme, then click Apply or OK. (Apply saves your changes and keeps the
window open; OK saves your changes and closes the window.)

Adding Your Own Color Theme

2-18

Note e This procedure requires administrative rights to the computer/file system.

To customize the Centracs color theme:

1 Inthe Centracs Skins folder (for example, C:\Program Files
(x86) \Econolite\Centracs\CentracsClient\Skins), make a copy of a theme
file and give it a descriptive name (such as GreenTheme.xaml).

2 Use atext editor or xaml editor to make your changes. Also change the Comment line
to describe the new theme (such as <sys:String xmlns:sys="clr-
namespace:System;assembly=mscorlib" x:Key="Comment">Green Theme.</
sys:String>). Save your changes.

3 From the main menu, go to View » Themes.

4 Select the new theme you added and click OK.
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Using Preference Sets

By default, when you log out of Centracs, your current display settings are automatically
saved to the database, so that the next time you log in, your containers and windows are
re-opened exactly as you set them — even if you log in on a different workstation.
Optionally, this behavior can be changed, as described below. You can also save specific
display settings to a “preference set” to be used later or by another user.

Permanently saving your display preferences in a named preference set allows you to:

change your view temporarily but go back to your current view afterwards
save different views for different tasks you do during the day

save different views for different jurisdictions you manage

save different views for different workstations you use

share your view with another user

While you are logged in, the title bar at the top of the Centracs window shows the name
of the preference set currently being used:

C]

File View Monitoring Control {onfiguration Management Reporis

the "Default"
preference set

isinuse

These settings are saved in preference sets:

The main container window size, layout, and contents

Any other container windows or undocked floating windows that are open (unless you
have the “SaveFloatingWindows” Local Setting set to “false”; refer to page 20-53)

Any hidden container tabs and their contents
The sort order and view style of your Entity Tree (if it is open)
Custom titles of windows (refer to page 2-13)

The pan and zoom levels on any maps that are open
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There are three Global Settings/Local Settings that affect the behavior of preference sets:

Setting Name

Save Floating
Windows

‘ Description

Controls whether any undocked floating windows are saved to your
current preference set when you log out.

Save Preference
Set On Logout

Controls whether Centracs automatically saves changes to the
current preference set when you log out:

m [f set to true, any changes you make to your display preferences
during your session are automatically saved when you log out.
The next time you log in, Centracs will look the same as the last
time you logged out.

m If setto false, any changes you make to your display preferences
during your session are discarded when you log out. The next
time you log in, Centracs will look the same as the last time you
logged in.

For example, suppose:

1 Your default preference set is called Pref Set 1, and it shows two
maps and two CCTV feeds.

2 Youloginand select Pref Set 2 instead, which shows three maps
and three CCTV feeds.

3 You open one more map and CCTV feed.
4 You log out.

In this case, if the setting is set to true, the next time you log in,
Centracs will use Pref Set 2, which now shows four maps and four
CCTV feeds. On the other hand, if the setting is set to false, the next
time you log in, Centracs will use Pref Set 1, which still shows only
two maps and two CCTV feeds.

The default is true.

Note e If this setting is set to true, and if you are using a
preference set owned by another user, Centracs tries to save
changes to the preference set, but cannot because you are not the
owner. Therefore, Centracs asks whether you want to save the
view to a new preference set. To avoid seeing this message every
time you log out, either choose another view that you own, save
the view to a new preference set, or change “Save Preference Set
On Logout” to false.

2-20
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Setting Name ‘ Description

Login With Local | Allows you to use different preference sets for different
Preference Sets workstations:

m If setto true, you can configure Centracs to use a different
preference set for each workstation you use. For example, if you
sometimes use Centracs on a desktop computer with a
widescreen monitor, and sometimes on a laptop with a small
screen, you can use a preference set that shows multiple maps,
CCTV feeds, and status displays when you log in to the desktop
computer, but use a streamlined preference set that shows only
afew important screens when you log in to the laptop.

m Ifsetto false, Centracs uses the same preference set when you
login, regardless of the workstation being used.

The default is false.

Note e These settings are included in both Global Settings and Local Settings. If both are
set, the Local Setting overrides the Global Setting.

If preference sets are not behaving as you expect, it is likely due to the settings your
system administrator chose for these two Global Settings. You can override the Global
Settings on your own workstation by configuring these two settings in your Local Settings.
For more information, refer to Configuring Local and Global Settings on page 20-53.

To save your current view to a preference set:
1 From the main menu, select View » Preference Sets...

(® Preference Sets
Default | Name Owner

Default Econglite

Default EconoliteUser

Default eessien
Default fpooran

Default

CrveGoren ] seere ] o]

The window shows all the preference sets currently defined in the database.
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2 Do one of these:

® To replace the preference set currently in use, click Save Current.
Or

® Tocreate anew preference set and leave the current one intact, click Save As. Enter
a name for the preference set and click OK.

(® Save Preference Set [ X

Enter a name for the preferenc

Name | CCTV Video wall |
| QoK || Cancel |

The preference set is saved to the database, and any user on any workstation can
access it. (Other users can use your saved preference set(s), but only you or an
administrator can rename or delete them.)

To use a saved preference set:
1 From the main menu, select View » Preference Sets...

(® Preference Sets
Default | Mame Owner

Default Econolite
Default eessien
Default fpooran

Default

Covecren ] e | o |

The window shows all the preference sets currently defined in the database.

2 Click a preference set (it is not necessary to be the owner of the set) and click Open,
or double-click the preference set.

The containers, tabs, windows, maps, and colors saved to that preference set are
loaded into your view.
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To set a preference set as your default:

Note e If you use Centracs on multiple workstations, and if the “Login With Local
Preference Sets” Global Setting or Local Setting is set to “true”, you can set a different
default preference set for each workstation you use.

1 From the main menu, select View » Preference Sets...

2 Right-click a preference set:

(® Preference Sets

Defaultl MName I Owmner | |

Default

Econglite

Open

Edit
Delete
Set As Login Default N

Remov

3 Click Set As Login Default. The Default column shows that this set is now the default:

ogin Default

This icon is shown when the “Login With Local
Preference Sets” setting is set to “true”: Preference Sets” setting is set to “false”:

[=] Preference Sets (=] [=] Preference Sets (=]

Default Mame Owner Default Mame Owner
Default Default
Default es Default es
Default
Default 1
Default
K Mac's
Default
Default

This icon is shown when the “Login With Local

Econalite Econalite

jaj Default jaj

Default 1
Default
K Mac's
Default
Default

desktop PC - North side

desktop PC - Morth side

desktop PC - South side

desktop PC - South side

laptop - CCTVs

laptop - CCTVs

laptop - maps

laptop - maps

laptop - status displays

laptop - status displays

Default

Default

Default
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To

i A W N

To

2-24

In the example on the left, this preference set will be used when you log into Centracs
on the same workstation; you can then log into another workstation and select a
different default preference set for that workstation. In the example on the right, this
preference set will always be used, regardless of the workstation you log into.

Click Save.

From now on, each time you log in, Centracs automatically opens this preference set.

Note e If the “Save Preference Set On Logout” Global Setting or Local Setting is set to
“true”, and if you open a different preference set after setting the default, the new
preference set becomes the default when you log out.

rename a saved preference set:

Note e If you do not have sufficient permissions, you can only rename preference sets
owned by you.

From the main menu, select View » Preference Sets...

The window shows all the preference sets currently defined in the database.
Right-click the preference set and click Edit to rename it:

In the Name field, type the new name over the old name.

Click OK.

Click Save.

delete a saved preference set:

Note e If you do not have sufficient permissions, you can only delete preference sets
owned by you.

From the main menu, select View » Preference Sets...

The window shows all the preference sets currently defined in the database.
Click the preference set to remove and press the Delete key on your keyboard.
Or

Right-click the preference set to remove, then click Delete:

Click Save.

The preference set is removed from the database.
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Most screens that show data in a grid format permit you to reorder the data by any of the
columns in the table, and to rearrange the columns.

To rearrange columns in a table:

» Drag and drop each column header to the preferred location in the table.

To change the sort order of the data in a table:

» Click the column header for the data item to sort by. The column header will change
colors when you roll your cursor over it, as shown below.

To sort the data in the opposite order:

» Click the column header a second time.

Centracs User Manual

(® Aleris and Events

Search events

| Event Name

¥ Adaptive

Adaptive Any Off

Adaptive Any On

Adaptive Cycle Changed

Adaplive Cycle Off

Adaptive Cycle On

Adaptive Offset Changed

Adaptive Offset Off

Adaptive Offset On

Adaptive Split 1 Changed

Adaptive Split 10 Changed

Adaptive Split 11 Changed

Adaptive Split 12 Changed

Adaptive Split 13 Changed

Software Version 2.x - March 2018
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Turning Confirmation Dialogs On/Off

Some actions in Centracs require confirmation, such as moving an entity within the Entity
Tree. When you do one of these actions, Centracs shows a confirmation dialog that asks
whether you are sure you want to continue. For example:

&Eﬂﬁh’M{N&

/'\

Enable the checkboxto prevent this
confirmation dialogin the future

Optionally, you can turn off some or all of these confirmation dialogs. When Centracs
shows a confirmation dialog that you do not want to see again, click the “Do not show this
message in the future” box before you click Yes or No.

You can also manage your on/off preferences for all confirmation dialogs at one time via
the Settings option. To do so, follow the procedure below.

Note ¢ The confirmation dialog preferences you choose have no effect on confirmation
dialogs for any other user of the system.

To see or change your confirmation dialog preferences:
1 From the main menu, select File b Settings...

2 Click the Confirmation Dialogs tab on the left side of the window.

Settings
Select the confirmation dialogs that should NOT be displayed when performing operations:
| Display Al | | Hide Al |

ActionSetDelete Delete Action Set?

A
AlertSchemeDelete Delete Alert Escalation? .
Confirmation Dialogs

ApplicationRolesDelete Delete Application Role?

AssetTypeDelete Delete Asset Type?

AssetTypeFieldDelete Delete Asset Type Field?

BingCredentialsDelete Delete Key?

Centrar=Closinn Centrars Closinn
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3 For each action, check the checkbox if you do not want Centracs to show a
confirmation dialog; uncheck the checkbox if you want Centracs to prompt you to
confirm the action. To sort this table by the action type, click the Caption header.

4 To save your changes, click Save.

IMPORTANT e Econolite does not recommend that you turn off all confirmation
dialogs. Some actions justify requiring a confirmation, such as the deletion of an entity.
Before you turn off confirmation dialogs for an action, carefully consider the possible
ramifications if that action is done accidentally.
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Viewing Active Windows

2-28

To handle all the complexities of transportation management, you can operate the system
with many different windows open at the same time and distributed between multiple
monitors. To stay organized and avoid confusion, you can use the Active Windows screen
to manage your open windows. This screen shows a list of all open windows along with
their dimensions (width and height in pixels) and screen coordinate locations. It also gives
you options to reorganize them. You can see a small graphical preview of each window for
easy identification.

To access the Active Windows screen:

» Fromthe main menu, select Window » Active Windows... The Active Windows screen
opens.

@ Active Windows

Name Top Width Height Center Topmaost

Centracs - Econclite User (Default) 71 885 623

Users Configuration 433 420

Entity Tree 133 500

Map Viewer &

Active Windows

T =

preview of Map
Viewer window

P> Tosee apreview of one of the windows (as shown above), roll your mouse cursor over
the window name.

» To move a window to the front, click Topmost for that window.
P To center a window in relation to the main container window, click Center.

P To close a window, click Close for that window.

Note ¢ Another way to keep your windows organized is to dock them in window
containers. For more information about containers, refer to Selecting a Container Layout on
page 2-2 and Moving Windows Into and Out of Containers on page 2-6. If a window is
docked in a container, it is not shown on the Active Windows screen as a separate window.
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An entity is any device or other object that is managed by Centracs (such as a CCTV camera
or a Signal), or a collection of devices managed by Centracs (such as a System or Group).
You can add, change, and monitor entities via the Entity Tree, which is a hierarchical view
of all the entities defined in the Centracs system.

To open the Entity Tree:

» From the main menu, select View » Entity Tree.

(® Entity Tree

b H KA S
@' | o*' ¢y AR
Search tree...

v System Colorado Springs Demo
COS Demo System

Eﬂ Section North Colorado Springs

COS Demo Management Seclion

L

, } Subsection Academy North

v n= Subsection Chapel Hills Area

H Signal VC 50104
Chapel Hills Dr. {@ Jamboree Dr.

H Signal VC 50105
Jamboree Dr. {@ Chapel Hills Mall North Access

#% Vehicle Detector Virtual 50105 Det 8
Call Phase(s) 8

@ Vehicle Detector Virtual 50105 Det 4
Call Phasze(z) 4

¢ Vehicle Detector Virtual 50105 Det 6
Call Phase(z) 6

¢ Vehicle Detector Virtual 50105 Det 1
Call Phase(s) 1

¢ Vehicle Detector Virtual 50105 Det 5
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An
| |

To

entity may be:

A device

A collection of devices

A collection of collections

A link to a website or program

An MMS location, manufacturer, vehicle, etc.

navigate the Entity Tree:

Use your mouse to point and click, and use the mouse wheel to scroll up and down in
the tree. Right-click to see a menu of available actions.

Or

Use the up/down/left/right arrow keys on your keyboard to scroll through the entities
in the tree. Note that the down arrow selects the next visible entity, and the right
arrow expands the selected grouping to show child entities.

Entity Types

Note e Not all of these entity types may be available to you, depending on which Centracs
modules are licensed for your system.

Basic Entities

3-2

The basic entity types in Centracs are:

Signal — a controller that manages traffic at one intersection.

Vehicle Detector — a device that detects the presence of a vehicle, such as a loop
detector.

CCTV — a Closed-Circuit Television video monitoring system that broadcasts to one or
more specific monitors.

DMS — a Dynamic Message Sign which can display messages to motorists.

DCS —an Autoscope camera, an RTMS device, or a BlueTOAD™ Data Collection Station
used to detect vehicles; it compiles data to calculate current speeds and other relevant
measurements for sections of road.

Link Pair (Travel Time) — a section of road between two BlueTOAD Data Collection
Stations.
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Entity Collections

To
tog

better organize and control entities that are logically related, you can group them
ether. There are several types of entity collections in Centracs:

System — the highest level of entity collection; you must define at least one System.

Section —a sub-level of entity collection, usually used for a string of consecutive signals
(and their associated devices) along a traffic corridor.

Subsection — a subset of the signals/devices included in the parent Section.

Group — a sub-grouping of entities below the System level or Region level; groups are
separate from the Section/Subsection hierarchy.

Link (LOS) — a collection of vehicle detectors (often loop detectors) that are associated
with consecutive intersections; a Link offers a convenient way to monitor and analyze
the data for these detectors collectively.

Region — a collection of MMS Locations; see MMS Entities on page 3-4.

You can send actions such as “Set Time” and “Time Broadcast” to all entities in a System,

Sec

tion, Subsystem, or Group at the same time.

Shortcut Entities

Two types of entities offer convenient shortcuts to other applications directly from the

Ent
| |

Centracs User Manual
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ity Tree:
Aries — a shortcut to launch the Aries executable.

URL — a shortcut to an internet address or to an executable program; for more
information about URL entities, refer to Adding Shortcuts to the Tools Menu on
page 2-14.
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MMS Entities

If your system is licensed for Centracs MMS (Maintenance Management System) for asset
management, these entity types are also available:

m  CCTV Location

m  Count Station

m  DMS Location

m  Flashing Beacon

m  HAR (Highway Advisory Radio)
m Intersection

m Lighted Crosswalk

m Location (generic)

m  Manufacturer

m  Ramp Meter

m Region

m Repair Depot

m  RWIS (Road Weather Information System)
m Signalized Intersection

m Vehicle

m  Warehouse

For more information about MMS, refer to Chapter 19, Managing Assets Using MMS.

Entity Relationships

The table below shows the hierarchical rules that are obeyed when you add entities to the
tree. The entity types are shown in alphabetical order:

Icon | Entity Name Parent Children
Aries System, Group, Section, | n/a
& Subsection, or Signal
CCTV System, Region, or n/a
o Group
= CCTV Location Region, Group, Section, | CCTV, URL
o (MMS) Subsection, System
3-4 Centracs User Manual
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Icon | Entity Name Parent ‘ Children
= Count Station Region, Group, Section, | CCTV, URL
= (MMS) Subsection, System
o DCS (Autoscope) System or Group Vehicle Detector

(see Note below)

DCS (BlueTOAD)

Group (see Note below)

n/a

- DCS (RTMS)

System, Group, Section,
or Subsection

Vehicle Detector

(MMS)

n Flashing Beacon

_— DMS System, Region, or n/a
o Group
DMS Location Region, Group, Section, | DMS, URL
. .
Il | (MMS) Subsection, System
Region, Group, Section, | URL

Subsection, System

Group

e

System, Region, or
Group

Aries, CCTV, CCTV Location, Count Station,
DCS, DMS, DMS Location, Flashing Beacon,
Group, HAR, Intersection, Level of Service
Link, Link Pair, Lighted Crosswalk,
Manufacturer, Ramp Meter, Repair Depot,
RTMS, RWIS, Section, Signal, Signalized
Intersection, URL, Vehicle, Vehicle Detector,
Warehouse

HAR (MMS)

g}

Region, Group, Section,
Subsection, System

URL

Intersection (MMS)

Region, Group, Section,
Subsection, System

CCTV, DMS, Signal, URL

s
B v

Lighted Crosswalk | Region, Group, Section, | URL
Subsection, System
Link Pair Group (see Note below) | n/a
)
— Location (MMS) Region, Group, Section, | URL

Subsection, System
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Icon | Entity Name Parent ‘ Children
LOS Link System, Section, n/a
T Subsection, or Group
> Manufacturer Region, Group, Section, | URL
(MMS) Subsection, System
Ramp Meter (MMS) | Region, Group, Section, | URL

i

Subsection, System

Region (MMS)

System or Region

CCTV, CCTV Location, Count Station, DMS,

- DMS Location, Flashing Beacon, Group, HAR,
Intersection, Lighted Crosswalk,
Manufacturer, Ramp Meter, Region, Repair
Depot, RWIS, Signal, Signalized Intersection,
Vehicle, Warehouse, URL
Repair Depot Region, Group, Section, | URL
| (MMS) Subsection, System
Route (BlueTOAD) | Group (see Note below) |n/a
o
RWIS (MMS) Region, Group, Section, | URL
s Subsection, System
- Section System or Group Aries, CCTV Location, Count Station, DMS
Hi; Location, Flashing Beacon, HAR, Intersection,
Level of Service Link, Lighted Crosswalk,
Ramp Meter, RTMS, RWIS, Signal,
Subsection, Signalized Intersection, URL,
Vehicle Detector
Signal System, Section, Vehicle Detector, Aries
l; Subsection, Region, or
Group
Signalized Region, Group, Section, | CCTV, DMS, Signal, URL

Intersection (MMS)

Subsection, System

Subsection

Section

Aries, CCTV Location, Count Station, DMS
Location, Flashing Beacon, HAR, Intersection,
Level of Service Link, Lighted Crosswalk,
Ramp Meter, RTMS, RWIS, Signal, Signalized
Intersection, URL, Vehicle Detector
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Icon | Entity Name Parent ‘ Children
o System n/a Aries, CCTV, CCTV Location, Count Station,
- DMS, DMS Location, Flashing Beacon, Group,
HAR, Intersection, Level of Service Link,
Lighted Crosswalk, Manufacturer, Ramp
Meter, Region, Repair Depot, RTMS, RWIS,
Section, Signal, Signalized Intersection, URL,
Vehicle, Warehouse
URL System, Section, n/a
=2 Subsection, Group, or
any MMS Location type
- Vehicle (MMS) Region, Group, Section, | URL
- Subsection, System
Vehicle Detector System, Section, n/a
L Subsection, Group, or
Signal (see Note below)
Warehouse (MMS) | Region, Group, Section, | URL
= Subsection, System

Note e Vehicle Detectors, DCS entities, Routes, and Link Pairs are not added to the tree in
the same way as other entity types. For details, refer to Entity Configuration - Vehicle
Detectors on page 3-48, Configuring & Deleting Autoscope Entities on page 17-14, and
Configuring BlueTOAD Entities on page 14-9.
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Adding Entities via the Entity Tree

Centracs has a predefined hierarchy for entities in the tree, best described as a set of
parent and child nodes. When you add new entities, there are hierarchical rules that
dictate which entity types are permitted to be parents or children to which other entity
types. The top level of the hierarchy is the System; you must define all other entity types
under a System (either directly, or in Groups, Sections, or Subsections).

If necessary, you can have multiple trunks in the Entity Tree; that is, you can have multiple
Systems at the top level of the tree. For most installations, one System is sufficient; but
multiple Systems may be useful in some instances, such as for a contracted company that
manages systems for multiple agencies.

For instructions on how to add entities to the Entity Tree, refer to the appropriate page:

Entity Type Refer to instructions on...
System page 3-21
Section or Subsection page 3-22
Group page 3-23
DMS page 3-27
Signal page 3-36
Vehicle Detector page 3-48
Link page 3-54
BlueTOAD Data Collection Station (DCS) page 14-9
BlueTOAD Link Pair page 14-9
Autoscope Data Collection Station (DCMS module) page 17-14
RTMS device (DCMS module) page 17-9
CCTv page 3-65
URL page 3-69
Aries page 3-70
MMS entities (Region, CCTV Location, Count Station, DMS page 19-41

Location, Flashing Beacon, HAR, Intersection, Lighted
Crosswalk, Location, Manufacturer, Ramp Meter, Repair
Depot, RWIS, Signalized Intersection, Vehicle, Warehouse)

For more information about each of these types, refer to Entity Types on page 3-2.
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Copying an Entity to Multiple Groups

If it is necessary to put an entity in more than one Group or Region, you can add a virtual
copy of it in the Entity Tree. In this case, Centracs does not actually add a second instance
of the entity — rather, there is one instance of the entity with multiple references to it.

To add a virtual copy of an entity in a different Group:

»  While you hold the Ctrl key, drag and drop the entity onto the new Group.

Any entity that is shown in the Entity Tree with the & symbol is a copy. For example:
o Sy

Original entity Entity copy

Any future changes made to either copy will also change the other.

If you subsequently remove an entity that has multiple copies in the tree, you are given
an option to remove only the copy you selected, or to remove the original instance of the
entity and all virtual copies of it.

Editing Entity Properties

After an entity has been added, you can easily change many of its properties at any time.

To edit the properties of an existing entity:

1 From the Entity Tree, right-click the entity to change and select Edit Properties. The
Entity Configuration window opens. The fields shown on this window depend on the
type of entity you are editing. For details about how to configure each entity type,
refer to Adding Entities via the Entity Tree on page 3-8.

2 Make your modifications.

3 When all changes have been made, click Apply or OK on the Entity Configuration
window. (Apply saves your changes and keeps the window open; OK saves your
changes and closes the window.)

Note ¢ To see or change the properties for more than one entity, it is not necessary to
open and close the Entity Properties window for each entity — with the window open,
simply click a different entity in the tree to populate the window with the properties for that
entity. (If you make changes to the properties for an entity, you must first save or discard
the changes before you can switch to a different entity.)
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Searching the Entity Tree

If you have a large number of entities in your system, you can use the “Search tree” option
to quickly find a specific entity or set of entities.

(® Entity Tree

Q- T~ 3R V
L#

L) b

To search the Entity Tree:
1 Putyour cursor in the “Search tree” box near the top of the Entity Tree.

2 Type one or more characters of the name, description, or type of the entity to find. It
is not case-sensitive. For example, to show only CCTV entities in the tree, type “cctv”.
To show only signals, type “signal” or the type of signal, such as “W4”. As you type, the
system filters out any entities whose name, description, and type do not contain the
characters you entered.

Entity Search Tips

3-10

Wildcards

m To perform a single character wildcard search, use the ? symbol.
m To perform a multiple character wildcard search, use the * symbol.

Examples:
® to search for text or test, you can use the search term: te?t

® to search for test, tests, or tester, you can use the search term: test*

Boolean Operators

Multiple terms can be combined together with Boolean operators (AND, OR, NOT) to form
a more complex query. The operator must be entered in upper case.

m The AND operator finds items containing both terms.
Example: University AND Park (finds items containing both words)

m The NOT operator excludes items containing the term after NOT.
Example: University NOT Park (finds items containing University but not Park)

m The OR operator finds items containing either of the terms. (If an operator is not
specified, OR is the default operator.)
Example: University OR Park (finds items containing either word)

Centracs User Manual
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Quoted Phrases

A phrase is a group of words surrounded by double quotes.

Example: “Westbound Lane”

Special Characters

When using any of the following special characters as part of the search criteria, enter \
before the character:

+-&« L)y Lyl e 2\
Example: to find (1+1):2, use the query: \ (1\+1\)\:2

Fuzzy Searches

Use the tilde (~) symbol at the end of a single word.

Example: to search for a term similar in spelling to roam, you can use the fuzzy search
roam~

This finds terms like foam and roams.

Customizing the Entity Tree View

You can use the icons in the toolbar at the top of the Entity Tree window to customize your
view of the Entity Tree.

Note e If the current width of your Entity Tree window is too narrow, some of the toolbar
icons may be hidden from view. To show the hidden icons, stretch the window or click the
small white down arrow on the right end of the toolbar.

To change the view style of the Entity Tree:

1 To see your choices of how entities can be shown in the tree, click the white down
arrow to the right of the View Style icon.

® Entity Tree

AT T
O~ T~~~ I V

ogrgq View Style

2 Click aview style, such as Large, Large—name only, Large with Status, Single Line, Single
Line with Status, or Single Line—name only. The “with Status” styles show a colored
indicator for each device to show the current status of the device (for the meaning of
each color, hold the mouse pointer over a colored indicator).
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The tree isimmediately changed to use the selected view style (in this case, Single Line

with Status):

(® Entity Tree
@~ T~ib- 233V

Search free...

¥ ¥ Colorado Springs
¥ {4 Woodmen Woodmen Rd
¥ [ Woodmen-East
¥ [ Woodmen @ N Union O
#1 WEB Woodmen @ N Union 1 Westbound 1
#% EB Woodmen @ N Union 1 Eastbound 1
#t WEB Wooedmen @ N Union 2 Westbound 2

#1 EB Woodmen @ N Union 2 Eastbound 2
f Woodmen @ N Academy VWoodmen Rd @ N Academy Bivd O
[ Woodmen @ IH25 W West frontage of 1125 O
§ Woodmen @ Rangewood O
[l Woodmen @ Austin Bluffs Woodmen Rd @ Austin Bluffs Plwy @
T Woodmen-East-EB

- Woodmen-West
[l Woodmen @ Chapel Woodmen Rd @ Chapel Ln O

{ Woodmen @ Rockrimmen @
[l Woodmen @ Powers N Powers Bivd O

T Woodmen-East-WB
w M8 Briarnato  Briorooto Bhed

To expand or collapse the Entity Tree:
» Click the Expand All icon to show all entities in all levels of the tree.

Or
» Click the Collapse All icon to hide all child entities under their parent entities in the

tree.

(® Entity Tree
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To filter the Entity Tree:
1 Click the funnel icon:

(® Entity Tree

@~ T~~~ 23RV

A dropdown list shows you the entity types you can filter (System, CCTV, DMS, etc.).

2 Select the types that you want to show in the Entity Tree view, and leave all others
unchecked. To show all entity types, leave all types unchecked.

To sort the Entity Tree:
1 Click the white down arrow to the right of the Sorting/Ordering icon to see your
choices of how entities can be ordered in the tree.

(® Entity Tree

- -
[~ 7~ iv~ 23R

® User-positioned — Sort the entities manually.

® Name — Sort the entities alphabetically by their user-specified names.

® Description — Sort the entities alphabetically by their user-specified descriptions.
® Type — Sort the entities by their type (signal, CCTV, URL, etc.).

”n u

If you selected “Name”, “Description”, or “Type”, the system immediately reorders
the entities for you.

2 If you selected “User-positioned”, click an entity and use the up or down arrow to
move the entity to the a new position in the tree, one position at a time. Repeat for
other entities as necessary.

(® Entity Tree

- -
Q- T~i¥~ XV

Centracs User Manual 3-13
Software Version 2.x - March 2018



Using the Entity Tree

= Printing the Entity Tree

Printing the Entity Tree

To print the Entity Tree:
1 From the main menu, select Reports » Entity Hierarchy. This report depicts the
relationships between all entities in the Entity Tree.

2 When the report opens, click the B boxes to expand the groupings.
3 To see how the report will look when printed, click the Print Layout icon.

4 |If necessary, click the Page Setup icon to change the report margins, orientation, or
paper size.

5 To select a printer and print the report, click the Print icon.

For more information, refer to Generating Reports on page 10-1.
Adding Notes to Entities
You can add notes of any type to your entities.

To add a note to an entity:
1 To access the Notes window, use any of these methods:

® From the main menu, select View P Notes.

Right-click an entity in the Entity Tree and select the Notes option.

Click [ to the right of the Notes field on the Entity Configuration window.

Right-click an entity on the map and select the Notes option.

Right-click an entity in the Favorites window and select the Notes option.

2 Ifthe entity is not already selected in the dropdown list, click the black down arrow to
expand the dropdown list and select the correct entity.

View and add notes to entities

Entity | 424746 North Union x | | | +Add_. || Edit. || X Delete |

| Timestamp I User Note

click ellipse to
select entity
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3 Click Add... The Edit Note window opens.

(® Edit Note

4 B39 & B 1 U AL
+ Entity added to system on 10/1 by G.M. Bluth

+ Entity name changed on 10/5 by Phil D.|

| OK || Cancel |

4 Use the available white space on the Edit Note window to enter the content of your
note. Standard formatting tools are available in the toolbar to set the style, type size,
alignment, and indentation of your note.

The built-in spellchecker will show a red underline below any words it does not
understand. You can right-click the word to see recommended corrections for the
word, or to tell the spellchecker to ignore the word.

5 To save the note, click OK.

Your new note is shown in the Notes window, along with your user name (as the
creator of the note) and the date and time the note was added. You can edit or delete
the note at any time.

(™ Motes

View and add notes to entities

Entity | 24746 North Union x ||:| | + Add... || Edit... || ¥ Delete

| Timestamp I User I Mote

» Entity added to system on 10/1 by G.M. Bluth

02/28/18 14:48 Econolite User

» Entity name changed on 10/5 by Phil D.

Note e To edit or delete an existing note, click the note, then click Edit or Delete. Any user
can edit or delete an existing note, regardless of who added it. When edited, notes keep the
timestamp from when they were originally added, and the user name of their original
creator.
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Bookmarking Your Favorite Entities

For fast and easy access to the Systems, Groups, Sections, Signals, DMS devices, etc. that
you use most frequently, you can use Favorites to bookmark them. You can create
multiple Favorites lists, based on any grouping criteria you choose. For example, you can
add a Favorites list for signals, another for DMS devices, and another for CCTV devices.

To add entities to your Favorites window:
1 From the main menu, select View » Favorites.

(8 Favorites

Favorites

2 Click the option in the toolbar. The Entity Selection window opens.
3 Select the entity or entities to add to your Favorites and click OK. For details, refer to
Using the Entity Selection Window on page 3-18.

(® Favorites

\_,ﬂ Autoscope - Woodmen Rd (@ Union Blvd EB
\,, Beacon Street {@ Filmore Street @'s 4 & 7 Fillmore
E VC 15101 Academy Blvd. @ Voyager Pkwy

B vc 15107 Academy Bivd. @ Dublin Blvd.
VG 15108 Academy Blvd. @ Lehman Dr.
#f* Woodmen Rd. @ 1-25 SB Off Ramp 30103

Favorites

Note e As ashortcut, you can also drag and drop entities from the Entity Tree.
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To perform actions on your Favorite entities:
1 From the main menu, select View » Favorites.

2 To perform an action on one entity, click an entity; to perform an action on multiple
entities at the same time, hold the Ctrl or Shift key while you select the entities.

3 Click:

® the E option in the toolbar to add a manual command for that entity. For more
information, refer to Issuing Manual Commands on page 7-8.

Or

® the option in the toolbar to schedule one or more actions on that entity. For
more information, refer to Using the Scheduler on page 7-11.

Note e Ifthese two options are not shown in the toolbar, they are not valid options for
the selected entity. For example, you cannot add commands for a URL entity.

Also, most of the options that are available to you when you right-click an entity in the
Entity Tree (for example, Show Status, Zoom to Parent, and Notes) are also available
to you when you right-click an entity in the Favorites window.

To add more Favorites tabs:

1 Click @ in the bottom-right corner of the window.
The application adds a new tab with a name of “Favorites”.
2 Right-click the tab name.

3 Click Rename.

4 Enter a meaningful name for the new tab and click &

To delete one or more entities from your Favorites:

» Click the entity to remove (or to select multiple entities, hold down the Ctrl key while

you click), then click the X option.
Or

P To delete all entities from the Favorites list, click the option.

Note e This does not delete the entities from the database — it only removes them from
your Favorites list.

To delete a tab from the Favorites window:

P On the tab to remove, click E.
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Using the Entity Selection Window

There are many situations in Centracs when you must specify one or more entities (for
example, when you bookmark your “favorite” entities, or add a manual command or
schedule entry). To do so, you use the Entity Selection window:

Types ]

[+] Autoscope

[«] BlueTOAD

[#] DMS Location
[#] Flazhina Rearnn

Entity Name

The left side of the window shows a list of defined entities. Because the list of entities can
be very large, you can use the search and filter options at the top to narrow down the list.
For example, if the entity you want is a Signal, you can change the Types checkboxes so
that only the Signal checkbox is enabled (as shown below). You can also use the Search
field to enter the first few characters of the entity name, description, street name, type,
or subtype (as shown below). The list of available entities is immediately limited to those
that match the criteria you specified.

Note ¢ For more details on how to use the Search field, including information about

wildcards, fuzzy searches, Boolean operators, and more, refer to Entity Search Tips on
page 3-10.
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(® Entity Selection

Use the search and filter options to narrow the list of available entities.

Expand All Entities

Select Expanded Enfities

= Select and highlight an entity before using

Select Expanded Entities

= .._ICalmado Springs Demo

v

n Morth Colorado Springs
- E=. Academy North

H VC 15108

! VG 15107

Using the Entity Selection Window =

Types [ ]
[] Scrap
[] Section
Signal

Rinnalized Interzactinn

Entity Hame

Sub-Types
ASC/2 NTCIP
ASC/3
Cobalt

[#] Fanle FPAN

Entity Descripticn

Colorado Springs De  COS Demo System

Under Types, if a device checkbox (such as Signal, DMS, or Autoscope) is checked, you can
also select one or more device sub-types from the Sub-Types list. For all other entity types,
the Sub-Types list is empty.

After you find the entity, move it to the “Selected Entities” side of the window (refer to
Selecting and Moving Entities within the Window on page 3-20). Depending on the
function you are performing, you may be able to move more than one entity to the
“Selected Entities” list; for example, when you select entities for the Favorites window,
there is no limit to the number of entities you can move to the “Selected Entities” list, but
when you create a manual command to send a new message to a DMS sign, you can select

one DMS entity only.

The sample window below finds all entities of any type that have a Description that begins
with “Academy”. In this example, one of the matching entities has been moved to the

“Selected Entities” list.

(® Entity Selection

Use the search and filter options to narrow the list of available entities.

* Select and highlight an entity before using Select Expanded Entities

Types [ |

Expand All Entities

[] scrap

Select Expanded Entities

[] Section
Signal

Sinnalized Intereactinn

-

‘llcdmdu Springs Demo
n Morth Colorado Springs

-

= E= Academy North

! VG 15108
VG 15107

Entity Mame
Academy North
VIC 15108

VIC 15107

Sub-Types
ASCI2 NTCIP
ASC/3
Cobalt

[#] Fanle FRAN
Entity Description

Acadermy Blvd. @ Lehman Dr.
Academy Blvd. @ Dublin Blvd.

Note e Entities are selected from a tree just like the Entity Tree Viewer. As shown above,
multiple entries can be selected using the Ctrl and Shift keys and the selected entries appear

on the right side of the

window.
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Selecting and Moving Entities within the Window

To move a single selected entity from one list to the other:
» double-click it

Or
P press the Space bar

To move multiple selected entities:

P press the Space bar
Or

P press the Insert key (moves entities from left to right)
Or

P press the Delete key (moves entities from right to left)
Or

P press the Backspace key (moves entities from right to left)

To remove all entities from the “Selected Entities” list:

» click the Clear button at the bottom of the window

To select all entities in a list:
> press Ctrl-A

To select a consecutive group of entities:

» click the first entity you want, press and hold the Shift key, then click the last entity
you want

To select a non-consecutive group of entities:

» press and hold the Ctrl key, then click each entity you want to select
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Entity Configuration

Entity Configuration - Systems

To add a new system to the Entity Tree:
1 Right-click anywhere in the Entity Tree.

2 Select Add new System. The Entity Configuration window opens.

(® Entity Configuration

Name/ldentifier| Houston|

Description ‘ ‘

Jurisdiction ‘General v|

e PRSI |

| OK || Cancel || Apply |

Note e Because the fields on the Entity Configuration window are configurable, your
screen may look different than the sample shown here. For details, refer to Using the
Type and Field Definitions Window on page 19-5.

3 Enter a unique name for the System, and optionally, a description. (You can enter any
text or numbers for the Name/Identifier and Description fields, and you can change
them at any time.)

4 Select the Jurisdiction to which the new System will belong. For more information,
refer to Defining Jurisdictions on page 20-12.

5 Optionally, to add notes for this entity, click [ to the right of the Notes field. For more
information, refer to Adding Notes to Entities on page 3-14.

6 Click OK.
The new System is shown in the Entity Tree. You can now add other entities to the new
System.
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Entity Configuration - Sections and Subsections

3-22

To add a new Section or Subsection:

1

Determine the parent for the new entity to be added. The parent of a Section must be
a System or Group; the parent of a Subsection must be a Section.

Right-click the parent entity in the tree.

From the pop-up menu, select Add Entity » Section or Add Entity » Subsection. The
Entity Configuration window opens.

E] Entity Configuration @ [E

Woodmen West

Woodmen Rd W of 1-25

Woodmen -

]
General R d
]

Note e Because the fields on the Entity Configuration window are configurable, your
screen may look different than the sample shown here. For details, refer to Using the
Type and Field Definitions Window on page 19-5.

Enter a name for the new entity, and optionally, a description. (You can enter any text
or numbers for the Name/Identifier and Description fields, and you can change them
at any time.)

In the Signal Coord Monitoring field, select an option from the dropdown list, or click
& to add a new one. For more information, refer to Signal Collection Coordination
Monitoring on page 3-24.

Select the Jurisdiction to which the new entity will belong. For more information, refer
to Defining Jurisdictions on page 20-12.

Optionally, to add notes for this entity, click i to the right of the Notes field. For more
information, refer to Adding Notes to Entities on page 3-14.

Click OK. The new entity is shown in the Entity Tree.

You can use your mouse to drag and drop child entities (signals, etc.) into the new
entity you added (drop them directly on the Section/Subsection name in the tree), or
you can right-click the Section/Subsection name and add a new entity.

Note ¢ To move an entity out of a Section/Subsection, drag and drop it onto a different
parent entity (such as another Section or Subsection).
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Entity Configuration - Groups

To add a new Group:

1 Determine the parent (i.e., a System or another Group) for the new Group to be
added.

2 Right-click the parent entity in the tree.

3 From the pop-up menu, select Add Entity » Group. The Entity Configuration window
opens.

E] Enfity Configuration

Convention Center Signals
=ignals in front of convention center
Special Event Seftings ~[ |

General

-
]

Note e Because the fields on the Entity Configuration window are configurable, your
screen may look different than the sample shown here. For details, refer to Using the
Type and Field Definitions Window on page 19-5.

4 Enter a name for the Group, and optionally, a description. (You can enter any text or
numbers for the Name/Identifier and Description fields, and you can change them at
any time.)

5 In the Signal Coord Monitoring field, select an option from the dropdown list, or click
& to add a new one. For more information, refer to Signal Collection Coordination
Monitoring on page 3-24.

6 Selectthe Jurisdiction to which the new Group will belong. For more information, refer
to Defining Jurisdictions on page 20-12.

7 Optionally, to add notes for this entity, click [ to the right of the Notes field. For more
information, refer to Adding Notes to Entities on page 3-14.

8 Click OK.
The new Group is shown in the Entity Tree.

You can use your mouse to drag and drop child entities (Signals, etc.) into the new
group you added (drop them directly on the Group name in the tree), or you can right-
click the Group name and add a new entity.

Note e To move an entity out of a Group, drag and drop it onto a different parent entity
(such as another Group or a System).
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Signal Collection Coordination Monitoring

3-24

After you schedule a collection of signals to run a specific pattern at a given time, it is
assumed without verification that the signals are continuing to run the correct
coordination plan, but this may not always be the case. To solve this problem, you can use
the Signal Collection Coordination Monitor as a verification tool to make sure that the
signals are running the correct coordination plan (or if Traffic Responsive is enabled, the
TR-based coordination plan). If one or more of the signals in a Group, Section, or
Subsection is not running the correct coordination plan, the Signal Coordination Monitor
can notify you immediately, and optionally, send a new pattern.

Note e For the sake of brevity, the term “collection” is used herein to refer to a Section,
Subsection, or Group.

Configuring Signal Coordination Monitoring

To configure the Signal Collection Coordination Monitor:

1 On the Entity Configuration window for a collection, click [ to the right of the Signal
Coord Monitoring field. The Signal Collection Coordination Monitoring Settings
window opens.

D Signal Collection Coordination Monitaring Seftings @ E

[ » [ New. ][ Detete | [ Rename |
Marnad s=ttings that can be shared among =ll signzl collections (2.9 Sections)

Time to Warning {mins)
Murnber of minutes befors raising a warning svent.

Time to Error (mins)
Mumber of minutes, relative to when the preblem occummed, before a failure error is registered

Set Pattern on Error
Cince an error state is reached, command the section to run 2 different pattemn or loeal TOD

Pattern Offset ” Free ]

Flash H Lacsl ]

2 Click New... and enter a name for this group of settings, then click OK.

3 For when a pattern mismatch is found, set the “Time to Warning” field to the number
of minutes that Centracs will wait before it writes a warning event to the event log for
the collection (or leave it blank if you do not want to write warning events to the log).
(You can run the System Events report to see these logged events.)

4 For when a pattern mismatch is found, set the “Time to Error” field to the number of

minutes that Centracs will wait before it writes an error event to the event log for the
collection (or leave it blank if you do not want to write error events to the log). (You
can run the System Events report to see these logged events.)
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5 To cause Centracs to send a different pattern when the “Time to Error” time is
reached, turn on the “Set Pattern on Error” checkbox. Enter the pattern number to
send, or specify that the signals should Flash, run Free, or run the Local TOD (time-of-
day) schedule configured on the controller. Note that when an error occurs, Centracs
sends the new pattern to the entire collection of signals; even if the mismatched signal
does not respond, the rest of the collection is commanded to the new pattern.

[j Signal Collecticn Coordinafion Monitoring Settings @ E

[Special Event Settings v” Mew . ] X Delete Rename

Mamed settings that can be shared among sl signal collections (2.9 Sections)

Time to Warning (mins) 4
Murnber of minutes before raising a warning svent.

Time to Error (mins}) 7
Murmnber of minutes, relstive to when the problem occumed, before a failure error is registered

Set Pattern on Error 7
Cince an error state is reached, command the section to run 2 different pattern or local TOD.

Paitern ]

Free H Flagh H @ Local ‘

6 Click Save.

This named group of settings can now be assigned to any collection (on the Entity
Configuration window).

Note e Youcanalso use the Signal Collection Coordination Monitoring Settings window to
rename and delete saved groups of settings.

To configure alerts (optional):

1 Onthe Events tab, verify that the events below are enabled and/or logged. For details,
refer to Events on page 4-2.

® Collection Pattern Monitor Error - ON
® Collection Pattern Monitor Error - OFF
® Collection Pattern Monitor Recovered
® Collection Pattern Monitor Warning

2 Add triggers for one or more of these events. For details, refer to Using Triggers on
page 4-25. In the triggers, select the collection (Section/Subsection/Group) as the
entity, not the signals themselves.

How the Signal Coordination Monitor Works

Note that the Signal Collection Coordination Monitor does not verify that all signals in the
collection are running the same pattern; rather, it verifies that all signals are running the
correct pattern. For example, if you have commanded a Section to run Pattern 1, the
Coordination Monitor will continuously verify that all the signals in that Section are still
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running Pattern 1; but if you later command one signal in that Section to run Pattern 2,
the Coordination Monitor will now continuously verify that the one signal is running
Pattern 2 and that all other signals in that Section are still running Pattern 1.

Using the sample Coordination Monitoring Settings shown above, if a signal in the
collection is not running the correct pattern:

1 Centracs waits 4 minutes for the problem to correct itself. If, after 4 minutes, the signal
is still not running the correct pattern, Centracs writes the “Collection Pattern Monitor
Warning” event to the event log.

2 If the signal changes to the correct pattern at this point, Centracs writes the
“Collection Pattern Monitor Recovered” event to the event log.

3 If, after another 3 minutes have passed, the signal is still not running the correct
pattern, Centracs writes the “Collection Pattern Monitor Error - ON” event to the
event log.

4 Once the signal is running the correct pattern as the other signals in the collection
(e.g., either because Centracs automatically sent a new pattern, or because a
technician corrected the problem), Centracs writes the “Collection Pattern Monitor
Error - OFF” and “Collection Pattern Monitor Recovered” events to the event log.

If you configured triggers for these events (described above), Centracs issues alerts.
Without any triggers, you can still see details about these events in the System Events
report (page 10-51).

You can also look at the Pattern Monitor section of the Status display (page 6-10) for more
details:

Q0D

sterson A INE

21
2

=

o
"
[

State Problem Detected - Waiting for Cormrection
Failed Signals 1
Time o Viaming MA

Tume o Emr 0037

7 Phases Time Preempt

This example indicates that one signal in the collection is not running the correct pattern.
When each of the “Time to Warning” and “Time to Error” timers counts down to zero,
Centracs writes the appropriate event to the log. In this example, the “Time to Warning”
timer has already reached zero, and Centracs has already written the Warning event. If
the problem is not corrected within the next 37 seconds, Centracs will write the Error
event. You can see these events in the System Events report (page 10-51).
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To disable or enable pattern monitoring for a collection, click the Disable/Enable toggle
button on the Status display.

Entity Configuration - DMS
Use the Entity Configuration window to add or change the parameters necessary to
deploy and operate dynamic message signs (DMS) in Centracs.
To add a new DMS:
1 Determine the parent (a System or a Group) for the new DMS to be added.
2 Right-click the parent entity in the Entity Tree.

3 From the pop-up menu, select Add Entity » DMS. The Entity Configuration window
opens.

(=] Eniity Configuration =[B!

administrator

Online

Note e Because the fields on the Entity Configuration window are configurable, your
screen may look different than the sample shown here. For details, refer to Using the
Type and Field Definitions Window on page 19-5.
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4

6

Enter a unique name for the DMS, and optionally, a description. (You can enter any
text or numbers for the Name/Identifier and Description fields, and you can change
them at any time.)

Click [ to the right of the Communications field. The Device Communication
Configuration window opens.

D Device Communication Configuration @ @
Comm Channel IP - NTCIP on Device Manager NTCIP j
Destination IP 127.0.0.1
Destination Fort 161
Serial Drop Address 1]

Primary Poll Rate (msec) 30000 [~ Use Default
Priority Poll Rate (msec] 10000 [~ Use Default
Retries 3 [ Use Default
Poll Retries D [+ Use Default
[ ok ][ cancel ]

Use this window to tell Centracs how to communicate with this DMS device. For
details about this window, refer to page 3-44.

To override the default access name used in SNMP communications between Centracs
and this device, uncheck the Use Default checkbox and enter the SNMP Community
name. (The default name is defined in the “DMS SNMP Community Name” Global
Setting.)

In the Mode dropdown, select Online (for full comms), Standby (for comms but no
polling), or Offline (for no comms).

In Standby mode, you can send messages and commands to the sign, but because
Centracs does not poll the sign for current status information, the DMS Status display
will not show the current message or any existing sign-related errors. The Poll button
on the DMS Status display is disabled, and the last known status information is
displayed.

In Offline mode, all buttons on the DMS Status display are disabled. No commands or
messages can be sent to the sign.

Optionally, to select the nearest cross-streets for this sign, click [ to the right of the
Primary Street and Secondary Street fields.
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The Street Names Editor opens.

D Street Mames Editor @ @
Add or fiter sirest. . O@@
Casa de Campo Rd ]
Chspel Ln

E Pikes Peak Ave

Garden of the Gods Rd

Lambert Rd

ieLaughlin Rd

Meridizn Ranch Rd

Meridian Rd

M Academy Bhvd

M Union

Rockrimmon Blvd

S Acadsmy Blva

3 Powers Blhvd |
W Pikes Peak Ave u

Wrmdman RA

(o< ) (Gonemt )

If the street for this sign is notin the list, you can add it. For details about how to search
the list of streets and add new streets, refer to Using the Street Names Editor on
page 20-88.

Once you select the cross-streets, the street names are automatically copied to the
Description field on the Entity Configuration window (unless you already entered a
Description).

To go back to the Entity Configuration window, click OK.

9 Optionally, to manually enter the latitude and longitude coordinates for the
geographical location of this sign, click [&] to the right of the Coordinates field. Or, you
can simply drag and drop it onto the map (for more details, refer to step 20). For
details about how to use the Coordinates window, refer to page 3-71.

10 Select the Jurisdiction to which the new DMS will belong. For more information, refer
to Defining Jurisdictions on page 20-12.

11 Click Apply. The new DMS is shown in the Entity Tree.

12 Optionally, to add notes for this entity, click [ to the right of the Notes field. For more
information, refer to Adding Notes to Entities on page 3-14.

13 Click Auto Configure to get configuration details (i.e., Sign Type, Matrix type, Sign
Specs, and MULTI Configuration) from the sign. This button is enabled only after you
have defined the Communications settings (above). A progress bar is shown, then
closes when the upload is done.
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Centracs populates these fields automatically:

Field Description

Sign Type m Variable — With Variable Message Signs (VMS), you can
write new messages in Centracs and download them to
the temporary memory on the sign.

m Changeable — With Changeable Message Signs (CMS),
messages are pre-defined on the sign; you cannot
download new messages from Centracs.

Matrix Type The box for this field shows various characteristics for the
matrix (such as line height and number of lines), depending
on the matrix type for the sign:

m Full matrix—The entire display area of the sign is divided
into pixels. There are no fixed lines or characters. You can
change each pixel independently.

m Line matrix—The display area of the sign is divided into a
fixed number of lines. Each line is divided into pixels.
There are no fixed characters.

m Character matrix — The display area of the sign is divided
into a fixed number of lines and characters. The spacing
between characters and the spacing between lines are
fixed.

m None - Examples: drum sign, blank-out sign, etc.
(not currently supported)

Sign Specs Characteristics of the sign, such as width, height, and
beacon type.

MULTI Configuration ~ Message characteristics, such as the supported MULTI tags,
the default font, and the default justification for messages.

14 If the matrix characteristics (such as line height and number of lines) that were
uploaded from the sign are not valid, a [iJ button is shown to the right of the Matrix
Type field. Click the button to open the Matrix Configuration window and correct the
invalid value(s) manually. For details about this window, refer to DMS Matrix
Configuration on page 3-33. (If the [i] button is not shown, Centracs considers all
uploaded values to be valid, and you do not need to change them.)

15 To see the specifications that were uploaded from the sign or to change the beacon
type, click [l to the right of the Sign Specs field. (The (] button is enabled only after you
have run the Auto Configure process.) The Sign Specifications window opens. For
details about this window, refer to DMS Sign Specifications on page 3-32.
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16 To define the default display settings and the supported MULTI tags for the sign, click
() to the right of the MULTI Configuration field. (The (@ button is enabled only after you
have run the Auto Configure process.) The Sign MULTI Configuration window opens.
For details about this window, refer to DMS MULTI Configuration on page 3-34.

17 To load the messages that are defined on the sign, click Load Messages. Centracs
copies the Permanent messages and the Changeable messages from the sign into the
Centracs database. A progress bar is shown while Centracs loads the messages. The
Entity Configuration window then shows the number of Permanent and/or
Changeable messages that have been loaded from the sign. You can load a maximum
of 100 Changeable messages and 50 Permanent messages from the sign.

18 To see the messages, click [ to the right of the Permanent Messages and/or
Changeable Messages fields. (The [ button is enabled only after you have run the
Load Messages process.) The DMS Messages window opens. For details about this
window, refer to Configuring DMS Messages on page 9-4.

[] Enfity Configuration (=]

administrator

Online
Eastwood

Tuffnel

35.8409331200772, -104.83023657

19 Click OK.

20 If you did not manually enter the latitude/longitude coordinates for the DMS
(described above), then from the main menu, select View » Map or View » Preset
Map and zoom in on the location for the device.
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Drag and drop the DMS from the Entity Tree onto the appropriate position on the map.

The Map Editor opens so that you can define and configure the map visuals for this
device. For details about how to use the Map Editor, refer to Editing the Map View on
page 5-18.

To edit the configuration for a DMS:
Refer to Editing Entity Properties on page 3-9.

DMS Sign Specifications

When you configure a DMS entity, if you click [ to the right of the Sign Specs field, the
Sign Specifications window opens:

E Sign Specifications @ g

Two beacons, opposing flazhing -

It contains details about the sign, such as the dimensions of the outer frame of the sign (in
millimeters), the type of technology used by the sign, and the beacon type (if any). To get
these details from the sign, click Auto Configure to the right of the Sign Specifications
field on the Entity Configuration window.

Sign Access shows the method to access the interior of the sign:
m  Front access

m  Rear access

m  Walk-in access

m  Other

Beacon Type shows the type of beacons on the sign, such as:

m None

m  One beacon, strobe light

m Four beacons, synchronized flashing

This window is read-only. Click OK or Cancel to go back to the Entity Configuration
window.
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DMS Matrix Configuration

If the configuration specs that Centracs received from the sign (when you click Auto
Configure on the Entity Configuration window) are not valid, Centracs gives you the
ability to change them manually.

On the Entity Configuration window, if you click [ to the right of the Matrix Type field, the
Matrix Configuration window opens. (The [ button is shown only if Centracs found an
invalid value in the configuration information, such as a sign width greater than 1000
pixels.)

The window shows various characteristics for the matrix, depending on the matrix type
for the sign:

Character Matrix Type

Full Matrix Type

Make changes as needed, then click OK to save your changes and go back to the Entity
Configuration window.
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DMS MULTI Configuration

When you configure a DMS entity, if you click [ to the right of the MULTI Configuration
field, the Sign MULTI Configuration window opens:

[=] Sign MULTI Configuration (=115

| B<B<N<B<N |
EEEEEN
EEEEEN

—
)
=
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]
F

Sign messages are constructed in MULTI (Mark-Up Language for Transportation
Information) format. A MULTI string controls which text shows in which area of the sign.

The Supported MULTI Tags section shows the tags supported by the sign. Centracs gets

this information from the sign when you click Auto Configure on the Entity Configuration
window; you cannot change these fields. For details about MULTI tags and syntax, refer
to the NTCIP 1203 standard, “Object Definitions for Dynamic Message Signs (DMS)”.

On this window, you can configure these settings:

m  Quick Message Location — Select the position of the “quick” message in the
Changeable library, usually 1. This position in the library is used to store a custom
message that is created “on the fly” using the Quick Message function.

m Blank Message Location — Select the location of the “blank” message. If you choose
Permanent or Changeable to indicate that the blank message is in the Permanent
library or the Changeable library, use the second dropdown list to select the blank
message from that library. If you choose Blank, the second dropdown list is not shown.
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These settings are not configurable at this time:

Font — The dropdown list contains the fonts available on the sign. Select the default
font. After you select a font, the Characters field to the right shows the number of
characters in that font set.

Line Justification — The default horizontal justification for messages: Left, Right, or
Center.

Page Justification — The default vertical justification for messages: Top, Bottom, or
Center.

Page-ON Duration — The default amount of time to show each page of the message,
in tenths of a second.

Page-OFF Duration — The default amount of time to blank the sign between pages of
the message, in tenths of a second.

For example, if Page-ON is 50 and Page-OFF is 20, the first page of the message is
shown for 5 seconds, then the sign is blank for 2 seconds, then the second page of the
message is shown for 5 seconds, then the sign is blank for 2 seconds, and so on.

Note e The Default settings are used only in the absence of MULTI tags in the message (for
example, a [jpx] tag in the message overrides the default Page Justification setting).

Click OK or Cancel to go back to the Entity Configuration window.
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3-36

Use the Entity Configuration window to add or change the parameters necessary to
deploy and operate signals in Centracs.

To add a new signal:
1 Determine the parent (i.e., a System, Section, Subsection, or Group) for the new signal
to be added.

2 Right-click the parent entity in the Entity Tree.

3  From the pop-up menu, select Add Entity P Signal. The Entity Configuration window
opens.

Note e Because the fields on the Entity Configuration window are configurable, your
screen may look different than the sample shown here. For details, refer to Using the
Type and Field Definitions Window on page 19-5.

4 Enter a unique name for the signal, and optionally, a description. (You can enter any
text or numbers for the Name/Identifier and Description fields, and you can change
them at any time.)

5 From the Signal Type dropdown, select the type of the controller.
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6 Click [ to the right of the Communications field to specify the properties for the
controller associated with this signal. The Device Communication Configuration
window opens.

E] Device Communication Configuration @ @

Comm Channel IP - NTCIP on Device Manager NTCIP
Destination IP 127.0.0.1

Destination Port 501

Serial Drop Address 1]

Primary Poll Rate {msec) 1000 [+ Use Default

Secondary Poll Rate (msec) 30000 [ Use Default

Tertiary Poll Rate (msec) 0 [¥ Use Default
Friority Poll Rate (mses) 1000 [v Use Default
3 [« Use Default
0 [¥ Use Default
econolite [+ Use Default
ssssssses [+ Use Default

SHMP Community Mame: adminisirator [¥ Use Default

Use this window to tell Centracs how to communicate with this controller. For details
about this window, refer to page 3-44.

Note e For more detailed controller configuration, use the Database Editor or the front
panel of the field controller.

7 Inthe Mode dropdown, select Online (for full comms), Standby (for comms but no
polling), or Offline (for no comms).

8 Optionally, to select the streets controlled by this signal, click [ to the right of the
Primary Street and Secondary Street fields.
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10

11

The Street Names Editor opens.

E] Sireet Names Editor @ @

Add ar filter strest. .

Casa de Campo Rd
Chapel Ln

E Pikes Peak Ave
Garden of the Gods Rd
Lambert Rd
MeLaughlin Rd
leridian Ranch Ra

Meridian Rd

M Academy Bhd
M Union
Rockrmmaon Blvd
S Academy Blvd
S Powers Blvd

W Pikes Peak Ave

Winndman R

If the street for this intersection is not in the list, you can add it. For details about how
to search the list of streets and add new streets, refer to Using the Street Names
Editor on page 20-88.

Once you select the cross-streets, the street names are automatically copied to the
Description field on the Entity Configuration window (unless you already entered a
Description).

e
To go back to the Entity Configumwindow, click OK.
L

Optionally, to manually enter the latitude and longitude coordinates for the
geographical location of this signal, click [i] to the right of the Coordinates field. Or, you
can simply drag and drop it onto the map (for more details, refer to step 18). For
details about how to use the Coordinates window, refer to page 3-71.

From the Primary Poll, Secondary Poll, and Tertiary Poll dropdowns, select the types
of polling packets to request from this controller. The items in these lists are defined
via the Polling Packet Editor (refer to page 20-50). The Primary Poll field is required.
Secondary polling is optional, and is usually used to get volume/occupancy/speed data
from the vehicle detectors. Tertiary polling is rarely used.

Optionally, to select the phase numbers and overlaps associated with each street in
this intersection, click [ to the right of the Main Street Phases and Side Street Phases
fields. The Phase Selection window opens.

E] Phase Selection @ ]
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click the phase numbers and overlap letters to select them, then click OK. (To deselect
one, click it again.)

12 To load the vehicle detectors from the controller, click [&] to the right of the Detectors
field. The Detector Configuration window opens. For details on how to use this
window, refer to Entity Configuration - Vehicle Detectors on page 3-48.

13 Select the Jurisdiction to which the new signal will belong. For more information, refer
to Defining Jurisdictions on page 20-12.

Note e If the “ECcomPath” Global Setting is enabled, a field called “ECCOMM
Monitoring” is shown (below the Notes field). With the combination of these two
settings, you can launch the EDI Malfunction Management Unit (MMU) Conflict Monitor
program from Centracs. The “ECcomPath” setting specifies the path to the executable;
the “ECCOMM Monitoring” field specifies the IP address. After these two items have
been configured, to launch the program, you can click the EDI option on the Signal Status
display (page 6-1), or you can right-click a signal in the Entity Tree or Map Viewer and
select Launch ECcom Monitoring...

14 To collect data for the MOE (Measure of Effectiveness) reports, turn on the Enable
MOE Logging checkbox. This activates the MOE logging on the controller. For more
information about the MOE reports, refer to Using the MOE Reports on page 11-1.

15 To attach files to this signal configuration (such as timing sheets, intersection
diagrams, or digital images of the intersection/equipment), click i to the right of the
Files field. The Attach Files window opens. For instructions on how to attach, open,
update, or delete files, refer to page 19-38. These attached files will be accessible to
users from the Signal Status display window (page 6-1).
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16 To save your entries, click Apply or OK. (Apply saves your changes and keeps the
window open so that you can add notes or change preemptor descriptions for this
signal; OK saves your changes and closes the window.)

(=] Entity Configuration [=11ES;

Woodmen @ Rockrimmon

ASCI

Woodmen Rd

Rockrimmen Blvd

38.9305822351557, -104.82036492¢

ASCY3 Primary Poll

The new signal is added to the Entity Tree.

17 Optionally, after the new signal has been saved, you can add notes for this entity. You
can also override the system-wide default preemptor descriptions for this signal. (If
you clicked OK to save and close the signal, right-click the new signal in the Entity Tree
and select Edit Properties to return to the Entity Configuration window.) To add notes,
click [ to the right of the Notes field. For more details, refer to Adding Notes to
Entities on page 3-14. To change the preemptor descriptions, click [ to the right of the
Preempt Descriptions field. For more details, refer to Customizing the Preemptor
Descriptions for a Signal on page 3-42.

18 If you did not manually enter the latitude/longitude coordinates for the signal
(described above), then from the main menu, select View » Map or View » Preset
Map and zoom in on the location for the signal.

Drag and drop the signal from the Entity Tree onto the appropriate position on the
map.
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The Map Editor opens so that you can define and configure the map visuals for this
signal. For details about how to use the Map Editor, refer to Editing the Map View on

page 5-18.

Note e The “Enable Simulation” field on the Entity Configuration window is only for
demonstrations and tests, and must be left unchecked for normal day-to-day operations.

To edit the configuration for a signal:
Refer to Editing Entity Properties on page 3-9.
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Customizing the Preemptor Descriptions for a Signal

Although the Preempts tab of the Settings window (page 20-5) sets the default preemptor
descriptions for the system, you can use the procedure below to override those
descriptions for specific signals

To customize the preemptor descriptions for a signal:
1 From the Entity Tree, right-click the signal and select Edit Properties. The Entity
Configuration window opens.

2 Click [ to the right of the Preempt Descriptions field. The Preemptor Descriptions
window opens.

[=] Preemptor Descriptions =
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3 Enter your new descriptions for the various preemptors. The current default
description for each preemptor is shown below each entry field. If you leave an entry
blank, Centracs uses the default description.

4 To save your changes, click OK.

The Preempt Descriptions field on the Entity Configuration window now shows the
number of preemptor description overrides you added for this signal. The new labels
you configured will now be shown in the Preempt dropdown when you add a manual
command, schedule entry, or action set to send the Preempt action to this signal.

5 To exit the window, click Close.

Centracs User Manual 3-43
Software Version 2.x - March 2018



Using the Entity Tree

= Device Communication Configuration

Device Communication Configuration

Use the Device Communication Configuration window to set the communication
properties for a signal controller, Autoscope/RTMS detector, or DMS device.

The Device Communication Configuration window opens when you click [ to the right of
the Communications field on the Entity Configuration window for a signal, Autoscope
detector, RTMS detector, or DMS.

Signal:

IP - NTCIP on Device Manager MTCIP hd
127.0.0.1
1000 [

Autoscope Detector:

Device Manager 1 b
192.168.3.4
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RTMS:

[ Device Communisation Configuration [=I1ES
Comm Channgel TCP on Device Manager 1 ;I
Destinaticn IP 172.20.97.201
Destination Port 2000
RTMS Id 1
Device Poll Rate (sec) [+ Use Default

[ ok ][ cancel |
DMS:

D Device Communication Configuration @ @
Comm Channel IP - NTCIP on Device Manager NTCIP j
Destination IP 127.0.01
Drestination Port 161
Serial Drop Address 1]

Primary Poll Rate (msec) 30000 [~ Use Default
Priority Poll Rate (msec] 10000 [~ Use Default
Retries 3 [ Use Default
Poll Retries 0 [+ Use Default
[ ok ][ cancel ]

For a signal, three different connection profiles can be defined — one for Centracs and
two for Local Edition. At the top of the window, click the tab for the profile you want to
configure. (You can merge the Local Edition profiles to/from other systems; you cannot
merge the “Centracs” profile. For information about the merge function, refer to Merging
Entity Data on page 16-1.)

The fields differ depending on the type of device being configured. The possible fields are
described below, in alphabetical order:

Field Description

Comm Channel Select the communication channel for this device. The items
shown in the Comm Channel dropdown list are defined on the
Servers/Comms Configuration window. For more information,
refer to Setting Up Communications on page 20-32.

Destination IP For IP channels, enter the IP address for the device.

Destination Port For IP channels, enter the UDP port through which the device will
reply to requests. Communications sent to any other port are
ignored.
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Field Description

FTP Username and For ASC/3 and Cobalt signals only. To override the default

FTP Password username and password used for FTP-based communications
between Centracs and this signal, uncheck the Use Default
checkbox and enter the new values. (The default values are
defined on the Default Comm Parameters window. For details,
refer to page 20-10.) FTP-based communications include MOE
uploads and downloads/uploads in the Signal Editor. The FTP
username and password must match the values set on the signal
controller.

Poll Retries To override the default number of Poll Retries for polling
communication attempts), uncheck the Use Default checkbox
and enter the new number of poll retries. (The default value is
defined on the Servers/Comms Configuration for this channel.
For details, refer to page 20-36.)

Primary Poll Rate (for | For an Autoscope detector, use this field to override the default
Autoscope detectors) | rate at which Centracs attempts to communicate with Autoscope
devices to make sure the devices are still “alive” and that comms
are good, in seconds. The value entered here will be applied to
this device only. (The default value is defined on the Autoscope
Settings window. For details, refer to page 20-2.)

Primary Poll Rate (for | To override the default Primary Poll Rate for the communication
DMS) channel, uncheck the Use Default checkbox and enter the new
poll rate, in milliseconds. (The default value is defined on the
Servers/Commes Configuration for this channel. For details, refer
to page 20-36.) A value of zero disables polling. Note that the
primary polling rate for a DMS device is usually slower than the
primary polling rate for a signal controller. For example, if you
poll the signal every 1 second, you might choose to poll the DMS
every 10 seconds (10000 milliseconds). The appropriate polling
rate for your sign depends on the type and speed of
communications between Centracs and the sign. The values
entered here will be applied to this device only.

There is no secondary or tertiary polling for a DMS.
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Field Description

Primary/Secondary/ | To override the default Primary Poll Rate, Secondary Poll Rate,
Tertiary Poll Rate (for | and/or Tertiary Poll Rate for the communication channel,
signals) uncheck the Use Default checkbox and enter the new poll rates,
in milliseconds. (The default values are defined on the Servers/
Comms Configuration for this channel. For details, refer to

page 20-36.) These values determine the frequency of polling for
the packets specified in the Primary Poll, Secondary Poll, and
Tertiary Poll fields on the Entity Configuration window

(page 3-36). A value of zero disables polling. The values entered
here will be applied to this device only.

Priority Poll Rate To override the default Priority Poll Rate for the communication
channel, uncheck the Use Default checkbox and enter the new
poll rate, in milliseconds. (The default value is defined on the
Servers/Comms Configuration for this channel. For details, refer
to page 20-36.) Avalue of zero disables priority polling. The value
entered here will be applied to this device only.

Retries To override the default number of Retries for non-polling
communication attempts, uncheck the Use Default checkbox and
enter the new number of retries. (The default value is defined on
the Servers/Comms Configuration for this channel. For details,
refer to page 20-36.)

RTMS Id Must match the sensor ID (from 1 to 65534) that is configured in
the ISS configuration utility.

Secondary Poll Rate | For an Autoscope detector, use this field to override the default
(for Autoscope rate at which Centracs polls Autoscope devices for a current
detectors) snapshot, in seconds. The value entered here will be applied to
this device only. (The default value is defined on the Autoscope
Settings window. For details, refer to page 20-2.)

Serial Drop Address | For serial channels, enter the numeric drop address for this
device on the channel. This is necessary to differentiate it from
other devices on the same channel. For IPcommunications, leave
this field set to 0.

SNMP Community For ASC/3, ASC/2, Cobalt, and Eagle signals only. To override the
Name default access name used in SNMP communications between
Centracs and this signal, uncheck the Use Default checkbox and
enter the SNMP Community name. (The default name is defined
on the Default Comm Parameters window. For details, refer to
page 20-10.)

To save the settings, click OK.
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Entity Configuration - Vehicle Detectors

In general, vehicle detectors are configured in Centracs automatically by uploading
detector information from the signal controllers. A few steps are necessary to allow this
automatic configuration.

Note e This feature is not supported for Tek-Chile controllers.

To
1

3-48

allow automatic vehicle detector configuration for a signal controller:

If not already done, configure one or more detectors as “System detectors” to collect
volume and/or occupancy data. You can do this in the Signal Editor then download to
the controller, or on the controller itself then upload to the Signal Editor. (For
information about the Signal Editor, refer to Changing the Controller Settings on
page 15-1.) A detector is defined as a “System detector” in the controller using the
fields below:

Controller Type Field(s)

ASC/3 and Cobalt | The “NTCIP Occupancy” field or “NTCIP Volume” field (or both)
must be enabled on the Vehicle Detector Setup screen

(MM-6-2).

ASC”2 The “System” flag must be enabled on the Vehicle Detector
Setup screen.

Oasis The “Enable Logging” field must be enabled on the Vehicle
Detector Assignments screen (7-1).

w4 The “Detector Count On” function must be enabled as a TOD/

DOW event.

Eagle The “Occupy” field or “Volume” field (or both) must be enabled

on the Detector Config Data screen.

From the Signal Editor, save the changes made in step 1 to the Centracs database.

There are two ways to confirm that the detector configuration succeeded:

® |n the Entity Tree, right-click the signal and select Edit Properties. On the Entity
Configuration window, the Detectors field shows the total number of detectors that
were successfully loaded into Centracs for this signal.

® |n the Entity Tree, click ® beside the signal. The newly loaded detectors are shown
as entities under the signal.
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To add additional information for a vehicle detector:

Note ¢ The Coordinates and Notes fields are informational only; they do not affect the
operation of the system or the detector.

1 From the Entity Tree, right-click a detector and select Edit Properties. The Entity
Configuration window opens. The fields vary, depending on the detector type.

@] |[=] Entity Configuration (=]

Willoughby Ln (@ Wasabi Way Det 5
- Westbound -

Forest Edge 1 det 102

@ wintoughby Ln @ Wasabi Way ~

1,6
1,6
60 Feet
5 Feet

Colorado Springs

System detector Autoscope/RTMS detector (DCMS)

2 Forsystem detectors, to manually enter the latitude and longitude coordinates for the
geographical location of this detector, click [ to the right of the Coordinates field. For
details on how to use the Coordinates window, refer to Setting Entity Coordinates on
page 3-71. Note that the Coordinates field for system detectors is informational only;
you cannot add system detectors to the map in Centracs.

3 To add notes for this detector, click [&] to the right of the Notes field. For more
information, refer to Adding Notes to Entities on page 3-14.

4 To save your entries, click Apply or OK on the Entity Configuration window. (Apply
saves your changes and keeps the window open; OK saves your changes and closes the
window.)

Note e For system detectors, to edit the Loop Length, Distance from Stop Bar, Name, or
Description, refer to the next section. For Autoscope/RTMS detectors, refer to page 17-27.
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To edit other detector properties:
1 From the Entity Tree, right-click the parent signal for the detector and select Edit
Properties. The Entity Configuration window opens.

(=] Entity Configuration (=14

Willoughyby Ln @& VWasabi Way

Willoughby Ln

Wasabi Way

38.8392575404776, -104 540242936569

Note e Because the fields on the Entity Configuration window are configurable, your
screen may look different than the sample shown here. For details, refer to Using the
Type and Field Definitions Window on page 19-5.

2 Click [ to the right of the Detectors field.
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The Detector Configuration window shows the settings for all the detectors defined
for this signal:

[ Detector Configuration for Willoughby Ln @ Wasabi Way =
Sy el | B4t Lopgy o Nams
Stop Bar
o 1 25 2,3 8 Feet 5 Feet |Willoughby @ Wasabi Det 1 |- Eastbound - |ﬂ
o 2 25 8 Feet |5 Feet |Willoughby @ Wasabi Det 2 |- Eastbound -
e 3 38 60 Feet|16 Feet |Willoughby @ Wasabi Det 3 |- Southbound -
o 4 38 8 Feet |5 Fest |Willoughby @ Wasabi Det4 |- Southbound -
o 5 16 16 60 Feet|16 Feet |Willoughby @ Wasakbi Det 3 |- Westbound -
i 6 1,6 8 Feet |5 Feet |Willoughby @ Wasabi Det 6 |- Westbound -
< 7 47 60 Feet|16 Feet |Willoughby @ Wasabi Det 7 |- Northbound -
e 8 4.7 8 Feet |5 Fest  |Willoughby @ Wasabi Det 8 |- Northbound -
9 9 9 60 Feet|16 Feet |Willoughby @ Wasabi Det 9 8
u . e - PP . P ]
[Reluad][ Save ][Glose]

Note e If this window is blank, you must populate it using information from the
controller. To do so, refer to page 3-48.

The fields on this window are:

System Detector — If the detector is configured in the controller as a “System
detector” to collect volume and/or occupancy data, a checkbox is shown in this
column. If the checkbox is checked, Centracs logs the volume and occupancy data
collected by the controller, and the detector is shown in the Entity Tree under its
parent signal; if unchecked, Centracs ignores the data collected by the controller and
the detector is not shown in the Tree.

A detector is defined as a “System detector” in the controller using the fields below:

Controller Type  Field(s)

ASC/3 and Cobalt | The “NTCIP Occupancy” field or “NTCIP Volume” field (or both)
must be enabled on the Vehicle Detector Setup screen

(MM-6-2).

ASC”2 The “System” flag must be enabled on the Vehicle Detector
Setup screen.

Oasis The “Enable Logging” field must be enabled on the Vehicle
Detector Assignments screen (7-1).

W4 The “Detector Count On” function must be enabled as a TOD/

DOW event.

Eagle The “Occupy” field or “Volume” field (or both) must be enabled

on the Detector Config Data screen.
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Vehicle Detector Number — The number of the detector, as defined on the controller.
You cannot change this value.

Call Phases / Extended Phases — These fields show the assigned phases and call phases
specified in the controller for each detector. If the detector is defined in the controller
as a call detector, the phases are shown in the Call Phases column. If the detector is
defined in the controller as an extension detector, the phases are shown in the
Extended Phases column. If the detector is defined as both, the phases are shown in
both columns. To change these values, you must change them on the controller and
reload them into Centracs using the Signal Editor.

Length — The length of the loop detector or detection zone. Centracs uses this value
for speed calculations in the MOE reports, VOS reports, Links, Traffic Responsive, and
Centracs Adaptive. When detector configurations are uploaded from the controller for
the first time, Centracs assigns the default length specified on the Default Detector
Settings window (refer to page 20-8). If the detector is configured in the controller as
a call detector (or as a call+extend detector), Centracs assigns the default “Call Length”
value; if the detector is configured as an extension detector, Centracs assigns the
default “Extended Length” value. To change the value, double-click it and type the
new value. One of these units must be included: feet or ft, miles or mi, meters or m,
kilometers or km. For example, “6 ft” or “1.8 m”. To copy the same length to all rows,
right-click the length and select Set all to {/length}.

Average Vehicle Length — Centracs uses this value for speed calculations in the MOE
reports, VOS reports, Links, Traffic Responsive, and Centracs Adaptive. When detector
configurations are uploaded from the controller for the first time, Centracs assigns the
default length specified on the Default Detector Settings window (refer to page 20-8).
To change the value, double-click it and type the new value. One of these units must
be included: feet or ft, miles or mi, meters or m, kilometers or km. For example, “15

ft” or “4.5 m”. To copy the same length to all rows, right-click the length and select Set
all to {length}.

Distance from Stop Bar — The distance of the detector from the stop bar at the
intersection. When detector configurations are uploaded from the controller for the
first time, Centracs assigns the default distance specified on the Default Detector
Settings window (refer to page 20-8). If the detector is configured in the controller as
a call detector (or as a call+extend detector), Centracs assigns the default “Call
Distance From Stop Bar” value; if the detector is configured as an extension detector,
Centracs assigns the default “Extended Distance From Stop Bar” value. To change the
value, double-click it and type the new value. One of these units must be included: feet
or ft, miles or mi, meters or m, kilometers or km. For example, “6 ft” or “1.8 m”. To
copy the same distance to all rows, right-click the distance and select Set all to
{distance}.

Name — A unique name for the detector. When detector configurations are uploaded
from the controller for the first time, Centracs assigns a name to each detector in the
format:

{parent signal name} Det {nn}
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where {nn}is a unique number. To change the name, double-click it and type the
new name.

Description — Any relevant details about the detector. When detector configurations
are uploaded from the controller for the first time, Centracs assigns a description to
each detector that lists the assigned phase and call phase(s) for the detector. To
change the description, double-click it and type over it. To copy the same description
to all rows, right-click the description and select Set all to {description}.

3 Click or double-click in the fields and make your changes. Optionally, for some fields,
if you right-click one of these fields, you have the option to copy the same value to all
of the detectors for the signal.

4 To save your changes, click Save.

5 To return to the Entity Configuration window, click Close.

Note e Torefresh the Call Phases and Extended Phases values (for example, if these values
have just been changed on the controller or in the Signal Editor), click Reload.
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Entity Configuration - Links
Centracs has two types of Link entities:

m Level of Service Link — a collection of vehicle detectors (often loop detectors) that are
associated with consecutive intersections on a section of road. A Level of Service link
offers a convenient way to monitor and analyze the volume, speed, and occupancy
data for these detectors collectively.

m  BlueTOAD™ Link Pairing — a section of road between two BlueTOAD Data Collection
Stations. BlueTOAD Data Collection Stations gather data from passing vehicles that
have Bluetooth™-enabled devices onboard. The data is used to calculate the current
speed and travel time for the section of road.

Both types of links can be shown on the map, and they use color-coding to indicate
current traffic conditions. Also, historical link data can be viewed in reports for further
analysis.

Use the procedure below to add a new Level of Service link; for BlueTOAD links, refer to
Configuring BlueTOAD Entities on page 14-9.

To add a new Level of Service Link:

1 Determine the parent (i.e., a System, Section, Subsection, or Group) for the new Link
to be added.

2 Right-click the parent entity in the Entity Tree.

3 From the pop-up menu, select Add Entity P Link. The Entity Configuration window
opens.

[=] Entity Configuration el =1

Level of Service

System Settings

Note e Because the fields on the Entity Configuration window are configurable, your
screen may look different than the sample shown here. For details, refer to Using the
Type and Field Definitions Window on page 19-5.
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4 Enter aunique name for the Link, and optionally, a description. (You can enter any text
or numbers for the Name/Identifier and Description fields, and you can change them
at any time.)

Note e The Link Type is automatically populated by the system and cannot be
changed.

5 Optionally, to manually enter the latitude and longitude coordinates for the
geographical location of this Link, click [ to the right of the Coordinates field. Or, you
can simply drag and drop the Link onto the map (for more details, refer to step 16 on
page 3-59). For details about how to use the Coordinates window, refer to page 3-71.

Note e For information about the Settings field, refer to Link Settings on page 3-59.

6 Inthe Max Volume field, enter the number of vehicles considered to be the maximum
for the computational period. Centracs uses this number to determine whether the
Link has exceeded any of the Volume thresholds specified on the Link Settings window
(page 3-59). The calculation is:

o)

detected volume / Max Volume = Volume %

7 In the Max V+kO field, enter the weighted volume-plus-occupancy value considered
to be the maximum for the computational period. Centracs uses this number to
determine whether the Link has exceeded any of the V+kO thresholds specified on the
Link Settings window (page 3-59). The calculation is:

oo

calculated V+kO / Max V+kO = V+kO

8 Inthe Max Speed field, enter the speed considered to be the maximum or “free flow”
speed (usually a number slightly higher than the speed limit for that stretch of
roadway). Centracs uses this number to determine whether the Link has exceeded any
of the Speed thresholds specified on the Link Settings window (page 3-59). The
calculation is:

o

average detected speed / Max Speed = Speed %

Note e Because the maximum occupancy is always considered to be 100%, there is not a
field for you to configure this value.

9 In the Occ Scaling Factor field, enter the value to use for k in all V+kO calculations for
this Link. Enter any whole number from 0 to 2147483647.
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10 Click[d to the right of the Detectors field to specify the vehicle detectors to be included
in this Link. (The detectors must already be defined in the Entity Tree.) The Link
Detector Settings window opens.

[=] Link Detector Settings (=1

Add locations and lanes to specify where detectors are capturing counis.
A location intersecis all lanes and is perpendicular to the roadway.
Wolume counts for each lane at a location are summed. Occupancy and speed are averaged.

.4.1 Location 1

Lane & Detector Wolume Scaling % Occupancy Scaling % Speed Scaling %

1 & 1o 100 (+

Configure the locations and lanes for all detectors included in this Link, and click OK.
A location may include one lane or multiple lanes, each with its own detector.

® Toassign a detector toalane, click [ in the Detector column and select the detector
from the Entity Selection window (page 3-18).

® To add a lane to a location, click @ to the right of a lane. The new lane is added
directly below the lane you clicked.

® To delete a lane, click B to the right of the lane.

® To add a location, click @ to the right of the location name. The new location is
added directly below the location you clicked.

® To delete a location, click B4 to the right of the location name.

® To “weight” the data from some detectors less than others, you can change the
Volume, Occupancy, and Speed Scaling values to be less than 100%.
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For example, suppose the Link includes a total of 9 detectors, numbered D1 thru 9:

3 locations
D7

D4 D1
gna gn_s__"_m—_
D9 E - [pa]
%
fraffic flow

In this case, you would specify a total of three locations, each with three lanes:
® |ocation 1 =detectors 1, 2, and 3
® |[ocation 2 = detectors 4, 5, and 6

® |ocation 3 = detectors 7, 8, and 9

For Link calculations that include only one location, the volumes for each detector are
added together, the occupancy values are averaged, and the speed values are
averaged.

For Link calculations that include multiple locations, the total volumes for each
location are averaged together, the occupancy values for all detectors are averaged
together, and the speed values for all detectors are averaged together.

Or more simply:
Link Volume = (sum of all detector volumes) + (total # of locations)

Link Occupancy = (sum of all detector occupancies) + (total # of detectors for all
locations)

Link Speed = (sum of all detector speeds) + (total # of detectors for all locations)
For example, in the drawing shown above:

Link Volume = ((D1 + D2 + D3) + (D4 + D5 + D6) + (D7 + D8 + D9)) + 3

Link Occupancy = (D1 + D2 + D3 + D4 + D5+ D6 + D7 + D8 + D9) + 9

Link Speed = (D1 +D2 + D3 + D4 + D5 +D6 + D7 + D8 + D9) + 9
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[=] Link Detector Seflings

B

‘Add locations and lanes to specify where detectors are capturing counts.
A location intersects all lanes and is perpendicular to the roadway.
Volume counts for each lane at a location are summed. Occupancy and speed are averaged.

\‘l Location 1

Lane & Detector

1 4 WB Woodmen @ N Union 1 ()
=)™

=

2 #% WE Woodmen @ N Union 2

3 &% WE Woodmen @ N Union 3

Volume Scaling % Occupancy Scaling % Speed Scaling %

100 100

100 100

100 100

\‘l Location 2

Lane & Detector

1 #% WE Woodmen @ N Union 4
2 #% WE Woodmen @ M Union 5

3 #% WE Woodmen @ N Union 6

Volume Scaling % Occupancy Scaling % Speed Scaling %

100 100

100 100

100 100

\‘l Location 3

Lane & Detector

1 #4 WB Woodmen @ Academy 7 (3 (]

2 #% WB Woodmen @ Academy 8 (3 (]

3 #4 WB Woodmen @ Academy 9 (3 (]

Volume Scaling % Occupancy Scaling % Speed Scaling %

100 100 100

100 100 100

100 100 100

11 After you have added all the necessary detectors, click OK to save the settings and go
back to the Entity Configuration window.

12 From the Enable Logging dropdown, select Off, Use Link Settings, or On. To use the
logging value from the Link Settings window (page 3-59), select the Use Link Settings
option. To override the logging value from the Link Settings window for this Link only,

select the On or Off option.

13 Select the Jurisdiction to which the new Link will belong. For more information, refer
to Defining Jurisdictions on page 20-12.

14 Optionally, to add notes for this entity, click [ to the right of the Notes field. For more
information, refer to Adding Notes to Entities on page 3-14.
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[=] Entity Configuration =0

LIMEK - East Woodmen - WEB
Wesibound

Level of Senvice

System Settings

Use Link Settings -
Colorado Springs -

15 To save your entries, click Apply or OK. (Apply saves your changes and keeps the
window open; OK saves your changes and closes the window.)

The new Link is shown in the Entity Tree.

16 If you did not manually enter the latitude/longitude coordinates for the Link
(described above), then from the main menu, select View » Map or View » Preset
Map and zoom in on the location for the Link.

Drag and drop the Link from the Entity Tree onto the appropriate position on the map.

The Map Editor opens so that you can define and configure the map visuals for this
Link. For details about how to use the Map Editor, refer to Editing the Map View on
page 5-18.

To edit the configuration for an individual Link:
Refer to Editing Entity Properties on page 3-9.

Link Settings

Use the Link Settings window to specify global properties for all Links defined in the
system.

To change the computational settings for all Links:

1 From the Entity Configuration window for any Link, click [ to the right of the Settings
field. Depending on the type of Link you chose, the appropriate Link Settings window
opens:
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Level of Service Links:

[-] Link Settings (=]

Yolume % W+kiO % Occupancy % Speed % Color

0%1o 20 % O%to 20 % O%to 20 % 100%tc &0 %. ..n

21% 10 40 % 21%to 40 % 21%1ic 40 % T9%to 60 % . ..n

41% 1o 60 % 41%to 60 % 41%te 60 % 59%to 40 % . ..n

61% 10 100%  61%to 100%  61%to 100%  39%to 0% . n

BlueTOAD Links:
[=] Link Settings (=114

Speed % Caolor

100%t0 80 % [ ..n
moa s @ B0
oo« B BEO
39% to 0% . n

IMPORTANT e The Settings on this window apply to all Links defined in the system.
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The fields are:

Centracs User Manual

® Desired computational frequency — (for Level of Service Links only) The interval at

which the system will gather detector data, make calculations, and update the Real-
time Link Status display (in seconds).

Max computational frequency — (for Level of Service Links only) The maximum time
the system will wait for data from a detector before it considers it invalid (in
seconds). If a detector has not reported any data by the end of this interval, the Link
will use the data it has from the other detectors to make calculations.

Min Good Detectors — (for Level of Service Links only) The percentage of detectors
in a Link which must collect valid data in order for Centracs to make Link
calculations. To always make calculations, enter O.

Enable Logging —if this option is turned on, Centracs saves Link data to the database
as it is calculated, and you can view this data on the Links report for a specific date/
time range; if this option is turned off, you can only see Link data on the Real-time
Link Status window (these calculations are not saved).

Levels — You can set up to ten thresholds, or Levels of Service, each with its own
color. Centracs uses these colors on the Map Viewer to indicate the current Level of
Service of the Link. Level of Service is a numeric indicator of the efficiency with
which the roadway is serving traffic over time. Low levels indicate free-flowing
traffic or no traffic; high levels indicate traffic congestion. You can see the results of
the Level of Service calculations in multiple places in Centracs:

— the Links shown on the Map Viewer change to the appropriate color when traffic
reaches the configured Level of Service

— you can add triggers for the “Link Threshold” events to alert operators when a
Link reaches a specific Level of Service (refer to Using Triggers on page 4-25)

— for Level of Service Links, the Link Status window shows a graph of the current
Level of Service calculations as they occur (refer to Real-Time Link Status on
page 6-45)

— for Level of Service Links, the Links report shows a graph of the Level of Service
calculations for a specific time period in the past (refer to Level of Service Links
Report on page 10-28)

For example, with the sample settings shown above, a BlueTOAD Link on the Map
Viewer will be green as long as the speed is greater than or equal to 80% of the Max
Speed specified on the Entity Configuration window. (Percentage volume,
occupancy, and V+kO increase as traffic flow increases; percentage speed decreases
as traffic flow increases — this is why the sample speed values shown above start
high and get lower for each level, while the other values start low and get higher for
each level.)

— To change a color, click the color box and select a color (for details, refer to
Using the Color Selector Window on page 3-64).

— To delete a level, click the 6.
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— To add a level, click the &,

— To add a trigger to send an alert or do some other action when the threshold is
reached, click the & (for details, refer to Using Triggers on page 4-25).

Because some agencies use numbers to indicate the Level of Service for a Link (like
Centracs does) and others use letters, the Symbol column allows you to select the
characters to use in your system. In the example above, letters A through D are used
instead of numbers. You can enter letters, symbols, numbers, or a combination of
these. The characters you enter will appear on the Level of Service graph on the
Real-Time Link Status display (page 6-45). (The Level of Service Link report always
shows numbers.)

Note e For Level of Service Links, you must also configure the LinkLOSSource Global
Setting. This setting specifies whether to base the Level of Service calculations for the
Map Viewer on Volume, V+kO, Occupancy, or Speed data. The default is Volume. For
instructions, refer to Viewing and Editing Global and Local Settings on page 20-61.
(For BlueTOAD links, Level of Service calculations are always based on speed data.)

2 Make the necessary changes, then click OK. The changes are applied to all Links.

Note ¢ You may need to restart the Centracs services for your changes to take effect.

Examples for Level of Service Links

Example 1

3-62

IF the Computational Frequency is set to 300 seconds...
and

IF LinkLOSSource is set to Volume...

and

IF the link levels are configured as shown in the “Level of Service Links” sample screen
above...

and
IF the volume detected in 300 seconds divided by the Max Volume is 30%...

THEN the Link icon on the Map Viewer turns yellow.
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Example 2
IF the Computational Frequency is set to 300 seconds...

and
IF LinkLOSSource is set to Speed...
and

IF the link levels are configured as shown in the “Level of Service Links” sample screen
above...

and
If the average detected speed in 300 seconds divided by the Max Speed is 30%...
THEN the Link icon on the Map Viewer turns black.
Example 3
IF LinkLOSSource is set to V+kO...
and

IF the link levels are configured as shown in the “Level of Service Links” sample screen
above...

and
If the calculated V+kO divided by the Max V+kO is 50%...

THEN the Link icon on the Map Viewer turns red.
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Using the Color Selector Window

To specify a background or foreground color for User Text icons in the Map Editor
(page 5-18), or to specify Link Level colors (page 3-59), click [ to the right of the field to
open the Color Selector window.

E] Color Selector @ @
S oo p—
[H: 255 ]
G: 255

B: 255

Red/Green/Blue
— 2 values
[Cumr RGB: |
H—w 4 color code
Copy Hex:

| #FFFFFFFF |

brightness
gradient box
You can specify a color by any of these methods:

m Enter Red/Green/Blue values in the “Copy RGB” field.
m Enter a hexadecimal color code in the “Copy Hex” field.

B Move the color spectrum slider up or down to choose a color, then click in the
brightness gradient box (or drag and drop the selector circle).

The sample box near the bottom changes color to reflect your choice. When you are
satisfied with the color, click OK.
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Entity Configuration - CCTVs

To add a new CCTV entity:
1 Determine the parent (i.e., a System or a Group) for the new CCTV entity to be added.

2 Right-click the parent entity in the tree.

3 From the pop-up menu, select Add Entity » CCTV. The Entity Configuration window
opens.

(=] Entity Configuration B

Axis PTZ COS ME

Axis PTZ Camera

General

Note e Because the fields on the Entity Configuration window are configurable, your
screen may look different than the sample shown here. For details, refer to Using the
Type and Field Definitions Window on page 19-5.

4 Complete the fields as appropriate. The fields you see may be different depending on
the type of camera you select in the Source Type field. For details about each field,
refer to Field Descriptions on page 3-66.

5 Click OK.
The new CCTV is shown in the Entity Tree.
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D Entity Tree @ @ X

L AVLE

Search free. . @

¥ ¥ Colorado Springs
¥ d Woodmen ‘Woodmen Rd
*» [ Woodmen-East
» o Woodmen-West
» . Briargate Brargate Blvd
¥ . New Signals in Testing
4 MNAcademy @ N Union @
4 Woodmen @ IH25 W West frontage of I-25 O
¢ N Academy @ N Union - S\W camera
= COS Traflic Cams Colorado Springs Traffic Cam Website
gd 5125
24 S Powers Blvd

6 Toaddthe CCTVtothe map, fromthe main menu, select View » Map or View » Preset
Map and zoom in on the location for the CCTV.

Drag and drop the CCTV from the Entity Tree onto the appropriate position on the
map.

The Map Editor opens so that you can define and configure the map visuals for this
CCTV. For details about how to use the Map Editor, refer to Editing the Map View on
page 5-18.

Note ¢ You must install the redistributables for your camera type on the client machine
before you can see the video feed from the camera you added.

Field Descriptions

The fields you see may be different depending on the type of camera you select in the
Source Type field. All fields are defined below, in alphabetical order:

Field Name Description

Advanced CCTV If shown, click [ to the right of the Advanced CCTV field. The
Advanced CCTV Cameras window opens, and shows a list of all the
cameras that have been defined in the Genetec software. Select the
camera device to be associated with this entity.

Camera Res. Smaller format resolutions decrease the bandwidth that is
necessary, but lower video quality.

Jurisdiction Select the Jurisdiction to which the new CCTV will belong. For more
information, refer to Defining Jurisdictions on page 20-12.
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Field Name Description

Media Type From the dropdown list, select Motion JPEG or MPEG-4 video
compression. Motion JPEG uses higher bandwidth, but makes
higher quality images; MPEG-4 decreases the image quality, but a
lower bandwidth is sufficient. The CCTV source must be compatible
with the compression algorithm that you select.

Name/Identifier ~ Enter a unique name for the CCTV, and optionally, a description.
and Description You can enter any text or numbers for these fields, and you can
change them at any time.

Notes Optionally, to add notes for this entity, click [ to the right of the
Notes field. For more information, refer to Adding Notes to Entities
on page 3-14.

PTZ If the camera supports Pan/Tilt/Zoom capabilities, check this box to

enable the pan, tilt, and zoom functions and open the PTZ
parameter fields.

PTZ IP Enter the IP address used to send PTZ commands to the camera.

PTZ Mode From the dropdown list, select Scan or Snap for the movement
mode of the CCTV. The Scan function shows a continuous view as
the camera sweeps across the field of view; you can click and hold
the mouse button to scan the entire field of view. The Snap function
snaps to a specific location that you indicate with the mouse
pointer; you must make multiple successive mouse-clicks to scan
the entire field of view.

PTZ Port Enter the TCP/IP port used to send PTZ commands to the camera.

PTZ Speed Enter the speed at which the CCTV moves when PTZ commands are
sent. For the recommended speed value, refer to the user manual
for the camera.

PTZ Type From the dropdown list, select the type of PTZ communications to
use for PTZ commands to the camera.

Source Channel Multi-channel video encoders can send up to four video streams
over the same IP Address and TCP/IP port. Select one of the
available channels or set to Quad to bring back all four channels in
the same CCTV entity.

Source IP In the Source IP field, enter the IP address of the CCTV device.

Source Password Enter the password that is set in the CCTV device. This is necessary
in order to stream video from the device.

Source Port In the Source Port field, enter the TCP/IP port through which the
CCTV device sends video streams.
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Field Name Description

Source Type Expand the Source Type dropdown list and select the camera type.

Note e For Source Types of Generic or Autoscope Terra, the PTZ
(Pan/Tilt/Zoom) functions are not available.

Note e For Source Types of Axis, Generic, or Autoscope Terra,
CCTV presets and tours are not supported. To use the preset and
tour features with an Axis camera, set the Source Type to
Advanced CCTV.

Source Username Enter the username that is set in the CCTV device. This is necessary
in order to stream video from the device.

3-68 Centracs User Manual
Software Version 2.x - March 2018



Using the Entity Tree

Entity Configuration - URLs =

Entity Configuration - URLs

To add a new URL:
Refer to Adding Shortcuts to the Tools Menu on page 2-14.

Examples:

Motepad

Shortcut to Motepad application

Motepad.exe

C035 Trafiic Cams
Ceolorado Springs Traffic Cam Website

Urd

hitp: e springsgov.comdtrafiiceng

Note e Because the fields on the Entity Configuration window are configurable, your
screen may look different than the sample shown here. For details, refer to Using the Type
and Field Definitions Window on page 19-5.
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Entity Configuration - Aries

3-70

For convenience, you can configure the Aries executable to be launched directly from the
Entity Tree.

To configure this feature:

1

10

Determine the parent (i.e., a System, Section, Subsection, Group, or Signal) for the
new Aries entity to be added.

Right-click the parent entity in the Entity Tree.

From the pop-up menu, select Add Entity » Aries. The Entity Configuration window
opens.

E] Enfity Configuration @ @

Note e Because the fields on the Entity Configuration window are configurable, your
screen may look different than the sample shown here. For details, refer to Using the
Type and Field Definitions Window on page 19-5.

Enter a unique name for the Aries link, and optionally, a description. (You can enter
any text or numbers for the Name/Identifier and Description fields, and you can
change them at any time.)

Enter the IDs for the Zone and Intersection to access in Aries via this link.

Select the Jurisdiction to which the new entity will belong. For more information, refer
to Defining Jurisdictions on page 20-12.

Optionally, to add notes for this entity, click [ to the right of the Notes field. For more
information, refer to Adding Notes to Entities on page 3-14.

To save your entries, click Apply or OK. (Apply saves your changes and keeps the
window open; OK saves your changes and closes the window.)

The new Aries link is shown in the Entity Tree.

In the Global Settings, add the AriesExePath setting (from the “Centracs” component
list) and enter the path to the Aries executable file. (It is only necessary to do this one
time, even if you configure multiple Aries entities in the tree.) For instructions, refer
to Viewing and Editing Global and Local Settings on page 20-61.
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Setting Entity Coordinates

When you manually set the latitude and longitude coordinates for an entity, you can enter
the values in decimal degrees or in degrees, minutes, and seconds. For examples, refer to
the two sample screens below.

[ Coordinates =[S

38.220763
-107.524693

Coordinates entered in decimal degrees

[-] Coordinates [=11ES;

14,7642

45014

Coordinates entered in degrees, minutes, and seconds

If you enter the values in degrees, minutes, and seconds, the system changes the values
to decimal degrees when you click OK.

Note e For many entity types (such as Signals and CCTVs), it is not necessary to enter the
coordinates manually — rather, you can simply drag and drop the entity from the Entity
Tree onto the Map Viewer.

Note ¢ Toremove an entity’s coordinates from the database, remove all values from the
Coordinates window and click OK. Then on the Entity Configuration window, click Apply.
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Configuring Events, Alerts, and
Triggers

Centracs receives notification of various “events” from field devices and other points in
the system. You can choose which events will be logged, which events will generate alerts,
which events will trigger other actions, and which events will be ignored. For example, you
may choose for Centracs to write a log entry each time a signal changes patterns, but to
alert you if a signal goes into flash.

An alert is a notification to one or more users that an event has occurred and may require
their attention. If an event is configured to generate an alert, Centracs can show the alert
on the screen for one or more users who are logged in; Centracs can also send the alert
automatically to one or more offline recipients. Online users are notified by a pop-up
window accompanied by an optional audible alert; offline recipients are notified by email
or SMS (Short Message Service) text message. Each alert is categorized as Informational,
Warning, or Critical.

For cases in which the alert is not acknowledged or closed within a reasonable period of
time, you can configure the Alert Escalation feature of Centracs to automatically send the
alert to a different recipient or set of recipients. You can configure multiple levels of
escalation, such that an alert continues to escalate until someone acknowledges or closes
it.

Just as you can configure events to generate alerts, you can also configure them to trigger
one or more actions. For example, you can configure Centracs such that each time a signal
goes into flash, an alert is generated, a CCTV preset is activated, and a report is generated.
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Events

In Centracs you can specify which system events are important (and will therefore be
logged and/or trigger an alert), and which events to ignore. For example, a comm failure
is obviously important, but you may make the decision that some other events are trivial
enough to ignore.

Changing Event Settings

4-2

Changing System-wide Event Settings

To see or change the Event settings:
1 From the main menu, select Configuration » Alerts and Events.

2 Click the Events tab at the top of the window. The Alerts and Events window opens.

(® Alerts and Events

Search events

| Event Name I Enabled I Log
» Adaptive

» Alarm State

» BlueTOAD™

Comms to Device

Communication Bad - OFF

[]
[]

Communication Bad - ON

[<]
[<]

Communication Good - OFF

Communication Good - ON

[<]
[<]

Communication Marginal - OFF

[<]
[<]

-]
-]
] O O
-]
-]
-]

Communication Marginal - ON

[<]
[<]

» Coord/Cycle

» Detector Diagnostics

» Dynamic Message Sign
Emergency Route Preemption
Flash
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The events are divided into logical groups. To expand a group, click the ¥ symbol to
the left of the group name.

To sort the events within each grouping, click a column header (Event Name, Enabled,
or Log).

To quickly find specific events, use the “Search events” box near the top of the
window — as you type, the system filters out any events (from all groups) that do not
contain the characters you entered.

3 Check or uncheck the various Enabled and Log checkboxes. The setting combinations
below are valid:

Enabled Log | Meaning

The event can be configured to generate alerts, the event will be

L 4 L 4
logged, and the event will be included in the reports.

The event can be configured to generate alerts, but the event will
not be logged or included in reports unless it triggers an alert.

The event is ignored by Centracs.

4 Click 24 to close the window.

Note e To generate alerts, it is not sufficient to enable the event; you must also use the
Trigger Editor to configure alerts for the event. Refer to Using Triggers on page 4-25.

Changing Event Names

To rename an event:

1 From the Events tab of the Alerts and Events window, click [i] to the right of the event
to rename.

2 Type the new name over the old name.

Note e If, at a later time, it is necessary to go back to the original name, you can click
Default. If you have a version of Centracs that is not in English, be aware that the
Default option causes the event name to revert to its original English name.

3 Click Save.

The new name you assigned to the event will now be reflected everywhere that event
names are shown (such as in alerts and reports).
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Event Types

Selected Centracs events are identified below, in alphabetical order.

Event Name

Adaptive

Meaning

Adaptive Any Off Not used at this time.

Adaptive Any On Not used at this time.

Adaptive Cycle Not used at this time.

Changed

Adaptive Cycle Off Not used at this time.

Adaptive Cycle On Not used at this time.

Adaptive Offset The offset was adjusted on the controller by Centracs Adaptive.
Changed

Adaptive Offset Off Not used at this time.

Adaptive Offset On Not used at this time.

Adaptive Split nn
Changed

The split for phase nn was adjusted on the controller by Centracs Adaptive.

Adaptive Split Off

Not used at this time.

Adaptive Split On

Not used at this time.

Alarm State

Alarm State nn - ON

The specified alarm input is active on the controller, where nn is a number from
01 to 16.

For ACT controllers, Alarm 05 always corresponds to the Cabinet Door Open
alarm, and Alarm 06 corresponds to the Police Switch alarm; Alarms 01 through
04 can be customized.

For NEMA controllers, Alarms 01 through 10 can be customized.
Alarms 11 through 16 are not used at this time.

For details on how to assign meaningful names to the Alarm State events (for
example, to change “Alarm State 05 - ON” to “Cabinet Door Open Alarm - ON”),
refer to Changing Event Names on page 4-3.

Alarm State nn - OFF

The specified alarm input is no longer active on the controller, where nn is a
number from 01 to 16.
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Event Name

BlueTOAD™

Event Types =

Meaning

BlueTOAD Server
Connected

Centracs is communicating successfully with the BlueTOAD web server.

BlueTOAD Server
Disconnected

Communication Bad -
ON

Centracs is no longer communicating with the BlueTOAD web server, either
because the BlueTOAD feature in Centracs was disabled, the BlueTOAD web
server is down, or there is a comm problem.

The percentage of successful polls to a specific controller is lower than the value
set in the FilteredCommBad Global Setting. By default, this value is set to 75,
meaning that if less than 75% of the polls from Centracs to a controller are
successful, communications to that controller are considered to be “bad”. This
event occurs at the same time as the “Communication Marginal - OFF” event.

Communication Bad -
OFF

The percentage of successful polls to a specific controller is higher than the
value set in the FilteredCommBad Global Setting. By default, this value is set to
75, meaning that if more than 75% of the polls from Centracs to a controller are
successful, communications to that controller are no longer considered to be
“bad”. This event occurs at the same time as the “Communication Marginal -
ON” event.

Communication Good
-ON

The percentage of successful polls to a specific controller is higher than the
value set in the FilteredCommMarginal Global Setting. This event occurs at the
same time as the “Communication Marginal - OFF” event.

Communication Good
- OFF

The percentage of successful polls to a specific controller is lower than the value
set in the FilteredCommMarginal Global Setting. This event occurs at the same
time as the “Communication Marginal - ON” event.

Communication
Marginal - ON

The percentage of successful polls to a specific controller is lower than the value
setin the FilteredCommMarginal Global Setting and higher than the value set in
the FilteredCommBad Global Setting. By default, these values are set to
FilteredCommMarginal=95 and FilteredCommBad=75, meaning that if 75% to
95% of the polls from Centracs to a controller are successful, communications
tothat controller are considered to be “marginal”. This event occurs at the same
time as the “Communication Good - OFF” event or the “Communication Bad -
OFF” event.
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Event Name Meaning

Communication
Marginal - OFF

Coordination Failure -
ON

Coord/Cycle

The percentage of successful polls to a specific controller is higher than the
value set in the FilteredCommMarginal Global Setting or lower than the value
set in the FilteredCommBad Global Setting. By default, these values are set to
FilteredCommMarginal=95 and FilteredCommBad=75, meaning that if less than
75% or more than 95% of the polls from Centracs to a controller are successful,
communications to that controller are no longer considered to be “marginal”.
This event occurs at the same time as the “Communication Good - ON” event or
the “Communication Bad - ON” event.

A cycle fault has occurred again within two cycles after a coordination fault.

Coordination Failure -
OFF

The coordination failure alarm is no longer active.

Coordination Fault -
ON

The serviceable call was serviced within two cycles after the cycle fault
(coordination is retried at this point).

Coordination Fault -
OFF

The coordination fault alarm is no longer active.

Current Coordination
Pattern

This event occurs each time a signal changes patterns.

Cycle Failure - ON

The controller is not running in coordination, and there is a serviceable call that
has not been serviced for two cycles.

Cycle Failure - OFF

The cycle failure has been resolved.

Cycle Fault - ON

The controller is running in coordination, and there is a serviceable call that has
not been serviced for two cycles.

Cycle Fault - OFF

The cycle fault has been resolved.

Local Zero

The local coordination cycle timer on the controller has reached zero for a signal
running in coordination.

Transition - ON

The controller is changing to a coordinated pattern (for example, from Free to
coordinated pattern 1, or from coordinated pattern 1 to coordinated pattern 3).

Transition - OFF

The controller is no longer in transition to a coordinated pattern.

Detector Diagnostics (NTCIP controllers only)

Detector
Communication Fault
-ON

There is a communication problem between the controller and the detector
BIU.
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Event Name Meaning

Detector
Communication Fault
- OFF

The communication problem between the controller and the detector BIU has
been resolved.

Detector
Configuration Fault -
ON

(Eagle controllers only) The detector is enabled in the controller but there is no
detector BIU at that location in the cabinet.

Detector
Configuration Fault -
OFF

(Eagle controllers only) The detector is enabled in the controller but there is no
detector BIU at that location in the cabinet.

Detector Erratic
Output Fault - ON

The detector is not operating; the cause is unexpected/excessive counts.

Detector Erratic
Output Fault - OFF

The Erratic Output fault on the detector has been resolved.

Detector Excessive
Change Fault - ON

The detector is not operating; the cause is an inductance change that was larger
than the maximum expected inductance value.

Detector Excessive
Change Fault - OFF

The Excessive Change fault on the detector has been resolved.

Detector Max
Presence Fault - ON

The detector is not operating; the cause is a presence indicator that exceeded
the maximum expected length of time.

Detector Max
Presence Fault - OFF

The Max Presence fault on the detector has been resolved.

Detector No Activity
Fault - ON

The detector is not operating; the cause is lower-than-expected activity.

Detector No Activity
Fault - OFF

The No Activity fault on the detector has been resolved.

Detector Open Loop
Fault - ON

The detector is not operating; the cause is an open loop (broken wire).

Detector Open Loop
Fault - OFF

The Open Loop fault on the detector has been resolved.

Detector Other Fault -
ON

The detector is not operating; the cause is NOT max presence, no activity,
communication, configuration, shorted loop, watchdog, or erratic output.

Detector Other Fault -
OFF

The ‘Other’ fault on the detector has been resolved.

Detector Shorted
Loop Fault - ON

The detector is not operating; the cause is a shorted loop wire.
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Event Name Meaning

Detector Shorted The Shorted Loop fault on the detector has been resolved.
Loop Fault - OFF

Detector Watchdog The detector is not operating; the cause is a watchdog error.
Fault - ON

Detector Watchdog The Watchdog fault on the detector has been resolved.
Fault - OFF

Dynamic Message Sign

Attached Device Error | An error related to an external device (i.e., one that is connected to the DMS
-ON and enabled, such as a gate or external environmental sensor) is active on the
DMS.

Attached Device Error | The Attached Device Error is no longer active on the DMS.
- OFF

Beacon - ON Based on the message currently shown on the sign, Centracs has determined
that the beacons are flashing.

Beacon - OFF Based on the message currently shown on the sign, Centracs has determined
that the beacons are no longer flashing.

Blank Sign - ON The “blank” message (i.e., the message specified in the Blank Message Location
field on the Sign MULTI Configuration window) is active on the DMS.

Blank Sign - OFF The “blank” message is no longer active on the DMS.

Climate Control One or more of the climate control systems (for example, fans, heaters,
System Error - ON dehumidifiers, A/C) attached to the DMS is in a failed state.

Climate Control The Climate Control System Error is no longer active on the DMS.
System Error - OFF

Control Mode The source of control of the sign changed. The Control Modes are Local, Central,
Changed and Central Override. For more information, refer to Using the DMS Status
Display on page 9-7.

Controller Error - ON | An error related to the controller (for example, a RAM error or program/
processor error) is active on the DMS.

Controller Error - OFF | The Controller Error is no longer active on the DMS.

Critical Temperature | Atemperature sensor in the sign housing or the controller cabinet has reported
Error - ON that the temperature is higher than the ‘high critical temperature’ threshold or
lower than the ‘low critical temperature’ threshold configured on the sign.

Critical Temperature | The Critical Temperature Error is no longer active on the DMS.
Error - OFF
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Event Name Meaning

Door Open Warning -
ON

The specified door to a DMS field component (cabinet or housing) is open.

Door Open Warning -
OFF

The specified Open Door Warning is no longer active on the DMS.

Humidity Warning -
ON

A humidity sensor in the sign housing or the controller cabinet has reported that
the percent relative humidity is approaching the limits of the DMS equipment.

Humidity Warning -
OFF

The Humidity Warning is no longer active on the DMS.

Lamp Error - ON

According to a lamp test, one or more lamps (such as on a fiber optic sign or
front-illuminated reflective sign) is stuck on or stuck off. (This error does not
apply to lamps or fluorescent lights that illuminate the housing or cabinet.)

Lamp Error - OFF

The Lamp Error is no longer active on the DMS.

Light Sensor Error -
ON

One or more of the light sensors attached to the DMS is in a failed state.

Light Sensor Error -
OFF

The Light Sensor Error is no longer active on the DMS.

Message Activated

The message shown on the sign has been changed to a different message.

Message Error - ON

An error related to showing a new message is active on the DMS. Examples of
Message Errors are:

m the priority of the new message is less than the priority of the current
message

m the message memory type is not supported by the device
m the message ID is invalid or not defined in the device

m the MULTI syntax isinvalid

m the messageistoolong

m the message was submitted locally, but the sign is under control of the
central system

m the message was submitted from the central system, but the sign is under
local control

Message Error - OFF

The Message Error is no longer active on the DMS.

Pixel Error - ON

According to a pixel test, one or more pixels in the sign display has an
illumination error (i.e., is stuck on or stuck off) or has a color error.

Pixel Error - OFF

The Pixel Error is no longer active on the DMS.
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Event Name

Meaning

Power Error - ON

The DMS has reported an error related to a local power supply (e.g., battery,
generator, voltage regulator, solar equipment, etc.). A Power Error can mean
either that the power supply has failed, or that is it producing voltage or current
outside of the expected range.

Power Error - OFF

The Power Error is no longer active on the DMS.

Temperature A temperature sensor in the sign housing or the controller cabinet has reported

Warning - ON that the temperature is higher than the ‘high warning temperature’ threshold
or lower than the ‘low warning temperature’ threshold configured on the sign.
These thresholds are meant to alert you of temperature changes that are of
interest but that will not damage the device.

Temperature The Temperature Warning is no longer active on the DMS.

Warning - OFF

Emergency Route Preemption

Emergency Route
Preemption Activated

Centracs received a command from an external Emergency Route Preemption
system to activate an emergency route action set.

Emergency Route
Preemption
Deactivated

Centracs received a command from an external Emergency Route Preemption
system to deactivate an emergency route action set.

Emergency Route
Preemption Extended

Centracs received a command from an external Emergency Route Preemption
system to continue an emergency route action set past its pre-defined duration.

Route Preempt Check
Time Exceeded

Flash: ALL OFF

The number of seconds specified in the Check Time field in the emergency route
action set has elapsed, but the expected preempt or special function is not
active.

The signal is no longer in flash.

Flash: ANY ON

The signal is in a flashing condition. This event is accompanied by another more
detailed event that indicates why the signal is in flash.

Flash: Auto - ON

The signal is in “automatic” flash. This is a programmed flash mode set by the
local TOD schedule or by a command from Centracs.

Flash: Auto - OFF

The signal is no longer in “automatic” flash.

Flash: Internal Fault -
ON

The signal is in flash because the internal controller diagnostics have
determined that the controller is not in a safe operational state.

Flash: Internal Fault -
OFF

The signal is no longer in “internal fault” flash.
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Event Name Meaning

Flash: Local Manual - | The signal was manually put into flash mode using a switch at the cabinet

ON (usually in the police access panel).

Flash: Local Manual - | The signal is no longer in “local manual” flash.

OFF

Flash: MMU - ON The signal is in flash because of a problem reported by the MMU conflict
monitor (for example, a channel conflict, low voltage, SDLC fault, or other fault
detected by the monitor).

Flash: MMU - OFF The signal is no longer in “MMU” flash.

Flash: Other - ON The signal is in flash for a reason other than startup flash, automatic flash,
manual flash, MMU flash, preempt flash, or internal fault flash.

Flash: Other - OFF The signal is no longer in flash.

Flash: Preempt - ON | The signal is in flash in order to grant right-of-way to an emergency vehicle,
train, or a specific traffic movement.

Flash: Preempt - OFF | The signal is no longer in “preempt” flash.

Flash: Startup - ON The signal is in flash because the controller is starting up following an
interruption in power. The startup flash period is programmed on the
controller.

Flash: Startup - OFF The signal is no longer in “startup” flash.

Free: Bad Cycle Time - | The signal is in Free mode because the programmed cycle time is too short to
ON service all minimum phase requirements.

Free: Bad Cycle Time - | The signal is no longer in Free mode due to an inadequate programmed cycle
OFF time.

Free: Bad Plan - ON The signal is in Free mode because an invalid pattern was called.

Free: Bad Plan - OFF | The signal is no longer in Free mode due to an invalid pattern.

Free: Command - ON | A command from Centracs put the signal in Free mode.

Free: Command - OFF | The signal is no longer in Free mode due to a command from the central system.
Free: Coordination - | The signal is in Free mode because the current coordination pattern is not
ON programmed on the controller.

Free: Coordination - | The signal is no longer in Free mode due to the coordination pattern

OFF programming.

Free: Input - ON The signal is in Free mode because the Free input on the controller is active.
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Event Name

Meaning

Free: Input - OFF

The signal is no longer in Free mode due to the Free input on the controller.

Free: Invalid Offset -
ON

The signal is in Free mode because the programmed pattern offset time is
longer than the programmed pattern cycle time.

Free: Invalid Offset -
OFF

Link Threshold
Increased to Level nn
/ Link Threshold
Decreased to Level nn

MOE Uploads

Link Threshold Exceeded

The signal is no longer in Free mode due to an invalid offset.

The current Level of Service of the Link is in the range specified for Link Level nn
in the Link Settings, where nn is a number from 1 to 10.

Level of Service is a numeric indicator of the efficiency with which the roadway
is serving traffic over time. Low levels indicate free-flowing traffic or no traffic;
high levels indicate traffic congestion.

A Link Threshold event is triggered only if the Link crosses the threshold in the
specified direction. For example, the “Link Threshold Increased to Level 02"
event occurs only when a Link changes from Level 01 to Level 02; the “Link
Threshold Decreased to Level 02” event occurs only when a Link changes from
Level 03 to Level 02. This direction-based event triggering allows you to see
whether traffic is increasing or decreasing.

Note e For Level of Service links, the Link Threshold events are governed by
the “Computational Frequency” intervals on the Link Settings window; for
BlueTOAD links, these events are governed by the “Data Poll Interval” on the
BlueTOAD Settings window. If the Link Threshold events are occurring too
frequently (for example, if a link is bouncing back and forth between Level 1
and Level 2), change the interval to a longer period of time.

For more information, refer to Entity Configuration - Links on page 3-54.

MOE Upload Failed

Before you can run the MOE reports, data must be collected on the controllers,
then uploaded to Centracs. This event indicates that an upload was attempted
but was not successful. For more information, refer to Using the MOE Reports
on page 11-1.

MOE Upload Success

Before you can run the MOE reports, data must be collected on the controllers,
then uploaded to Centracs. This event indicates that an upload was attempted
and that it succeeded. For more information, refer to Using the MOE Reports

on page 11-1.
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Event Types =

Meaning

Collection Pattern
Monitor Error - ON

The Signal Collection Coordination Monitor has determined that a signal in the
collection (Section, Subsection, or Group) is not running the same pattern as the
other signals in the collection. This event occurs if the signal is still running a
different pattern when the “Time to Error” interval on the Signal Collection
Coordination Monitoring Settings expires.

Depending on how the Signal Collection Coordination Monitoring Settings are
configured, Centracs may attempt to correct the pattern being run. For more
information, refer to Signal Collection Coordination Monitoring on page 3-24.

Collection Pattern
Monitor Error - OFF

This event occurs after the “Collection Pattern Monitor Error - ON” event, and
indicates that the signal is now running the same pattern as the other signals in
the collection.

Collection Pattern
Monitor Recovered

This event occurs after the “Collection Pattern Monitor Warning” event and/or
the “Collection Pattern Monitor Error - ON” event, and indicates that the signal
is now running the same pattern as the other signals in the collection.

Collection Pattern
Monitor Warning

The Signal Collection Coordination Monitor has determined that a signal in the
collection (Section, Subsection, or Group) is not running the same pattern as the
other signals in the collection. This event occurs if the signal is still running a
different pattern when the “Time to Warning” interval on the Signal Collection
Coordination Monitoring Settings expires.

For more information, refer to Signal Collection Coordination Monitoring on
page 3-24.

Pattern Monitor
Compare Difference

Preempt - ALL OFF

During its normal coordination monitoring of all the signals in the system,
Centracs found that the pattern being run by a specific signal does not match
the expected pattern. This can occur, for example, if comms were lost and the
controller reverted to its timebase schedule — when comms are restored,
Centracs determines that the signal is running an unexpected pattern. When
this event occurs, Centracs automatically sends the correct pattern.

No preempts of any type (railroad, emergency vehicle, or other) are active.

Preempt - ANY ON

A preempt of any type (railroad, emergency vehicle, or other) and any number
has been activated.

Preempt Emergency
Vehicle - ALL OFF

No Emergency Vehicle preempts are active.

Preempt Emergency
Vehicle - ANY ON

One or more of the Emergency Vehicle preempts has been activated.

Centracs User Manual
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Event Name Meaning

Preempt Emergency
Vehicle nn - ON

The Emergency Vehicle nn preempt has been activated, where nn is a number
from 01 to 12.

Preempt Emergency
Vehicle nn - OFF

The Emergency Vehicle nn preempt is no longer active, where nn is a number
from 01 to 12.

Preempt Other nn -
ON

The Other nn preempt has been activated, where nn is a number from 01 to 10.

Preempt Other nn -
OFF

The Other nn preempt is no longer active, where nn is a number from 01 to 10.

Preempt Railroad -
ALL OFF

No Railroad preempts are active.

Preempt Railroad -
ANY ON

One or more of the Railroad preempts has been activated.

Preempt Railroad nn -
ON

The Railroad nn preempt has been activated, where nn is a number from 01 to
04.

Preempt Railroad nn -
OFF

The Railroad nn preempt is no longer active, where nn is a number from 01 to
04.

Stuck Preempt - ALL
OFF

There are no longer any stuck preempts.

Stuck Preempt - ANY
ON

A preempt has been active longer than the time permitted in the
‘StuckPreemptTimeout’ Global Setting.

Stuck Preempt
Emergency Vehicle -
ON

An Emergency Vehicle preempt has been active longer than the time permitted
in the ‘StuckPreemptTimeout’ Global Setting.

Stuck Preempt
Emergency Vehicle -
OFF

The stuck Emergency Vehicle preempt is no longer active.

Stuck Preempt Other - | An Other preempt has been active longer than the time permitted in the
ON ‘StuckPreemptTimeout’ Global Setting.

Stuck Preempt Other - | The stuck Other preempt is no longer active.

OFF

Stuck Preempt

A Railroad preempt has been active longer than the time permitted in the

Railroad - ON ‘StuckPreemptTimeout’ Global Setting.
Stuck Preempt The stuck Railroad preempt is no longer active.
Railroad - OFF
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Meaning

Special Function nn -
ON

The specified Special Function output on the controller is active, where nn is a
number from 01 to 08.

For details on how to assign meaningful names to the Special Function events,
refer to Changing Event Names on page 4-3.

Special Function nn -
OFF

Logged Status
Records Dropped

The specified Special Function output is no longer active on the controller,
where nn is a number from 01 to 08.

For troubleshooting Server-to-Server.

Low Database Storage | The quantity of free space left on the specified drive on the server machine is

- Logging Suspended | very low (i.e., below the threshold set in the LowDatabaseStorageStopLogging
Global Setting). Centracs does not add any more data to the logs until the
available free space is higher than the LowDatabaseStorageStoplLogging value
again. Centracs monitors the quantity of free space every 12 hours.

Low Database Storage | The quantity of free space left on the specified drive on the server machine is

Space low (i.e., below the threshold set in the LowDatabaseStorageWarning Global
Setting). Centracs monitors the quantity of free space every 12 hours.

New Traffic Algorithm | The Traffic Algorithm action is running (for example, via the scheduler or a

Pattern manual command), and the results of the calculations caused Centracs to send

a new pattern to the signal(s).

Threshold TR Fault

A problem occurred during calculation of a Traffic Responsive algorithm. This
can occur, for example, if the algorithm is not configured correctly, or if there is
not sufficient good detector data to make the calculations.

User Logged Off

The specified user logged out of the Centracs application.

User Logged On

The specified user logged in to the Centracs application.

Transit Signal Priority

Transit Signal Priority:
Active

A Transit Signal Priority call is being served (i.e., the controller is either serving
the priority phase or is reducing the preceding phase(s) in order to start the
priority phase sooner). When this event occurs, the Transit Signal Priority icon
on the map and status display (if configured) is shown in green.

Transit Signal Priority:
Call

A Transit Signal Priority call has been requested and is pending. When this event
occurs, the Transit Signal Priority icon on the map and status display (if
configured) is shown in blue.

Centracs User Manual
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Event Name Meaning

Transit Signal Priority:
Inhibit

A Transit Signal Priority call has been ignored. This can occur if a preempt or
special function is already in effect, or if the number of cycles since the last TSP
call is less than the minimum Reservice Cycles defined on the controller. When
this event occurs, the Transit Signal Priority icon on the map and status display
(if configured) is shown in red.

Transit Signal Priority:
Off

The Transit Signal Priority call completed or was stopped (for example, due to a
preempt). When this event occurs, the Transit Signal Priority icon is not shown
on the map or status display.

details.

Unit Control: Backup
Mode - ON

Note e For ASC/3 and Cobalt controllers, Centracs receives the Transit Signal Priority events from the
controller only if the “asc3KingCountyTSPStatus” object is included in the poll packet. Refer to
Configuring Polling Packets on page 20-50.

For ASC/2 controllers, refer to the “EnableASC2TSP” Global Setting in Centracs for configuration

Unit Control Mode

The controller is operating under local time-of-day/time-based control due to
the absence of commands from Centracs (for example, because Centracs is
offline).

Unit Control: Backup
Mode - OFF

The controller is no longer operating in Backup mode.

Unit Control:
Interconnect - ON

The controller is under the control of external (hardwire interconnect)
coordination inputs and outputs.

Unit Control:
Interconnect - OFF

The controller is no longer operating under Interconnect control.

Unit Control:
Interconnect Backup -
ON

The controller is operating under local TOD control due to a problem with
Interconnect control.

Unit Control:
Interconnect Backup -
OFF

The controller is no longer operating under Interconnect backup control.

Unit Control: Manual -
ON

The controller is operating under local manual control.

Unit Control: Manual -
OFF

The controller is no longer operating under local manual control.

Centracs User Manual
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Event Name Meaning

Unit Control: Other -
ON

The controller is operating in a mode other than Backup, Interconnect,
Interconnect Backup, Manual, System, System Standby, or Time Base (for
example, the “Other” mode may be reported while the controller starts up, or
while the System Pattern Override feature is in effect).

Unit Control: Other -
OFF

The controller is no longer operating in a mode other than Backup,
Interconnect, Interconnect Backup, Manual, System, System Standby, or Time
Base.

Unit Control: System -
ON

The controller is running a pattern or other command sent from Centracs.

Unit Control: System -
OFF

The controller is no longer running a pattern or other command sent from
Centracs.

Unit Control: System
Standby - ON

The controller has been commanded by Centracs to be under local control (i.e.,
Centracs sent a command to cancel any prior commands from Centracs).

Unit Control: System
Standby - OFF

The controller is no longer operating in Standby mode.

Unit Control: Time
Base - ON

The controller is operating under local time-of-day/time-based control.

Unit Control: Time
Base - OFF

24 VDC Failure - ON

Unit/Controller

The controller is no longer operating under local time-of-day/time-based
control.

An alarm has been activated on the MMU to indicate the loss of sufficient
voltage.

24 VDC Failure - OFF

The voltage alarm has been resolved.

Conflict - ON The conflict monitor (or MMU) has sensed that the green, walk, or yellow
indications are active at the same time on conflicting channels.
Conflict - OFF The Conflict fault has been reset.

Controller Comm to
Conflict Monitor Fail -
ON

There is a problem with communications between the controller and the MMU
(conflict monitor).

Controller Comm to
Conflict Monitor Fail -
OFF

The communications problem between the controller and the MMU (conflict
monitor) has been resolved.

Controller Database
Changed

A user downloaded changes from the signal editor to the controller.
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Event Name Meaning

Detector Fault - ON

This generic event indicates that a detector fault has occurred. If enabled, the
other detector fault events (such as “Detector Max Presence Fault - ON”) show
the type of fault that occurred.

Detector Fault - OFF

A detector fault has been resolved. If enabled, the other detector fault events
(such as “Detector Max Presence Fault - OFF”) show the type of fault that was
resolved.

Local Override - ON

The Local Override alarm on the controller has been activated — i.e., the
program on the controller or an external input will not permit the controller to
accept a pattern command from the system.

Local Override - OFF

The Local Override alarm on the controller has been resolved.

Low Battery - ON

The Low Battery alarm on the controller has been activated.

Low Battery - OFF

The Low Battery alarm on the controller has been resolved.

Main Street Green -
ON

The main street phases for the intersection are green.

Main Street Green -
OFF

The main street phases for the intersection are no longer green.

Power Restart

Power has been restored to the controller after an interruption in power.

Response Fault - ON

The Response Fault alarm on the controller has been activated to indicate a
response frame fault.

Response Fault - OFF

The Response Fault alarm on the controller has been resolved.

Side Street Green -
ON

The side street phases for the intersection are green.

Side Street Green -
OFF

The side street phases for the intersection are no longer green.

Signal Database
Compare Difference

Indicates that the “Signal Upload and Compare” action ran for the specified
signal. The event details provide a list of parameter segments in which Centracs
found differences between the settings on the controller and the settings
stored in the Centracs database. You can also view these results in the Signal
Upload and Compare report (refer to page 10-44).

Stop Time - ON

The Stop Time input on the controller has been activated to indicate that the
controller timing has been stopped to diagnose a fault.
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Event Name Meaning

Stop Time - OFF The Stop Time input on the controller is no longer active.

Time Drift Value The Time Drift Check action reported that the current time on the controller

Exceeded differed from the current time on the Centracs server by more than the
“Maximum drift” value used when running the Time Drift Check.
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Alerts

Centracs can generate three types of alerts, shown here in the order of severity:
m Critical

m  Warning

m Informational

You can configure alerts to pop up on the screen for one or more online users; you can
also configure Centracs to send them to offline personnel via email or SMS text message.

Pop-up Alerts

Depending on how your system is configured, you may see a “toast” pop-up at the bottom
of the screen when an alert is triggered. Shown below are examples of the three types of
toast pop-ups:

[ Mert
Information alert
Name: Enfrance Inbound Pending

Description: Entrance is in transition to Inbound
Device: Entrance |-45S @ Dixie Farm Rd
Detail: Unit Control Mode: Remote

A Alert

Warning alert

MName: Enfrance Pend. Cmd. Not Progressing
Description: Entrance is not respending to the last
command executed

Device: Entrance 1-458 @ Dixie Farm Rd

Detail: Unit Control Mode: Remate

Informational = blue
Warning = yellow
Critical = red

Only one alert pop-up is shown on the screen at any one time. Therefore, if multiple alerts
occur at the same time, you may not see a pop-up for each one. To see all alerts, open the
Alert List (refer to Using the Alert List on page 4-22).

Note e When you click the alert pop-up, this does not acknowledge or close the alert.
Refer to Acknowledging and Closing Alerts on page 4-32.

Offline Alerts

4-20

If configured to do so, Centracs will send alerts to specified personnel via email and/or
SMS text message. These offline alert recipients can reply back to Centracs to
acknowledge, close, or unacknowledge an alert.
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If an alert is updated with a new Ack State (i.e., if it has been acknowledged, closed, or
unacknowledged), a follow-up alert is sent to the original offline recipients to notify them
of the alert’s new status. For example, if an alert is sent via email to an offline recipient,
then acknowledged, and then closed, that recipient will receive a total of three emails for
that alert.

Note e Before Centracs can send offline alerts, your system administrator must configure
this capability.

Alert Status Bar

You can easily determine the number of alerts at any given time with a glance at the alert
status bar in the upper-right corner of the Centracs main window:

C]

File View Monitoring Control Configuration Management Reports Window Help D [ |

The circled indicators above represent the number of current alerts — in this case, six. The
alerts are categorized into three types:

The number in each circle shows the count of current alerts for that type. If there are no
alerts of a specific type, no number is shown in the corresponding circle, and the circle is
dark.

When there are unacknowledged alerts, the Warning and Critical indicators blink to call
your attention. When all of the alerts of a specific type have been acknowledged, that
indicator stops blinking. Informational alerts are considered to be acknowledged on
receipt, so the Informational indicator does not blink. To manually stop an indicator from
blinking, right-click it.

To see details about the alerts, left-click one of the three indicators in the alert status bar
to open the Alert List for that alert type. Or to see all alerts of all types, select
Monitoring » Alerts... from the main menu. For instructions on how to use the Alert List,
refer to page 4-22.
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Using the Alert List

You can use the Alert List to monitor, acknowledge, and close alerts.

To open the Alert List:
P To see all alerts of all types, select Monitoring » Alerts... from the main menu.
Or

» To see only Informational, Critical, or Warning alerts, click the corresponding circle in
the alert status bar in the upper-right corner of the Centracs main window:

Informational Warning Critical
alerts alerts alerts

The Alert List window opens.

[=] Avert List =

Crticality Trigger Device Acknowledge State Created
|E| New

Signal Woodmen (@ Interstate 25 (West) Comms Bad - ON New w H 1/4/2011 9:35 AM

& Threshold TR Fault New “ H 1/5/2011 12:20 FM
Thrashold TR Fault  Ack'd M W 12/28/2010 11:40 AM

Signal Woodmen @ Interstate 25 (Wesi) Comms Bad - OFF 1/B8/2011 3:24 PM

Signal Woodmen @ Rockrimmon Preempt EV 1 OM 1742011 10:33 AM

Signal Woodmen @ N Union Detector Fault OFF 142011 10:31 AM

Signal Woodmen @ N Union Detector Fault 12/28/2010 1:08 PM

New, unacknowledged alerts are shown in the top section of the window; acknowledged
alerts and Informational alerts are shown in the bottom part of the window.

Within each section of the window, you can click a column header to sort the alerts by that
column.
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To see the current age of an alert, hold your mouse over the Created field for that alert.
For example:

-F 4!’4:21]11{&19 Frd

-F' 442011 tem s 3 hrs 11 mins oid. |
[KiGiose] 4412011 2:17 P
| —

The icon in the Trigger column shows the type of trigger that generated the alert:

V' = an “Occurs once” trigger
7 = an “Occurs ___timesin __ minutes” trigger

() = an “Active for ___minutes” trigger

Note ¢ The Alert List you see does not necessarily reflect all existing alerts — you only see
the alerts for which you are a designated online recipient.

To see more details about an alert:

» Double-click an entry in the Alert List. The Alert Details window opens.

[=] Alert Detail =] 14

ka2

=

Information

Detector Fault

Acknowledged

‘J Single Instance

Signal Weoodmen @ M Union

Detecter Fault - OMN

1202972010 1:09:44 PM

Single instance of event, no duration.

To open the Entity Status display, you can click & to the right of the Device field. Refer to
Using the Signal Status Display on page 6-1.
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To remove the alert from the Alert List, click X Close Alert.

Note e The “CoreAlertCap” Global Setting controls the maximum number of alerts for a

given event type that can be in the Alert List at one time for a particular entity (the default
is 20). After the maximum is reached, Centracs closes any new occurrences of the alert. To
see these alerts that Centracs closed automatically, run the Alerts Log (refer to page 10-18).
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Using Triggers

Centracs generates alerts only if one or more alert “triggers” have been added. A trigger
specifies which events will trigger alerts. In addition to alerts, triggers can also launch
other actions, such as CCTV Preset, Generate Report, or Set Pattern.

Note e Inorder for an event type to trigger an alert or action, you must enable that event
type in the Alerts and Events window. Refer to Events on page 4-2.

When you add a trigger, you can select from three event trigger types, three severity
levels, and three notification mechanisms:

Event Trigger Types Severity Levels Notification Methods
Occurs once Information Online

Occurs __timesin __ minutes Warning Email

Active for __ minutes Critical SMS (text messaging)

Note e The capability to send email & SMS alerts must first be configured by your system
administrator.

To add a new trigger:
1 From the main menu, select Configuration P Alerts and Events... The Alerts and
Events window opens, along with any triggers that have already been added.

J Triggers [ Alert Escalations " Events ]

D Aleriz and Events @ E

[ aga J[_edt J[ pecte ]

Enabled Name Event Action Descripfion
v CRITICAL: Comm Problem Communication Bad - ON Alert | Any entity; all online users, all offline supervisors e
o CRITICAL: Temp. Error on Sign Critical Temperature Error - ON |Alert | Any DM5; all online users, two offline users I
< IMFQ: Comm Problem Resohved Communication Good - ON Alert | Any entity; all online users =t
< MFC: Message Activated on Sign Message Activated Alert | Any DMS; all enline users I
o WARNING: Door Open on Sign Door Open Waming - ON Alert | Any DMS; all online users (7]
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2 Click Add. The Trigger Editor window opens.

Below Trigger Properties, enter a name and description for the new trigger.

For this trigger to be active immediately, check the Enable checkbox; for the trigger to
be disabled temporarily, uncheck the Enable checkbox.

Below Triggering Event, open the dropdown list and find the type of event that will
cause this trigger to run. For a description of each event type, refer to Events on
page 4-2.

If this trigger must run only for specific entities, click & to the right of the Entity Filter
box and select one or more entities in the Entity Selection list, then click OK. If this
trigger will run for all entities, leave the Entity Filter box empty. For instructions on
how to select entities, refer to Using the Entity Selection Window on page 3-18. (If the
trigger is for an event type that does not involve entities, such as the “Low Database
Storage Space” event, the Entity Filter box is not shown.)
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7 Below Event Trigger Type, specify how frequently the event must occur before the

trigger will run:

® Occurs once — If the specified event occurs one time for the specified entity/

entities, the trigger will run. For example, you can set up a trigger to run any time a
signal goes into flash.

Occurs __ times in __minutes — If the specified event occurs the specified number
of times in the specified number of minutes, the trigger will run. For example, you
can set up a trigger to run if communications to a controller are “bad” more than
one time in 30 minutes.

Active for __ minutes — If the specified event occurs but does not resolve within the

specified number of minutes, the trigger will run. For example, you can set up a

trigger to run if communications to a controller are in the “margina

|"

state for more

than 5 minutes.

8 From the Type dropdown in the Action box, specify what will occur when this trigger
runs. For example:

Action Steps

To trigger an
alert

1 Expand the “Alerts” list of actions from the Type dropdown and
select Alert (if it is not already selected).

2 Specify the severity of the alert (Information, Warning, or
Critical).

3 Click [ to the right of the Recipients field to specify the people
who will receive the alert (the default is all online users). For
details, refer to Selecting Recipients on page 4-43.

To trigger an
alert escalation

Expand the “Alerts” list of actions from the Type dropdown and
select one of the alert escalations that have been added to your
system. (If no escalations have been set, no escalations are shown
in this list.)

When you select an escalation, the details of that escalation are
shown.

For more information, refer to Escalating Alerts and Tickets on
page 4-34.
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To trigger a
CCTV preset

1 Expand the “Common” list of actions from the Type dropdown

Note e For more details about how to set CCTYV presets, refer
to Defining and Maintaining Presets on page 8-6.

and select CCTV Preset.

Click [ to the right of the Selected Users field to specify the users
to whom the preset will be shown. On the User Selection
window, to select multiple users at a time, hold the Ctrl or Shift
key while you select them; to select all users, press Ctrl-A. After
you have made your selections, click [z to move them to the
“Selected” side of the window, and click OK. To see an example,
refer to page 7-26.

Click [ to the right of the Selected Preset field to specify the
camera preset. The CCTV Preset Selection window shows all the
cameras that are defined in the Genetec server. Expand the list
for the appropriate camera, select one of the presets, and click
OK. To see an example, refer to page 8-12.

To trigger
other actions

1 Expand the “Common”, “DMS”, or “Action Sets” list of actions

2 For details about each action type, refer to Action Types in

from the Type dropdown and select an action.

Appendix A.

Centracs User Manual
Software Version 2.x - March 2018



Configuring Events, Alerts, and Triggers

Using Triggers =

For example:

WARNING - Pessible Comm Problem Fl
Any entity, == 2 minutes; all onling users, two offline users

Communication Marginal - ON -
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These fields are:

Include the entity | If you selected one or more entities in the Entity Filter field
that caused the above, you can select this option to use the same entities
event... for the Action. For example:

m ifthe Triggering Eventisa “Preempt- ALL OFF” event for
Subsection 101, and

m if the Action is “Set Pattern”, and

m if the “Include the entity that caused the event...”
optionis enabled

then when a preempt ends for any signal in Subsection
101, Centracs automatically sends a Set Pattern command
to all the signals in Section 101.

Priority Specify whether the Action will run in the scheduler (with
“Normal” priority) or run as a manual command. This
determines the priority of the Action. For more
information, refer to Action Priorities on page 20-4. If you
do not want the triggered Action to override a manual
command that is already running, set the Priority to
“Scheduled”. If you want the triggered Action to override
all other commands that are already running, set the
Priority to “Manual Command”.

Timing Specify when the Action will end:

m Don’t stop —the action will run indefinitely, until it is
deleted manually.

m Stopin...—specify the duration of the command in
minutes or hours.

10 To save the trigger, click OK.
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The new trigger is shown in the Triggers tab of the Alerts and Events window.

[] Alerts and Evenis

BX

| Triggers | Alert Escalations || Events |

[ add ][ Edit |[ Deete |

Enabled MName Event Acfion Description
< CRITICAL: Comm Problem Cemmunication Bad - ON Alert | Any entity; all online users, all offline supervisors e
e CRITICAL: Temp. Error on Sign Critical Temperature Error - ON |Alert | Any DMS; all online users, two offline users
< INFQ: Camm Problem Reschved Communication Good - ON Alert | Any entity; all online users
< IMFC: Message Activated on Sign Message Activated Alert [Any DMS; all enline users i
e WARNING: Door Open on Sign Doer Open Warming - ON Alert | Any DMS; all enline users I
< WARNING: Possible Comm Problem | Communication Marginal - ON |Alert | Any entity, == 2 minutes; all online users, two offline | &

|

Centracs User Manual

Optionally, you can set up more triggers for the same event. If there are multiple
triggers for an event, all triggers will run at the same time. For example, if you set up
one trigger to send an alert, one trigger to launch a CCTV preset, and one trigger to
generate a report, all three of these actions will be started immediately when the
triggering event occurs.

Note e If you are having trouble with offline alerts or offline alert acknowledgements,
refer to Troubleshooting Offline Alerts on page 20-82.

To change a trigger:
1 From the main menu, select Configuration P Alerts and Events... The Alerts and
Events window opens, along with any triggers that have already been added.

2 Click the alert to change and click Edit. The Trigger Editor window opens.
3 Make the necessary changes, then click OK.
To delete a trigger:

1 From the main menu, select Configuration P Alerts and Events... The Alerts and
Events window opens, along with any triggers that have already been added.

2 Click the alert to remove and click Delete.

3 If a confirmation window opens, click Yes. The trigger is removed from the database.

To disable or enable a trigger:
1 From the main menu, select Configuration » Alerts and Events... The Alerts and
Events window opens, along with any triggers that have already been added.

2 Inthe Enabled column, click the checkbox for the appropriate trigger to toggle the
setting:

® checked = the trigger is active and will run when the triggering event occurs
® unchecked = the trigger is disabled and will not run when the triggering event

occurs
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Acknowledging and Closing Alerts

4-32

An online user or an offline recipient must acknowledge Warning alerts and Critical alerts.
This lets other personnel know that someone is aware of the alert and is presumably
taking action (if necessary). If your system is configured to do so, unacknowledged alerts
are automatically escalated to another recipient or set of recipients. Closing an alert lets
other personnel know that the issue has been resolved.

Note e Informational alerts do notrequire acknowledgement — they are considered to be
acknowledged on receipt. The only exception is if an alert escalation is configured for an
Informational alert; in this case, acknowledgement is required in order to stop the
escalation.

You can acknowledge, close, or unacknowledge alerts:

m  When you acknowledge an alert, it moves from the top section of the Alert List to the
bottom section, and escalation stops (if an escalation is defined for the alert).

m  When you close an alert, Centracs removes it from the Alert List for all offline users,
and escalation stops (if an escalation is defined for the alert). Closed alerts are still
included in the Alerts Log report. After an alert is closed, you cannot re-open it.

m  When you unacknowledge an alert, it moves from the bottom section of the Alert List
to the top section, and escalation continues (if an escalation is defined for the alert).
To continue an escalation, you can unacknowledge any of the alerts in the escalation.

It is only necessary for one person to acknowledge/close an alert. This can be an online
user or an offline recipient.

To acknowledge, close, or unacknowledge one or more online alerts:

Note e It does NOT acknowledge or close the alert when you click the online alert “toast”
pop-up.

1 Openthe Alert List (refer to page 4-22).

(=] aert List (=]
I‘mkSelactﬂ! I‘AnkM xdnseSelentad ;Clnsehlew ﬁcameAnhed ﬁcmm
Criticality Trigger Device MName Acknowledge State Created
B |
0 Signal Woodmen (@ Interstate 25 (West) Comms Bad-ON  New @ 1/4/2011 9:35 AM
A Threshold TR Fault New @ 1/5/2011 12:20 PM
||:| Acknowledged |
A Threshold TR Fault  Ack'd [ O Unack | [ 3¢ Close | 12/23/2010 11:40 AM
[i] Signal Woodmen @ Interstate 25 (West)  Comms Bad - OFF 106/2011 8:24 PM
H Signal Woodmen @ Rockrimmon Preempt EV 1 OM 1/4/2011 10:33 AM
[i] Signal Woodmen @ N Union Detector Fault OFF 1/4/2011 10:31 &AM
1] Signal Woodmen @ N Union Detector Fault % Close 12/29/2010 1:09 PM
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2 Acknowledge, close, or unacknowledge alerts in any of these ways:

® Double-click an alert to see its details, then click Acknowledge, Close Alert, or
UnAck, as appropriate. (Only the options that are valid for the chosen alert are
shown; for example, for an alert that has already been acknowledged, UnAck is
shown but Acknowledge is not.)

® To the right of an alert, click Ack, Close, or UnAck.
® Right-click an alert and select an option from the pop-up menu.

® To select multiple alerts, hold the Ctrl or Shift key as you click the alerts, then click
Ack Selected or Close Selected to acknowledge or close all of the selected alerts.

® Click Close New to close all alerts in the “New” section of the window without
acknowledgement.

® Click Close Acked to close all alerts in the “Acknowledged” section of the window.

® Click Ack All or Close All to acknowledge or close all alerts in the list, regardless of
their status.

To acknowledge, close, or unacknowledge an offline alert:

Reply to the original email or SMS alert with a command of “ack”, “close”, or “unack”.
(These are not case-sensitive.) You must also include the alert ID in order for Centracs to
apply the command to the correct alert. You can find the alert ID at the bottom of the
original alert message. If your email/SMS is configured to include the text from the
original alert, you only need to add the “ack”, “close”, or “unack” command at the
beginning of your reply. If your email/SMS is not configured to include the text from the
original alert, you must add the alert ID to your reply. For example:

close 112

Note e If Centracs finds more than one valid command in your reply, it uses the first and
ignores any others.

When an offline alert is acknowledged, closed, or unacknowledged, a follow-up alert is
sent to the original offline recipients to notify them of the new alert status. For example,
if an alert is sent via email to an offline recipient, and then acknowledged, and then
closed, that recipient will receive a total of three emails for that alert.

Note e If you are having trouble with offline alerts or offline alert acknowledgements,
refer to Troubleshooting Offline Alerts on page 20-82.
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Escalating Alerts and Tickets

For cases in which an alert or ticket alert is not acknowledged or closed within a
reasonable period of time, you can configure Centracs to automatically send it to a
different recipient or set of recipients. You can set up multiple levels of escalation, such
that an alert continues to escalate until someone acknowledges or closes it.

Each time an alert is escalated to a new level, a new alert is added to the system. For
example, say you define an alert escalation where the first level is a Warning alert to all
online users and the second level is a Critical alert to multiple offline users. If the original
Warning is not acknowledged or closed within the specified amount of time, another alert
is added to the system with a criticality of Critical.

Escalation stops when someone acknowledges or closes the alert at any of its escalation
levels. In our example, even if the alert has already escalated to the second level (Critical),
someone can acknowledge the Warning alert at the first level and the escalation stops. In
this case, Centracs changes both alerts to “Acknowledged”. To continue an escalation, you
can unacknowledge any of the alerts in the escalation.

Note e Although Centracs does not require Informational alerts to be acknowledged, you
can add an alert escalation that requires an Informational alert to be acknowledged or
closed in order to stop the escalation.

To add a new alert escalation:
1 From the main menu, select Configuration » Alerts and Events... The Alerts and
Events window opens.

2 Click the Alert Escalations tab.

Any escalations that have already been defined are shown in table format.

D Alerts and Events @ @

Alert Escalations

(aga J(_eat J( copy ][ Detete ]

Mame Description
Comms Marginal |E:ca ate after 5 minutes |
3 Click Add.
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The Alert Escalation Editor opens.

[=] Alert Escalation Editar =[S

4 Enter a name, and optionally, a description, for the alert escalation.

5 Ifthis escalation will be used for MMS ticket alerts, turn on the “MMS Default” option.
Otherwise, leave this option turned off. For more information about ticket alerts, refer
to Alerts for MMS Tickets on page 4-41.

6 Click Add.

A set of escalation detail fields is shown.

[=] Alert Escalation Editar =[S

Escalate after 1 minute | [ |

All Online Users

7 Select the criticality level for the first alert (Informational, Warning, or Critical). For
example, you can first send a Warning alert to all online users; if the Warning is not
acknowledged, you can then send a Critical alert to more personnel.

8 Enter a name, and optionally, a description for the first alert. These will be shown in
the details of the actual alerts that are generated, as well as the Alerts Log report
(page 10-18).
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9 Click E. The Recipient Selection window opens.

[] Recipient Selection =]

ﬁ Tech Group 1
e Tech Group 2

a .&, Administrater

a Technician
&, Bil Lumbergh
& Forrest Lawrenceton

8, ceorge Michael Bluth 1)

10 Select the recipient(s) of the first alert. For instructions on how to use the Recipient
Selection window, refer to Selecting Recipients on page 4-43.

11 To save your selections, click OK.

[=] Alert Escalation Editor =11

Escalate after 1 minute | ||

=
cety

Alert Name:  Communications Problem - WARNING

Descriplion:  ack within one minute to avoid escalafion

Recipients: ) Online Users

12 Now that theinitial alert has been defined, click Add again to add another level to your
escalation. Each alert escalation must have at least two levels.

13 Asinthe previous steps, specify the criticality level, name, description, and recipient(s)
for this level of the escalation.
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[-] Alert Escalation Editor

Escalate after 1 minute

=
ctty

Alert Name:  Communications Problem - WARNING

Descrption:

Recipients: a1 Online Users

Ack within ong minute to aveid escalaticn

e
=

ctt

Alert Name:  ¢ommunications Problem - STAGE 2

BEX

Deseription:  vamning alert was not ack'd by online users

Recipients:
=0 lF‘hineasT. PnnelElSue Sylvester [
All Online Users

in one minute

The green arrow shown between the escalation levels specifies the interval of time (in
HH:MM format) that Centracs will wait for acknowledgement of the alert before it

triggers the next escalation level. For example,

if set to 00:05 (the default), the online

users have five minutes to acknowledge the Warning alert. If five minutes pass
without an acknowledgement, a Critical alert will automatically be sent to the

specified recipients.

14 To change the time interval between these two alert levels, click the green arrow. The
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4-38

Dﬂ: - Ack within one minute to avoid escalafion

A1l Online Users

€3 Critical - [|[=] Escalation Configuration

VWarning alert was

15 Enter the time in HH:MM format, where HH is hours and MM is minutes, then click OK.

16 Repeat the previous steps to add as many escalation levels as necessary.
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If it is necessary to rearrange the levels, you can use the up and down arrows, circled
in red below:

(] Alert Escalation Editor \SS_ =[S
ERenig afer 1 minute |

=
ot

Alert Name:  communications Problem - WARNJNG

Deseription: ek within one minute to avoid escalj
Recipients:  a)| Online Users

Lo - N
& alu
=

Alert Name:  communications Problem - STAGE 2

Deseriplion:  \warning alert was not ack'd by online users within one minute

ipients:
Recipien 'FhinaasT. Prune [ | [<|Sue Sylvester [ i
All Online Users

17 Click OK.

The new alert escalation can now be specified by name in an alert trigger. For more
information, refer to Using Triggers on page 4-25.

If it is necessary to add more alert escalations that are similar to the first, you can use
the existing Escalation as a template. For details, refer to the next section on how to
copy alert escalations.

Note e If you are having trouble with offline alerts or offline alert acknowledgements,
refer to Troubleshooting Offline Alerts on page 20-82.
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To add a new alert escalation from a copy:
1 From the main menu, select Configuration » Alerts and Events... The Alerts and
Events window opens.

2 Click the Alert Escalations tab.

[=] Aleris and Events [=]]ES;

Hame Description

Comms Marginal Escalate after 3 minutes
Comms Bad Escalate after 1 minute

3 Click the Escalation to copy, then click Copy. The Alert Escalation Editor opens.

Escalate after 1 minute [ [ |

BEX

Communications Problem - WARNING
Ack within one minute to avoid escalafion

All Online Users

4 Make the appropriate changes to the name, description, and escalation levels, then
click OK.
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Alerts for MMS Tickets

In Centracs MMS, you can configure the system so that when a ticket is created or
reassigned, the assigned person automatically receives notification via email or SMS text
message.

To configure MMS ticket alerts:

1 Add a new alert escalation (for details, refer to page 4-34).

2 Onthe Alert Escalation Editor window, turn on the “MMS Default” option.

3 Inthefirst level of the escalation, for the Recipients field, select “Assigned User” from
the Available Recipients list. Use the Available Message Types dropdown to specify
whether to send an email or SMS text message (or both) to the assigned user.

4 Complete the other fields as appropriate (for details, refer to page 4-34). For the
Criticality field, select either Warning or Critical. PR 26567

5 Inthe second level (and subsequent levels) of the escalation, specify the users to be
notified if the assigned user does not acknowledge the ticket. Refer to the sample
escalation on page 4-42.

6 On the Recipient window, make sure each potential ticket recipient has an email
address and/or SMS address defined. For details, refer to Defining Recipients on
page 20-73.

7 Inthe On-Call Scheduler, make sure each potential ticket recipient is set to be “on call”
at the appropriate days and times. A recipient will not receive an alert (or an alert
escalation) if they are not on call, even if the ticket is assigned to them. For details,
refer to Using the On-Call Scheduler on page 19-27.

Tips

m Totroubleshoot ticket alerts, refer to Setting Up Email/SMS Capability on page 20-66
to make sure the system has been configured properly.

m If the “toast” settings are turned on, all online users see a toast popup when a ticket
is added, when a ticket is reassigned, or when the Location field is changed on a ticket.
For information on the toast settings, refer to page 20-54.

m Forthe Recipients field, none of the escalation levels should have “All Online Users” as
the only recipient.

m Itis not necessary for a user to be in a User Group in order to receive alerts for tickets
assigned to them.

m  When a recipient receives a ticket alert, replying with “CLOSE” closes the ticket, and
replying with “ACK” changes the ticket to “Accepted” status. For more details, refer to
Acknowledging and Closing Alerts on page 4-32.

m [f a ticket alert cannot be sent due to a configuration problem, a “Ticket Alert
Escalation Failed” entry is added to the System Activity report (page 10-50).
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4-42

Sample Alert Escalation for MMS Tickets

The following sample setup for MMS ticket alerts (below left) assumes that you configured

the Entity Configuration window for your MMS Locations to use the Technician, Backup
Tech, and Supervisor shared fields, as shown in this sample window (below right):

® Action Editor

Name: | MMS TicketE; D tion: | escalale after 10 mins | v M|

Add

Actions Lol o
— Ticket Assigned to You - Please ACK AV X o U2 ETITE

Criticality: A Waming -

Alert Name: | Ticyet Assigned to You - Please
Descriplion: | s cxnowledge ticket in 10 minutes to avoid escalation to Technician

Recipients: | aj online Users asigned User X

A
%Y Assigned User x ~

— Ticket Not Acked By Assigned User A Y X

Criticality: A Waming -

Alert Name: | Ticket Not Acked By Assigned User Superviso %, George Warlegga a1
Descriplion: | s cxnowledge ticket in 10 minutes to avoid escalation to Backup Tech Close

Recipient: A i S8
All Online Users gwgTochnician x 8%, Technician x

— Ticket Not Acked By Technician A Y X

Criticality: A Waming -

Alert Name: | Ticket Not Acked By Technician
Descriplion: | s cxnowledge ticket in 10 minutes to avoid escalation to Supervisor

Recipients: | aj online Users BS Backup Tech x A
' 0
5§ Backup Tech x =

— Ticket Not Acked By Backup Tech A Y X

Criticality: A Waming -

Alert Name: | Ticket Not Acked By Backup Tech
Description:

Final level of escalation

Recipients: | aj online Users

| Supervisor x B8 Supervisor x

Cancel

Note e Forinformation on how to add the Technician/Backup Tech/Supervisor shared
fields to the Entity Configuration window, refer to Using the Type and Field Definitions
Window on page 19-5.

In the alert escalation levels shown here (above left), the Assigned User, Technician,

Backup Tech, and Supervisor values are dynamic, and they will pull the appropriate user(s)
from the Entity Configuration window for the Location associated with the ticket (or in the

case of Assigned User, from the ticket itself). In this case, when a ticket is added (or
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reassigned) for the MMS Location named “Autoscope - Perry @ 5th”, the user assigned to
the ticket will be alerted first. If he or she does not acknowledge or close the ticket within
10 minutes, the Technician (in this case, Ross Poldark) will be notified that the assigned
user did not respond. If the Technician does not acknowledge or close the ticket within
the next 10 minutes, the Backup Technician (in this case, a user group called Mobile Techs)
will be notified, and so on.

Note e If the Technician, Backup Tech, and/or Supervisor fields on the Entity
Configuration window are set to a User Group instead of an individual user, all users in the
user group receive an alert at the same time (that is, unless they are not on-call).

Selecting Recipients

When you set up alerts and alert escalations, you must specify the individuals who will be
alerted, and how they will be notified. You can send online alerts to all online users or to
specific online users, and/or you can send offline alerts to specific personnel via email or
SMS text message.

For each user who needs to receive offline alerts via email or text message, you must set
them up as a recipient in order to specify their email/SMS contact information. You can
also send offline alerts to individuals who are not online users of Centracs — these
recipients cannot log in to Centracs, but they can receive and acknowledge offline alerts.

To select one or more recipients for an alert or alert escalation:
1 Open the Recipient Selection window from the Trigger Editor (page 4-25) or the Alert
Escalation Editor (page 4-34).

[] Recipient Selection =]

& Tech Group 1
e Tech Group 2
& Administrater

e
e
& Technician
&, Bil Lumbergh
7]

&I Forrest Lawrenceton

8. George Michasl Bluth

2 You can select one or more individual recipients, one or more user roles, and/or one
or more user groups. If you select a user role or user group, then all users who are

assigned to that role or group will receive the alert. User groups (&%) are shown at the

top of the Available Recipients list, user roles (%) are shown next, and recipients (&)
are shown at the bottom.

Centracs User Manual 4-43
Software Version 2.x - March 2018



Configuring Events, Alerts, and Triggers

= Selecting Recipients

IMPORTANT e It is recommended that you always include at least one online user
for each alert. This ensures that someone can see and acknowledge the alert even if
external communications via SMS and email are temporarily down.

Alert Steps

To alert all online users

Enable the “Send to ALL online users” checkbox.

This will notify everyone who is logged into Centracs at the
time of the alert.

To alert specific online
users

1
2

Disable the “Send to ALL online users” checkbox.

In the “Available Recipients” side of the window, click
the recipients and/or roles to alert.

From the Available Message Types dropdown, select
“Online”.

Click B to move them to the “Selected Message Types”
section of the window.

To send an SMS text
message alert

In the “Available Recipients” side of the window, click
the recipients and/or roles to alert.

From the Available Message Types dropdown, select
IISMS”.

Click B to move them to the “Selected Message Types”
side of the window.

To send an email alert

In the “Available Recipients” side of the window, click
the recipients and/or roles to alert.

From the Available Message Types dropdown, select
“Email”.

Click B to move them to the “Selected Message Types”
side of the window.

Note e To select multiple recipients/roles at a time, hold the Ctrl or Shift key while
you click them; to select all, press Ctrl-A.

If it is necessary to notify a recipient both by email and by SMS, you must add them to
the “Selected Message Types” section of the window two times — one time with a
message type of Email, and one time with a message type of SMS.

3 To save your selections, click OK.
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Offline alert recipients must also have an email address and/or SMS address specified in
Centracs, and you must “enable” them to receive alerts (refer to Defining Recipients on
page 20-73 and Enabling Recipients on page 20-75). Otherwise, a yellow triangle is shown
to the right of their user name when you add them to the “Selected Message Types” box.
If you roll your mouse over the yellow triangle, an informative message is shown:

[=] Recipient Selection =TI

[>-<] Econglite User %

Recipient problems:
Recipient Econclite User does not have an email address assigned at this time.

Viewing/Printing the Alerts Log

To see or to print a history of the alerts that have been generated within a specific time
frame, generate the Alerts Log report. For details, refer to Generating Reports on
page 10-1 and Alerts Log on page 10-18.
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Using Maps

Overview

Centracs maps offer you a real-time display of the overall state of your devices and
entities. Dynamicicons superimposed onto true GIS-based maps indicate the type, status,
and location of each active field device.

To show more or less detail for specific areas, you can scroll and zoom the map. You can
specify how icons look at each zoom level. You can click any device icon to see more
details about that field device, to show live video feeds (if the CCTV feature is enabled), or
to send commands to the device. Centracs uses graphics and colors to make the map
display easy to understand.

» | Table of Contents

Mouse Posilion

X -11863744 Y 4714838

Map Scale zoom level

39720 Al: 135 E—

' ¥ By |.|"'"'| 8

‘ .
R O O O ol 1 mapunlts
Options

Hide ||Lock|| Refresh

E z
LA D

e ]

s
LT T L L

i l:r)lr‘\g = Qﬂer.!S‘.-_'EEi."c'lag contributors ﬁ

.

Sample map, with toolbar shown at left
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Show Toolbar
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Sample map, with Signal status legend shown at top
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Viewing and Navigating the Map

Use the actions below to open, navigate, and adjust the Centracs maps:

Action Steps

To open the default map From the main menu, select View » Map.

The Map Viewer window opens. For instructions on how to change
the default map, refer to Setting the Default Map Display on
page 5-5.

To open a preset map From the main menu, select View » Preset Map P <map name>.

The Map Viewer window opens. This option is available only if one or
more preset maps have been set. For instructions on how to set a
preset map, refer to Using Preset Maps on page 5-6.

To show the toolbar Right-click the map and select Show Toolbar.

The toolbar shows the X/Y coordinates and the latitude/longitude of
the mouse pointer on the map. It also shows the map scaling factor
and the zoom level of the current map view.

To select the entity types to Right-click the map and select Show Toolbar. Turn on the checkboxes
show or hide on the map for the entity types to show on the map; turn off the checkboxes for
the entity types to hide on the map.

Note e If the “Save Preference Set On Logout” Global Setting is set
to true, your selected entity types will be remembered the next
time you log in.

Note e To select the entity types to show or hide on the map
portion of the Signal Status display, Section Status display, and
Location Status display, refer to Editing Map Layer Settings on
page 20-83.

To show or hide the legend Right-click the map and select Show Legend.

The legend shows the meaning of each color used when signals are
shown on the map. Each color represents a different status.

Note e Thelegend is available only in systems that are licensed for
Signals, DMS, and/or Data Collection Stations. It is not available in
systems that are licensed only for MMS.

To pan the map view Left-click the map and drag it to a new view, then drop it.

To zoom the map view Roll your mouse wheel forward to zoom in, or backwards to zoom
out.
Or
On the toolbar, move the slider to the left to zoom out or to the right
to zoom in.
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To prevent the map view from  Right-click the map and select Lock Map.
panning and zooming Or

On the toolbar, click Lock/Unlock.

To turn the pan and zoom Right-click the map and select Lock Map to remove the checkmark for
features back on this option.
Or

On the toolbar, click Lock/Unlock.

To switch maps Right-click the map and select Go to Location P <map name>.
To reload the map tiles On the toolbar, click Refresh.
To determine the latitude/ Open the toolbar. As you move your mouse, the latitude and

longitude of a point on the map longitude values shown in the toolbar are updated to reflect the
current position of the mouse pointer.

To remove the toolbar from the Below Options, click Hide.

window
Note e A third way to keep a specific map view (other than to save it as the default map
location or save it as a preset map) is to dock it in a container. As long as you leave the map
open and docked when you exit Centracs, the map will be shown in the same location in the
same container when you log back in.
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Setting the Default Map Display

When any Centracs user selects View » Map from the main menu, the default map opens.
You can change the default so that the map most commonly used by the users is shown
automatically.

IMPORTANT e This is a system-wide setting — there is only one default location that
all users share. If you change the default map location, you will change the default for
all users of the system.

To change the default map display:
1 From the main menu, select View » Map.

The Map Viewer opens.

2 Panto the correct position on the map, and select a zoom level. For instructions on
how to pan and zoom the map, refer to Viewing and Navigating the Map on page 5-3.

3 Optionally, resize the window as you would any other Windows® dialog (i.e., click a
corner or border of the window and drag it).

4 Right-click the map and select Save as Default Location.
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Using Preset Maps

5-6

If you frequently use numerous maps or different views of the same map, you can save
each map view as a “preset map” which you can easily call up at any time. Any map views
that have been saved as preset maps are available to all users of the system.

To save a map view as a preset map:
1 From the main menu, select View » Map.

The Map Viewer opens.

2 Panto a position on the map, and select a zoom level. For instructions on how to pan
and zoom the map, refer to Viewing and Navigating the Map on page 5-3.

3 Optionally, resize the window as you would any other Windows® dialog (i.e., click a
corner or border of the window and drag it).

4 Right-click the map and select Save as Map Preset... The Save Preset Map Location
window opens.

E] Save Preset Map Location @ @
Enter 2 name io associate with this new location:
Preset Map Name |

[ ox J[ cance |

5 Enter a unique name for the preset map view and click OK.

This map view is now available to all users of the system via the View » Preset Map
option from the main menu or via the Go to Location option from the Map Viewer’s
pop-up menu.

To open a preset map:
» From the main menu, select View » Preset Map and choose a map from the list.
Or

» From Map Viewer, right-click the map, select Go to Location, and choose a map from
the list.
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Edit Preset Maps Option

If you frequently use numerous maps or different views of the same map, you can save
each map view as a “preset map” which you can easily call up at any time. Any map views
that have been saved as preset maps are available to all users of the system.

To delete a preset map:
1 Fromthe main menu, select View P Edit Preset Maps... The Edit Preset Map Locations

window opens.

E] Edit Preset Map Locations @ @

Mame Longitude Latitude Zoom Level

Houston, TX -95.3375165170748 29.7693720129061 9.5
Eastwood Transit Center  -95.33444164653285 29.7274217754351 17
Dixie Farm Rd -95.192056222196  29.5937382820976 18.5

This window shows the name, longitude, latitude, and zoom level for each preset map.

2 Clicka mapin the list, then click Delete. If you are asked to confirm the deletion, click
Yes.

Note e Youcannotchange orrename a preset map — you must delete it and re-add it with
the new name or new properties.
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Viewing Entities and Elements on the Map

After they have been configured via the Map Editor (refer to Editing the Map View on
page 5-18), graphics that represent the entities and elements in your system are
superimposed onto the map to show the location, type, and status of each active field
device. The tables below identify the graphics used to represent the various field devices.

Note e If your entities do not show on the map as expected, and if you have already added
them to the map (refer to Adding Icons to the Map on page 5-31), check your toolbar
settings on the map. To do so, right-click the map and select Show Toolbar. Turn on the
checkboxes for the entity types to show on the map. If the “Save Preference Set On Logout”
Global Setting is set to true, your selected entity types will be remembered the next time
you log in.

Signal Status

Centracs uses the icons below to show the current status of a signal when the map is
zoomed out:

Icon Color Meaning

@ Green Incoordination
i VYellow In transition
@ Red Error flash (i.e., unintentional flash)
@ Orange Programmed flash (i.e., intentional flash)
O  White Free
O Pink Preempt active
@ Gray Offline
@ Black Standby
@ Blue Comm failure (or comms are not configured)
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Centracs uses the icons below when the map is zoomed in:

Icon Meaning

The green circle in the center indicates that the signal is in
coordination. In this example, pattern 1 is active.

The yellow circle in the center indicates that the signal is in
transition. In this example, pattern 2 is active.

The center of the circle indicates that the signal is in error flash (i.e.,
unintentional flash), and the color of the icon alternates between
transparent and red.

The center of the circle indicates that the signal is in programmed
flash (i.e., intentional flash).

The center of the circle indicates that the signal is in Free mode.

The pink circle in the center indicates that a preempt is active.

The Mode for the signal is set to Offline (in the Entity Configuration
window).

The Mode for the signal is set to Standby (in the Entity Configuration
window).

The Mode for the signal is set to Online (in the Entity Configuration
window), but there is a communications failure (or comms are not
configured).

*E2000 00

The main street phase is currently green. The longer set of arrows
represents the main street; the shorter set of arrows represents the
side street.

The main street phase is currently red. The longer set of arrows
represents the main street; the shorter set of arrows represents the
side street.

¢ o
o O

o
=
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The blue arrows indicate that the Main Street / Side Street Phases
have not been specified on the Entity Configuration window.
- The gold halo surrounding the signal indicates that the signal is
@ currently under the control of a manual command from Centracs.
> The blue halo surrounding the signal indicates that the current
: pattern (pattern 3) was selected by a Traffic Responsive algorithm.
DMS Status
Centracs uses the icons below to show the current status of a DMS entity:
Icon Color Meaning
Yellow Communications between Centracs and the
D:I DMS are good, there are no errors
associated with the DMS, and a message is
active on the sign.
Yellow Communications between Centracs and the
E:I and black DMS are good, there are no errors
associated with the DMS, and the sign is
blank.
Red Communications between Centracs and the
!:I DMS are good, but one or more error
conditions exist. You can use the DMS Status
display (refer to page 9-7) or run the System
Events report (refer to page 10-51) to get
details about the error(s).
Gray The status of the DMS is unknown (such as if
E:I the communications mode for the DMS
entity is set to Offline).
Black The communications mode for the DMS
m entity is set to Standby.
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=y

Meaning

Autoscope/RTMS Status (DCMS) =

Centracs is unable to communicate with the

DMS device.

Sign 101 - 1-25 @ Founders- Southbound

If you hold your mouse pointer over the
DMS icon on the map, Centracs shows a
miniature representation of the current
message display on the sign. In this
example, the beacons are off.

Autoscope/RTMS Status (DCMS)

Centracs uses the icons below to show the current comm status of an Autoscope or RTMS

device:
Icon Meaning Icon Meaning
Good comms (zoomed Good comms (partially
out) zoomed out)
] N
Good comms for an Good comms for an RTMS
Autoscope (zoomed in) device (zoomed in)
Py (this icon varies slightly \/xr’,.-’*}
. I
depending on the type of
the scope)
» Bad comms, or device is Bad commes, or device is
Bt [w set to Offline or Standby set to Offline or Standby
?ﬂl 4 (zoomed in) . (zoomed out)
..13"
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MMS Ticket Status

If your system is licensed for Centracs MMS, colored flags are used to indicate that the
MMS Location has one or more open tickets. In this example, a Warehouse Location is
shown with an open ticket:

5-12

If the Location has more than one open ticket, the map shows the status of the most
important ticket, as follows:

m If the tickets have different priorities, the ticket with the highest priority is shown.

m If multiple tickets have the same priority, but one is a Call ticket and one is a Work
Order, the Call ticket is shown.

m If multiple tickets have the same priority and the same ticket type, the ticket with the
lowest ticket number is shown.

The color of the flag indicates the status of the ticket:

Icon

Color

Red

Meaning

Dispatched — Ticket has been assigned. Once a ticket reaches
Dispatched status, the dispatch date can no longer be changed by
the user.

Yellow Accepted — A technician has taken ownership of the ticket and

entered an ETA.

Green

Started — The technician is en route to the location.

Purple Arrived — The technician is at the location and starting work.

e die die dimlile

Blue Closed Work Pending — The work is finished for now, but more
work will be required at a later time. (When a technician later
returns to this ticket, it goes back into Started status.)

Red A ticket flag with this symbol indicates that this is a Call ticket.

Black A ticket flag with this symbol indicates that this is a Found On-site

ticket.

Centracs User Manual
Software Version 2.x - March 2018



Using Maps

BlueTOAD Link Status =

To see details about the ticket, hold the mouse pointer over the flag icon:

o

1-25 @ Wolfensberger - Northbound

Ticket # 11 Arrived
Description: Ramp meter light broken A0
Priority: MNormal
Call Date: 2/14/2017 12:31:16 PM
Assigned User: Sally Ann Cavanaugh
ETA: 4/7/2017 11:00:01 AM
Vehicle: Electric Vehicle £5

Total Active Tickets: 2

b|ﬁ3’ W AVTED]

For more information about MMS, refer to Chapter 19, Managing Assets Using MMS.

BlueTOAD Link Status

Centracs uses colors to indicate the status of BlueTOAD Link Pairs along the roadway. The
colors are user-configurable. For example, you might configure the colors so they appear
on the map as shown below:

Free-flowing traffic (green) Moderate traffic (yellow) Heavy traffic (red)

For details on how to configure the colors, refer to Entity Configuration - Links on
page 3-54.
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Zooming to Specific Entities

5-14

Note e There are multiple map layers in Centracs maps, which are user-configurable via
the Map Editor (page 5-18) and the Map Layers window (page 20-83). As you zoom the map
from one layer to another, the appearance of the entity/element icons may change —
specifically, their size, shape, and orientation on the map. For example, you may choose to
show small icons when you are zoomed out (to prevent a cluttered map display with icons
that overlap), and larger, more detailed icons when you are zoomed in. You can also
configure the map layers to show some icons and hide others.

To
1

2

center the map on a specific entity:
Make sure you have a Map Viewer window open.

From the Entity Tree, right-click the entity and select the Zoom to Entity option.

Note e If no Map Viewer windows are open, this option is hidden from the Entity Tree.

If you have only one Map Viewer window open, this map is centered and zoomed to
the entity you chose.

If you have multiple Map Viewers open, a sub-menu is shown with a list of the Map
Viewers that are currently open:

Show Status...
Motes...

Parent Operation »

Zoom 1o Entity ¥ Colorado Springs - Morth

Zoom to Parent  » Colorado Springs - South

Remove Entity

Select the map to use. This map is then centered and zoomed to the entity you chose.

center the map on a specific collection of entities:
Make sure you have a Map Viewer window open.

From the Entity Tree or from the Map Viewer, right-click any entity in the collection,
then select the Zoom to Parent option.

Note e If no Map Viewer windows are open, this option is hidden from the Entity Tree.

If the entity has more than one hierarchical “parent” in the Entity Tree (i.e., all entities
have a parent System, but they may also have one or more parent Groups, Sections,
or Subsections), a sub-menu is shown with a list of all the parents of the entity. Select
the parent collection on which to center the map.
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If you have only one Map Viewer window open, or if you selected the Zoom to Parent
option from the map rather than the tree, this map is centered and zoomed to the
collection of entities you chose.

4 |f you selected the Zoom to Parent option from the tree and you have multiple Map
Viewers open, another sub-menu is shown with a list of the Map Viewers that are

currently open:

Show Status...
Motes...
Parent Operation »

Zoom to Parent  »

Edit Properfies. ..

050 - Wilcox St @ Sth St »
5th St k Colorado Springs - Morth
Signals Colorado Springs - South

Plum Creek, CO

Select the map to use. This map is then centered and zoomed to the collection of

entities you chose.

Centracs User Manual
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Viewing Status Details

To see detailed status information for an entity or element:
» Double-click the icon on the map. A status window opens.

Or
» Hold your mouse pointer over the icon on the map.

For all except CCTV and DMS devices, a pop-up window shows such information as the
entity name, controller type, phase, pattern, time drift, communications status, etc.
These are the same fields shown on the status display. For CCTVs, the actual view from
the camera is shown; for DMS devices, the current message on the sign is shown.

026 - Meadows Blvd @ Coachline Rd - 50511 on .22
Meadows Elvd @ Coachline Rd
Jurisdiction General

Type ASC/3 q} 020 - Meadows Pkwy @ Meadows Blvd - 50503 on .70
ik FisH  Meadows Pkwy @ Meadows Blvd
¢y TimeDrint i ~ | Jurisdiction General
= Comms w0003 Type
_-: Veh Detector - Cirlr Ref: 1 - Mo Activity Fault -;“ Ped Phase 4
g Pattern 1

-
| .
g

"
\

\

N
\

\,

Sample Signal Status pop-up (left), DMS Status pop-up (bottom center), and Element Status pop-up (right)

Note e Centracs automatically issues a “Get Time” command when you request to see the
status details for a signal. For more information about the “Get Time” action, refer to
Synchronizing the Time on page 6-17.

To launch the status window for multiple entities/elements:
1 Hold the Ctrl key while you click the entities/elements.

Or

Hold the Shift key, then click the map and drag your mouse pointer to draw a
rectangle around the icons. Release the mouse button.

2 Right-click one of the selected icons and click Show Status... For most entity types, a
status window opens for each entity selected. (Only one window opens for multiple
elements of the same intersection.) For CCTV devices, the actual view from the camera
is shown.
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Note e This feature is not supported for BlueTOAD Links.

Issuing Commands

If you have sufficient permissions, you can issue commands to individual entities directly
from the map — simply right-click the icon and select a command from the pop-up menu.

k Show Status. ..

Manual Command...

Schedule. ..

Motes. ..

Device Collection Monitor...

Launch ASC/3 Front Panel
h Signal Editor...

MOE Reports..

MOE Settings

Upload MOE Logs

Spihit Monitor..

Zoom fo Entity

Zoom to Parent

Launch Map Editor. ..

Remove from Map
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Editing the Map View

The Map Editor controls how your entities are shown on the map. You can add various
icons to the map to show the locations of signals, Autoscope/RTMS detection devices,
DMS devices, CCTV devices, and MMS Locations. With this graphical representation, you
can easily recognize entity types with a glance at the map.

You can also use the Map Editor to adjust the location (latitude and longitude) of a
previously mapped entity.

There are multiple map layers in Centracs maps, which are user-configurable. You can set
up your map layers so that as a user zooms the map from one layer to another, the
appearance of the entity icons change — specifically, their size, shape, and orientation on
the map. For example, you may choose to show small icons when the user is zoomed out
(to prevent a cluttered map display with icons that overlap), and larger, more detailed
icons when the user is zoomed in. You can also configure the map layers to show some
icons and hide others.

Note e For details on how to set the zoom ranges for each map layer, refer to Editing Map
Layer Settings on page 20-83.

[=] Map Editor - N Academy @ N Union =]

4 N Academy @ N Unicn
-104.7756047

35.9048283

28

1.74495684551896

Mame Status Property
CoordinationCircle | ExtSignalState

-
Mainstreet ExtMSGState -
Sidestreet ExtSSGState -

-

CmdStatus SystemControlMode

Note ¢ You cannot use the Map Editor to change the appearance of the base map itself
(for example, the colors of streets or bodies of water). You can use a third-party tool to
change the appearance of the base map, if necessary.
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Overview of Map Layers

Several tabs are shown near the top of the Map Editor window. These tabs represent the
map layers you can configure for the selected entity type. Each layer corresponds to a pre-
defined zoom range. Usually, the layer on the left-most tab is a zoomed-out view of the
area around the entity; the layer on the right-most tab is a zoomed-in view of the
elements associated with the entity (if any); any middle layers are between the two.

Notes:

m The Intersection layer, when available, dictates what is shown in the Signal Status
display (page 6-1) and Autoscope Status display (page 17-29).

m  Tochange the names of the layers, refer to Editing Map Layer Settings on page 20-83.

m To enable priority polling for a layer, refer to Editing Map Layer Settings on
page 20-83. If enabled, priority polling will be activated any time that map layer is
viewed by a user in the Map Viewer.

Point Layer

The Point layer usually contains only one icon to show the location of an entity on the
map. The examples below show how these entity types look in the Map Viewer:

Entity Type Appearance on Map

Entity Type Appearance on Map

Signal Tk T URL £3 .
o) =
E Bt
!:vir«.'. -:- _EILI
CCTV e CCTVv B
& 3
T o
A
N
BlueTOAD = DMS B
Link Pair or g8 f | I
Level of @ljﬁ] i
Service Link gl ." .'I
| i)
Autoscope/ =
RTMS
Detectors "2
(DCMS) 3
E I
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Sample Map Editor Layout for a Signal on the Point Layer
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MSGStatus Layer

The MSGStatus layer shows the real-time status of the main and secondary phases for a
signal. You can add other icons to show directional information for each phase, or to show
whether any of these are in effect:

®  preempts

m vehicle calls

m pedcalls

m traffic algorithms

m local or system manual commands

Sample Map Editor Layout for a Signal on the MSGStatus Layer

m MSGStatus | MSEPattem
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MSGPattern Layer

The MSGPattern layer is a slightly closer view than the MSGStatus layer, and shows more
detail. For a signal, when this layer is shown in the Map Viewer, the circle in the center of
the red and green cross symbol shows either the number of the pattern that is running or
the status: FREE or FLASH.

Sample Map Editor Layout for a Signal on the MSGPattern Layer

MEGStatug | MSGPattemn
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The window below shows how this layout would look in the Map Viewer:

E] Idap Viewer @ @

dmen Rd

M Linle

ll;‘.in-:l} Pi

—_—
% by
13Oc-"{-lle’J.OL

ol

Intersection Layer

The Intersection layer includes all the possible icons necessary to assemble an
intersection. For a signal, you can use the Intersection layer to show detailed information
such as:

the status of each phase

the location and status of each vehicle, pedestrian, and bicycle detector
the presence of preempts and alarms

the cycle length

the coordination status and pattern

Note e The Intersection tab dictates what is shown in the Signal Status display (page 6-1)
and Autoscope Status display (page 17-29).
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Sample Map Editor Layout for a Signal on the Intersection Layer

E]Map‘viewer @

B
5|
E|

=
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The Any Preempt symbol (in the upper-right corner of the Map Editor layout) and the
Traffic Algorithm symbol (in the lower-right corner) are not shown in this Map Viewer
example because there are no preempts or algorithms in effect at the moment.

Locations Layer (MMS Only)

The Locations layer allows you to specify how you want each MMS entity (Warehouse,
Flashing Beacon, Count Station, etc.) to appear on the map. You can change the size,
position, and orientation of each MMS icon.

Tickets Layer (MMS Only)
When an open ticket exists for an MMS entity, the map shows a flag for that entity. For

example:

The Tickets layer in the Map Editor allows you to specify how you want the flag to appear
on the map. For example, you can make the flag smaller, make the flag appear to the left
of the entity icon, to the right of the entity icon, etc.
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Available Map Icons

lcon

The table below identifies all of the icons that may be available to you — the actual icons
available depend on the type of entity and the map layer. For example, because the Point
map layer is zoomed out, only a few general icons are available; but because the
Intersection layer is zoomed in, there is room to add element-level icons, and so more

icons are available to you.

Symbolizes...

A Signal entity (on the Point tab only)

Symbolizes...

A URL entity (also available in red and
yellow to distinguish one URL entity from
another)

A Signal entity (on MSGStatus / MSGPattern tabs); when you put this icon on the map, it is
important that you orient the red arrows to be parallel with the main street, and the green

arrows parallel with the secondary street

A CCTV entity

4

A CCTV entity

A DMS entity (on the Point tab only)

1y

A DMS entity (on the MSG and Intersection
tabs)

An Autoscope or RTMS Data Collection

An Autoscope or RTMS Data Collection

the MSGPattern and Intersection tabs) —
this icon differs slightly for each Autoscope
type (Terra, Solo Pro Il, etc.)

“ Station (on the Point tab only) ’; Station (on the MSGStatus tab only)
An Autoscope Data Collection Station (on J An RTMS Data Collection Station (on the
/g
L

MSGPattern and Intersection tabs)

Straight traffic

-

Left-turn traffic

Right-turn traffic

2,

Straight and left-turn traffic

Straight and right-turn traffic

+|

Straight, left-turn, and right-turn traffic

Left-turn and right-turn trafficata T

=

Left-turn and right-turn trafficata Y

Phase indicator (on all tabs but the Point
tab) — optionally, you can use this indicator
torepresent phases rather than the various
arrow indicators

Pedestrian phase — flashes Walk and Don’t
Walk symbols
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Symbolizes...

Vehicle call indicator 1 (refer to Notes
below) — center of rectangle turns blue
when a call exists for the assigned phase,
turns clear when no call exists

Icon

Available Map Icons =

Symbolizes...

Pedestrian call indicator — center of circle
turns blue when a call exists for the
assigned phase, turns clear when no call
exists

)

Detector fault indicator — appears only
when there is an active detector fault for
the intersection

e

Railroad preempt indicator — appears only
when the assigned preempt is in effect

:»" ‘

Emergency vehicle preempt indicator
(refer to Notes below) —appears only when
the assigned preempt is in effect

Emergency vehicle preempt indicator
(refer to Notes below) —appears only when
the assigned preempt is in effect

Emergency vehicle preempt indicator
(refer to Notes below) —appears only when
the assigned preempt is in effect

Any preempt indicator —appears when any
preempt is in effect

D

Alarm input indicator — appears only when
the assigned alarm input is active

Special function indicator — appears only
when the assigned special function is active

=

Coordination state and pattern indicator

Coordination alarm indicator — appears
only when the assigned alarm or fault is
active

Local zero indicator —appears momentarily
each time local zero is reached

Local cycle length counter — for NTCIP
signals, the “NTCIP Controller Count Up”
Global Setting determines whether the
clock counts up or down

Manual command — appears only when a
“Set Pattern” manual command from
Centracs is active

Manual command — appears only when a
local manual command (from the
controller) is active

The direction North on the map

Transit Signal Priority indicator — appears
and changes colors to indicate different TSP
states; refer to the TSP events on page 4-15

Dynamic text — to show more properties on the map, such as the programmed cycle time, the
current time drift, the current time of day, the phases currently in effect, etc.

Static text (long) — to add notes or entity
names to the map

L]

Static text (short) — to add notes or entity
names to the map

Permissive green traffic (refer to Bindings
for the Permissive Green Icon on
page A-17)

&

-0

Traffic algorithm indicator
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L

Symbolizes...

Vehicle call indicator 2 (refer to Notes
below) —appears only when a call exists for
the assigned phase

Icon

Symbolizes...

Bicycle detector

Vehicle detector actuation — appears only
when a vehicle is over the assigned
detector

Bus preempt indicator —appears only when
the assigned preempt is in effect

Icon

Notes:

B You can use one or both of the two vehicle call indicators. The rectangular indicator is
always shown on the map, and changes color when a call is present, whereas the
square indicator is shown on the map only when a call is present.

m The three emergency vehicle preempt indicators are interchangeable.

MMS lIcons

The icons below are available only if your system is licensed for Centracs MMS:

Symbolizes...

CCTV Location

Icon

Symbolizes...

Count Station

DMS Location

Flashing Beacon

HAR (Highway Advisory Radio)

Intersection

Lighted Crosswalk

‘;?

Manufacturer

Ramp Meter

]

Repair Depot

RWIS (Road Weather Information System)

Signalized Intersection

Warehouse

2N

Ticket

Location (for any other type not listed above, such as a Toll Station)
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For more information about MMS, refer to Chapter 19, Managing Assets Using MMS.
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Toolbar Options

Use the options on the toolbar near the top of the Map Editor to change the map view:

"o O~ =[]

These options are identified in the table below:

Function

Saves your changes to the map view.

Centers the map to the latitude/longitude of the entity.

In the Map Editor view, shows or hides the icons for nearby entities.

B EE D

This option is available only on the Intersection layer. The Status Display for an
entity shows a small portion of the map at the entity’s location. This option
shows you the portion of the map that will actually show in the Status Display.
Areas shown in gray will not be shown in the Status Display, so any icons or
objects you place in the gray areas will not be visible in the Status Display.

Deletes the selected icon from the map view.

Deletes all icons on all layers of the map view for this entity.

Adds an external image (such as a .BMP) to the map.

Changes, deletes, or moves an external image that was previously added to the
map.

E B EE N

Copies the icons from the map view of a different entity to this one.

Note e Right-click the map for more commands (such as copy, cut, paste, center, and
delete). For some of these commands, you must first select one or more icons.

5-30

Centracs User Manual
Software Version 2.x - March 2018



Using Maps

Adding Icons to the Map =

Adding Icons to the Map

To add map icons to a map layer:
1 Right-click an entity in the Entity Tree and select Launch Map Editor...

Note e This option is available only if the entity has been assigned a location on the
map. To assign a map location to the entity, open a Map Viewer window and drag and
drop the entity from the Entity Tree onto the appropriate position on the map.

The Map Editor window opens, centered over the latitude/longitude of the entity.

Note e If you have just added a new entity to the map, the Map Editor launches
automatically.

[] Map Editor - Woodmen @ Austn Bluffs g =B

N |" St Francis
Medical
Center

properties
assigned
toanicon

2 To add anicon to a map layer, click a map layer tab and:

® Drag and drop an icon from the Visual Templates palette (left side of window) onto
the appropriate location on the map.

Or

e Click the ™ in the lower-right corner of the icon (this option is shown when you hold
your mouse pointer over the icon) to automatically add the icon at the center-point
of the entity’s location on the map.
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Map
Point | M5GStatus | MSGPattern | Intersection
S &, .4
1@' a = 0
F 1L D _ L
p e S o8
G T, 2= &
= 4 - Fremont e L‘;jf
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- o 3 i
i =} rﬁ} 0= B
&y 2 %,
C'-".'& '?— “pd_ .\L-E"" D L Q

3 Click the new icon to move it, rotate it, or resize it. When you click an icon, “grab”
points become visible on the corners of the icon, as shown here for a “North” symbol:

Tomove |m Clickinthe centerofit, dragittothe new location, and drop it.
the icon Or

m Change the values in the Latitude and Longitude fields in the Visual
Properties area of the window (right side).

Toresize | m Click one of the corner grab points, then pull or push the icon to
the icon increase or decrease the size.

&
Or

m Change the value in the Custom Scale field in the Visual Properties
area of the window. The larger the value, the larger the icon.
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To rotate | m Click the fifth grab point above the icon, and spin the icon to the new
the icon orientation.

i

&

Or

m Change the degree value in the Rotation Angle field in the Visual
Properties area of the window. A value of 0 degrees is the icon’s initial
orientation. A value of 90 rotates the icon 90 degrees clockwise, and
so forth.

[=] Map Editor - N Academy @ N Union =]

4 NAcademy @ N Union

-104 7756047

35.9046293

23

1.74485684551856

Mame l tstus Property
Cuordlnahan(lr’le ExtSignalState
Mainstreet I, ExtMSG5State
sicestreet & [Ext55G5tate
SystemControlMode

=
-
-
-

4 Foreachicon that represents an element that can change state (for example, a phase,
a detector, a railroad preempt, etc.), you must associate the icon with the appropriate
state property. To do this, use the Bindings section of the window.

Note e For some icons, such as the Point icon on the Point tab, default bindings are
automatically set for you. In these cases, the binding fields are grayed-out, and the Use
Defaults option is checked. To change the defaults, uncheck the Use Defaults option and
make your changes.
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To set the binding for an icon, click the icon, then expand the dropdown list below
“Status Property” as shown here:

Bindings
Use Defaulis I_]

MName Status Property
Detector 1 State -|

Defector 1 Siate a8
Detector 2 State =]

Detector 3 State
Detector 4 State
Detector 5 State
Detector 6 State
Detector 7 State
Detector & State
Detector 9 State
Detector 10 State
Detector 11 State
Detector 12 State

Detector 13 State

Select the correct identity for the icon — in this case, a vehicle detector. For example,
suppose your intersection has two vehicle detectors, and these two detectors are
assigned Controller Reference numbers of 1 and 2 (in their entity properties defined
in the Entity Tree). You would then add two vehicle detector icons to the Map Editor,
and assign the first detector a binding of “Detector 1 State” and the second detector
a binding of “Detector 2 State”.

For phase arrows, you must select the correct phase property. For example, for an
arrow that represents phase 7 traffic, you would select “Phase 7” or “Overlap 7”. In
the sample Intersection layer shown earlier in this section, phases 2, 4, 6, and 8 are
assigned to the straight and right-turn arrows; phases 1, 3, 5, and 7 are assigned to the
left-turn arrows.

For User Text icons, give values for the three other fields in the Visual Properties
section of the window:

® Text —the text of the note to be shown on the map (such as an intersection name).
® Background — the background color for the text box.
® Foreground — the font color for the text.

To specify a background or foreground color, click [ to the right of the field. For
details, refer to Using the Color Selector Window on page 3-64.

Repeat steps 2 through 5 for more icons, as appropriate for this map layer.

Note e If there are other entities nearby, you can click the Filter icon on the toolbar to
superimpose those icons onto the current map layer and check for overlaps.

Although not required, it is recommended that you save your changes after you
complete each map layer (click the Save icon in the toolbar).

Click the next map layer and add the appropriate icons.
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To save all your changes, click the E icon in the toolbar, then click Close.

If you open a Map Viewer window over this entity, you can see the new icons you
configured, which are now superimposed on the map:

Hold your mouse over a signal or other intersection-related icon to see live status
information, or double-click the icon to launch the Signal Status display (page 6-1).

Double-click a Link icon to see data for the collection of detectors.

Hold your mouse over a CCTV icon, or double-click the icon, to see the live video
stream.

Hold your mouse over an Autoscope Data Collection Station to see the live video
stream or the most recent snapshot image, or double-click it to launch the Autoscope
Status display (page 17-29).

Hold your mouse over an RTMS icon to see current comm information, or double-click
the icon to launch the RTMS Status display (page 17-31).

Double-click a URL icon to launch the assigned website or executable.

If at any point it is necessary to change the icons, you can right-click an icon in the Map
Viewer and select the Launch Map Editor... option.

Copying Map Icons from Another Entity

To copy the map icons from a different entity:

1

On the Map Editor window, choose one of the four map layers, and click the icon
in the toolbar. The Entity Selection window opens.

® Entity Selection
Use the search and filter options to narrow the list of available entities.  Types D Sub-Types
[[] scrap ASCI2 NTCIP

Expand All Enfiies
T [] Section ASC3

Select Expanded Enfifies
: Signal Cobalt
* Select and highlight an entity before using Select Expanded Entities [ S| erren T Ol e

- ‘I]Culolado Springs Demo Entity Name Entity Description

- ﬂ North Colorado Springs Colorade Springs De  COS Demo System

v [} Academy North

! VC 13108

! VG 15107

2 Inthe list of entities on the left side of the window, double-click the entity to copy
icons from. You can use the search fields at the top of the window to filter out
unwanted entities. For example, you can use the Street fields to enter the first few
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characters of the street names (as shown above). For instructions on how to use the
search and filter options on this window, refer to Using the Entity Selection Window

on page 3-18.
3 Click OK.

The icons are copied for the selected map layer only. You can then move them, resize
them, change their bindings (if applicable), etc.

4 Repeat for other map layers if necessary, then save your changes.

Note e You can also copy and paste icons within the same map layer. To do so, select one
or more icons (hold the Ctrl key while you select them), then right-click and use the Copy
and Paste commands. You cannot copy and paste icons between different map layers.

Shown below is a Map Viewer window that shows the overall status of a string of seven
signals with various statuses. This map shows the Point map layer.

[:] Iap Viewer
og. Flash] Preempt | Transition | Caoord | Free
Brln@w Lopheg Dr %,
"8 &
vd 3 q’-w
= - v 3 E Woadmen Rd L o
= Fullergy ¥ a
& - o b o Pass Dr
Shridar Rt 3 B2 ‘E!'“i a™y
Copley Rd 5 g Fieall
Q Q7 £ Woodmen Rd @ £ & z
De B,N{! i Sang w
e | werk Rd . Brockwo™® 4 Cottonwood & '% Lol %
e - E YT Creek » & 2 :
Sei 5 ] Park z
g Dubdin Blwd L " Dbl Bl
F ’ Y A Lange by = z 0, Baisam 81 Iy
o a e, = B

Adding Images to the Map
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Optionally, you can add images to the map, such as an aerial photo of an intersection.
Centracs supports these graphic formats: BMP, JPG/IPEG, PNG, and GIF. In order to use
this feature:

m The map tile server must be installed, and the ECPI Tile Server tab (accessed via the
File » Settings option) must be configured to point to it. Refer to page 20-2.

m  The map layer(s) must be configured with the “ECPI Raster” Tile Requestor. If this is
not done, a “No Image Layer” error will occur when you try to add images in the Map
Editor. For details, refer to Editing Map Layer Settings on page 20-83.

To overlay an image onto the map:
1 Onthe Map Editor window, choose one of the four map layers.

2 Click the “Add an image” icon in the toolbar.

3 Find and select the image file to add to the map. The image is shown on top of the
map, and below any map visuals that have been added to the map.
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4 You can move and resize the image, the same as other map icons. You can also click it
and roll your mouse wheel forward to enlarge it or backward to shrink it.

5 Save your changes to make the image part of the map.
To edit or remove an image on the map:

1 Click the “Edit map images” icon in the toolbar.

2 Read the warning message that is shown, then click Yes.

The image is extracted from the map; you can delete, move, or resize it. (If multiple
tabs contain imported images, all images are extracted.)

3 Save your changes.
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Editing the Map View for a Link (LOS)

Use the Link Editor to establish road centerlines, which can have Links on one side or both
sides. For example, if you have a surface street that runs North-South, you can draw one
centerline and tell Centracs to create two Links: one running North and one running
South.

ALico Roap 250
INDUSTRIAL
SUBDIVISION

ALico RoAp FLEX INDUSTRIAL PARK
INDUSTRIAL PARK

ALICO PARK

[RPORT
ALIcO-GATOR RoAD % ! IR TERCH

HIDDEN 4 Fog o Oon ot
HARBOR 23 7 CALOORA TRACE

oon <
MERCIALL PARK T

i, DALICOYLAKES : BRIAR
(o) il

R
HARBORAGE

Park Rl )

e

agl
VILLAS AT
HIDDEN

Note e You must create the Link entities in the Entity Tree before you can add them to a
centerline.

To create a centerline, use the Roadway Snap tool or the Freehand tool.

As shown above, colors are used to show the direction of a centerline: the start/origin is
a green dot, and the end/destination is a red square.

E Save — Saves your changes to the map view.

Center — Centers the map to the latitude/longitude of the entity.
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Undo — Reverts to the map view prior to your last change. You can also use the
Ctrl-Z shortcut.

Redo — Reverts to the map view prior to the Undo action. You can also use the
Ctrl-Y shortcut.

Delete — Removes the selected item from the map view.

Use the Selection tool to select a centetline.

Use the Direct Selection tool to:

m select a point on the centerline and move that point
m select the centerline and move the entire line
m select the origin or destination point and move it

For example, if you use the Roadway Snap tool to add a centerline to follow the
shape of the roadway, but it does not exactly follow the road due to a problem in
the spatial data, you can manually move the line or the points as needed.

! Use the Roadway Snap tool to create a centerline that automatically snaps to the
shape of the roadway. To use this feature, you must have spatial map data loaded
into Centracs for the area. If spatial data is available, you will see intersection
nodes on the map, as shown in the sample window above.

To use the Roadway Snap tool to create a new centerline, click an intersection
node on the map to create the origin, then click the destination. Then either save
the Link or click the Roadway Snap tool to turn it off.

To move the origin or destination, select the centerline, then select the origin or
destination to move. Then use the Roadway Snap tool to move the selected origin
or destination to a new location. click the new location to confirm.

n Use the Freehand tool to create a centerline in free-form so there are no
restrictions on the location.

To use the Freehand tool to create a new centerline, click the map to indicate the
location of the origin. Then use single clicks to indicate subsequent points on the
Link. After you indicate the final point (destination), either save the Link or click
the Freehand tool to turn it off.

To use the Freehand tool to add or remove points, simply click the new point to
add, or click an existing node on the centerline to remove that point.
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m Use the Pan tool to move the map image. After you click the Pan tool, click the
map to drag and drop the image.

n Use the Zoom tool to change the magnification of the map image. After you click
the Zoom tool, use the mouse wheel to zoom in or out. Or, click the map to zoom
in, or hold the Alt key and click the map to zoom out.

After you draw the centerline, you must specify what this line represents. In the Links
dropdown at the top of the window, specify whether the centerline represents two Links
in opposite directions (i.e., the Both option) or only one Link (i.e., Left, Right, or Center).
For example, for a surface street with one Link running North and another Link running
South, select the Both option, then use the Left and Right fields to specify which Link
entity is Northbound traffic and which Link entity is Southbound traffic.

Use the Binding field to specify whether to base the Level of Service calculations for the
Map Viewer on Volume, V+kO, Occupancy, or Speed data. Or, if you set the Binding field
to Default, Centracs uses the value from the “Link LOS Source” Global Setting.

Note ¢ When you delete a Link from the Map Viewer (by right-clicking on the Link in the
Map Viewer window and selecting the Remove from Map option), the centerline does not
get deleted. Instead, the Link assignment is removed from the centerline. You can then open
the Map Editor and either assign a different link to the centerline or delete the centerline
from the Map Editor.
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Deleting an Entity from the Map Viewer

As described in Editing the Map View on page 5-18, you can remove icons from the Map
Viewer using the Map Editor. You can also remove an entity’s icons directly from the Map
Viewer, as described below.

To delete an entity from the Map Viewer:
1 From the main menu, select View » Map. The Map Viewer window opens.

2 Locate the entity you want to delete. Refer to Zooming to Specific Entities on
page 5-14.

3 Right-click the entity and select Remove from Map.

Note that after you remove an entity’s icon from the Map Viewer or Map Editor, Centracs
retains the entity’s latitude/longitude coordinates. To remove the coordinates (for
example, if you want to move the entity to another location on the map), follow the steps
below.

To remove an entity’s coordinates from the database:

1 From the Entity Tree, right-click the entity and select Edit Properties. The Entity
Configuration window opens.

2 Click [ to the right of the Coordinates field. The Coordinates window opens.
3 Remove all values from the Coordinates window and click OK.

4 On the Entity Configuration window, click Apply.

Special Note About Links

When you use the Remove from Map option for a “Level of Service” Link, the Link’s
centerline does not get deleted. Instead, the Link assignment is removed from the
centerline. You can then open the Map Editor and either assign a different link to the
centerline or delete the centerline from the Map Editor. For more information, refer to
Editing the Map View for a Link (LOS) on page 5-38.
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The Signal Status display shows a graphical representation of an intersection

Il

-
Pmen'lpt Alarms

Mode [ Pattern Coordination
: Free Actual  Prog Last 15:Hk29
: = Offset wa  na |8 )

5 i} 7
13
35 35

Contreller nunning command free Rirg 1= Red Rest
Sysiem controd active

Ring 2 Red Rest

You can use it to quickly assess the state of an intersection, and to quickly and easily issue
commands to a signal controller.

Note e To specify which types of entity icons (e.g., for CCTVs, DMS, Links, etc.) to show or
hide on the map portion of the Signal Status display, refer to Editing Map Layer Settings on
page 20-83.

6-2
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To open the Signal Status display:
» Double-click the signal in the Entity Tree or the Map Viewer.

Or

» Right-click a signal in the Entity Tree, Map Viewer, Section Status display, or
Subsection Status display and select Show Status... from the popup menu.

You can open Status displays for multiple signals at the same time. You can move them,
resize them, and dock them like other windows in Centracs.

The display at the top of the Status window shows an aerial view of the intersection on a
map. You can configure it to include a number of animated icons that show the current
state of the various intersection elements. (To do so, use the Map Editor (page 5-18) to
define and arrange the icons on the Intersection layer.) These are the same icons shown
in the Map Viewer. For the meaning of each icon, refer to Viewing Entities and Elements
on the Map on page 5-8. To see details about a specific icon or phase arrow, or to see a
CCTV camera feed or a DMS sign, hold your mouse pointer over it:

(-] Woodmen @ N Unian Blvd - (ASC/3) - SubSec: Woodmen-East Drift: Os =1

~_ardin " _n Time

You can also double-click a URL entity on this map to launch the executable or link.

The bottom section of the window contains details about the status of the intersection
and its elements. You can also do a number of operations directly from this window.
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When you dock the window or resize it, Centracs condenses the information into three
different tabs:

(=] Woedmen @ N Union - Woodmen Rd, N Union Bivd (ASC3) - SubSec: Woedi 7] (E1] <]

M55 Mode/Pattern Time Alarms Preempt  Comms

0005 |
Last 14:00:40

SY5/1 Emor: s & mEEEE

[=] woodmen @ N Union - Woodmen Rd, N Union Bivd (ASC3) - SubSec: Woodi (7] (E1] [<]

M5G Mode/Pattern Time Alarms Preempt Comms

Last 14:11:10
SY5/1 Emoe 0

( Timings '
5

M5G Mode/Pattern Time Alarms Preempt Comms
Last 14:11:10

SY5/1 Emor: Ds & FEEEE

Cycle &7 —_— - .
e - Tul e click tab to view

Detector is faulied

Battery is low

Controller in Transition - offset seeking
System control active

Ring 1: Extension
Ring Z: Extension

The MSG indicator shows the current state of the main street phase for the intersection
(MSG=Main Street Green). For details, refer to MSG Colors and Signal Status Colors on
page 6-15.

Mode / Pattern

The Mode / Pattern section of the window contains an overall summary of the status of
the intersection, specifically:

Field Description

Desired The mode that the controller should be in, and the pattern that should be
running, according to Centracs.

Current The actual controller mode and the actual pattern reported by the controller.
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For details, refer to Controller Modes and Patterns on page A-15.

Coordination

This section of the window shows whether the signal is currently running in coordination
(if not, the values are set to N/A and the colored boxes are replaced with “Free” or
“Flash”).

Signal in coordination: Signal in transition to coordination: Signal in flash:

Coordination
Flash Actual  Prog

Cycle MiA MNFA
Offset HiA  HAA

It shows the programmed offset and cycle times, along with the actual offset and the
counter for the current cycle.

While a signal attempts to get in coordination, “Controller in transition - offset seeking” is
shown in the Messages section at the bottom of the window.

Time

The Time section of the window shows the time reported by the controller for the last
“Get Time” request (in HH:MM:SS format), followed by the time drift between Centracs
and the controller. This section of the window also includes options to request the current
time from the controller or set the time on the controller. For more details about time
drift and the information shown in the Time section, refer to Synchronizing the Time on
page 6-17.

Preempt

The Preempt section shows whether a preempt is active for this intersection:

Emergency vehicle preempt: Railroad preempt: Other preempt:
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Alarms

The Alarms section shows the number of alarms that the signal controller is reporting (if
any):

Alarms

1

An example of a controller alarm is “Detector is faulted”. A short description of each alarm
is shown in the Messages section of the window (below).

Phase / Overlap

This unlabeled section is split into two tables: one for phases (1-16) and one for overlaps
(A-P). The tables contain the information below for each phase/overlap:

Field Description

Actual  The actual split for this phase during the current or most recent cycle (in
seconds).

The number may be followed by one of these letters:

m G-—thegreentime terminated because the phase gapped out.
m M-the phase reached its maximum green time.

m F-the greentime for the phase was forced off.

Prog The programmed split for this phase (in seconds).

On The current state of the vehicle phase/overlap: green, yellow, red, or orange
(for programmed flash).

Ped The current state of the pedestrian phase (the Walk symbol, the Don’t Walk
symbol, or the flashing Don’t Walk symbol).

Call There are four possible states for this indicator:
m Ablue boxindicates the presence of a vehicle call.
m Ared letter M in a gray box indicates a manual vehicle call.

m Aredletter Min a blue box indicates the presence of both types of vehicle
calls.

m Adarkgray boxindicates the absence of any vehicle calls.

Note e The red M does not appear during phase recall.

Ped Call Same as above, but for pedestrian calls.

Next During the last few seconds of the active phase(s), orange arrows are shown
below the phase(s) that will be active next.
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To see more details, hold the mouse pointer over a phase number or overlap letter:

Phase 8 - Pattern 1 Details
Hide:

Rirg
Termination
Wt

To put a temporary call on a phase, click Assert vehicle call or Assert pedestrian call.
Click the button again to turn off the call. (When you close the Signal Status display,
Centracs asks whether you want to remove the call.)

Slide-out Menus

Tools and Phase Options Menu

If you hold your mouse over the wrench icon near the right edge of the window, this slide-
out menu is shown:

Cycle NIA NIA

2T e -
ONMNON STBYFREE | o= e

ﬂ HO || RO T Edit

The options are:

m  FP-Launchesthe remote front panel emulator for the controller, where you can view
or change the settings on the controller (page 15-6).

m EDI - Launches the EDI Malfunction Management Unit (MMU) Conflict Monitor
program. To enable this option, add the “ECcomPath” Global Setting and specify the
path to the executable. When you do this, a field called “ECCOMM Monitoring”
becomes available in the Entity Configuration for each signal in the Entity Tree; use this
field to specify the IP address. After these two items have been configured, you can
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Click the EDI button here to launch the conflict monitor program, or you can right-click
a signal in the Entity Tree or Map Viewer and select the Launch ECcom Monitoring...
option.

m  HO - Hides the overlaps not in use.
m RO — Restores the hidden overlaps.
m  HP - Hides the phases not in use.
m  RP —Restores the hidden phases.

m Files — Allows you to view or download files that are attached to this signal (files are
attached via the Entity Configuration window (page 3-36)).

m Edit — Launches the Controller Editor for this signal.

Manual Control Menu

If the “Enable Remote Interval Advance” Global Setting is turned on, this slide-out bar is
also shown on the Signal Status display:

These options allow you to manually control a signal from the Signal Status display:
m  Enter Manual Advance mode
m  Exit Manual Advance mode

m  Advance the interval

Note e If youclose the Signal Status display (or the Centracs client) while Manual Advance
mode is active, Manual Advance mode times out after a short period of time.

Information Menu

oun
|

If you hold your mouse over the “i” icon near the right edge of the window, this slide-out

bar is shown:

=

erlap A B C O E F G H | J K L

It provides information about the controller, including the type of controller (such as
ASC/3), the IP address or drop address, and the firmware version.
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Notifications

The unlabeled section at the lower-left corner of the window contains messages to notify
you of various conditions, such as a communication problem, a detector fault, a local
override, or local zero. For example:

& Marginal Comms

Rings
This unlabeled section at the bottom of the window shows the current state of each ring,
such as Min Green, Yellow Change, or Extension.

Ring 1- Red Rest
Ring 2 Red Rest

Comms

The Comms section is a summary of the communications status between Centracs and the
controller for this intersection. Hover the mouse over the colored bar on the bottom to
see more details; click it to open the Comm Statistics graph. For more information, refer
to Viewing Comms on the Status Display on page 6-53.

When shown just above the Comms section, . indicates that the intersection is
currently running in Adaptive mode. For information about Centracs Adaptive, refer to
Chapter 18, Using Centracs Adaptive.
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Using the Status Display for Sections/Subsections

The Status display for a Section or Subsection shows a graphical representation and a
comprehensive summary of the intersections included in the selected Section/Subsection

grouping:
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You can use it to quickly assess the state of a collection of signals, and to quickly and easily
issue commands to the signal controllers.

Note ¢ To specify which types of entity icons (e.g., for signals, CCTVs, Links, etc.) to show
or hide on the map portion of the Section/Subsection Status display, refer to Editing Map
Layer Settings on page 20-83.

6-10 Centracs User Manual
Software Version 2.x - March 2018



Monitoring Devices

Using the Status Display for Sections/Subsections =

To open the Status display:
» Double-click the Section or Subsection in the Entity Tree.

Or

P Right-click the Section or Subsection in the Entity Tree and select Show Status... from
the popup menu.

You can open Status displays for multiple Sections/Subsections at the same time. You can
move them, resize them, and dock them like other windows in Centracs.

The display at the top of the Status window shows an aerial view of the Section/

Subsection on a map. To see details about a specific icon, or to see a CCTV camera feed or
a DMS sign, hold your mouse pointer over it:

[] section Woodmen - Woodmen Rd - East of 1-25 (=11

%
&
|
]
¢
3
(=8
Q

FaLcon ESTATES

T=-ffic Algo=*m P~+arn Monit~=

You can also double-click a URL entity on this map to launch the executable or link.

The bottom section of the window contains details about the status of the signals. You can
also do a number of operations directly from this window.

Centracs User Manual
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Summary

The Summary section shows:

Mode/Pattern — The desired controller mode and the pattern that should be running,
according to Centracs; refer to Controller Modes and Patterns on page A-15

Signal Patterns — A list of all the patterns currently in effect on the signals in the
Section/Subsection

Avg Time Error — An average of the time drifts for all the signals in the Section/
Subsection

Avg Comms — An average of the communications statuses for all the signals in the
Section/Subsection

Transitions — The number of signals currently in transition (these signals are shown on
the map with a yellow dot)

Preempts — The total number of preempts currently active for this Section/Subsection

Alarms — The total number of alarms the controllers are reporting

The Summary section also includes options to:

@ request the current time from all controllers

E set the time on all controllers

© define a schedule entry

@ define a manual command

For more information about these functions, refer to Synchronizing the Time on
page 6-17 and Overview of Scheduling and Manual Commands on page 7-1.
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Traffic Algorithm

The Traffic Algorithm section contains details about the configured traffic algorithm for
this Section/Subsection, including:

m  Algorithm — The algorithm type

m State — The current state of the algorithm:

® “Running in background” — In this state, Centracs makes calculations for the
algorithm

® “Manually disabled” —Inthis state, Centracs does not make calculations for the
algorithm

® “Active on Section” —In this state, Centracs makes calculations and sends
pattern changes to the controllers

m Time to Calc — When the next calculation will be made, in minutes and seconds (the
Interval field on the Settings tab of the Threshold Traffic Responsive window sets the
amount of time between calculations; refer to Configuring Channels, Thresholds, and
Patterns on page 13-8)

m Pattern — The pattern selected by the algorithm for these signals

m Last COS Levels — The last Cycle, Offset, and Split (COS) levels reported by the
algorithm calculations

m Last Message or Error — The last message or error reported (such as “Sidestreet
channel failed because ‘good detector’ quota was not met”)

These buttons are available:
m Disable/Enable — turns calculations off/on

®  Run Now — calculates the algorithm on demand (this is the same as the Run Now
option on the TR monitoring window (page 13-16))

m  Monitor... — opens the TR monitoring window; refer to Monitoring Real-time TR
Calculations on page 13-16

For more information, refer to Introduction to Traffic Responsive (TR) on page 13-1.
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Pattern Monitor

The Pattern Monitor section contains information about the current state of Signal
Coordination Monitoring for this Section/Subsection:

m State — Shows whether pattern monitoring is active or disabled for this Section/
Subsection

m Failed Signals — The number of signals currently in a failed state, if any

m  Time to Warning — A countdown to when Centracs will write a Warning event to the
event log (if the pattern conflict is not corrected within that time)

m Time to Error — A countdown to when Centracs will write an Error event to the event
log (if the pattern conflict is not corrected within that time)

To turn monitoring on or off for this Section/Subsection, you can click the Enable/Disable
toggle button at the bottom of this section.

For more information, refer to Signal Collection Coordination Monitoring on page 3-24.

Signals

The table at the bottom of the window shows details for each signal. To sort the signals
by name, click the “Signal” column header (once for ascending order, twice for descending
order). To sort the signals by their order in the Entity Tree, click the “Sort by user-
positioned” up arrow (ascending order) or down arrow (descending order). For each
signal, the following information is shown:

m Signal — The signal name
m  Comm — The current communications status for the signal

m  Mode/Pattern — The current controller mode and the pattern currently running; refer
to Controller Modes and Patterns on page A-15

m Coordination — The cycle counter and the programmed offset

B MSG - The current state of the main street phase for the intersection (MSG=Main
Street Green); refer to MSG Colors and Signal Status Colors on page 6-15

m Timing Phases — The phases currently active (i.e., the phases that are green)

m Time — The time reported by the controller for the last “Get Time” request (in
HH:MM:SS format), and the time drift between Centracs and the controller; for more
details about time drift and the information shown in the Time column, refer to
Synchronizing the Time on page 6-17

m  Preempt — An indication of any preempts that are active for the signal:
® railroad preempts are shown as

® emergency vehicle preempts are shown as 0

Centracs User Manual
Software Version 2.x - March 2018



Monitoring Devices

Using the Remote Front Panel (ASC/3, Cobalt) =

If you right-click a signal, a menu is shown with a list of operations that you can do for this
signal (such as Launch Signal Editor, Launch Map Editor, Manual Command, Schedule,
etc.). To launch the Signal Status display (page 6-1), double-click a signal.

MSG Colors and Signal Status Colors

The colored dots in the MSG column have different meanings than the colored dots shown
on the map and in the Entity Tree (if you have the tree set to show the signal status). The
differences are identified below.

Signal Status Colors:

O Coordinated (green) O Intransition (yellow) O Free (white)
@ Error flash (red) @ Programmed flash (orange) @ Offline (gray)
O Preempt active (pink) @® Comm failure, or comms @ Standby (black)

are not configured (blue)

MSG Phase Status Colors:

@ Main street phase is currently @ There is a communications failure, or the
green main street phases have not been configured

@ Main street phase is currently {3 Signal is not running in coordination, or the
red, or signal is in error flash main street phases have not been configured

@ Signalis in programmed flash

Using the Remote Front Panel (ASC/3, Cobalt)

You can use the remote front panel emulator to view the status displays (which show you
what is happening on the controller right now), or to change the controller settings
directly from Centracs. Refer to page 15-6.
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Testing Comms between Centracs and a Controller

To test the comms between Centracs and a signal controller:
1 From the main menu, select Monitoring » Comm Test...

Or
click the colored bars in the Comms area of the Signal Status display (page 6-1):

Comms

The Communications Test window opens.

E] Communications Test @ @
Enfity § woodmen @ M Academy Asci3 & ||
MHumber of Attempts 10

Interval (seconds) 1

2 If the Entity is not already selected, click & to launch the Entity Selection window and
select the controller to test. Only one controller can be tested at a time. For
instructions on how to use the Entity Selection window, refer to page 3-18.

3 In the Number of Attempts field, enter the total number of polls to make to the
controller for this test.

4 In the Interval field, enter the number of seconds to wait between polls for this test.
5 Click Start.

Progress bars at the bottom of the window show the results of the test. The Attempts
bar shows the number of polls that have been sent, the Successes bar shows the
number of attempts that have been successful, and the Success % bar shows the
calculated success rate percentage, where:

Success % = ((Successes) / Attempts) * 100
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Synchronizing the Time

You can configure Centracs to automatically check for differences between the current
time on the server and the local time on the field devices, and to broadcast the current
server time to the devices in order to synchronize them with Centracs. You can also
synchronize device times manually.

Time Drift

“Time drift” measures any difference between the current time according to Centracs and
the current local time on the field devices.

The “ShowExactTimeDrift” Global Setting determines how the time drift is shown in the
Status display. If this option is set to true, the exact time drift is shown in seconds,
minutes, or hours (as appropriate). If this option is set to false, and if the time drift is larger
than 60 seconds, the drift is shown as “Error: > 1 min”.

Note e For signal controllers, in order for time drift to be calculated and shown correctly,
the time format configured in Centracs must be the same as the time format set on the
controllers. In Centracs, the time format is set on the Servers/Comms Configuration window
for each channel (for more information, refer to Configuring Communication Channels on
page 20-36).

In the Status display, you can request and send the time with the click of a button:

Button | Meaning ‘Description

Get Time | Commands a device to report its current local time back to
Centracs.

8 Set Time | Commands a device to replace its local time with the current time
from the Centracs server.

For more information about these commands, refer to the sections that follow.

Requesting the Time from a Device

Centracs automatically issues a Get Time command in these instances:

m  When the Signal Status display (page 6-1), Autoscope Status display (page 17-29), or
the DMS Status display (page 9-7) is opened.

m  When you hold your mouse pointer over a signal, an Autoscope, or a DMS icon on the
Map Viewer.

m Periodically, according to the time refresh rate configured for your system in the
Global Settings.
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To manually request the time from a device, cIick@ in the Signal Status display (page 6-1)
(or for multiple controllers in the Section/Subsection Status display), the Autoscope
Status display (page 17-29), or the DMS Status display (page 9-7).

Sending the Time to a Device

You can use the Set Time command to synchronize devices whose local time is different
from the current time on the Centracs server. When this command is issued, Centracs
sends its current time to the specified device(s). The time on the device(s) is replaced with
the Centracs server time, and a confirmation is sent back to Centracs.

Note e The Time Broadcast command is the same as the Set Time command, but Centracs
does not receive a response back from the device(s).

To manually set the time on a device, click E in the Signal Status display (page 6-1) (or
for multiple controllers in the Section/Subsection Status display), the Autoscope Status
display (page 17-29), or the DMS Status display (page 9-7).

Note e Youcan also issue Set Time and Time Broadcast via scheduled/manual commands.
As a result, you can schedule the command to run automatically at a specified time oron a
recurring schedule, and you can issue the command for multiple devices at the same time.
When you run these commands via a schedule entry or manual command, you can select
one or more Signals, DMSs, Groups, Sections, Subsections, Autoscopes, and/or Systems to
receive the time. For more information, refer to Overview of Scheduling and Manual
Commands on page 7-1.
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Using the Device Collection Monitor

To see signal status information for multiple devices at the same time, use the Device
Collection Monitor.

Note ¢ You can have multiple Device Collection Monitors open at the same time, each
with its own collection of signals.

To add signals to the Device Collection Monitor:
1 From the main menu, select Monitoring » Device Collection Monitor... The Device
Collection Monitor window opens.

[ Devite Collection Monitor (=]

2 Click . The Entity Selection window opens, where you can select all the signals to
monitor. You can select signals individually, or you can select entire Systems, Sections,
and Subsections. For instructions on how to use this window, refer to Using the Entity
Selection Window on page 3-18. After your selections have been made, click OK.

Note ¢ You can also drag and drop entities from the Entity Tree onto the Device
Collection Monitor window.

The collection of signals you specified is shown in the Monitor. In the example below,
the collection contains three signals.

[=] Device Callection Monitor =
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Forinformation about the fields shown in the Monitor, refer to Using the Signal Status
Display on page 6-1.

Note ¢ Aslong as the Device Collection Monitor is left open (docked or undocked) when
you close Centracs, the signals included in the collection will be remembered the next time
you log in. But if you close the Collection Monitor and re-open it, you must add the signals

to the collection again.

To change the display of the Monitor:

» To toggle between Horizontal and Vertical modes, click H/V. The example above is a
horizontal display; the example below is a vertical display.

Centracs User Manual
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» To show the signal names and descriptions only, click Props:

[] Device Callection Monitor

» To show the map visuals for the intersections, click Map:

[] Device Callestion Monitor =1

» Toshow coordination status, current pattern, time drift, and other status details about
the signals, click Coord:

[ Device Callestion Monitor =00

Centracs User Manual 6-21
Software Version 2.x - March 2018



Monitoring Devices

= Using the Device Collection Monitor

To re-order the signals:
» When in horizontal mode, click the #! and [# arrows to rearrange the signals.

» When in vertical mode, use the ™ and * arrows.

To remove a signal from the collection:

» Click the ¥ at the upper-right corner of the signal container.
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Viewing the Device Status Window

The Device Status window shows current status information for all devices at the same
time.

All signals, Autoscope/RTMS detection devices, and DMS signs defined in the Entity Tree
are shown in the Device Status window, regardless of whether they are fully configured.
Devices from external Server-to-Server systems are also shown.

D Device Status @ @
Name Descripfion Type General Status Communications Alertz  Alarms Primary Street Secondary Street Sub-fype a
Annie Goolahee (@ Bad Billy Pratt 504 J DFLT/FREE 100.0 3% o 1 Annie Goolahee Bad Billy Pratt ASC/3
Annie Goolahee @ Olaf Way 501 :I SYS/FLSH 100.0 3% o 1 Annie Goolahee Olaf Way ASC/3
Annie Goolahee @ Sweet Trav 502 J DFLT/FREE 100.0 3% o 1 Annie Goolahee Sweet Trav Ln ASC/3
Annie Goolahee @ Tofutti Klein Ave 503 :I DFLT/FREE 100.0 3% o 1 Annie Goolahee Tofutti Klein Ave ASC/3
Sign (@ Eastwood Transit Center Skyline =y Comm Good wi Message 100.0.% o o Eastwood Rd CRT1 Variable Message Sign
Sign @ I-25 & Woodmen Dakironics =  Comm Fail 0.0 % o o Woodmen Rd Interstate 25 Variable Message Sign I
Did s 1L AnsA 4 - T oeaea Eail n A DA Infornd-ds JC

Note e If your Centracs system is configured to communicate with other Centracs systems,
the System column shows whether the device resides on your Local system or on an external
system.

For signals, the General Status column shows the current mode and pattern that the signal
controlleris reporting (for details, refer to Controller Modes and Patterns on page A-15.),
or else shows Offline, Standby, or Comm Fail. For DMSs, this column shows whether the
commes to the sign are good, and if so, whether a message is being shown on the sign. For
Autoscope Data Collection Stations, this column shows the current Mode.

To see the Alarms for a signal, open the Signal Status display for that signal.

To open the Status display for a device, double-click the device in the list.

Right-click a device to access many of the commands that are available from the Entity
Tree (the actual commands shown depend on the type of device you clicked on):

Command Available for... Refer to...
Show Status... Signals, DMS, RTMS, Autoscope DCS page 6-1
Show Video... Autoscope Data Collection Stations page 17-1
Manual Command... Signals, DMS, RTMS, Autoscope DCS page 7-8
Schedule... Signals, DMS, RTMS, Autoscope DCS page 7-11
Notes... Signals, DMS, RTMS, Autoscope DCS page 3-14
Device Collection Monitor... Signals page 6-19
Launch Cobalt Front Panel / Signals

Launch ASC/3 Front Panel

Launch Signal Editor... Signals page 15-2
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Available for...

MOE Reports / MOE Settings Signals page 11-1
Upload MOE Logs Signals page 11-3
Split Monitor Signals page 6-26
Blank Sign DMS page 9-12
Edit Messages DMS page 9-4
Activate Message DMS page 9-11
Quick Message DMS page 9-13
Central Override DMS page 9-9
Software Reset DMS

Detector Group Chart RTMS, Autoscope DCS page 17-33
Zoom to Entity / Parent Signals, DMS, RTMS, Autoscope DCS page 5-14
Launch Map Editor... Signals, DMS, RTMS, Autoscope DCS page 5-18

To filter the devices:
1 Right-click the Type column header:

2 From the “Filter” sub-menu, check the device types to show, and uncheck the device
types to hide.

To select the columns to show in this window:

1 Right-click one of the column headers:

2 From the “Hide or show column” sub-menu, check the columns to show, and uncheck
the columns to hide.

To group the devices:

1 Right-click one of the column headers, as shown above.

2 From the “Grouping” sub-menu, select the column by which to group the devices.

The examples below show some of the grouping possibilities:

D Device Status @ @
Name Descripfion Type General Stafus Communicafions Alerts Alarms Primary Street Secondary Street Sub-type u
[B ASCI3 ]
[|:| Oasis ] i
[Ew ]
[|:| Variable Message Sign ]
Sign (@ Eastwood Transit Center Skyline =y Comm Good w/ Me IWE a 1] 1] Eastwood Rd CRT1 Variable Message Sign
Sign @ 1-25 & Woodmen Dakironics = Comm Fail 0.0 % 1] 1] Woodmen Rd Interstate 25 Variable Message Sign a
Grouped by Subtype
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D Device Status @ @
Name Descripfion Type General Stafus Communicafions Alerts Alarms Primary Street Secondary Street Sub-type n
[E| Active Alarms ]
Annie Goolahee @ Bad Billy Pratt 504 :' 5Ys/2 im a ﬁ 0 1 Annie Goolahee Bad Billy Pratt ASCI3
Annie Goolahee @ Olaf Way 501 J S5YsSH im a ﬁ 0 1 Annie Goolahee  Olaf Way ASCI3
Annie Goolahee @ Sweet Trav 502 :' SYS/FLSH im a ﬁ 0 1 Annie Goolahee  Sweet Trav Ln ASCI3
Annie Goolahee @ Tofutti Klein Ave 503 J STBY/FREE im a ﬁ 0 1 Annie Goolahee  Tofutti Klein Ave ASCI3
Woodmen Rd @ 1-25 Wa :' Comm Fail 7 0 1 Woodmen Rd Interstate 25 W4
[|:| No Alarms ]-
i
Grouped by Alarms
D Device Status @ @
Name Descripfion Type General Stafus Communicafions Alerts Alarms Primary Street Secondary Street Sub-type n
[E| Good Comm ] -
[|:| No Comm ]
Sign @ 1-25 & Woodmen Dakironics =) Comm Good w/ M 0.0% 1] 1] Woodmen Rd Interstate 25 Variable Message Sign
Woodmen Rd @ I-25 Wi [ Comm Fail 7 o 1 Woodmen Rd Interstate 25 W4 I
z Nacic : Conmm Eail o n 1 Nacic a
Grouped by Communications
D Device Status @ @
Name Descripfion Type General Stafus Communicafions Alerts Alarms Primary Street Secondary Street Sub-type n
[B 5YSM ]
[C svsiFLsh ]
Annie Goolahee @ Sweet Trav 502 J SYS/FLSH iW H ﬁ 0 1 Annie Goolahee Sweet Trav Ln ASCI3 i
[E| Comm Fail ]
[E| Unknown ]
[ sTBYIFREE ]I
[= svsr &

Grouped by General Status

In each case, click the [F] sign to expand each grouping; click to collapse a grouping.

Note e While the devices are grouped, the sort feature is disabled. In order to sort the
devices, you must first ungroup them.
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Using Split Monitor

You can use Split Monitor to analyze phase utilization for standard dual-ring controllers.
The Split Monitor diagram compares the actual splits for an intersection to the
programmed splits. Use this analysis to adjust the splits for the most efficient throughput.
Split Monitor can analyze data six ways:

Most recent time
Most recent cycles
Last pattern

Real time

Custom time frame

Advanced time period

Before Split Monitor can analyze the data:

1

You must upload the controller settings and save them to the Centracs database (if this
has not already been done). For instructions, refer to Using the Controller Editor
Workspace on page 15-10.

Your system must collect split monitor data for the time period of interest. To do so,
turn on the “Split Monitor Logging” action via the scheduler, a manual command, or
an action set. For Oasis controllers, also refer to the information about the “Use Oasis
Split Monitor Log” Global Setting on page 20-58.

To run the Split Monitor:

1

From the main menu, select Monitoring » Split Monitor...

E] Split Monitor

ﬁ Select a Signal...

(@ Most recent fime

B

Uses cycles starting &t the present time and going back the specified number of minutes. All patterns are included.

Most recent 30

minutes

E {Check on data availability)

() Most recent cycles

(7 Last pattern

() Real-time

() Custom time frame

() Advanced time period

Cycle Length Sample 'I-'lne Pattern Alarms
Programmed (avg): s Palternsin Sample: 0 Patterm Shown: Transifions:
3 # of Cycles Averaged:
3 Duration of Sample:
s Start
End:
Last Refresh:
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2 To launch the Entity Selection window and select the signal to analyze, click Select a
Signal... For instructions on how to use the Entity Selection window, refer to

page 3-18.

3 Select the type of analysis to do:

Type

Most recent
time

‘ Description

Uses cycles starting at the current
time and going back the specified
number of minutes (2 to 100000).
All patterns are included.

‘ Steps

For “Most recent minutes”, enter
the time length of the data to
analyze. The most recent x
minutes of data will be shown
(default = 30).

Most recent
cycles

Uses cycles starting at the current
time and going back the specified
number of cycles (1 to 100000).
All patterns are included.

For “Most recent cycles”, enter
the number of most recent cycles
to analyze (default = 10).

Last pattern

Uses cycles for the pattern before
the current or last logged pattern.

No entries necessary; continue to
the next step.

Real-time

Uses data from the current cycle
as it is running. The analysis is
shown after the cycle has
completed. All patterns are
included. The graphs are
refreshed automatically at the
end of each cycle, for as long as
you leave the real-time mode
running. If you manually refresh
the display, the Start time is reset
to the current time, and all prior
real-time data is discarded from
the display.

No entries necessary; continue to
the next step.

Customtime
frame

Uses data from a specified date/
time range. All patterns are
included.

Enter starting and ending dates
and times for the time period to
analyze. You can use the date
dropdowns or simply enter the
dates.
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Type ‘ Description ‘ Steps
Advanced Use this option to specify a date |1 Enter starting and ending
time period |range, a specific time of day, dates for the date range to
specific days of the week, and/or analyze. You can use the date
a specific pattern number. dropdowns or simply enter the
dates.

2 Enterthetime period each day
(for example, midnight = 0,
11:00PM = 23).

3 Select the days of the week to
analyze.

4 To analyze a specific pattern,
disable the “Include All
Patterns” checkbox, and enter
the pattern number.
Otherwise, leave the checkbox
enabled to analyze all patterns
together.

Click the . “Check on data availability” icon.
When the data check is done, Centracs shows one of two messages:
“There is data available. Analysis can be performed.”

Or

“Data is not available for analysis.” Inthis case, Centracs also shows the
reason for no data. For example:

Usually, to resolve this issue, it is necessary to upload the controller settings to
Centracs. You can click the @ button (if shown) to launch the Controller Editor from
here. For instructions on how to upload the controller settings, refer to Using the
Controller Editor Workspace on page 15-10.

Another possible reason for no data is:

5

6-28

This means that you tried to run in Real-time mode but the signal is not currently in
coordination, or that the signal was not running in coordination during the time period
or cycle range you chose. Select a different mode, time period, or cycle range.

If data is available, click the . “Perform analysis” icon.
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A progress bar is shown during the analysis. The configuration section collapses; to

expand it again, click the E’] expander in the upper-left corner (to the left of the Select
a Signal option).

To refresh the data at any time, click the . icon again.

Understanding the Split Monitor Results

E] Split Monitor

expandsicollapses the
configuration section

Pattern Alarms
Patterns in Sample: 3 Pattern Shown: 1,2, 3 Cycle Failures:

101.00 ¢ # of Cycles Averaged: 10 Cycle Faulis:

Duration of Sample:  00.00:16:59 Coordination Faulis:
Start: 17372012 2:45:12 PM Coordination Failures:
End: 17372012 3:02:11 PM Transitions:

Last Refresh: 3:02:33 PM '

p) ~®3 o4

m 15 20 5 10 15 20 25 30 35 40 4 5 10 15 5 1|ll 1|5 le]

Actual Vehicle Phazes

Programmed Vehicle Phazes

Programmed Pedestrian Phases

Split Distribution

(%) 30
25
20
15

| ! !
1 ; = : . “:: + :I “:= i + I

HHH HH + ST HHH TR AT +
10 20 30 40 5 10 15 20 25 30 35 40 45 50 55 30 5 10 15 20
= — —

Ring 2

o8

0 15 20 i0 15 20 25 30 35 40 45 5 1|ll 1|5 le] 25 30

Actual Vehicle Phazes

Pregrammed “ehicle Phases

Pregrammed Pedestrian Phases

Split Distribution

10 20 30 40 5 20 25 30 35 40 45 5

The top part of the window shows summary information about the selected time range or
cycle range. The bottom part shows up to four bar graphs for each phase.
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Summary Info

The information below is shown in the summary section at the top of the window:

Cycle Length

Programmed (avg.) — The configured cycle length for the pattern, in seconds. If
multiple patterns are shown, the programmed cycle lengths are averaged.

Actual (avg.) — The average of the actual cycle lengths during this time period, in
seconds. If multiple patterns are shown, all patterns are averaged. Any cycles longer
than 255 seconds are ignored.

Minimum — The minimum cycle length that occurred during this time period (for any
of the patterns included in the analysis), in seconds.

Maximum —The maximum cycle length that occurred during this time period (for any
of the patterns included in the analysis), in seconds.

Sample Time

Patterns in Sample — The total number of patterns included in the analysis.
# of Cycles Averaged — The total number of cycles included in the analysis.

Duration of Sample — The length of time between the Start and End dates/times, in
DD.HH:MM:SS format (days, hours, minutes, and seconds).

Start — The starting date and time for the analysis. (When you use the “Custom time
frame” option, the Start time shown may not be the same as the starting time you
entered — Centracs adjusts it to coincide with the nearest cycle end time so that the
analysis includes only complete cycles.)

End — The ending date and time for the analysis. (When you use the “Custom time
frame” option, the End time shown may not be the same as the ending time you
entered — Centracs adjusts it to coincide with the nearest cycle end time so that the
analysis includes only complete cycles.)

Last Refresh — The time at which the data analysis was last done (or refreshed); in
Real-time mode, this is the end time of the last cycle that completed.

Pattern

6-30

Pattern Shown — A list of the patterns that occurred during the analysis period.

Oasis Offset — This field is shown only for Oasis controllers.
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Alarms

Cycle Failures — The number of cycle failures that occurred during the analysis period.
A cycle failure occurs when the controller is NOT running in coordination, and there is
a serviceable call that has not been serviced for two cycles. This field is not shown for
Oasis controllers when the “Use Oasis Split Monitor Log” Global Setting is set to true.

Cycle Faults — The number of cycle faults that occurred during the analysis period. A
cycle fault occurs when the controller is running in coordination, and there is a
serviceable call that has not been serviced for two cycles. This field is not shown for
Oasis controllers when the “Use Oasis Split Monitor Log” Global Setting is set to true.

Coordination Faults — The number of coordination faults that occurred during the
analysis period. A coordination fault occurs after a cycle fault if the serviceable call is
serviced within two cycles after the cycle fault (coordination is retried at this point).
This field is not shown for Oasis controllers when the “Use Oasis Split Monitor Log”
Global Setting is set to true.

Coordination Failures — The number of coordination failures that occurred during the
analysis period. A coordination failure occurs after a coordination fault if a cycle fault
occurs again within two cycles of the coordination retry. This field is not shown for

Oasis controllers when the “Use Oasis Split Monitor Log” Global Setting is set to true.

Transitions — The total number of cycles that were in transition for all or part of the
cycle length; a transition occurs when a signal changes to a coordinated pattern (for
example, a change from Free to coordinated pattern 1, or a change from coordinated
pattern 1 to coordinated pattern 3).

Preempts — The total number of preempts that occurred during the analysis period.
This field is not shown for Oasis controllers when the “Use Oasis Split Monitor Log”
Global Setting is set to true.

Graphs

These bar graphs are shown for each phase:

Actual Vehicle Phases — An average of the actual cycle lengths and the splits (green,
yellow, and red clear) for all cycles included in the analysis. A separate graph is shown
for each phase. The values are shown in seconds.

Programmed Vehicle Phases — The programmed splits for the pattern (min green,
green, yellow, and red clear), in seconds; if multiple patterns are shown, the
programmed splits are averaged. A separate graph is shown for each phase. The entire
length of the bar (including min green, green, yellow, and red clear) shows the overall
split length that is configured in the controller for this phase.

Programmed Pedestrian Phases — The programmed Ped Walk (dark green) and Ped
Clear (light green) times for the pattern, in seconds; if multiple patterns are shown, the
programmed times are averaged. A separate graph is shown for each phase.
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m Split Distribution — A rough distribution of the splits that make up the Actual Vehicle
Phases average for each phase. Use this graph to see whether the average is made up
of all splits very near the average or whether there are some very short splits and some
very long splits in the mixture. The Y-axis (vertical) shows the percentage of the total
number of splits, and the X-axis (horizontal) shows the split length in seconds.

In the Split Distribution example shown below for phases 4 and 8, all of the splits were
between 8 and 22 seconds in length; 12% of the splits were 8 seconds in length, 26% were
9 seconds, 38% were 10 seconds, 12% were 18 seconds, and 12% were 23 seconds.

e NI T,

10 15 20 25 30
| l l |
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Using the Time Space Analysis

The Time Space Analysis (TSA) is a visual tool that illustrates coordination relationships
between consecutive intersections. It makes a diagram with data from two or more
controllers to give you a graphical representation of their timing splits.

Use the TSA tool to analyze progression and coordination along a specified route. The
analysis shows progression color bands from multiple intersections that are in
coordinated operation, which you can use to verify the level of optimization (based on
various parameters).

In order to generate the display, the TSA uses phase data transition information stored in
the Centracs database for the selected controllers. Therefore, the controller settings for
the signals must have been uploaded to Centracs via the Controller Editor before you can
run the TSA. (Refer to Using the Controller Editor Workspace on page 15-10.)

Note e If you want to always use metric units in the Time Space Analysis tool, enable the
“Use Metric Units By Default” Global Setting (refer to Configuring Local and Global Settings
on page 20-53). If this setting is enabled, metric units are used by default for speed (kph) and
distance (km) in all newly added Time Space configurations.

To run a Time Space Analysis:
1 From the main menu, select Monitoring » Time Space Analysis...

E] Time Space Analysis @ @

2 Select a calculation type: (if these options are not shown, click the m expander to un-
hide them)

® Programmed — Makes a diagram based on coordination plan data. Enter a pattern
number in the Pattern field.

® Historical — Makes a diagram based on a specific time period in the past. Enter the
start and end dates and times. In this mode, you can analyze up to 24 hours of data.

® Real-time — Makes a diagram based on real-time data as it is received from the
signals, including early phase termination due to gap out.

3 To add signals to the analysis, click the . icon. The Entity Selection window opens.
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4 Select the entities to be included in the TSA and click OK. For instructions on how to
use the Entity Selection window, refer to page 3-18.

If any of the selected entities is shown with a yellow triangle /&, hold your mouse over
the triangle to see the error message:

® |fthe messageis “Error loading programmed information...”,you mustuse
the Controller Editor to upload the controller settings for this signal. Refer to Using
the Controller Editor Workspace on page 15-10.

® |fthe message is “"No split monitor data was logged for the specified
time frame”, you tried to use Historical mode but there is no historical cycle/
phase length information in the database for this signal for the time range you
specified. To collect split monitor data, turn on the “Split Monitor Logging” action
via the scheduler, a manual command, or an action set.

® |fthe messageis “The controller is not currently in coordination”,you
cannot run the analysis in Real-time mode. Instead, choose Programmed or
Historical mode.

5 To rearrange the order of the intersections, click the & and % arrows to the right of

the signal names (circled below). To delete an intersection, click the ¥ to the right of
the signal name (also circled).

E] Time Space Analysis @ g

o

Woodmen @ N Academy

{sajiu) aouejsig

Note e To view a signal’s description, hover the mouse pointer over the signal name.
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6 To change the distance or the estimated average vehicle speed between two
intersections, hold your mouse over the vertical distance/speed indication, then click
the bar that is shown (circled below).

E] Time Space Analysis @ @

Woodmen @ N Union

(sajw) souejsig

Two fields for Distance and Speed are shown, as shown above. Make the necessary
changes, then click OK. When you enter distances, be sure to include the units (such
as miles, mi, km, feet, ft, meters, or m). You can enter speed values with units of mph
(miles per hour), kph (kilometers per hour), ft/s (feet per second), or m/s (meters per
second).

On systems that use spatial map data, Centracs uses the spatial data in the database
to determine the distance between each intersection (rather than requiring you to
manually it). If Centracs is unable to get a distance from the spatial database within
the time specified by the “Spatial Timeout” Global Setting (which defaults to 15
seconds), the distance is set to 0. In this case, optionally, you can click the Update
Distance button to override the timeout and retrieve the distance from the spatial
database anyway.

7 Click each intersection name to configure signal-specific settings. The Signal Location
Properties window opens:

E] Signal Location Properties

direction of
traffic flow

o 1)

ring order
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This window shows the current cycle time and offset configured in the controller.

To see the programmed times for other patterns, change the number in the Pattern
field.

To change the order of the rings, click the ¥ or * arrow.

To specify the direction of traffic to analyze, click the button to the right of the Bands
field until it shows the option you want:

e [A] analyzes traffic flow in the up direction on the diagram, i.e., from this signal to
the signal above it

© M analyzes traffic flow in the down direction on the diagram, i.e., from this signal
to the signal below it

® [X] turns off the analysis for the specified ring

To change the phases included in the diagram, click the phase numbers to enable or
disable them.

8 To start the TSA calculations, click the . Perform Analysis icon. The TSA plots the
locations of the signals along the vertical axis and the signal timing along the horizontal
axis:

E] Time Space Anzlysis @ @

Time (seconds) 540

430
IIIIIIIIII

I I |
Woodmen @ N Union = | I I N =
ASCI3 172.98.46.2 B

= (.25

0.5 mi - 35 mph

Ll || —

(sapw) aauejsig

g 5
A — 025
E
wn
[=] -
Woodmen @ Interstate .. = | N R B
| I N S A
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The left side of the screen shows the signals on the selected route. The right side
shows the analysis — using colored bars, and gray progression bands between the
intersections. The vertical Y-axis represents the distance between each intersection;
the horizontal X-axis represents time in seconds.

Each pair of colored horizontal bars represents an intersection, and shows the red,
yellow, and green times for the coordinated phases for that signal. The top bar
represents Ring 1, the bottom bar represents Ring 2.

The diagonal gray bands indicate the flow of traffic from one intersection to the next
(for two-way traffic, two gray bars are shown, one for each direction). They represent
the estimated vehicle progression between intersections based on the distance
between the intersections and the average speed along the route. Follow each gray
band from left to right — from the green interval of one intersection to the next
intersection — to determine whether vehicles will arrive on green, yellow, or red. In
the example above, nearly all of the vehicles will arrive on red.

If you make changes to any of the settings, click . again to refresh the diagram.

To zoom in or out on the X-axis, use the Time Scale slider at the top of the window —
slide it to the right to zoom in, to the left to zoom out.

To view descriptive information about a signal, hover the mouse pointer over the
signal name, as shown above. (This information is populated from the Description field
on the Entity Configuration window.)

9 InProgrammed or Historical mode, you can use the diagram to adjust the coordination
offsets and increase the efficiency of the signals. Drag and drop the colored bars
horizontally until the gray diagonal progression bands line up from green to green for
each intersection. (This feature is not available in Real-time mode.) Remember to
follow the gray progression bands from left to right, not from right to left. Depending
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on the distance, speed, and cycle time settings for each intersection, you may not be
able to line up all the greens perfectly; but the idea is to achieve the best fit, resulting

in the highest possible number of arrivals-on-green:

BX

[=] Time Space Anzlysis

Time (seconds) 540

430

1 1 1 | I 1 1 1 | I L1

A

Woodmen @ N Academy

(sajiw) asuejsig

0.5 mi - 35 mph

Woodmen @ Interstate. .

In many situations, it is difficult to achieve optimal progression in both directions using
the same plan. In these cases, it is advisable to create two different plans: one for
morning rush hour and one for afternoon rush hour. The example above achieves
optimal progression during morning rush hour, where the bulk of the traffic is moving
from residential areas into commercial areas (Southbound, in this case). The example
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below achieves optimal progression during afternoon rush hour, where the bulk of the
traffic is moving from commercial areas into residential areas (Northbound, in this
case):

Whereas if you attempt to use only one of these plans for both periods of rush-hour
traffic, a sizable number of vehicles will arrive on red.

As you drag the bars, the resulting offset for that intersection is shown directly above
the bars near the left side of the window:

0.5 mi-35m

Offzet: 26 ez

L5 miph

After you have made all the necessary adjustments to the colored bars, you can hold
your mouse over each of the bars to see the new recommended offsets for each ring
as a result of your changes:

F-'.lng 2
Oifzet: 36 secs

Centracs User Manual 6-39
Software Version 2.x - March 2018



Monitoring Devices

= Using the Time Space Analysis

10 If you are satisfied and you decide to change the controller settings based on this TSA,
click the signal name. The Signal Location Properties window opens, showing the new
offset value:

(=] signsl Location Properties

vRing 1: Bands B {up) @@@
ARing 2" Bands E (down)} @@

Note e The New Offset value must be between 0 and 255 seconds.

11 Click Save... The Set Controller Offset window opens:

(=] Set Contraller Offset =1

o

12 To save the new offset to the Centracs database, click Save to Database, or to save
the new offset to the field controller AND the Centracs database, click Save and
Download.

Note e The new offset is saved and/or downloaded for the specified pattern only; you
must save/download each signal and each pattern separately.

To add more signals to an existing route:
1 On the main TSA window, click the . icon.

2 Use the Entity Selection window to select the signal(s) to add.
3 Make any changes necessary (e.g., rearrange the new signals, etc.).
4

Click Save.

To delete a signal from an existing route:
1 Onthe main TSA window, hold the mouse over the signal to delete.
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2 Click the ¥ to the right of the signal name.
3 Click Save.

To save a TSA route:
1 Onthe main TSA window, click Save As... The Save Route As window opens.

2 Enter a name for the route and optionally, a description.

3 Click OK.

To open a saved TSA route:
1 Onthe main TSA window, click Load/Delete... The Load/Delete Route window opens.

2 Highlight a route and click Load.

To delete a saved TSA route:

1 Onthe main TSA window, click Load/Delete... The Load/Delete Route window opens.
2 Highlight a route and click Delete.

3 If asked to confirm the deletion, click Yes.
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Real-Time Detector Status

The Detector Status window shows real-time data about the volume, occupancy, and
speed calculations collected from one or more vehicle detectors.

To open the real-time detector status window:
» From the main menu, select Monitoring » Real-Time Detector Status...
Or

» From the Entity Tree, double-click a detector, or right-click it and select Show Status...

E] Resl-Time Detector Status: @ @

Average Volume Sum Violume: Occupancy Avg Speed WOS Table

Average Yolume

& Volume

0
1112011 41172011 72011 100172011 1112012

To add one or more detectors to be monitored in real time:
1 Expand the Detectors section at the bottom of the window.

2 Click @ to launch the Entity Selection window.

3 Select one or more detectors and click OK. For instructions on how to use the Entity
Selection window, refer to page 3-18.
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Note e You can also drag detectors from the Entity Tree onto the Detector Status window.

The Detector Status window includes five tabs of data. When the window is first opened,
the tabs are blank. As the detectors reply to poll requests from the system (usually one
time per minute), data will start to be shown on the tabs. The first four tabs contain
graphs; the VOS Table tab shows the volume, occupancy, and speed data used to make
the graphs, in tabular format. For supported detector types, the Status column shows any
existing detector faults (otherwise, this column shows “OK"”); the Valid column shows
whether the system considers the volume, occupancy, and speed data from this detector
to be reliable (in the case of a detector fault, the system considers the data to be
unreliable and does not include it in the graphs/calculations).

Note e The VOS Table tab allows primary and secondary sorting. To sort by one column
only, click the column header; to sort by a second column, hold the Shift key while you click
the second column header. The VOS Table tab also allows grouping. To group the data by
detector name, right-click the column header and select “Group by Detector”; to ungroup
the data, right-click the column header and select “Ungroup Detectors”. When sorting, data
will sort within the groups.

A maximum of 24 hours of data can be shown in the Detector Status window. When you
close the window, all information is discarded.

Sample Graphs

E] “ehicle Detector ES Woodmen @ Academy and 22 more Detector(s) @ @

Awerage Yolume Sum Volume Occupancy Avg Speed VOS Table

Average Velume

[ ]

S15PM  925PM  935PM  S45PM  ®55PM  100SPM  10:5PM 10:25PM
S20PM  S30PM  S40PM  SSOPM  1000PM  100PM  10:20 PM
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[] wehicle Detector EB Wondmen @ Academy and 22 more Detector(s)

|' Average Volume |

" Occupancy || Avg Speed || \OS Table |

BX

i olume

1.

15EM  925PM
5:20 FM

9:35 M

230 PM 2:40 PM

5:45 PM

250 PM

9:55 M

10:05PM  10:15 FPM

10:00 BM 10:10 BM 10:20 PM

10:25 PM

[] ehicle Detector EB Woodmen @ Academy and 22 more Detector(s)

|' Average olume || Sum Volume |

Occupancy

" AvgSpeed || VOS Table |

OX

Oecupancy

M Cccupancy

915 PM
220 BM

9:25 PM

S:30 PM

9:35 PM

S:40 PM

945 PM

S50 PM

255 PM

10:00 BM

10:05 PM

10:15 PM
10:10BM 1020 BM

10:25 PM
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Real-Time Link Status

The Link Status window shows real-time data about the Volume, Occupancy, Speed,
V+kO, and Level of Service calculations collected from one or more LOS Links (page 3-54).

Note e To get historical Link data, run the Links report (page 10-28).

To open the real-time link status window:

» From the main menu, select Monitoring » Real-Time Link Status...

Or

» From the Entity Tree or Map Viewer, double-click a Link, or right-click it and select
Show Status...
[] Resl-Time Link Status: =11

k0 || Ovcupaney || Speed | LevelofServies || VOS Table |

& Volume

[} 1 1 T
11201 41201 TME0N 10172011 1202

To add one or more Links to be monitored in real time:
1 Expand the Links section at the bottom of the window.

2 ClickE to launch the Entity Selection window.

3 Select one or more Links and click OK. For instructions on how to use the Entity
Selection window, refer to page 3-18.
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Note e You can also drag Links from the Entity Tree onto the Link Status window.

The Link Status window includes six tabs of data. When the window is first opened, the
tabs are blank. As the detectors in the Links reply to poll requests from the system (usually
one time per minute), data will start to be shown on the tabs. The first five tabs contain
graphs; the VOS Table tab shows the data used to make the graphs, in tabular format.

Note e The VOS Table tab allows primary and secondary sorting. To sort by one column

only, click the column header; to sort by a second column, hold the Shift key while you click
the second column header.

A maximum of 24 hours of data can be shown in the Link Status window. When you close
the window, all information is discarded.

Sample Graphs

(] Link Woodmen Rd West - EB and 1 mare Link(s) =11

H
I
|
I

M olume

Vehicles per Hour

1242PM | 1246PM | 1250PM
12:40 PM 12:44 P 12:43 PM
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[ Link Woodmen Rd West - EG and 1 mare Link(s)

B

[ voume || v+ko [ESENELSEN speed | LevelofService || wOS Table |

Occupancy %
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IRTIRIETIETIR

o
12:40 PM 12:45PM 12:50 PM 12:55 P 1:00 PM
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The Level of Service graph is a visual representation of the efficiency with which the
roadway is serving traffic over time. The link levels defined in your Link Settings window
are shown on the Y axis (the scale of this axis may vary depending on how many levels you
have configured). Low levels indicate free-flowing traffic or no traffic; high levels indicate
traffic congestion.

Note e The sample Level of Service graph shown above does not show realistic real-world
data; it is used only to illustrate the different aspects of the graph.

Monitoring Detector Faults

6-48

For ASC/2, ASC/3, and Cobalt controllers, the Detector Fault Status window is a list of all
existing detector faults. All detectors are monitored, regardless of whether they are
defined in the Entity Tree.

Note e Detector faults are reported to Centracs only if:

m the “shortAlarmStatus” object is included in the polling packet definition. For
more information, refer to Configuring Polling Packets on page 20-50.

and

m the “ActivateDetectorDiagnostics” Global Setting is set to “true”. Without
this setting, the Detector Fault Status window is disabled. (It may be
necessary to stop and start the Centracs Core service on the server machine
in order for changes to this parameter to take effect.)

To see live detector faults:

» From the main menu, select Monitoring » Detector Fault Status.

[ Detector Fault Status =]
[ Refresh | [ Prnt |
DateMime Signal Name DET'?E-'N Detector Detector Type Detector Faults
Mumber
1/6/2011 5:34:11 PM | Woodmen @ Rockrimmen | 1 Woodmen @ Rockrimman-1 | Veh Detector | No Activity Fault

Waoodmen @ Rockrimmon-3 | Veh Detector | No Activity Fault
Woodmen @ Rockrimman-4 | Veh Detector | No Activity Fault

1/6/2011 5:34:11 PM |Woodmen @ Raockrimmon
1/6/2011 5:34:11 PM [ Woodmen @ Rockrimmon

Pad | == w0 | e |

1/6/2011 5:34:11 PM | Woodmen @ Rackrimmeon \Veh Detector Veh Detector | Mo Activity Fault
1/6/2011 5:34:11 PM | Weodmen @ Rockrimmon Woodmen @ Rockrimman-7 | Veh Detector | Max Presence Fault
1/6/2011 5:34:11 PM | Woodmen @ Rackrimmeon Ped Detector Ped Detector | Mo Activity Fault

The first column shows the date and time at which the detector fault data was last polled
(the polling frequency is determined by the settings in the Polling Packet Editor

(page 20-50) and the Servers/Comms Configuration window (page 20-36). For each
faulted detector, this window also shows the signal name, the detector number (i.e., the
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Controller Reference number in the Entity Configuration for the detector), the detector
name (if any), the detector type, and the existing fault(s) for that detector.

You can sort this table by any column.

To update the list with the most current fault information, click Refresh. When a fault is
no longer being reported to the system by the controller, it is removed from this list.

To run the Detector Fault Status report (page 10-22), which is a printable view of the
existing detector faults, click Print.

Note e For a history of all detector faults that have occurred during a specific time range
(both existing and resolved faults), run the System Events report for all the “Detector” event
types (NTCIP controllers only), or run the Signal Detector Events report (NTCIP and ACT
controllers). Refer to System Events Report on page 10-51 or Signal Detector Events Report
on page 10-34.
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Dynamic Message Signs (DMS)

Using the DMS Status Display

The DMS Status display shows a graphical representation of the current status of a
dynamic message sign:

E] Sign @ Eastwood Transit Center - Eastwood @ Tuffnel (WariableMessageSign) @ [E

Display Summary

Current Message: Control Mode: Central
Runtime Priority: 1 Display Type: LED
Meszage Type: Changeable Valtage: 0
Message Dz 1 Lime Voltage: O

Stored Messages:

Permanent 55

Time

Last 01:15:46
Changeable: 35

Quick Message |l Elank Sign

For details, refer to page 9-7.

Viewing the Device Status Window

You can view the current communications status of all your DMS devices at once, using
the Device Status window. Refer to page 6-23.

DCMS

For information about the Autoscope Status display, refer to Chapter 17, Using DCMS for
Data Collection.

MMS

For information about the Status displays in the MMS module, refer to Chapter 19,
Managing Assets Using MMS.
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Viewing Overall Comm Statistics

The Comm Statistics window shows details about the current communications quality
between Centracs and each device. It shows statistics for the last 60 seconds.

Note e To get statistics about communications for a specific time period in the past, run
the Comm Statistics report (page 10-20).

These devices are not shown in the Comm Statistics window:

m Devices without any configured communication settings (on the Entity Configuration
window)

m Devices from external Server-to-Server systems

To launch the Comm Stats window and get current communications statistics:
1 From the main menu, select Monitoring » Comm Statistics...

2 To update the communications statistics, click Refresh.

D Comm Statistics

OX

Dievice

Ti

Failures  Comm Success % Last Fail Time Last Fail Emor _ Poll Success %

Poll Period Avg (ms)  Poll Time Avg (ms)  Subscrib

=5 Skyline Sign

10/6/2014 11:18:03 AM

0.0 10/6/2014 11:18:01 AM | Read timeout | 0.0 30000

| Controller 501

10/6/2014 11:18:03 AM

100.0 100.0 999 Split Monitor Collector

| Controller 503|

10/6/2014 11:18:03 AM

100.0 100.0 999

1 Controller 502,

10/6/2014 11:18:04 AM

100.0 100.0 1000

1 Controller 504]

10/6/2014 11:18:04 AM

2

64
64
64
64

e|el=]=[=

olalala|m

100.0 100.0 1000 signal Dialog

For each device, this window shows:
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Device — the name, as specified in the Entity Tree.
Timestamp — the date and time of the last refresh of these statistics.

Attempts — the total number of communication attempts made within the last 60
seconds.

Failures — the number of those attempts that failed.

Comm Success % — the calculated success rate percentage of all communications
(polling and non-polling comms) with this device within the last 60 seconds:

%

Comm Success

((Attempts - Failures) / Attempts) * 100

Last Fail Time — the date and time of the last communications failure to this device
(avaluein this field does not necessarily mean there is currently a failure; the Comm
Success % and Poll Success % columns show the current status of communications).

Last Fail Error — the type of error that occurred at the Last Fail Time.
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Poll Success % — the calculated success rate percentage of all polis to this device
within the last 60 seconds.

Poll Period Avg — the average time between polls to this device (in milliseconds)
within the last 60 seconds. The Primary Poll Rate specified for the device in Centracs
is the intended poll rate; the Poll Period Avg is an average of the actual poll rates for
the specified date/time range. Times are measured from the start of one poll to the
start of the next poll.

Poll Time Avg — the average time (in milliseconds) from when a poll was sent to
when the response was received, within the last 60 seconds.

Max Poll Time — the maximum time (in milliseconds) from when a poll was sent to
when the response was received, within the last 60 seconds.

Subscribers — shows which Centracs functions, if any, are currently requesting
priority polling for a device. For example, in the sample shown above, the
Subscribers column shows that at least one user has the Signal Status window open
for Controller 504, and that the Split Monitor Logging action is running for
Controller 501. Both of these functions use priority polling. For more information,
refer to Priority Poll Rate on page 20-42

Note e The Attempts, Failures, and Comm Success % values include both polling and
non-polling comms; the Poll Success % column is based on polling comms only. For more
information, refer to Overview of Polling Comms vs. Non-polling Comms on page 20-47.

To see more statistics for a device in the list, double-click it.

[=] Comm Statistics Details

Timestamp 100672014 11:15:03 AM
Poll Success Rate % 100.0

Comm Success Rate % 100.0

Last Fail Time

Last Fail Error

Subscribers

Poll Message Sent

Failed  Average Period

Average Elapsed  Missed

B

Last Failure Time

Primary 9597721

0003255

Success

1/1/0001 12:00:00 AM

DetectorDiagnostics 00:00:59,9853515

Success

1/1/0001 12:00:00 AM

Secondary 00:00:59,9853515

Success

1/1/0001 12:00:00 AM

This window shows per-poll message statistics for the last 60 seconds of activity. To
refresh the Details window, click Refresh on the main Comm Statistics window.

Note e Non-polling comms include commands sent to the device (to synchronize the
time, to upload/download controller settings, etc.). A number of non-poll attempts also
occur automatically when Centracs first establishes comms to a device.
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Viewing Comms on the Status Display

The Comms section of the Signal Status display (page 6-1), Autoscope Status display
(page 17-29), RTMS Status display (page 17-31), and DMS Status display (page 9-7) is a
summary of the communications status between Centracs and the selected field device.

Signal Status, DMS Status, RTMS Status Displays

The bar on top shows the calculated communication success rate for the device. The color
of the top bar indicates the overall communications status (green=good, yellow=marginal,
red=bad). Examples:

Comm success rate: 100.0 %
Last Updatie: 17:46:44

The Last Update field shows the time of the last poll.

The bar on the bottom is a five-segment bar that shows the most recent poll activity. Each
segment of the bar represents one poll. The right-most segment represents the most
recent poll. A green segment indicates a successful poll; a red segment indicates a failed
poll (i.e., no response was received, or the response was invalid); a yellow segment
indicates a missed poll (i.e., a poll was not doable within the poll period interval — maybe
an upload or download was in progress, the network was saturated, the CPU was
saturated, or the time-out value is set to be higher than the poll rate). In the example
below, comms are 100% (including polls), but Centracs was unable to do a poll in 3 of the
5 polling periods because significant bandwidth was needed to perform an upload of
tables for a signal controller on a serial channel:

The amount of time represented by the entire bottom bar depends on the poll period of
the device. For example, if the device is being polled once per second, the bar represents
the most recent five seconds of activity. If the device is being polled once per minute, the
bar represents the most recent five minutes (roughly) of activity — but each segment still
represents one second.
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You can hover the mouse pointer over any of the five segments to see details about that
individual poll. The details show the count of successful polls, failed polls, missed polls,
successful requests, and failed requests. (“Requests” are non-polling communications,
such as Get Time/Set Time commands.) For example:

37 seconds ago;
Succasstul Paolls;
Failed Polls:
Missed Polls:
Successful Requests:
Failed Requests:
Click te show graph

[=N == Ry ]

Note ¢ While you hold the mouse pointer over a segment, you suspend the updating
process for the five segments. When you move the mouse pointer away, it may take a few
seconds for the display to catch up.

The user-defined Primary Poll Rate or Priority Poll Rate determines the polling interval.
These poll rates are set on the Servers/Comms Configuration window (for an entire
channel; refer to page 20-36) or on the Device Communication Configuration window (for
a specific device; refer to page 3-44). For more information about priority polling, refer to
Priority Poll Rate on page 20-42.

To view the Comm Statistics Graph (page 6-56) for the selected device, click the bottom
bar.

On the Signal Status display only, to test the comms between Centracs and a signal
controller, click the top bar. For details, refer to page 6-16. (This option is not available for
DMS, RTMS, or Autoscope devices.)

If there is a communication problem, a message such as the one below is shown in the
message area at the bottom of the window:

4 Marginal Comms
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Autoscope Status Display

The bar on top shows the calculated communication success rate for the device. The color
of the top bar indicates the overall communications status (green=good, yellow=marginal,
red=bad). Examples:

The bar on the bottom shows whether the most recent status poll succeeded (green) or
failed (red).

For some device types, you can see additional information by holding your mouse pointer
over each bar:

Last poll Good
Last Update: 17:47.36

bottom Comms bar

Comm success rate: 100.0 %
d Last Update: 17-46:44

top Comms bar

The Last Update field shows the time of the last poll. The user-defined Primary Poll Rate
or Priority Poll Rate determines the polling interval. These poll rates are set on the
Servers/Comms Configuration window (for an entire channel; refer to page 20-36) or on
the Device Communication Configuration window (for a specific device; refer to

page 3-44). For more information about priority polling, refer to Priority Poll Rate on
page 20-42.

If there is a communication problem, a message such as the one below is shown in the
message area at the bottom of the window:

4 Marginal Comms
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Viewing the Comm Statistics Graph

In the Comms section of the Signal Status display (page 6-1), DMS Status display

(page 6-50), and RTMS Status display (page 17-31), click the bottom Comms bar to show
the new Comm Statistics Graph window. This window allows you to identify
communication problems more easily, as well as to identify trends in your
communications (for example, you may determine that system command failures are high
during certain times of the day).

This window has two modes:
m Real-Time: to view current communications information

m Historic: to view information for a specific time period in the past

[=] signal 5111 -

6-56
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On the left side of the window, you can select which of the six available graphs to show,
whether to show a legend on each graph, and whether to aggregate the data by second,
minute, hour, or day. (The Second interval is available only in Real-Time mode.)

The available graphs are:
m Health

m Data Usage

m  Poll Count

m  Poll Period

m Poll Length

m Retries Used

Each graph’s legend shows the types of data shown on that graph. You can hover the
mouse pointer over any bar on the graphs to see more details about that bar.

In Real-Time mode, you can use the Seconds field or the Seconds slider bar (at the top) to
specify the amount of time to show on each graph (between 1 and 3600 seconds). For
example, if you set the Seconds to 1800, each graph will show data for the most recent 30
minutes. A button in the upper right corner of the window allows you to pause or resume
updating the graphs in real-time.

In either mode, you can use the scroll wheel on your mouse to zoom in or out. While
zoomed in, use the slider bar below the graphs to move left or right along the X axis.

Note e In Historic mode, you can query a maximum of 3600 data points. If your selected
data range will return more than 3600 data points, the date/time range fields turn red. To
proceed, either limit the date range, or change your selection for the Interval option.
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Interpreting the Comm Stats Graph

Examples of the Comm Statistics Graph are shown below to help you interpret the data
you may see on your system.
Comm Scenario: Good Comms

This example shows good communications with a one-second primary poll rate to a
device:

[=] signal 18 - 31st 5t. & Fillmare B

= [

’ I Comm Success Rate
i Foll Success Rate

<R R

LN N 4

i Foll Bytes Sent

B Mon-Poll Bytes Sent

[¥] Poll Bytes Received

{l on-Poll Bytes Received
il Bytes Discarded

i Successful Polls
i Failed Polls
[ Missed Polls

JIJSEEEEEESEEREEEEREER

™Mil II
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Callouts on the Graph:

1 Thisareashows that both the communication success rate and the ability to poll in the
desired time period are at 100%. This is what you typically want to see.

2 This area shows that more poll bytes were sent and received in this period of time than
the surrounding times. This occurred because this device has multiple types of poll
messages of varying polling periods. In this case, there were primary, secondary, and
tertiary poll message transactions that occurred. This is confirmed by item 3 below.

3 Asmentioned initem 2, three poll messages occurred in this time period. When more
than one poll is indicated in the same polling interval, it usually means that they were
for different poll message types.

4 The scale on these graphs automatically adjusts, which can be confusing at times. The
large variance in the bars might give the impression that there is a large variance in the
poll period, but this graph actually shows a very small variance — plus or minus ~20
milliseconds for the 1000 millisecond poll period.

5 For the average poll time, a smaller time is usually better; but the time can be
impacted by a number of factors, including device type and comm infrastructure. The
poll time is measured from the time Centracs sends a poll request until the response
is received by Centracs. This example is for an Oasis signal controller over a 9600 baud
serial channel.
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Comm Scenario: Good Comms With Some Non-Poll Data

This example shows good communications along with a small amount non-polling comm
traffic:

[=] signal 18 - 31st 5t. & Fillmare [=I1ES

l I Comm Success Rate
- Poll Success Rate

[ Foll Bytes Sent

B Non-Poll Bytes Sent

g Poll Bytes Received

- Mon-Poll Bytes Received

B Successful Polls
) Failsd Polis

| ICsadu | LU LR NNNRRRANTLE ]

o |l |

b
4| 15| b

The circled area shows that there were two separate non-poll messages sent to the device
with some type of response received for each. The two bottom graphs (“Successful Polls”
and “Average Poll Period”) show that the non-poll messages had little to no impact on the
polling — no failed or missed polls are shown, and the average poll period at the time of
the non-poll messages is nearly identical to the poll period before and after the non-poll
messages.

Although this example shows no impact to polling, this is not always the case. Non-poll
messages can impact the ability of Centracs to maintain polling to a device — primarily
due to the type of message or the type of comm infrastructure.
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Comm Scenario: Delayed Poll Response

This device is being polled once per second. This example shows a poll that took
considerably longer to get back to Centracs; the response did, however, make it to
Centracs before the configured Device Timeout:

[] Signal 82 - HW 24 @ 21st 5t =]

il Comm Success Rate
il Foll Success Rate

mleleio) I ISIS IS IS IS

[l Foll Bytes Sent
B Mon-Poll Bytes Sent
[I¥] Poll Bytes Received
|| il Mon-Poll Bytes Received
il Bvtes Discarded

PS5 N

| [l Successful Polls
[ Failed Folls
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Callouts on the Graph:

1

D v A W N

This area shows that no message transaction occurred during this time period. This
does not indicate a failure — it only means that a send/response transaction did not
occur in that time period. This is also true for items 2 thru 5 below. This is a common
occurrence on systems with high poll periods.

No bytes were received in this time period.

A successful poll did not occur in this time period.
The poll period measurement is still in progress.
Same as item 4.

This area shows that the delayed response was large enough that the poll success rate
dropped. This only means that the poll was missed in the desired one-second time
frame — not that the poll failed. This missed poll also appears on the Status display as
a yellow block:

This area shows that there was a missed poll in a prior interval. In the current second
and the prior two seconds, only two polls were accomplished; therefore, the desired
poll rate of one poll per second was not met.

The delayed poll response impacted the average poll period.

This area shows that the poll time (send/response transaction) took over a second.
Some sort of delay occurred between the time the poll request was sent and the time
Centracs received the response.

Note that the scale changed dramatically due to the much larger poll time measured.
This scale change caused the normal poll response time bars to be very small and
difficult to see. Once the large bar shifts off the left side of the graph, the scale will
return to a range where you can see the other bars more easily.
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Comm Scenario: Single Failed Poll Response
This example shows a polling failure:

[=] Signal 82 - HW 24 @ 21st 5t. | =0

{* Real-Time

I

" Historic

’ - Comm Success Rate
- Poll Success Rate

sl Ne o} IR I IS I NG I

[ Foll Bytes Sent

B Non-Poll Bytes Sent

S Poll Bytes Received

. Mon-Foll Bytes Received
. Bytes Discarded

| [ Successful Polls
- Failed Polls

1
I [ Average Poll Time

B EEEBE
SEEEENEEN SESSESEEEENEEEEEEES

Callouts on the Graph:

1 The three areas noted with a “1” show that the system had nothing to compute
because it was waiting for a response.
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2 This area indicates a failed poll. This means that a response to a poll request was not
received within the Device Timeout period. The failed poll also appears on the Status
display as a red block:

Avyellow block also appears, due to a delayed poll response. And the failed poll caused
the overall Comms bar to drop to 92%.

3 The four areas noted with a “3” reflect the impact of no response to a poll packet.

In the first bar graph above, the Comm Success Rate (blue bar) is always either 0% or
100%. It indicates the percentage of successful comm transactions for the selected time
interval. A value of 0% means that no successful transactions occurred — either because
no transactions were attempted during the interval, or because the transaction took
longer to complete than the interval, or because the transaction failed to complete.
Because the Interval is set to “Second” in this example, and because it is uncommon to
have multiple transactions within one second, the bar will almost always show 0% or
100%. However, if you set the Interval to a larger time period, there will be more
transactions to average, and you will likely see values other than 0% or 100%. In the
example below, the Interval is set to “Minute”, and the value for the 15:52 minute is
roughly 70%:

[=] signal 82 - HW 24 @ 21st 5t =I1E

@ Comm Success Rate
| [ Poll Success Rate

il Foll Bytes Sent
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Comm Scenario: Several Bad Poll Responses Due to a Small Timeout Value
This example shows generally poor comms:

[=] signal 13 - 31st St. & Fillmore (=]

[ Comm Success Rate
[ Foll Success Rate
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Callouts on the Graph:
1 This area shows 10 failed poll messages.

2 The average poll times are roughly 120 msec. Because this is a relatively high number
for poll times, it is possible that the poll failures are occurring because the Device
Timeout value configured for the channel is not large enough to compensate for these
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higher poll times. In this example, the time it took the device to send a response over
a serial channel at 9600 baud was indeed sometimes greater than the programmed
Device Timeout value.

3 The two areas noted with a “3” show that three poll messages (primary, secondary,
and tertiary) were attempted within the selected Interval, and that two of those failed.
The Comm Success Rate and Poll Success Rate are 33%, which confirms that only one
of the three polls succeeded.

Note e This example shows the possible consequences of a small Device Timeout value,
whereas the next example shows the possible consequences of a large Device Timeout
value. For these reasons, it is important to configure the timeout value correctly.
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Comm Scenario: Good Comms With Periodic Interruptions to Polls
This example shows an interruption to the polling every 10 seconds (circled in orange):

[=] signal 202 Cellular - Main St. @ Centennial Bivd. (=]

mleleio) I ISIS IS IS IS

i
FIFIF

|
‘-. " _

14 b

|

In two of these cases, two polling cycles were missed; in the other case, only one poll was
missed.

Since there are no failed polls, the source of the problem is not likely to be the device or
a failure of the comm infrastructure. The device is simply not being polled — for some
reason, Centracs cannot request the poll packet at the desired rate. To diagnose this issue,
you must have knowledge of the comm infrastructure, and you must be aware of other
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activities occurring in Centracs. For example, if the device is on a serial channel (meaning
that it must share the line with other devices on that channel), determining what is
happening elsewhere on the shared serial channel would help you diagnose the source of
the problem.

In this particular example, research revealed the following diagnosis:

m There was a device on the same serial channel that was not responding to Centracs
(i.e., comms were failed).

m The configured Device Timeout value for the channel was very large (1500 msec).

m The period at which Centracs is programmed to retry communications to a failed
device was set at 10 seconds.

Although all three of these conditions contributed to the polling interruptions, the major
contributor was the failed comms to the other device. Because Centracs is required to
wait the entire timeout period for a device to respond, the channel remains inactive
during that time, which caused the missed polls. In this situation, the device with failed
comms should be set to Offline in Centracs on the Entity Configuration window (if it is
known that the device will not be communicating for a period of time); this would prevent
the failed device from degrading comms for other devices.

Note e This example shows the possible consequences of a large Device Timeout value,
whereas the previous example shows the possible consequences of a small Device Timeout
value. For these reasons, it is important to configure the timeout value correctly.
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Comm Scenario: Good Comms With Significant Interruptions to Polls
This example shows frequent interruptions to the polling:

[=] signal 202 Cellular - Main St. @ Centennial Bivd. (=]
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As with the prior example, since there are no failed polls, the source of the problem is not
likely to be the device or a failure of the comm infrastructure. The device is simply not
being polled.
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In this particular example, research revealed the following diagnosis:

m Someone had started a database upload from another device sharing the serial
channel with this device.

Itis important to understand that certain actions can impact the ability of Centracs to poll
at the desired rate.

The following example shows the Comm Stats Graph for the device where the database
upload is occurring — note the large amount of “Non-Poll Bytes Received” (dark blue
bars):

[=] signal 13 - 31st St. & Fillmore (=]
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Overview of Scheduling and Manual Commands

In addition to the signal-related commands that you can issue from the Status display, the
Entity Tree, and the Map Viewer, Centracs includes two other types of commands: manual
commands and schedule entries. You can configure these commands to run immediately
or in the future, you can give them an end time, and in the case of schedule entries, you
can set them to run repeatedly on a specific schedule.

There are two categories of actions that you can run via a schedule entry or manual
command:

m Instantaneous actions, or actions without any duration (for example, Time Broadcast)
m Actions with duration (for example, Set Pattern for 1 hour)

You can run many of the action types for an entire System, Section, Subsection, or Group
at the same time with one schedule entry or manual command.

Schedule Entries

You can use the Centracs scheduler to configure operations that need to be repeated on
afixed schedule — such as time broadcasts, controller log uploads, report generation, and
recipient enablement. With the scheduler, it is only necessary to define these recurring
commands one time. You can assign simple scheduling conditions (for example, the 1st of
each month at 9:00am) or complex scheduling conditions (for example, the 17th of
February, each hour on the hour from 9:00am until 9:00pm for 30 minutes at a time, if and
only if this day falls on a Monday or Friday and is not a holiday). After the command has
been saved and enabled, Centracs automatically runs the command as scheduled, with no
operator involvement.

Note e The Centracs scheduler is not to be confused with the local schedule that resides
on the field controllers.
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Manual Commands

Manual commands are temporary or one-time operations, such as archiving or restoring
Centracs log data. You can configure them to run immediately or in the future. For actions
with duration, you can assign an end time. You cannot set manual commands to repeat
(as you can with schedule entries).

Manual commands have a higher priority than schedule entries, and therefore have the
ability to override the scheduler.

Scheduling Confflicts

7-2

Free

Scheduling conflicts occur when multiple commands try to control the same signal at the
same time. For example, in the diagram below, this signal runs in Free mode (yellow)
unless otherwise commanded; but commands to run Pattern 2 at 8am and Pattern 3 at
5pm will conflict with the command that runs Pattern 1 from 4am until 9pm:

Pattern 1

Pattern 2 Pattern 3

3am Lam Qam 12pm 3pm Gpm 9pm 12am

pattern changes

And because you can assign a Signal to a Section, a Subsection, and any number of Groups,
very complex scheduling conflicts can arise. For example, suppose Signal 1 is in Section A
and also in the Football Game Group; if Pattern 3 is sent to Section A and Pattern 5 is sent
to the Football Game Group at the same time, which pattern takes precedence for Signal
1? To resolve such conflicts, Centracs considers these factors (in the order shown below):

1 the type of command sent (manual command, schedule entry, etc.)

2 the type of entity targeted by the command (System, Section, etc.)

3 entity parent priorities (configured on the Action Priorities window)

4 the type of recurrence assigned to the command (for schedule entries only)
5 the time of the command

Each of these factors is discussed below.

Type of Command

The modes of intersection control are ranked below, from highest priority to lowest
priority:

1 Manual command
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Schedule entry with High priority
Schedule entry with Normal priority

Traffic Responsive (TR) command

i A W N

Local time-of-day (TOD) plan

Note e Although you can change these rankings on the Action Priorities window
(page 20-4), it is highly recommended that you use the default values.

A manual command overrides any other type of command that acts on the same entity at
the same time.

All schedule entries are assigned a priority of Normal or High. If two entries are scheduled
to send commands to the same entity at the same time, the schedule entry with the
higher priority executes first. If they have the same priority, then the winner is determined
by the type of entity that was commanded. For details, refer to the next section.

Time-of-day (TOD) plans are configured locally on the controller. Control reverts to the
local TOD plan if the controller does not receive any commands from Centracs. This
usually occurs when there is a communications failure. This can also occur if the control
mode is Traffic Responsive, but sufficient detector data is not available to run in TR mode,
and no other control from Centracs is available.

In the diagram below, this signal runs in Free mode (yellow) unless otherwise
commanded. These conflicting commands are set to run during the day:

m The scheduler is set to run Pattern 3 with a High priority today from 3am until 9pm
B The scheduler is set to run Pattern 2 with a Normal priority from 5am until 11am

B A manual command is issued to run Pattern 1 between 1pm and 11pm

Free Pattern 3 - High priority - special event day

Patiem 2

Manual Command - Pattern 1

12am Fam Bam 9am 12pm FIpm GBpm 9pm 12am

4

pattern changes

Because High priority schedule entries take precedence over Normal priority entries,
Pattern 3 runs at 3am and Pattern 2 is ignored. Because manual commands take
precedence over schedule entries, Pattern 1 overrides Pattern 3 at 1pm and runs until
11pm. The signal goes back to Free mode at 11pm.
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12am

7-4

Section = Free
(Signals 1, 2, 3, 4)

Type of Entity

You can send intersection control commands to one intersection or to a collection of
intersections (a System, Section, Subsection, or Group). When scheduling conflicts arise
between different entity types, Centracs uses the entity hierarchy obeyed in the Entity
Tree to prioritize the commands — but in the opposite order. The entity types are ranked
below, from highest priority to lowest priority:

1 Signal (one intersection or device)

2 Group (multiple Signals, Sections, and/or Groups)
3 Subsection (multiple Signals)

4 Section (multiple Signals and/or Subsections)

5 System (all Signals, Sections, and Groups)

So in the example given earlier:

Signal 1 is in Section A and also in the Football Game Group; Pattern 3 is sent to Section
A and Pattern 5 is sent to the Football Game Group at the same time

the command for the Football Game Group would take precedence over the Section A
command. Signal 1 would run Pattern 5; any other Signals that are in Section A but NOT
in the Football Game Group would run Pattern 3.

For more information about the entity hierarchy, refer to Entity Types on page 3-2.

In the diagram below, Signals 1, 2, 3, and 4 are part of a Section; Signals 1 and 4 also belong
to a Group. The Section is scheduled to run Free unless otherwise commanded. At 6am,
two commands run which both affect Signal 1:

GI'CII.-I[] = Pattern 2
(signals 1 and 4)

Signal 1 = Pattern 1
3am Bam 9am 12pm 3Ipm Gpm 9pm 12am

Because a Signal command takes precedence over a Group command:
m Signal 1 runs Pattern 1 from 6am until 2pm

Because a Group command takes precedence over a Section command:
m Signal 4 runs Pattern 2 from 6am until 9pm

m Signal 1 runs Pattern 2 from 2pm until 9pm

m Signals 2 and 3 run in Free mode all day

Centracs User Manual
Software Version 2.x - March 2018



Schedule Entries, Manual Commands, and Action Sets

Scheduling Conflicts =

In the diagram below, the Signal and the Section have been reversed:

Signal 1 = Free

: Group = Pattern 2
Section = Pattern 1 P

12am Fam Bam 9am 12pm Fpm GBpm 9pm 12am

In this case, Signal 1 runs Free all day because the Section and Group commands are lower
priority than the Signal command.

Entity Parent Priorities

On the Action Priorities tab (under File P Settings), you can prioritize entity parents in the
Entity Tree; these priorities are then used to break “ties” when multiple commands are
attempting to act on the same entity at the same time. For more details, refer to Action
Priorities on page 20-4.

Type of Recurrence

When you define a schedule entry, you must specify how frequently the command will
repeat. The Recurrence type plays a role in resolving scheduling conflicts. The types are
ranked below, from highest priority to lowest priority:

1 No Recurrence
2 Yearly

3 Monthly

4 Weekly

5 Daily

In other words, if two schedule entries with the same priority are set to act on the same
entity at the same time, the command with the least frequent recurrence executes first.
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12am

In the diagram below, multiple conflicting commands are set to run on the same signal
with various recurrences:

Free

=

Daily - Pattern 4 | Daily - Pattern 4 Daily - Pattern 4

Weekly - Pattern 1 Weekly - Pattern 1

Monthly - Pattern 2

Yearly - Pattern 3

3am Bam 9am 12pm Ipm Gpm 9pm 12am

t p 4 p 74 4

pattern changes

In this case, the signal runs:

Free from 12am until 3am
Pattern 1 from 3am until 8am
Pattern 2 from 8am until 11am
Pattern 3 from 11am until 5pm
Pattern 2 from 5pm until 7pm
Pattern 1 from 7pm until 9pm
Pattern 4 from 9pm until 11pm

Free from 11pm until 12am

Time of Command

If a “tie” still exists between two commands, the most recent command wins. In the
graphic on page 7-2, at 8am, Pattern 1 and Pattern 2 are both set to be running; but
because Pattern 2 was issued after Pattern 1, Pattern 2 wins. To summarize this graphic:

Signal runs Free from 12am until 4am
Pattern 1 runs from 4am until 8am
Pattern 2 runs from 8am until 2pm
Pattern 1 runs again from 2pm until 5pm
Pattern 3 runs from 5pm until 11pm

Signal runs Free from 11pm until 12am
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Examples
As stated earlier, to resolve conflicts, Centracs considers these factors:

A. Type of command

B. Type of entity

C. Entity parent priorities
D. Type of recurrence

E. Time of command

The examples below show the outcomes when one command has a higher ‘type of
command’ and the other command has a higher ‘type of entity’, and when one command
has a higher ‘type of entity’ and the other command has a higher ‘type of recurrence’:

Example 1

Manual command Schedule entry
for a Section vS. for a Signal

Section manual

command runs

Example 2

Schedule entry with Schedule entry with
no recurrence VS. daily recurrence
for a Section for a Signal

Signal daily

command runs
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Issuing Manual Commands

To add a manual command:

Note ¢ To add a manual command for one specific entity, as an alternative to the
procedure below, right-click the entity in the Entity Tree or the Map Viewer and select
Manual Command... This eliminates a few steps and automatically populates the
Entities field for you.

1 From the main menu, select Control » Manual Commands... The Manual Commands
window opens, and shows any manual commands that are already defined but have
not run yet or are running now.

@ Manual Commands

| Add.. || Edt. || Copy. ||EndDelete |

[ Action | Targets | Start | End | Entered By |

2 Click Add... The Manual Command window opens.

(® Manual Command
Action
v D Display response window

Select an action...

Timing
Specify a date and time to start the action:

® Now

3/8/2018 09:08

Specify when the action should stop:
_) Don't stop

09:38

® Stop at._. | 3/8/2018
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3 Inthe Action dropdown, expand the available lists to find and select the correct
command or action set, as shown below. For details about each available action, refer
to Action Types on page A-1.

(® Manual Command

Action

v |:| Display response window

v DMS

¥ QOasis

# Common
Archive Logs Data
Change Section
Controller DB Download
Controller DB Upload
Database Maintenance
Generate Report
Preempt
Set Pattern
Set Time
Signal Change Logging
Signal Upload and Compare
Special Function
Split Monitor Logging
Time Broadcast
Time Drift Check
Traffic Algorithms
Upload Controller Logs
Upload MOE Logs

¥ W4

¥ Action Sets

:ict an action...

If you have DMS entities, Oasis controllers, and W4 controllers configured in the Entity
Tree, action groups for DMS, Oasis, and W4 will also be available in the list, in addition
to the Common list of actions.

Note e There must be at least one action set defined in the system in order to see the
Action Sets list. Refer to Running Action Sets on page 7-21.

4 Complete the parameters for the action you selected. For details about each available
action, refer to Action Types on page A-1.

5 Optionally, enable the “Display response window” checkbox to see status details
about the command as it runs. (The type of details shown depends on the Action type.)

6 If the Timing section of the window is not already expanded, click the plus/minus sign.

7 Specify the date and time of day (in 24-hour HH:MM format) at which the command
must run, or select the Now option if the command must run immediately. In the date
fields, you can type the date, or you can click the arrow to pull down a calendar and
select the date.
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8 For some actions, you must also specify when the command must stop:
® You can select “Don’t stop” to run the command indefinitely.

® You can select “Stop in...” and specify the duration of the command in minutes or
hours.

® You can select “Stop at...” and specify the date and time at which the command will
be stopped.

9 To save the command, click OK.

The new command is shown in the Manual Commands table. After the command
completes, it is automatically removed from the table.

@ Manual Commands

| Add... || Edi... || Copy... || End.rnelete|

[ Action | Targets [ start [ End | Entered by
Set Pattern to 1 Section Morth Colorado Springs 3/8/2018 14:29:37  No End

Note ¢ When you define a new Set Time or Time Broadcast manual command with a
specific start time, the system automatically adds 30 seconds to the start time. The system
does this to avoid potentially skipping or duplicating commands that run at the top of the
minute.

To change a manual command:
1 From the Manual Commands list, click the command to change, then click Edit...

2 On the Manual Command window, make the necessary changes and click OK.

Note e After a manual command has been saved, you cannot change the Action field.

To delete or stop a manual command:
1 From the Manual Commands list, click the command to remove or stop, then click
End/Delete.

2 If you are asked to confirm the deletion, click Yes. The command is removed from the

list of manual commands, and if the command is running, it is stopped immediately.

To copy a manual command:
1 From the Manual Commands list, click the command to copy, then click Copy...

2 Onthe Manual Command window, make any necessary changes and click OK. The
copy is saved as a new command in the list.
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Using the Scheduler

Note e Before you use the scheduler for the first time, please read Overview of Scheduling

and Manual Commands on page 7-1.

To add a new schedule entry:

1 From the main menu, select Control » Scheduler... The Scheduler Entries window

opens, and shows any schedule entries that have already been added.

(® Scheduler Entries

Add... || Edit.. || Copy... || Delete |

| Name I Range Start I Range End I Start I End I Recurrence I Action I Enabled I Targets I Priority I Entered By |

2 Click Add. The New Schedule Entry window opens.

(® New Schedule Entry

v Enabled

Select an action...

Recurrence

Priority
® Normal O High

Range

Start: | 3/8/2018
End: |3/8/2018 [] Noend

|:| Repeat every year

Times

Start 1335 |
End:

Recurs every week on the following days

) Daily

Bk ae [] Sunday [v] Monday Tuesday Wednesday [v| Thursday Friday [ | Saturday
| All Days ‘ | Weekdays | ‘ Weekends | ‘ Clear All |

o Weekly
! Monthly
) Yearly

> | Exceptions

3 Enter a unique name for this schedule entry in the Entry Name field.
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4

In the Action dropdown, expand the available lists to find and select the correct
command or action set, as shown below. For details about each available action, refer
to Action Types on page A-1.

@® New Schedule Entry

7-12

Entry Name: |Generate Daily System Activity Report | Priority =
- ® Normal ) High
Range

Generate Report v | [v| Enabled
Archive Logs Data
Change Section i
Controller DB Download '|
Controller DB Upload
Database Maintenance
Preempt

Set Pattern

Set Time

Signal Change Logging

Signal Upload and Compare

Special Function

Split Monitor Logging

Time Broadcast

Time Drift Check

Traffic Algorithms

Upload Controller Logs

Upload MOE Logs
» Action Sets

® Weekly | "

Format:

Start: | 3/8/2018
End: | 3/8/2018 [] Noend

|:| Repeat every year

Email Recipient:

Times

Start:

Save To:

I (=

on the following days:

flonday Tuesday Wednesday IE‘ Thursday Friday |:| Saturday
| Weekdays | | Weekends | | Clear All |

[AIrDEys

If you have Oasis controllers, W4 controllers, and DMS entities configured in the Entity
Tree, action groups for Oasis, W4, and DMS will also be available in the list, in addition
to the Common list of actions.

There must be at least one action set defined in Centracs in order to see the Action
Sets list. Refer to Running Action Sets on page 7-21.

Complete the parameters for the action you selected. For details about each available
action, refer to Action Types on page A-1.

For this schedule entry to be active immediately, check the Enable checkbox; for the
schedule entry to be disabled temporarily, uncheck the Enable checkbox.

To cause this schedule entry to take precedence over another schedule entry that runs
at the same time for the same entity(ies), set the Priority to High; otherwise, leave it
set to Normal. For detailed information on how Centracs prioritizes commands and
resolves conflicts between competing commands, refer to Overview of Scheduling
and Manual Commands on page 7-1.

In the Range box, specify the first and last days on which this schedule entry will run.
Optionally, you can check the “No end” checkbox to run the command indefinitely. In
the Start and End fields, you can type the date, or you can click the arrow to pull down
a calendar and select the date.

For schedule entries with an End date, you can optionally enable the “Repeat every
year” checkbox to cause the command to run during the same date range each year.
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10 In the Times box, specify the time of day at which the command will run, in 24-hour
HH:MM format. The command will run at the specified Start time on each day that it
occurs.

11 If the action you specified for your schedule entry is an action with duration (for
example, Set Pattern), specify the time at which the command must be stopped, in 24-
hour HH:MM format. For example, you can set a pattern for only specific hours each
day.

If you enter an End time that is less than the Start time, Centracs shows the message
“On Next Day” to the right of the End time to indicate that the command will start on
one day and stop on another day:

Times

Start: 13:35

End: |00:30 | On Next Day

For actions without duration (such as Set Time), the End time field is hidden from view.

12 In the Recurrence box, specify how frequently the command will run. There are five
recurrence options:

None

The command will run one time only, and then be removed from the schedule. This
option is essentially the same as a manual command.

Daily
The command will run one or more times per day, for each day in the specified date
range.
Recurrence
Recurs every day between the start and end times, as follows:
None .
@ Daily Once (starting at 13:35)

Weekly - Every [0~| hours and |30~| minutes

Monthly

Yearly

There are two Daily options:

® Once — The command will run one time per day for each day in the specified date
range.

® Every xx hours... — The command will repeat throughout the day at a specified
interval. For example, you can configure the action to run each hour on the hour. If
the action you specified for your schedule entry is an action with duration (for
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example, Set Pattern), you must also specify how long the command will run each
time, in hours and minutes. For actions without duration (such as Set Time), the
“with each occurrence lasting” fields are hidden from view.

Weekly

The command will run one or more times a week.

Recurs every week on the following days:

BT [ ] Sunday [«] Monday Tuesday Wednesday [v| Thursday Friday [ | Saturday

- Daily | All Days | | Weekdays | | Weekends | | Clear All |
® Weekly

Maonthly
Yearly

For each week in the specified date range, the command will run one time per day on
the specified days of the week. To quickly select or deselect groups of days, you can
use the All Days, Weekdays, Weekends, and Clear All options.

Monthly

For each month in the specified date range, the command will run one time per day
on the specified day(s) of the month.

Recurs every month on the following day(s):

Last Wednesda

Daily <|[1-

Weekly
® Monthly

Yearly

None

A

Last~ ” Wednesday =

| Remove All || Remove |

Use the dropdown lists to select one day or to make a list of days. Use the first
dropdown to select specific days of the month by number (such as the 1st of the
month); use the second and third dropdowns to select a specific weekday in a specific

week (such as the fourth Friday of each month). Click | 5] to move each selected day to
the “Recurs every month” list; you can also click Remove to remove a day from the
list, or Remove All to start over. You can use one or both of these methods to specify
multiple days. The days are shown in the order in which you add them.
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Yearly

For each year in the specified date range, the command will run one time per day on
the specified day(s) of the year.

Recurs on ‘[None] ,‘
) None and |January 12 - SEgS M T W T F 5§
i Lt onday nJanua, for 1 52015 (N it i KRR TR R T
) Weekly ‘Lasl vHMondayv‘ in |.January v‘ for ‘2 v‘ day(s)
) Monthly
® Yearly
| Remove All || Remove |

There are two ways to select days (each is notated on the sample window above):

® Day of year — Use the two dropdowns to specify the month and the day number
(such as January 1st). If the command must run on this day only if it occurs on
specific days of the week, check the appropriate day checkbox(es) (Sunday,
Monday, Tuesday, Wednesday, Thursday, Friday, Saturday).

® Day of month — Use the first three dropdowns to specify the week, day, and month
(for example, the last Monday in May). If the command must run on multiple
consecutive days, you can specify this in the last dropdown.

Click 2] to move each selected day to the list; you can also click Remove to remove a
day from the list, or Remove All to start over. You can use one or both of these
methods to specify multiple days. The days are shown in the order in which you add
them.

You can also include a previously defined day or set of days from the “Recurs on”
dropdown list. These sets of days are defined on the Holiday/Special Days Editor
(page 7-18).

13 To enter any exceptions to this schedule entry, such as holidays or vacation days,
expand the “Exceptions” section of the window (as shown below).

Except on ||"~.IewYear’s Day v|
EL L January 1 if -MTWTF- ‘J || | S M T WT F 8§
anuary ~||1 - lfD
v []
‘Firs v||Tut-1s.day"‘ in ‘January v| for ‘1 v| day(s)

Remaove All H Remove |

14 Specify any days or dates on which the command must not run. You can select a
previously defined day or set of days from the “Except on” dropdown list. These sets
of days are defined on the Holiday/Special Days Editor (page 7-18).

Centracs User Manual 7-15
Software Version 2.x - March 2018



Schedule Entries, Manual Commands, and Action Sets

= Using the Scheduler

You can also use one or more of the methods below to select days (each is notated on
the sample window above):

® Day of year — Use the dropdowns to specify the month and day number of a fixed
exception day that occurs on the same date each year (for example, New Year’s Day
is always January 1st). If this day must be considered an exception day only if it
occurs on specific days of the week, check the appropriate day checkbox(es)
(Sunday, Monday, Tuesday, Wednesday, Thursday, Friday, Saturday).

® Day of month — Use the dropdowns to specify the week, day, and month of a
floating exception day whose date changes from year to year (for example,
Thanksgiving is always the third Thursday in November). If the exception includes
multiple consecutive days, you can specify this in the Days dropdown.

® Date — Use the pull-down calendar (or type over the current date) to specify the
date of a one-time exception day, such as a major sporting event.

Click L= to move the day you specified to the list.

You can use any combination of these methods to specify multiple exception days. The
days are shown in the order in which you add them, not in date order.

Toremove one or more days that you added to the list, click the day and click Remove,
or click Remove All to start over.

15 To save your settings, click OK. Your new entry is now shown in the Scheduler Entries
table.

Note ¢ When you define a new Set Time or Time Broadcast command with a specific start
time, the system automatically adds 30 seconds to the start time. The system does this to
avoid potentially skipping or duplicating commands that run at the top of the minute.
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To change a schedule entry:
1 From the main menu, select Control » Scheduler...

2 From the Scheduler Entries list, click the command to change, then click Edit...

3 On the New Schedule Entry window, make the necessary changes and click OK.

To delete or stop a schedule entry:
1 From the main menu, select Control » Scheduler...

2 From the Scheduler Entries list, click a command, then click Delete.
3 If you are asked to confirm the deletion, click Yes. The command is removed from the

schedule, and if the command is running, it is stopped immediately.

To copy a schedule entry:
1 From the main menu, select Control » Scheduler...

2 From the Scheduler Entries list, click the command to copy, then click Copy...

3 Onthe New Schedule Entry window, make any necessary changes and click OK. The
copy is saved as a new entry in the schedule.

To disable or enable a schedule entry:

1 From the main menu, select Control » Scheduler...

2 From the Scheduler Entries list, in the Enabled column, click the checkbox for the
appropriate schedule entry to toggle the setting:

® checked = the schedule entry is active and will run as scheduled

® unchecked = the schedule entry is disabled and will not run

Centracs User Manual 7-17
Software Version 2.x - March 2018



Schedule Entries, Manual Commands, and Action Sets

= Specifying Holidays and Special Days

Specifying Holidays and Special Days
Use the Holiday/Special Days Editor to specify:

B Any exceptions to the normal schedule, such as federal holidays and major local
events. These days can then be selected as exceptions when you add a new schedule
entry (page 7-11).

® Any day or set of days to use as the basis for a new schedule entry that occurs yearly.

To add a new holiday or special day:

1 From the main menu, select Control » Holiday/Special Days... The Holiday/Special
Days Editor window opens.

[ Holiday/Special Days Editor ] 4

Mew Year's Day
Christmas Day

Thanksgiving MNew Year's Day

The left side of the window shows the days that have already been defined in the
system.

2 Click New... An empty record is shown.

[=] Holiday/Special Days Editor =1

Mew Year's Day
Christmas Day

Thanksgiving ——

ganuay  v|1 ]

Day of month Fost < [suany ] i ]

3 On the right side of the window, enter a unique name for the day (or group of days),
and optionally, a description. The name you assign here will be shown in the
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Exceptions dropdown and the Recurs On dropdown (for Yearly recurrences) when you
add a schedule entry.

4 Use the Days field to select one or more days. There are three ways to populate the
Days list (each is notated on the sample window above):

® Day of year — Use the dropdowns to specify the month and day number of a fixed
special day that occurs on the same date each year (for example, New Year’s Day is
always January 1st). If this day must be considered a special day only if it occurs on
specific days of the week, check the appropriate day checkbox(es) (Sunday,
Monday, Tuesday, Wednesday, Thursday, Friday, Saturday).

® Day of month — Use the dropdowns to specify the week, day, and month of a
floating special day whose date changes from year to year (for example,
Thanksgiving is always the third Thursday in November). If this is a multi-day
holiday, you can specify this in the Days dropdown.

® Date — Use the pull-down calendar (or type over the current date) to specify the
date of a one-time special day, such as a major sporting event.

Click E to move the day you specified to the Days list.

You can use any combination of these methods to specify multiple special days. The
days are shown in the order in which you add them, not in date order. In the example
below, all federal holidays are specified in one set. This is useful in the scheduler to
select all special days at one time.

To remove one or more days that you added to the Days list, click the day and click
Remove, or click Remove All to start over.

[=] Holiday/Special Days Editor

Mew Year's Day
Christmas Day
Thanksgiving

Foothall Game - Cctober
Mew Years Eve

All Holidays

5 Click Save.
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Mame: All Holidays
Description: Al federal holidays

Days:

January 1

Third Monday in January for 1 day(s)
Third Monday in February for 1 day(s)
Last Monday in May for 1 day(s)

July 3 if ——F-
July 4

B
July 5 -M——

=15

SMTWTFS

1

First Monday in September for 1 day(s) E [Firsi

- I Sunday

v]in[.lanuan'I - ]fur[1 v]Days

Second Monday in October for 1 day(s)
Third Thursday in Movember for 2 day(s)
December 24 if -—-F-

December 25

December 28 if -M-——

10/06/2012 )+

December 31 if -—-F-
January 2 if -M-—-
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Example - Thanksgiving

[=] Holiday/Special Days Editor 8

Mew Year's Day
Christmas Day -
ET =R Thanksgiving
Football Game - October - - ;
New Years Eve Thanksgiving holiday - Thursday & Friday
All Holidays

Third Thursday in Movember for 2 day(s

[January |1~

Fist_ v|sunday  <|inlyanuary v ior[1 ]

Example - Major Sporting Event

[=] Holiday/Special Days Editor = 11E|

Ne\l}r Year's Day

o Faotball Game - Cctober
New Years Eve Red River Rivalry

All Holidays

Janary <1 -]
Pt v|sunday -] b~

o

Example - New Year’s Eve

[=] Holiday/Special Days Editor =116

Mew Year's Day

Christmas Day

Thanksgiving Mew Years Eve

Football Game - Cctober

Mew Years Eve For years when MNew Year's Day falls on a Saturday

All Holidays
January 31 if —-F-

danuary v |1~

Fist~[Swntay < Jin[samiary__~Jior(1 ]
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Running Action Sets

Manual commands and schedule entries usually contain one action, but they can also run
compound actions, known in Centracs as “action sets”.

An action set is a series of user-configurable actions that can all be kicked off at the same
time (or sequentially) by one command. For example, to generate the System Activity
report, the User Login report, and the Alerts Log each night at midnight, you can add an
action set that contains these three actions. This eliminates the need to add multiple
commands, and as a result, you can work more efficiently.

After an action set has been added, you can choose it by name as the action in a manual
command (page 7-8) or schedule entry (page 7-11).

To add an action set:
1 From the main menu, select Configuration » Action Sets... The Action Sets window

opens.

MName Cescription Actions

Run Daily Reperts | Run daily reports and email PDFs to supervisor |3 |

2 Click Add. The Action Set Editor window opens.

[=] Action Set Editor (=1

@ Simultaneous
When the action set is run, all actions are executed 3t the same tima.

() Timed
Actions in the action set are run at s=t fimes offset relative to the start of the sction s=t. This mode can be used for routs preemption, for example.

Entities

3 Enter a unique name for the action set, and optionally, a description. The name you
assign to the action set will be shown in the Action dropdown when you add a manual
command or schedule entry.
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4 Click Add. The Action Set - Edit Action window opens.

[—] Action Set - Edit Action [=I1ES

Note e The DMS, Oasis, and W4 action groups are shown only if you have DMS
entities, Oasis controllers, and W4 controllers configured in the system.

5 Inthe Action dropdown list, expand the available lists of actions and select the action
to add to the action set. For details about each available action, refer to Action Types
on page A-1.

6 Complete the parameters for the action you selected, then click OK. For details about
each available action, refer to Action Types on page A-1.

7 To configure all the actions for the action set, repeat steps 4 through 6.

[ Action Set Editor [=]]E

Check Confrollers
Compare time & settings on confrollers with Cenfracs server

Description Entifies

Time Drift Check Check if device clock is drifting. & Colorade Springs

Signal Uplead and Compare | Upload controller database and compare to local copy. & Colorade Springs

Generate Report Schedule a repert to be generated.
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8 Tocause all actions to run at the same time, leave the “Simultaneous” radio button on
and go to the next step.

Or

To cause the actions to run in a specific order, turn on the “Timed” radio button. Three
more columns are added to the window:

(-] Action Set Editor =114

MHame Check Controllers

Description Compare time & settings on confrollers with Centracs server

1 Simultaneous
When the action st is run, all actions are executed at the same time.

@ Timed
Actions in the action set are run at s=t times offset relative to the start of the action s2t. This mode can be usad for route preemgtion, for example.

MName Description Entities Offset (sec) Duration {sec) Check Time - preempt only (sec)
Time Drift Check Check if device clock is t@ Color:

Signal Upload and Com| Upload controller datak P{ Color:

Generate Report Schedule a report to be

Click in the Offset and Duration boxes and enter values for each action. Duration
specifies how long the action will run; Offset specifies how long after the start of the
action set the individual action will start.

9 Click OK. A list of all the action sets is shown.

[5) Action Sets @

Mame Description Actions
Check Controllers Compare time & settings on controllers with Centracs server |3
Run Daily Reports Run daily reports and email PDFs to supervisor 3

The newly added action set is now eligible to be run by the scheduler or a manual
command.
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To change an action set:
1 From the main menu, select Configuration » Action Sets... The Action Sets window
opens.

[5) Action Sets @

Mame Description Actions
Check Controllers Compare time & settings on controllers with Centracs server |3

Run Daily Reports Run daily reports and email PDFs to supervisor 3

2 click the action set to change, then click Edit. The Action Set Editor window opens.

(-] Action Set Editor [=]]

MHame Check Confrollers

Descripfion Compare fime & settings on confrollers with Cenfracs server

(@ Simultaneous
When the action st is run, all actions are executed at the same time.

() Timed
Achions in the action set are run at 5=t times offset relative to the start of the acbion set. This mode can be used for route preemgtion, for example.

MName Drescription Entities
Time Drift Check Check if device clock is drifting. t@ Colorade Springs

Signal Upload and Compare | Upload controller database and compare to local copy. | 4 Colorado Springs

Generate Report Schedule a report to be generated.

3 Make the necessary changes to the action set:
® You can change the name and/or description on this window.
® To include more actions in the action set, click Add, add the action(s), and click OK.

® To change an action associated with the action set, click the action, click Edit, make
your changes, and click OK.

® To delete an action from the action set, click the action, then click Delete.

4 To save all changes, click OK.
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To delete an action set:
1 From the main menu, select Configuration » Action Sets... The Action Sets window

opens.

Mame
Check Contraollers

Degcription

Compare time & settings on controllers with Centracs server

Actions

3

Run Daily Reports

Run daily reperts and email PDFs to supervisor

3

2 click the action set to remove and click Delete.

3 If you are asked to confirm the deletion, click Yes.

Note e If any schedule entries or manual commands contain the action set to be

deleted, you are given a warning that if you continue, the associated schedule entries
and/or manual commands will also be deleted. If necessary, you can cancel the deletion

at this point.
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User Selection / Recipient and Role Selection

7-26

When you define a “CCTV Preset”, “CCTV Tour”, or “Generate Report” action (in a manual
command, schedule entry, trigger, or action set), you use either the User Selection or
Recipient and Role Selection window to specify the users for whom the CCTV preset or
tour will be shown, to whom the report will be emailed, etc. Depending on the type of
action, Centracs decides which of these two windows to use. The only differences are:

m The User Selection window lists all users defined on the User Configuration window

(page 20-24).

The Recipient and Role Selection window lists all recipients defined on the Recipient
window (page 20-73), plus all roles defined on the User Roles window (page 20-23),
plus all user groups defined on the User Groups window (page 20-30). If you select a
role or user group, all users who are assigned to that role or group will be associated
with this action (i.e., the preset, report, etc. that you are defining). User groups are
shown at the top of the Available list, roles are shown next, and recipients are shown
at the bottom.

To select one or more users/recipients/roles:
1 Onthe User Selection or Recipient and Role Selection window:

E User Selection

Bill Lumbergh

Forrest Lawrenceton
George Michael Bluth
Gob Bluth
Michael Bolton
Ir Manfredjensenjen

[=] Recipient and Role Selection

Tech Group 1
Tech Group 2
Administrator
Technician
Eill Lumbergh

Forrest Lawrenceton
George Michael Bluth
Gob Bluth

Michael Bolton

Mr Manfredjensenjen
Peggy Hill

Phil Dunphy

Randall 'Pink' Floyd
Sue Sylvester

Trudy Wiegel

User Groups

User Roles

select one or more users/recipients/roles in the “Available” side of the window. To
select multiple items at a time, hold the Ctrl or Shift key while you select them, or to
select all, press Ctrl-A.

After you have made your selections, click [ to move them to the “Selected” side of
the window, and click OK.
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Note e Forinformation about Autoscope cameras used as vehicle detectors, refer to Using
DCMS for Data Collection on page 17-1.

Overview of CCTV

CCTV (Closed-Circuit TeleVision) is a video camera monitoring system that broadcasts a
signal to one or more specific monitors (as opposed to a public broadcast). You can use
the CCTV features in Centracs to see intersections and field devices via live video streams.
You can show more than one video display at the same time, and you can dock them in
containers like any other Centracs window. When configured, each camera is shown as an
icon on the Map Viewer and in the Entity Tree for easy on-demand access. Specific camera
views (called “presets”) can be configured to automatically launch if a specific event
occurs. You can also launch presets by manual commands and schedule entries.

In addition to manual, real-time control of cameras in Centracs, you have the option to
digitally archive video streams to permanent storage on a disk drive via the Genetec
Omnicast user interface. This feature is flexible:

m you can schedule archiving during specific times of the day
m  movement in the video frame can activate it
® an alarm input can activate it

Centracs supports Autoscope cameras as well as cameras from vendors such as Axis, Cohu,
ACTi, VCS, and Pelco. If supported by the camera type, Centracs includes PTZ (pan, tilt, and
zoom) capabilities to control the camera position.
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CCTV Setup

Before you can use the CCTV features, these configuration steps must be completed:

Task Description

1

Initial setup The system administrator must install the redistributables/
runtimes for your camera type on the client machine (e.g.,
Axis runtimes for Axis cameras, Cohu runtimes for Cohu
cameras, Genetec runtimes for Advanced CCTV, VLC Media
Player for Generic or Autoscope Terra, etc.).

For Advanced CCTV, the system administrator must also
set up communications to the Genetec server. Refer to
Configuring the Advanced CCTV Feature on page 20-64.

Add CCTVs to the Entity This supplies details to Centracs about the individual
Tree camera devices. Optionally, you can also specify locations
for the devices on the map, and configure how Centracs
shows them on the map. Refer to Entity Configuration -
CCTVs on page 3-65 and Editing the Map View on
page 5-18.

Define preset camera  Optional. This is necessary in order to use the preset
views features. Refer to Defining and Maintaining Presets on
page 8-6.

Define camera tours Optional. This is necessary in order to use the tours
features. Refer to Using CCTV Tours on page 8-13.

Automatically Launched Presets

You can configure CCTV presets to launch automatically as the result of a trigger, a
schedule entry, or a manual command. When a preset is about to launch automatically,
the prompt shown below opens. To show the preset, click Yes, or to cancel it, click No.

& Run COTY Preset?

Note e Presets launched automatically are view-only — you cannot pan, zoom, or tilt
them, or change to a different preset.

8-2

Centracs User Manual
Software Version 2.x - March 2018



Using CCTV Displays

Showing a Live Camera Feed =

Showing a Live Camera Feed

From the Entity Tree
» Double-click a CCTV entity in the tree.
A real-time video display from that camera is shown in a new window.

For instructions on how to set up CCTV entities in the tree, refer to Entity
Configuration - CCTVs on page 3-65.

From the Map Viewer

There are two ways to launch a video display from the Map Viewer — the first opens a
view-only window, and the second opens a window that you can pan, zoom, resize, etc.

» Hold your mouse pointer over the CCTV icon on the map (shown below).

E] Map Viewer A @@

E Kiowa 51

Pty e

E Pikes Peak

i g

A real-time video display from that camera is shown in a new window. This display is
view-only.

Or
» Double-click the CCTV icon on the map.

A real-time video display from that camera is shown in a new window. You can pan,
tilt, zoom, and resize this display (page 8-4), you can set presets (page 8-6), you can
launch presets (page 8-10), and you can configure and launch tours (page 8-13).

For details on how to add CCTV icons to the map, refer to Editing the Map View on
page 5-18.

Note ¢ To change the size of the video display, use the CctvTooltipWidthPx and
CctvTooltipHeightPx Local/Global Settings. For more information, refer to Viewing and
Editing Global and Local Settings on page 20-61.
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Moving a Camera View

8-4

With the video displays in Centracs, you can pan the camera left and right, tilt it up and
down, and zoom in and out.

Note e These procedures cannot be used for CCTV entities that have a Source Type of
Generic or Autoscope Terra. Refer to Entity Configuration - CCTVs on page 3-65.

To zoom the video display in or out:
1 Launch the video display from the Entity Tree or the Map Viewer. Refer to Showing a
Live Camera Feed on page 8-3.

2 Roll your mouse wheel forward to zoom in, or backwards to zoom out.

To tilt the camera up or down, or pan the camera sideways:
1 Launch the video display from the Entity Tree or the Map Viewer. Refer to Showing a
Live Camera Feed on page 8-3.

2 click the display in the direction you want to move the camera — in relation to the
center-point of the display — and hold until the correct position is reached. For
example, to move the camera down, click directly below the center-point and hold.

The distance between the mouse pointer and the center-point determines how fast
the camera moves. If you click close to the center-point, the camera moves slowly; if
you click close to the edge of the display, the camera moves quickly. The examples
below demonstrate this.

(<] comvi-4s (E] (] (=] cctvi-4s (3] (<] (<] comvi-4s (E] (]

slowly pans right quickly pans right quickly pans left
and tilts up and tilts up and tilts down

To save a snapshot of the camera view:

Note e This procedure cannot be used for CCTV entities that have a Source Type of
Generic, Autoscope Terra, or Axis. Refer to Entity Configuration - CCTVs on page 3-65.

1 Launch the video display from the Entity Tree or the Map Viewer. Refer to Showing a
Live Camera Feed on page 8-3.

2 Pan, tilt, and/or zoom the video display as necessary.
3 Right-click the display and select Snapshot. A “Save As” window opens.

4 Specify a filename and location for the saved snapshot, then click Save.
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A snapshot of the camera view is saved to a file in JPEG format. You can open this file
in most third-party graphics applications.
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Defining and Maintaining Presets

8-6

For some camera types (such as Axis), preset views are defined on the Genetec server; for
ACTi, Cohu, and Advanced CCTV, presets are defined in Centracs. Saved presets are
available to all users.

Note e These procedures cannot be used for CCTV entities that have a Source Type of
Generic, Autoscope Terra, or Axis. Refer to Entity Configuration - CCTVs on page 3-65.

To define presets 1 through 10:

1

4

Launch the video display from the Entity Tree or the Map Viewer. Refer to Showing a
Live Camera Feed on page 8-3.

Pan, tilt, and/or zoom the video display as necessary. Refer to Moving a Camera View
on page 8-4.

Right-click the display and select Set Preset.

The sub-menu below is shown.

Stop

Snapshot

Go to Preset

Set et Presst 1

Preset Configuration._.. Preset 2
Preset 3
Preset 4
Preset 5
Preset 6
Preset 7
Preset §
Preset 9

Preset 10

Preset (n)...

Select the preset number to assign to this view.

IMPORTANT e If the preset number you choose is already assigned to a different
view, the prior view is replaced with the new view, without warning from the
system.

The new preset is now available for use in manual commands, schedule entries, action
sets, and triggers.
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Note ¢ Tochange apresetview, simply define it again. When you save it with the same
preset name, the old view is replaced with the new view.

To define more presets (after the first ten):

1 Pan, tilt, and/or zoom the video display as necessary. Refer to Moving a Camera View
on page 8-4.

2 Right-click the display and select Set Preset.

The sub-menu below is shown.

Stop

Snapshot

Go to Preset

et Preset Preset 1

Preset Configuration._.. Preset 2
Preset 3
Preset 4
Preset 5
Preset 6
Preset 7
Preset §
Preset 9
Preset 10

Preset (n)...

3 Select the Preset (n)... option. The Preset Selection window opens.

(=] Presst Selection [=]1E

Presets

Preset 2
Preset 3
Preset 4
Preset 5
Preset 6
Preset 7
Preset &
Preset @
Preset 10
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4 For ACTi and Cohu cameras, if you click the last line and then click OK, a new preset is
added with the next available number (in this case, Preset 11). Alternatively, you can
double-click the last line and type a unique name for the new preset, then click OK.

For Advanced CCTV, the list shows 256 possible presets. Select the preset number to
assign to this view.

The new preset is now available for use in manual commands, schedule entries, action
sets, and triggers.

To rename a preset (ACTi and Cohu only):
1 Launch the video display from the Entity Tree or the Map Viewer. Refer to Showing a
Live Camera Feed on page 8-3.

2 Right-click the display and select Preset Configuration... The Preset Selection window
opens.

[=] Presst Selection =]

Preset 1
Preset 2
Preset 3
Preset 4
Preset 5

Preset 6
Preset 7
Preset 8
Preset 9
Preset 10

3 Double-click the preset to rename, and enter the new name.
4 Click Close.

The new name is now reflected when you add manual commands, schedule entries,
action sets, and triggers.
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To delete a preset (ACTi and Cohu only):
1 Launch the video display from the Entity Tree or the Map Viewer. Refer to Showing a
Live Camera Feed on page 8-3.

2 Right-click the display and select Preset Configuration... The Preset Selection window
opens.

(=] Preset Selection (=115

Preset 1
Preset 2
Preset 3
Preset 4
Preset 5

Preset 6
Preset 7
Preset &
Preset 9
Preset 10

3 click the preset to remove and click Delete.

4 Click OK.
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Viewing Camera Presets

Note e This procedure cannot be used for CCTV entities that have a Source Type of
Generic, Autoscope Terra, or Axis. Refer to Entity Configuration - CCTVs on page 3-65.

Use the procedure below to recall a preset from an open video display.

Note e A preset can also be launched automatically by a trigger, a schedule entry, or a
manual command. For more information, refer to Using Triggers on page 4-25 and Overview
of Scheduling and Manual Commands on page 7-1.

To see a CCTV preset:
1 LaunchaCCTVvideo display from the Entity Tree or the Map Viewer. Refer to Showing
a Live Camera Feed on page 8-3.

2 Right-click the display and select Go to Preset.
A sub-menu shows a list of presets 1 through 10 (whether they have been defined or
not).
Stop

Snapzhot

Go to Presst h‘ ¥ Preset 1

et Preset k Preset 2

Preset Configuration... Preset 3
Preset 4
Preset 5
Preset 6
Preset 7
Preset &
Preset 9
Preset 10

Preset (n)...
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3 Do one of these steps to select a preset:

® click a preset from the list.
Or

® Select Preset (n)... to open the Preset Selection list:

E Preset Selection @ [E

1-North
2-South
3-East
4-West

5-Northeast
G-Morthwest
7-Southeast
B-Southwest

click a preset and click OK.

The camera pans, tilts, and/or zooms to the defined preset you chose.
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CCTV Preset Selection

When you define a “CCTV Preset” action in a manual command, schedule entry, trigger,
or action set, use this window to select the camera preset to show.

To select a camera preset:

1 When you click [ to the right of the Selected Preset field (from one of these windows:
Manual Command, New Schedule Entry, Trigger Editor, or Action Set - Edit Action), the
CCTV Preset Selection window opens.

[=] cCTV Preset Selection (=1

b S ACTI- Cam - 0

b S5 Axis 215 PTZ - Cam - 01

This window shows all the cameras that are defined in the Genetec server.

2 Expand the list for the appropriate camera.

[=] cCTV Preset Selection [=11ES;

¥ S ACTI- Cam-
1-Morth
2-South
3-East
4-\West

S-Neorthaast
E-Meorthwest
7-Southeast

8-Southwest
b e duis 215 PTZ - Cam - 01

3 Select one of the defined presets and click OK.
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Using CCTV Tours

A CCTV tour is a sequence of CCTV preset views shown in a specified order.

Note e Your camera type must be able to support tours in order to use this feature. For
example, if your CCTV entity has a Source Type of Generic, Autoscope Terra, ACTi, or Axis,
you cannot configure tours. Refer to Entity Configuration - CCTVs on page 3-65.

To add a single-camera tour:

Note e Although you can run multi-camera tours in Centracs, they must first be defined in
the Genetec software. You can define only single-camera tours in Centracs.

1 Launch the video display for the camera from the Entity Tree or the Map Viewer. Refer
to Showing a Live Camera Feed on page 8-3.

2 If you have not already done so, add the preset views to include in the tour. Refer to
Defining and Maintaining Presets on page 8-6.

3 Right-click in the camera view window and select Tour Configuration... The Edit
System Tours window opens.

D Edit System Tours @ [E
Tours Looping
Tour B True
Tour C True

[ Add [ =dt J[ Delete |

4 Click Add. A new row is added.
5 Optionally, click or double-click the tour name and type a new name.

6 Inthe Looping column, specify whether the tour will repeat automatically (True or
False).

7 Click Edit. The System Tour Stops window opens.
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8-14

[ Edit System Tours

Looping
Tour & True
True

True
Tour D

(=] System Tour Siops

8 Click Add.

A new row is added.

(] Edit System Tours

Looping
True
True

True
Tour D

(=] System Tour Stops

9 Enter the number of the first preset to be shown during this tour. The value must be
numeric.

10 Enter the number of seconds this preset will be shown.
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11 To configure all the presets to be included in this tour, repeat steps 8 through 10.
Make sure that they are in the correct order.

E] System Tour Stops @ E]
Preseat Time
1 3
2 3
3 3
4 3
5 3
& 3
7 3
8 3

[ Adg ][ Celete |

12 To close the System Tour Stops window, click (<.

13 To close the Edit System Tours window, click X,
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To run a tour:

» From the main menu, select View » CCTV Tours... The Advanced CCTV Tour Selection
window opens.

[ Advanced CCTV Tour Selection =1

Highlight the tour to run, then click OK. The tour launches in a new window. (To stop
the tour, close the tour window.)

Or

» Launchthevideo display for the camera from the Entity Tree or the Map Viewer. Refer
to Showing a Live Camera Feed on page 8-3.

Right-click in the camera view window and select Run Tour. The Run System Tours
window opens.

[=] Run System Tours =11

Tour A

Highlight the tour to run, then click OK. The tour launches in a new window. (To stop
the tour, close the tour window.)

To launch a tour automatically for specific users:
1 Define a manual command, schedule entry, or trigger and choose CCTV Tour as the
Action. (CCTV tours can also be part of an action set.)

2 Highlight the tour to run.

3 Click [ to the right of the Selected Users box and specify one or more users to show
the tour for.
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When the manual command, schedule entry, or trigger runs, the tour will
automatically be shown for the selected users (if they are logged in).

To change a tour:

1 Launchthevideo display for the camera from the Entity Tree or the Map Viewer. Refer
to Showing a Live Camera Feed on page 8-3.

2 Right-click in the camera view window and select Tour Configuration... The Edit
System Tours window opens.

[=] Edit System Tours =11
Tours Looping
Tour B True
Tour C True

[ Add J[ =¢t J[ Delete |

w

Optionally, change the name and/or loop setting.

s

To change the presets, highlight the tour and click Edit. The System Tour Stops window
opens.

wn

Change, add, reorder, or delete the presets.
6 To close the System Tour Stops window, click B4,

7 To close the Edit System Tours window, click (<.
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To delete a tour:
1 Launchthevideo display for the camera from the Entity Tree or the Map Viewer. Refer
to Showing a Live Camera Feed on page 8-3.

2 Right-click in the camera view window and select Tour Configuration... The Edit
System Tours window opens.

(=] Edit System Tours =1
Tours Looping
Tour B True
Tour C True

[ add || Edit |[ Delete |

3 Highlight the tour to remove and click Delete.

4 To close the Edit System Tours window, click <.
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Overview of Dynamic Message Signs (DMS)

You can use Centracs to monitor your dynamic message signs (DMS) and to send new
messages to the signs.

You define DMS devices in the Entity Tree like any other entity type. The actual messages
can be uploaded to Centracs from the sign, configured in Centracs and downloaded to the
sign, or a combination of the two.

Each defined DMS has a status display that shows the current message on the sign, the
state of communications between Centracs and the sign, the state of the beacons (on or
off), the current control mode of the sign (remote or local), and any errors being reported
by the DMS (such as climate control errors and message syntax errors):

(-] DMS Sign @ Eastwood Transit Genter - Skyline (VariableMessageSign) 1s B <

Summary

Current Message: Controd Modes Central  Brightness: 25

Runtime Priority: 1 Display Type LED
Voltage: 14.2
Line Voltage: 110

Meszage Type: Changeable
Meszage I0x 1

Stored Messages: Time
Permanent 12 Last 184515 Last Update: 18:45:18

Changeable: 5 Error: 1s

Quick Message [Blank Sign|  Poil RGN

Temperature Warnimng Door Open
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The status display includes options for you to change the message on the sign.

You can also use the Map Viewer to keep an eye on your DMS devices. Each DMS is shown
asanicon on the map. Because the icons are color-coded, you can quickly get information
about the status of the DMS with just a glance at the map. For example, in the graphic

shown below, the red status indicator tells you that the sign is reporting one or more
errors:

(=] Map Viewer (=11

For more details about map icons, including the meaning of each color, refer to Viewing
Entities and Elements on the Map on page 5-8 and Editing the Map View on page 5-18.
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If you hold your mouse pointer over the DMS icon on the map, Centracs shows a miniature
representation of the current message shown on the sign:

[~] Map Viewer ]34

In this example, the beacons are off.
These commands can be used to send a message to a sign:

m Activate Message — sends a command to a single sign to show a particular message
from one of the message libraries.

®  Quick Message — sends a command to a single sign to show a custom message not
defined in the message libraries; this feature allows you to create and send new
messages “on the fly”.

m Blank Sign — sends a command to one or more signs to activate the “blank” message
(which is specified by the Blank Message Location field on the Sign MULTI
Configuration window (page 3-34)).

You can issue DMS commands manually (from the DMS Status display, from the map,
from the Entity Tree, or via a manual command), or you can schedule them to run at
specific times via the scheduler. You can also use triggers to configure Centracs to send
specific messages when certain events occur. For example, you could allow current traffic
conditions to trigger the appropriate message, as shown below:

Trigger 1 - When the “Link Threshold Increased To Level 03” event occurs, activate the
message: “HEAVY TRAFFIC - CONSIDER ALTERNATE ROUTE”

Trigger 2 - When the “Link Threshold Increased To Level 02” (or “Link Threshold
Decreased To Level 02”) event occurs, activate the message: “"HEAVY TRAFFIC
- USE CAUTION”

Trigger 3 - When the “Link Threshold Decreased To Level 01” event occurs, activate the
message: “HAVE A NICE DAY”
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Configuring DMS Entities

Use the Entity Configuration window to add or change the parameters necessary to
deploy and operate dynamic message signs (DMS) in Centracs. For details, refer to
page 3-27.

Configuring DMS Messages

Use the windows shown below to add, change, or delete Changeable messages for a DMS
entity. The messages defined here are stored in the Centracs database, and they are also
sent to the DMS device for storage in the message libraries on the sign.

Note e Your Jurisdiction Role must include the Edit DMS Message permission.

Note e The add/change/delete functions are available only for Variable Message Signs
(VMS). For Changeable Message Signs (CMS), you can only view the messages that are
defined on the sign.

Note ¢ You can use the Upload Changeable Messages command (via the scheduler or a
manual command) to copy all the messages from the Changeable message library on the
sign into Centracs. Be aware that if you have already defined or loaded Changeable
messages in Centracs for this DMS, this command replaces them with the Changeable
messages currently defined on the sign.

To add a new Changeable message:
1 Inthe Entity Tree, right-click the DMS entity and select Edit Messages. The DMS
Messages window opens:

E] DMS Messages @ @

Runtime
Priority

Beacon MULTI String

All the Changeable messages for the sign are shown, along with their Runtime Priority
and Beacon setting. You can hover the mouse pointer over the MULTI String column
to see a representation of the message on the sign.
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The first position in this table (with an ID of 1) is always reserved for quick messages,
and cannot be changed or deleted on this window.

Note ¢ This window shows only Changeable messages; Permanent messages cannot
be changed in Centracs.

2 Click Add... The Edit DMS Message window opens.

[-] Edit DMS Message (=]
A Default [ PSEISE N e S .

B Page 1of 18

0| 5 Runtime Priority 1 Beacon

3 Enter the text and properties for the message. You can enter multiple lines and
multiple pages, you can change the fonts, justification, etc. For details on how to use
the message editor, refer to Using the DMS Message Editor on page 9-15.

Click OK.
To set up more messages for this DMS device, repeat steps 2 through 4.

On the DMS Messages window, click OK again.

N o un b

On the Entity Configuration window, click Apply or OK. (Apply saves your changes and
keeps the window open; OK saves your changes and closes the window.)

8 Centracs asks for permission to send the new message to the sign for storage in its
internal message library. Click OK.

A progress bar is shown while Centracs updates the sign. The new message is also
stored in Centracs.
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= Configuring DMS Messages

9-6

To edit a Changeable message:

1

From the list on the DMS Messages window, select a message and click Edit. The Edit
DMS Message window opens.

Make the necessary changes and click OK.
On the DMS Messages window, click OK again.

On the Entity Configuration window, click Apply or OK. (Apply saves your changes and
keeps the window open; OK saves your changes and closes the window.)

Centracs asks for permission to send your changes to the sign to update its internal
message library. Click OK.

A progress bar is shown while Centracs updates the sign. Your changes are also stored
in Centracs.

Note e If you edit a message that is already active on the sign, you must reactivate the
message in order for your changes to take effect on the sign.

To delete a Changeable message:

1

From the list on the DMS Messages window, select a message from the list and click
Delete.

Click OK (or to cancel the deletion, click Cancel).

On the Entity Configuration window, click Apply or OK. (Apply saves your changes and
keeps the window open; OK saves your changes and closes the window.)

Centracs asks for permission to delete the message from the internal message library
on the sign. Click OK.

A progress bar is shown while Centracs updates the sign. Your changes are also stored
in Centracs.

Note e Ifyoudelete a message thatis already active on the sign, this does NOT remove the
message from the sign display; you must send another message (or the blank message) to
the sign.
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Using the DMS Status Display

Using the DMS Status Display

The DMS Status display shows a graphical representation of the current status of a
dynamic message sign:

(] DMS Sign @ Eastwood Transit Center - Skyline (VariableMessageSign) 1s (=]

Current Message: Controd Mode: Central — Brightness: 25

Runtime Priority: 1 Display Type: LED
Voltage: 14.2
Line Voltage: 110

Mezsage Type: Changeable
Mezzage [Oc 1

Stored Messages: Time

Permanent 12 Last 1B:4515 Last Update: 18:45:18
Changeable: 5 Error: 1=

Quick Message [Blank Signf  Pol  JNECNTT

Temperature Warning Door Open

To open the DMS Status display:

» Inthe Entity Tree, double-click the DMS, or right-click the DMS and select Show
Status... from the popup menu.

Or

» Inthe Map Viewer, double-click a DMS icon, or right-click the icon and select Show

Status... from the popup menu.

You can open Status displays for multiple DMS entities at the same time. You can move

them, resize them, and dock them like other windows in Centracs.
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= Message

Message

9-8

Current Message

Field Description

Runtime A number from 1 to 255 that specifies the importance of the message,
Priority where 1is the lowest priority and 255 is the highest priority. To activate
a new message, the Activation Priority of the new message must be
greater than or equal to the Runtime Priority of the current message;
otherwise, the sign rejects the new message.

Message Type | The type of message that the sign is currently showing:

m Permanent— Cannot be changed without physically replacing
hardware components; does not lose its content if the power is
turned off.

m Changeable — A user can change the content; does not lose its
content if the power is turned off.

m Blank —one of 255 blank messages (each has a different runtime
priority).

m Other—Any other type than those specified above; refer to the
manual for the device.

Message ID The ID number of the message currently shown on the sign.

Stored Messages

This section shows the number of messages currently contained in the Permanent and
Changeable message libraries in Centracs for this sign (this may not match the number of
messages stored on the sign if you have not uploaded all of the messages to Centracs).

At the bottom of the Display section, the Activate Message/Quick Message and Blank
Sign options allow you to change the sign directly from the Status display. For information
about these commands, refer to Action Types on page A-1.

Note ¢ The Quick Message option is shown for Variable Message signs; the Activate
Message option is shown for Changeable Message signs.

The Poll button causes Centracs to check the status of the sign on demand. When status
information is received from the sign, the Last Update field changes to the current time.
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Summary =

Field Description

m Local —thessignis under control of the local control panel or another
device (such as a laptop) that is connected to the sign locally.

m Central—the signis under control of the central system.

m Central Override —local mode has been overridden by central (for
example, in the case that a technician accidentally left the sign set to
local mode); in this mode, commands from the local control panel are
ignored.

To put a sign into Central Override mode, right-click the DMS entity in
the Entity Tree and select Central Override.

The display technology used by the sign:
m Bulb

m Drum

m LED

m Fiber Optics

m Flip Disk

m Shuttered

m Other

The sign battery voltage, in volts. The range is 0 to 655.35.

The AC line voltage, in volts. The range is 0 to 255.

The current brightness level of the sign. The range is 0 (off) to 255
(brightest).

Summary
Control Mode
Display Type
Voltage
Line Voltage
Brightness
Time

Field Description

Last

The time of day reported by the sign for the last “Get Time” request (in
HH:MM:SS format).

Last Update

The last time Centracs polled the sign for status information (in
HH:MM:SS format).

Error

The time drift between Centracs and the sign.

This section of the window also includes buttons to request the current time from the sign
or set the time on the sign.
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= Notifications

For more details about time drift and the information shown in the Time section, refer to
Synchronizing the Time on page 6-17.

Notifications

Comms

9-10

The unlabeled section at the lower-left corner of the window contains messages to notify
you of various conditions, such as a communication problem, a message error, or a sign
voltage error. For example:

Meszsage Ermor

It tells you at a glance whether the DMS device is reporting any errors. A red dot to the
left of an error type tells you that the DMS is currently reporting an error of that type. To
see more details, hold your mouse pointer over the error.

For a brief explanation of each error type, refer to Dynamic Message Sign on page 4-8.

(You can also set up alert triggers for these error types. For details, refer to Using Triggers
on page 4-25.)

The Comms section is a summary of the communications status between Centracs and the
DMS device. Hover the mouse over the colored bar on the bottom to see more details;
click it to open the Comm Statistics graph. For more information, refer to Viewing Comms
on the Status Display on page 6-53.
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Activating a DMS Message from the Library =

Activating a DMS Message from the Library

At any time, you can activate a DMS message from the Permanent or Changeable library.

Note ¢ To activate a custom message, use the Quick Message action (page 9-13).

To activate a message from the libraries:
1 From the Entity Tree or Map Viewer, right-click the sign and select Activate Message.
This window opens:

D Sign (@ Eastwood Transit Center - Activate Message @ E

Message Library +/ Permanent | Changeable

Message { v

Activation Priority 253

Duration 1 Minutes Hours Days © Moend

Preview:

- ox | cancel |

2 For Message Library, select the type(s) of messages to show in the Message dropdown
list (below). For example, if you select Permanent, the dropdown list shows only the
messages in the Permanent message library on this sign.

3 From the Message dropdown list, select the message to show on the DMS. A preview
of the message is then shown at the bottom of the window.

4 Enter the Activation Priority for the message. In order for this message to supercede
the message currently shown on the sign, the Activation Priority must be greater than
or equal to the Run Time Priority of the current message. (The Run Time Priority of the
current message is shown on the DMS Status display.)

5 Inthe Duration field, enter the length of time to show the message on the sign. Use
the radio buttons to specify whether the duration you entered is in minutes, hours, or
days. Or click the “No end” option to run this action indefinitely (i.e., until another
message with a higher activation priority supersedes it).

6 Click OK.

Note e You can also send the Activate Message action via the scheduler or a manual
command. Because this action is considered to be an instantaneous action in Centracs, it
disappears from the Manual Commands or Scheduler Entries window as soon as it runs.
Centracs sends the Duration settings to the sign, and the sign controls when the message is
removed from the display.
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= Activating the Blank Message

Activating the Blank Message

At any time you can send the “blank” message to one or more signs. The Blank Message
Location field on the Sign MULTI Configuration window (page 3-34) specifies the message
that Centracs sends for the Blank Sign action.

To activate the “blank” message:

» From the DMS Status display, click Blank Sign.
Or

» From the Entity Tree, right-click the sign and select Blank Sign.
Or

» From the Map Viewer, right-click the sign and select Blank Sign.
Or

» To blank multiple signs at the same time, use the scheduler or create a manual
command for the Blank Sign action.

Unlike the Activate Message action, the Blank Sign action does not have options for
Activation Priority or Duration. For the Blank Sign action, the Activation Priority is
automatically set to 255 (the highest priority), and the Duration is automatically set to “No
end”.
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Creating a Quick Message =

Creating a Quick Message

At any time, you can activate a custom message on the DMS rather than activating a
message from the libraries.

To activate a quick message:
1 From the DMS Status display, click Quick Message.
Or
From the Entity Tree, right-click the sign and select Quick Message.
Or
From the Map Viewer, right-click the sign and select Quick Message.

This window opens:

D Sign (@ Eastwood Transit Center - Quick Message @
Edit Message

Activation Priority 255

Duration 1 Minutes Hours Days © Moend

[ ox ][ cance |

2 Enter the Activation Priority for the message. In order for this message to supercede
the message currently shown on the sign, the Activation Priority must be greater than
or equal to the Run Time Priority of the current message. (The Run Time Priority of the
current message is shown on the DMS Status display.)

3 Inthe Duration field, enter the length of time to show the message on the sign. Use
the radio buttons to specify whether the duration you entered is in minutes, hours, or
days. Or click the “No end” option to run this action indefinitely (i.e., until another
message with a higher activation priority supersedes it).
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= Creating a Quick Message

4 Click Edit Message. The Edit DMS Message window opens:

[] Edit DMS Message =]
A Default = 0 1 _Ij_IJ_ﬂ

BPage 1of 18

Runtime Priority 1 Beacon

5 Define the text and properties for the quick message. You can enter multiple lines and
multiple pages, you can change the fonts, justification, etc. For details on how to use
the message editor, refer to Using the DMS Message Editor on page 9-15.

6 Click OK.
7 From the Quick Message window, click OK again.

The current quick message is always stored in the Changeable library, in the position
specified by the Quick Message Location field on the Sign MULTI Configuration window
(refer to DMS MULTI Configuration on page 3-34).
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Using the DMS Message Editor =

Using the DMS Message Editor

You can use the DMS Message Editor to edit Changeable messages, add Changeable
messages, and create Quick messages:

[-] Edit DMS Messags [=I1ES
A Default = 0 _lj_IJ_ﬂ

B Page 1of 18

D 5 Runtime Priority 1 Beacon

Note e If you edit a message that is already active on the sign, you must reactivate the
message in order for your changes to take effect on the sign.

To use the DMS message editor:

1 Inthe ID field (if shown), enter the number that identifies this message on the DMS
device, i.e., the location for this message in the Changeable library. (Two messages can
have the same ID only if they have different message types — i.e., Permanent versus
Changeable.) If you are creating a Quick message, the ID is automatically set to 1, and
the ID field is not shown.

2 Inthe Runtime Priority field, enter a number from 1 to 255 that specifies the
importance of the message, where 1 is the lowest priority and 255 is the highest
priority. When this message runs, another message can override it only if the
Activation Priority of the new message is greater than or equal to the Runtime Priority
of this message; otherwise, the sign rejects the new message.

3 To flash the beacons when the sign shows this message, check the Beacon option.
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= Using the DMS Message Editor

4 Inthe black matrix, enter the text for the message. You can enter multiple lines and
multiple pages, you can change the fonts, justification, etc.:

To select text

Use the mouse to click and drag over the text, or hold down
the Shift key and use the arrow keys to move the cursor.

To add a line break

Press Enter.

To add another page

Place your cursor at the location for the new page, then
click i_l.

To delete a page

Place your cursor in the page, then click Fl

To change how long
each page is shown

Click I to open the Page Timing window. Under the Time
section, the On value specifies how long the page will be
shown, and the Off value specifies how long the sign will be
blank in between. To change these values, turn off the
Default checkboxes. If you want to specify different timings
for each page, turn off the “Use a single timing for all pages”
option; otherwise, a single set of On/Off timing values will
be used for all pages. (Note that this option is available only
if multiple pages have been defined for the message.)

For example:
D Page Timing @ E]
Use a single fiming for all pages
WILDLIFE USE
CROSSING EXTREME
AHEAD CAUTION
Time (seconds) Default Time (seconds) Default
On 2 On 3
Off 0 v off o v
[ 4 T

In this example, the first page will be shown for 4 seconds,
the second page will be shown for 3 seconds, and there will
be no blank time in between.

To navigate to another
page

Click [ for the previous

page, or [=] for the next page.

9-16
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To change the Click [= for left justification, ] for center justification, or =
horizontal justification | for right justification. justification. You can use more than
one horizontal justification within the same message, and
even within the same line. For example:

rl—?ﬂSlci Resort Access - Skyline ]

s

To change the vertical | click 5] for top justification, & for middle justification, or

Justification =l for bottom justification. The entire message must use

the same vertical justification.

To change the font Select the text to be changed, then select a font from the
dropdown list beside the .

To insert a dynamic Click the down arrow beside the dropdown. A list of

field available fields is shown. For example, you can use dynamic
fields to show the current date, time, or temperature on the
sign.

To see the MULTI Click [. (Click il again to close the MULTI box).

syntax

For details about MULTI tags and syntax, refer to the NTCIP
1203 standard, “Object Definitions for Dynamic Message
Signs (DMS)”.

To undo a change you | click M. To undo multiple changes, click M multiple times.
made

Toredo a changeyou | click . To redo multiple changes, click B multiple times.
undid
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= Viewing the Device Status Window

If Centracs detects an error in your message (for example, if you enter a character that
is not supported by the font you selected), the MULTI box containing the syntax of
your message is shown below the black matrix:

[-] Edit DMS Messags [=I1ES
A | Default [ RSREE  we m| .

B Page 1of 18

MULTE [753)=+ NEVER GIVE UP, NEVER SURRENDER =***

D s Runtime Priority 1 Beacon

* iz not a valid character in font: 101 L
T

To see details about the error, hover the mouse pointer over the MULTI box, as shown
above. Correct the error, then click [l to close the MULTI box.

5 When the message is complete, click OK.

Note e The up/down arrows on the keyboard are not fully supported in the editor.

Viewing the Device Status Window

You can view the current communications status of all your DMS devices at once, using
the Device Status window. Refer to page 6-24.
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Overview

In Centracs you can generate a number of useful reports, described below.

Centracs Enterprise Reports

Report

Comm Reports

Comm Statistics Report

Description

Shows various statistics about the communications
between Centracs and your field devices. Refer to
page 10-20.

Hourly Comm Statistics

System Reports

The percentage of communications that failed for each
signal during each hour of the day. Refer to page 10-26.

Alerts Log

Alist of the alerts that have been triggered by the system
within a specified time range. Refer to page 10-18.

Device Configuration

The current communications settings for each field
device defined in the Entity Tree. Refer to page 10-23.

Entity Hierarchy

A printable view of the Entity Tree. Refer to page 10-24.

Entity Notes

A list of the notes that have been defined for entities in
the system. Refer to page 10-25.

System Activity

An audit trail of all the user activity in the Centracs
application. Refer to page 10-50.

System Events

A list of all events that Centracs has logged within a
specified date/time range. Refer to page 10-51.

User Login

Alist of the logins to and logouts from the Centracs client
application within a specified time range. Refer to
page 10-60.
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= Centracs Enterprise Reports

Report Description

10-2

Users and Recipients

A list of all the people-{areremete S2Sand-C2Esystems,
i#-any} that are configured as users and/or recipients in
your database. Refer to page 10-61.

Detection Reports

Detector Fault Status

A list of all existing detector faults. (For ASC/2, ASC/3,
and Cobalt controllers only.) Refer to page 10-22.

Level of Service Link Report

A set of graphs that show historical Volume, Occupancy,
Speed, V+kO, and Level of Service data for a collection of
detectors. Refer to page 10-28.

Raw Detector Data Report

A list of the raw vehicle data collected from polls to the
signal controllers. Refer to page 10-31.

Travel Time Link Report

A set of graphs that show the speed and travel time data
for a specific BlueTOAD link pair during multiple date
ranges. You can use this report to see changes in trends
over time. You can plot data points every hour, every half
hour, every quarter hour, or every 5 minutes within the
specified date ranges. Refer to page 10-56.

VOS Daily Report

A set of graphs that show the volume, occupancy, and
speed data for one or more vehicle detectors during a
specified date range; you can plot data points every day,
week, or month within the date range. Refer to

page 10-62.

VOS Hourly Report

A set of graphs that show the volume, occupancy, and
speed data for one or more vehicle detectors during a
specified date range; you can plot data points every
hour, every half hour, every quarter hour, or every 5
minutes within the date range. Refer to page 10-65.

VOS Multi-Date Hourly
Report

A set of graphs that show the volume, occupancy, and
speed data for one or more vehicle detectors during
multiple date ranges; you can plot data points every
hour, every half hour, every quarter hour, or every 5
minutes within the specified date ranges. Refer to
page 10-69.

VOS Multi-Date Daily Report

A set of graphs that show the volume, occupancy, and
speed data for one or more vehicle detectors during
multiple date ranges; you can plot data points every day,
week, or month within the specified date ranges. Refer
to page 10-74.
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Report

Signal Reports

Signal Changes

Centracs Enterprise Reports =

Description

A log of all signal events (Phase Green, Pattern Change,
Ped Walk, etc.) that have occurred within a specified
time period. Refer to page 10-33.

Signal Detector Events

A historical list of detector-related faults (such as Max
Presence and No Activity faults) during a specified time
period. Refer to page 10-34.

Signal Events

A historical list of controller-related events and errors
(such as Local Flash Active and Cycle Fault) during a
specified time period. Refer to page 10-36.

Signal MMU Events

Information about events reported by the MMU
(Malfunction Management Unit) for one or more signals.
Refer to page 10-38.

Signal Upload and Compare

A list of the outcomes of all “Signal Upload and
Compare” actions during a specified time period. Refer
to page 10-44.

Split Monitor

Statistics about the number of cycles that occurred, the
average of the actual cycle lengths, and the minimum
and maximum cycle lengths during a specified time
period for a specific signal; it also shows a bar graph of
the average splits for each phase during this time period.
Refer to page 10-46.

Time Drift

A list of the outcomes of all “Time Drift Check” actions
during a specified time period. Refer to page 10-53.

Time Drift History

Traffic Responsive

Monitors Traffic Responsive performance on the system.
Refer to page 10-55.
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= Centracs DCMS Reports

| Centracs DCMS Reports

10-4

For more information about these reports, refer to Data Collection Reports on

page 17-42.

Report

Data Collection Reports

All Detector Data

Description

Shows the following data for each selected device’s
detectors: Total Volume, Average Occupancy, Arithmetic
Mean Speed, Average Flow Rate, Average Vehicle
Headway, Average Vehicle Gap, 85% Speed.

Arithmetic Mean Speed

Shows the time mean speed for each detector during
each hour of the day.

Average 85th Percentile
Speed

(For G4/5X-300 RTMS only.) Shows the average travel
speed of 85% of the traffic.

Average Vehicle Counts
Classification

Shows the raw numbers of vehicles counted of each
type, during each hour of the day, and averages them.

Average Vehicle Gap

(For G4/5X-300 RTMS only.) Shows the average number
of seconds between vehicles, for each hour of the day.

Average Vehicle Headway

Shows the average time between vehicles for each
detector during each hour of the day.

Average Vehicle Occupancy

Shows the average occupancy for each detector during
each hour of the day.

Average Vehicle Volume

Shows the average number of vehicles for each detector
during each hour of the day.

Average Vehicle Volume
Classification

(For G4/5SX-300 RTMS only.) Shows the raw numbers of
vehicles counted of each type, during each hour of the
day, and averages them.

Comparison Report

Allows you to generate various graphs and data tables to
compare Autoscope data for two different dates or for
two different date ranges.

Peak Hour Volume Report

Shows the 60-minute period that had the highest total
volume.

Station Report

Allows you to generate various graphs and data tables
for a single date or a single date range.

Total Vehicle Counts
Classification

Shows the raw numbers of vehicles counted of each
type, during each hour of the day.
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Report Description

Total Vehicle Volume

Shows the total number of vehicles for each detector
during each hour of the day.

Total Vehicle Volume
Classification

(For G4/5X-300 RTMS only.) Shows the raw numbers of
vehicles counted of each type, during each hour of the
day, and totals them.

Centracs MMS Reports

For more information about these reports, refer to MMS Reports on page 19-88.

Report

MMS Reports

Asset and Inventory Counts

Description

For each Location, and for each asset/inventory type,
this report shows the number of ‘In Service’ assets/
inventory, the number of ‘Out of Service’ assets/
inventory, and the percent that are out of service. The
report also shows overall totals for the entire System.

Assets and Inventory Out of
Service

Graphically shows the number and percentage of assets/
inventory that are currently marked as Out of Service.

Assets Nearing Expected
Failure

Shows assets that are nearing the end of their expected
service life.

Assets Past Expected Failure

Shows assets that have passed the end of their expected
service life.

Average Response

Shows statistics about Call ticket handling.

Dispatch History

Shows status information about the tickets for each
Region and Location. You can filter the report to show
call tickets, work orders, tickets found on-site, or all of
the above.

Moved Assets

Shows assets that have been moved in Centracs from
one Location to another.

PM Coming Due

Shows the last modified date, due date, and number of
days until the due date for all Preventive Maintenance
Checklists that have been scheduled and are still open.

PM Progress

Shows the current status, due date, and last modified
date for all Preventive Maintenance Checklists that have
been scheduled and are still open.
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Report Description

Project Activity You can generate four different Project Activity reports:
m Call Tickets
m Work Order Tickets

® Found Tickets (submitted by a technician via the
mobile app)

® Preventive Maintenance (PM)

System Age Dashboard Graphically shows you the overall age and health of the
assets in your system (green = young, red = old).

System Performance Graphically shows you the number of:

Dashboard

m assets out of service

m assets nearing expected failure
m assets past expected failure

m outstanding call tickets

m outstanding work orders

System, Region, and Location Shows the original value and the current depreciated

Values value of each asset in the system — grouped by Region,
then by Location. The report shows assets only (not
inventory, because Centracs does not calculate
depreciation for inventory items).

Trending Count Allows you to track the number of new tickets opened
and the number of tickets closed over a specified date
range. You can run the report for Call tickets or for Work
Orders.

Trending Response Shows statistics about Call ticket handling.

You can run these reports on demand or on a schedule — for example, you may choose
to schedule the System Activity report to run at the end of each day.

With each report, you can format it, print it, save it to a file, and/or email it to a recipient.

Note e External ‘Server-to-Server’ entities are not included in the Centracs reports.
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Using the Toolbar

The report toolbar is highlighted below:

@® User Login
Configurable Report Options

Start Date & Time: | 3/9/2018 14:29 End Date & Time: | 3/9/2018 15:29

User(s): acox,adamico, bgriggs,can ~ Login Type: User Logged In,User Logil +

View Report

% | E - | 100% Find | Nex )

User Login

Time Range:

3/9/2018 2:29:20 PM - 3/9/2018 3:29:20 PM

2018 2:37:35 PM ds Donnie Smith User Logged In
2018 3:12:08 PM EconoliteUser Econolite User User Logged In
2018 3:15:28 PM cflores Chris Flores (Aegis) User Logged In

CEN:I‘_BA'_‘;S" 10f1 31912018 3:29:21 PM

The report toolbar offers options to scroll through the pages of a report, print it, save it,
and so on:

& Show/Hide Parameter Area — for reports that include parameters to filter the
report data, this toggle option shows or hides the parameter area at the top of
the window.

M First Page — takes you to the first page of the report.

4 Previous Page — takes you to the previous page of the report.

N Next Page — takes you to the next page of the report.

N Last Page — takes you to the last page of the report.

Back to Parent Report —in the Users and Recipients report (page 10-61), you can

&
launch the User Login report (page 10-60) as a child report; in the Hourly Comm
Statistics report (page 10-26), you can launch the Comm Statistics report
(page 10-20) as a child report. This button then returns you to the original
report.
Centracs User Manual 10-7
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Stop Rendering — cancels the report generation.

Refresh — regenerates the report.

W

3 Print — launches the Windows® Print window.

E Print Layout — shows a print preview of the report.

Page Setup — sets the paper size, margins, and orientation of the report before
you print or export it.

Export — saves the report to a file (XML, CSV, PDF, HTML, XLS (or XLSX), TIF, or
DOC (or DOCX)).

There are also three entry fields on the toolbar:

Enter the Select the Enter a search term and
page number zoom level for click Find/Mext to find
to goto the report view specific data inthe report
> S
P e B3 HE- | 100% - Find | Mext

Running a Report on Demand

To generate a report now:
1 From the main menu, click the Reports menu and select one of the available reports.

Some reports generate automatically at this point. Other reports require you to
specify the types of data to be included in the report.

2 If the chosen report includes fields at the top of the window to filter the data to be
included in the report, specify the settings for each filter option.

3 Click View Report.

Saving Your Report Parameters

If you frequently run the same report with the same parameter settings, you can save your
settings as a “configurable report” so you never have to enter them again. For example,
you can create a configurable Comm Statistics report that shows the communications for
a specific set of devices for the previous day. You can then schedule Centracs to
automatically run this report each morning and email it to you. (For details about
scheduling reports, refer to Scheduling a Report to Run on page 10-12.)

10-8 Centracs User Manual
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Note e The Users and Recipients report, Entity Hierarchy report, and Detector Fault Status
report do not have configurable options.

To add a configurable report:
1 From the Reports main menu, select one of the available reports.

2 Onthe report window, click (5] to expand the Configurable Report Options:

Name | User Login | IZ‘ Shared

Report Time Period | Default '|

Configurable Report Options

Save Close

Start Date & Time: | 3/9/2018 14:29 End Date & Time: | 3/9/2018 15:29

User(s):

|acux,adamico.bgriggs,can v| Login Type: | User Logged In,User Logii v|

3 Change the Name field to describe the new report. For example, you might choose to
include the time period of the report in the name to distinguish it from the standard
report of the same name.

Centracs User Manual

From the Report Time Period dropdown, specify one of the options below:

® Default — uses the default date/time parameters for the report you chose. For

example, when you first open the Comm Statistics report, the report is set to show
data for the most recent sixty minutes by default.

Configured Time —uses a hard-coded date/time period. After you select this option,
enter the specific date/time values into the report’s date/time fields.

Hour —includes data from one or more prior full hours. (Step 5 below allows you to
specify the number of hours to include.) For example, if you set the report to run at
10:05 and to include 2 hours of data, it includes data for 08:00 to 10:00.

Day — includes data from one or more prior full days. (Step 5 below allows you to
specify the number of days to include.) For example, if you set the report to run at
3pm on Wednesday and to include 1 day of data, it includes data for Tuesday at
00:00 through Wednesday at 00:00. (To run the report for the most recent 24
hours, use the Hour option instead.) Note that the Day option is almost identical to
the Beginning to End of Day (BTEOD) option, except that the BTEOD option ends at
23:59 instead of 00:00.

Week —includes data from one or more prior full weeks, starting on Monday. (Step
5 below allows you to specify the number of weeks to include.) For example, if you
set the report to run on Tuesday the 14th and to include 1 week of data, it includes
data for Monday the 6th through Sunday the 12th. To run the report for the most
recent 7 days, use the Day option instead.

10-9
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® Month—includes data from one or more prior full months. (Step 5 below allows you
to specify the number of months to include.) For example, if you set the report to
run on the 15th day of January and to include 2 months of data, it includes data for
the entire months of November and December. To run the report for the most
recent 30 days, use the Day option instead.

® Year —includes data from the prior full year. For example, if you set the report to
run on the 31st day of May 2016, it includes data for January 2015 through
December 2015. To run the report for the most recent twelve months (in this
example, June 2015 through May 2016), use the Month, Week, or Day option
instead. That is, run the report for 12 Months, 52 Weeks, or 365 Days.

® Beginning to End Of Day — includes data from one or more prior full days. (Step 5
below allows you to specify the number of days to include.) For example, if you set
thereporttorunat3pm on Wednesday and toinclude 1 day of data, it includes data
for Tuesday from 00:00 to 23:59. (To run the report for the most recent 24 hours,
use the Hour option instead.) Note that the Beginning to End of Day (BTEOD) option
is almost identical to the Day option, except that the BTEOD option ends at 23:59
instead of 00:00.

[=] comm Statistics

BX

Report Time Period

E] Configurable Report Options

Mame Comm Statistics - Devices A B, C - YESTERDAY +| Shared

Default -

Default
Configured Time

Celumns to Displ

10-10

Hour

Start Date & Time: EE—F
Week

( save [ close |

[01/16/20123:36:05 P View Report |
g Month e -
Mon |ACT, NTCIP -
TACT DM NTOIE DM - Comm Senvers: [ comm Server 1 Comm Serve |
5 If you selected the Hour, Day, Week, or Month option, a numeric field appears to the

8
9

right. Enter the number of hours, days, weeks, or months to include in the report. For
example, for the Hour option, if you enter 3 hours and if the report runs at 10:05, it
includes data for 07:00 to 10:00.

If you leave the Shared checkbox enabled, the new report can be viewed, run,
changed, or deleted by any user in the system (if they have the proper reporting
permissions in their Application Role). To make the report private so that only you can
use and maintain it, disable the Shared option.

Enter values for the other report parameters as appropriate. For example, on the
Comm Statistics report, set the Columns to Display, Device Manager Type, Device
Managers, Comm Channels, and Devices parameters.

Click View Report to save the values into the report.

Click Save.

The new report now appears in the Reports menu, under the Shared Reports submenu or
the My Reports submenu.

Centracs User Manual
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Changing or Deleting a Configurable Report

If one or more configurable reports have been saved in the system, they can be edited or
deleted on the Manage Configurable Reports window.

Note ¢ To delete a configurable report, you must have the System Configuration
permission in your Application Role (page 20-19).

To manage a configurable report:

1 From the main menu, select Reports » Manage Configurable Reports... The report
management window opens:

B Manage Configurable Reports @ E
| Comm Statistics - YESTERDAY - |
Name Comm Statistics - YESTERDAY Shared
Report Time Period [Day * | 1 day(s)
Source Report  Comm Stafistics Close Delete

2 From the dropdown list at the top, select a configurable report.

3 To make changes to the report, you can change the name, time period, and/or
visibility (shared or private) of the report, then click Apply or OK. Or to delete the
report, click Delete.

Note ¢ You cannot change the Source Report field. To change the original report on which
a configurable report is based, you must delete and re-add the configurable report.

To change report-specific parameters for a configurable report:
1 From the Reports » Shared Reports or Reports » My Reports menu, select one of the
configured reports.

2 Change the parameters as needed, then click View Report to save the values into the
report.

3 Click Save.

To create a new configurable report from an existing one:

1 From the Reports » Shared Reports or Reports » My Reports menu, select one of the
configured reports.

2 Enter a name for the new report.

3 Change the parameters as needed, then click View Report to save the values into the
report.

4 Click Save As.
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Scheduling a Report to Run

10-12

To configure a report to run on a schedule:

1

From the main menu, select Control » Scheduler... The Scheduler Entries window
opens.

Click Add... The New Schedule Entry window opens.
Enter a name for this schedule entry, such as “Generate Daily Alerts Log Report”.

In the Action dropdown list, expand the “Common” list of actions, then select
Generate Report.

Select a report from the standard reports lists, or from the Shared Reports or My
Reports list. (For information about “Shared Reports” and “My Reports”, refer to
Saving Your Report Parameters on page 10-8.)

Make sure the Enabled checkbox is checked.

From the Format dropdown, select the file format for the generated report:
® Comma-separated values file (.csv)

® Microsoft Excel spreadsheet (.xls)

Web page (.html)

Adobe Acrobat file (.pdf)

Graphic file (.tif)

Microsoft Word document (.doc)

Extensible Markup Language file (.xml)
If you want the report emailed to one or more people:
a Click i to the right of the “Email Recipient” box.

b Select the recipient(s) to whom the report will be emailed. You can select one or
more individual recipients, and/or one or more User Roles. If you select a User Role,
then all users who are assigned that role AND who have been set up as a recipient
will receive the report. To select more than one recipient/role at a time, hold the
Ctrl or Shift key while you select them, or to select all, press Ctrl-A.

¢ After you have made your selections, click [z5] to move them to the “Selected” side
of the window, and click OK.

Note e Recipients of reports must also have an email address specified in Centracs.
For details, refer to Defining Recipients on page 20-73.

If you want to save the report to a local folder or network location:

a Click [ to the right of the “Save To” box.

Centracs User Manual
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b Select the folder where you want to save the report file after it runs (or click “Make
New Folder” to create a new folder for the report).

c Click OK.

10 Onthe New Schedule Entry window, specify the date range for this schedule (such as
a Start date of today’s date, and an End date of “No end”) in the Range box.

11 In the Times box, specify the time of day at which the report will be generated.

12 In the Recurrence box, specify how frequently the report will be generated (such as
every weekday).

13 To enter any exceptions, such as holidays or vacation dates, expand the “Exceptions”
section of the window and specify the days or dates. For details on how to add
exceptions, refer to Using the Scheduler on page 7-11.

14 Click OK.

Your new report schedule is now shown in the Scheduler Entries table.

Centracs User Manual 10-13
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Stretching a Dropdown List

To expand a dropdown list:

Most of the reports use dropdown lists. To expand a list for easier viewing, click the
bottom-right corner and drag it:

[—] System Activity

Start Date & Time:  {07/23/2011 4-24:28 PM

User Legin:
Activity:

System /

Time Range:

TI232011 4:31:33 P

DateiTime

of 1

TIZH2011 4:36:31 PM

i

I Econolite, EMorthman, gmb_j

Entity Type:

| Action Set, Added Applicati ~ |

[w] [Select All)
[w| Action Set

|w] Added Entity

|w| Added Global Setting

[w] Added Applicaticn Role
|w| Added Entity/Channel As

[w| Added Holiday/Special D
[w| Added Local Setting

~

= 1005

= User Login

System

N

End Date & Time:

=)

e m Activity

TIZHZ011 4:41:32 PN

System

Start Dateg Time:

TIZ32011 4:45:33 PM System User Login:
TI232011 45133 PN System o

71232011 45634 PN System Activity:
TI232011 5:01:35 PN System

TI232011 5:06:36 PM System

702312011 51136 PM System M 41 of

TI232011 51637 PM

System

TIZH2011 5:21:38 PM

System

R P o T T ]

ek

l
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Time Range:

DateiTime

System /

[07/23/2011 4-24:28 P

e

I Econolite, EMorthman, gmb_j

| Action Set, Added Applicati ~ |

End Date & Time:
Entity Type:

[w] [Select All)
[w| Action Set

[w] Added Entity

|w| Added Global Setting

|w| Added Local Setting

|w! Added Recipient

[w] Added Applicaticn Role

[w| Added Manual Command
TI2312011 4:31:33 B Added Map Visuals

[w| Added Scheduled Event

[w] Added Entity/Channel Association |

vl Added Holiday/Special Day

-~

100%

ity Typc N

TI2362011 4:36:31 PN ntrance
[w| Added SMTP Server
TI232011 4:41:32 PN ntrance
TIZ32011 4:45:33 PM bl Added User t
45 ntrance
[w| Added User Role
TI232011 45133 PM . ntrance
I EWETET [w| Alert Escalation :
55 ntrance
[w] Archive Logs Data
FI2362011 5:01:35 PN ] Archive Logs Finished ntrance
TI2302011 5:06:36 PM . t
[w| Archive Logs Started rrance
TIZ32011 5:11:36 PM F ce
TI232011 5:16:37 PM ¥ { tra
7/23/2011 5:21:38 PM System S lenirdnce

R P P o T T

ek

b e

< |

UL
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Sorting Report Data

To reorder the rows in the report:
Click the sort arrows in the column header. To sort in the opposite order, click them again.

Time Range:

71192011 9:23:15 AM - 771972011 922,

TH2011 10:01:05 AM ) LafeyetteR . Lafayette Reynolds Uszer Logged In
THS2011 10:02:47 AN kam K Mac Uzer Logged In
THS2011 10:03:25 AN 83 Sue Syhvester User Logged Out
THS2011 10:18:05 AM System Inwalid Login: m

4|

To see the sort arrows, you must not be in Print Layout view.

The sample below shows that the report is currently sorted by user ID, in ascending order.

Hime nalnge. -

71972011 9:23:15 AM - 771972011 9:23:15 PM

= User Login = Details ‘ﬂ
TAS2011 1.01:53 PM EMorthman Eric Merthman User Logged In
THS2011 10:02:47 AN kam K Mac User Logged In
I

Note e Some columns cannot be sorted.
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Saving a Report to a File

To save a copy of a report:

1 Click the 3 Export icon on the report toolbar.

A dropdown list shows the file format options:
® Comma-separated values file (.csv)

® Microsoft Excel spreadsheet (.xIs or .xIsx)

® Web page (.html)

® Adobe Acrobat file (.pdf)

® Graphic file (.tif)

® Microsoft Word document (.doc or .docx)

® Extensible Markup Language file (.xml)
2 Select the type of file to export the data to.
3  When prompted, specify a name and location for the export file.

The file is added to the location you specified, and you can open it in the appropriate
application, print it, email it, etc.

Filtering by Date

Many of the Centracs reports allow you to enter a date range to filter the data:

Stark Date: [t1/12/2015 T End Date: [ti/12jz015 115959 P

In this example, the End Date shows a date and a time (11:59:59 PM), whereas the Start
Date shows only a date. If the time is not shown, it indicates a time of 00:00:00 (midnight).
So in this example, the report would include data for 11/12/2015 00:00:00 AM through
11/12/2015 11:59:59 PM.
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Hiding the Parameters

To hide the parameter area at the top of a report:
Click the small arrow button above the toolbar, as shown below:

Start Date & Time:  |07/19/2011 9:23:15 AM lﬁ End Date & Time:  |07,/19/2011 9:23:15 PM i

User(s): IEcunuI ite, EMorthman, gmb,

H 41 of 1 b M |« % & EdaE

Time Range:

M 4 1 of 1L b M |« % i B - | 100% - Find | Next
Time Range:

719/2011 9:23:15 AM - 7/19/2011 9:23:15 PM

User Login
THS2011 1:.01:53 PM EMorthman Eric Northman User Logged In
THS2011 10:02:47 AM kam K Mac User Logged In
THS2011 10:01:05 AM LafeyetteR Lafayette Reynolds User Logged In
THS2011 11:30:53 AM LafeyetteR Lafayette Reynolds User Logged Qut
THS2011 101810 AM pip Phineas T. Prune User Logged In
THS2011 10:03:29 AM LX) Sue Sylvester User Logged Qut

TIANAAA Af.A0.AC Abs P [T I I S S

4

m

To show the parameters, click the button above the toolbar again.
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The Alerts Log is a list of all the alerts that have been triggered within the time range you
specify, along with any actions that have been taken on those alerts. The report shows the
date and time at which the alert originally occurred, the entity name and event name

associated with the alert, and the severity of the alert (Information, Warning, or Critical).

When an alert is originally generated, the Ack State is “New”. If someone acknowledges
or closes the alert, the Ack State is changed to “Acknowledged” or “Closed”, the Ack User
column is populated with the user ID of that person, and the Ack/Close Time column is
populated with the date and time at which this action was done. If someone
unacknowledges the alert, the Ack State is set back to “New”. Because Centracs does not
require Informational alerts to be acknowledged by a person, they are treated as if they
have already been acknowledged, and are shown in the report with an Ack State of
“Acknowledged”.

A full history of each alert is kept in the log. For example, an alert that has been
acknowledged and then closed will be shown in the log three times — one time as New,
one time as Acknowledged, and one time as Closed.

You can filter the report by date and Entity State, which specifies whether to include only
active entities, only deleted entities, or both.

You can sort the information by any column (by default, the report is sorted by date/time).

By default, the report shows up to 500 alerts that match your selection criteria. If your
database has a large number of alerts, select 250 from the “Row Limit” dropdown to
increase the efficiency of the report. If necessary, you can also select a number larger than
500, or you can choose to show all alerts.
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Note e Events that are not configured to generate alerts are not included in this report;
those events are included in the System Events report (page 10-51).

[=] averts Log

BX

’[3 Configurable Report Options

Start Date & Time:  [12/28/2010 8:57:33 AM iz

Entity Type: | Aries, CCTV, Centracs, DM, ~ |

Entity State: m

Row Limit:

1 of 3 b M % ;.;u.u b~ | 100%
Alerts Log
Time Range:

12/28/2010 8:57:33 AM - 12/29/2010 11:57:33 AM

500

End Date & Time: [12/20/2010 11:57:33 AM 8]

=

l

12/28/2010 9:31:46 AM (Information Detector Fault - ON Acknowledged Woodmen @ N Union Bhvd (ASC/3) E
12/28/2010 11:31:45 Information Detector Fault - ON Closed Econolite User [1/7/2011 2:35:21 PM Woodmen @ N Union Bhvd (ASC/3)
AN
12/28/2010 5:29:40 PN (Information Detector Fault - OFF Acknowledged Woodmen @ N Union Bhvd (ASC/3)
12/28/2010 8:22:23 AM (Critical Flagh: Local Manual - New Woodmen @ Chapel (ASCS3)

ON
12/2%/2010 8:25:01 AM (Critical Flash: Local Manual-  [Acknowledged [Johnny Brave |12/2%2010 8:25:01 AM  |Woodmen @ Chapel (ASC/3)

ON
12/28/2010 8:53:22 AM |Critical Flash: Local Manual - [Closed Johnny Brave |12/2%2010 8:53:22 AN |Woodmen @ Chapel (ASC/3)

ON
1272972010 9:21:11 AM [Warning Detector Erratic Qutput [New WB Woodmen @ N Union 1

Fault - OH
12/28/2010 11:00:01 VWarning Threshold TR Fault Acknowledged |Econclite User |12/2%2010 1:22:40 PM (Colorado Springs) TR Algorithm Woodmen
AN Rd Corridor failed:

Percent values could T
4 T r
Note e For alerts on the numbered preempt events (i.e., Preempt Emergency Vehicle ##,

Preempt Railroad ##, Preempt Other ## — for example, Preempt Railroad 01), the Details
column shows the preempt description that is currently in effect for that preempt. (If the
preempt description has been changed since the alert was generated, the preempt
description in the Details column will not be the same as the preempt description that was
in effect when the alert was triggered.) If the default preempt descriptions have been
overridden for a specific signal, the override description is shown in the report; if not, the
default description is shown in the report. For more information, refer to Preempts on
page 20-5 and Customizing the Preemptor Descriptions for a Signal on page 3-42.
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The Communication Statistics report contains various stats about the communications
between Centracs and your field devices. For each device, the report shows:

Attempts — the number of communication attempts made within the specified date/
time range.

Failures — the number of those attempts that failed.

Comm Success % — the calculated success rate percentage of all communications
(polling and non-polling comms) with this device:

Comm Success % = ((Attempts - Failures) / Attempts) * 100

Poll Success % — the calculated success rate percentage of all polls to this device. sE&—

Poll Period Avg — the average time between polls to this device (in minutes, seconds,
and milliseconds). The Primary Poll Rate specified for the communication channel in
Centracs is the intended poll rate; the Poll Period Avg is an average of the actual poll
rates for the specified date/time range.

Content Failures —the number of incoming poll packets from the device that were not
the correct size or did not contain the correct information.

Note e The Attempts, Failures, and Comm Success % values include both polling and non-
polling comms. For more information, refer to Overview of Polling Comms vs. Non-polling
Comms on page 20-47.

The report also shows the device manager, comm channel, and jurisdiction that each
device is assigned to.

You can sort the information by any column (by default, it is sorted by Entity Name).

Note e This report can also be launched for a specific hour from the Hourly Comm
Statistics report (page 10-26). To return to the parent report, click the “Back to Parent
Report” icon.
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[=] Comm Statistics

Configurable Report Options

B

Start Date & Time: i End Date & Time:

Columns to Display: | Agtempts, Failures, Comm 5. 7 Device Mansger Type: [ Tcip |

Device Managers: IDevice Manager 1 j Comm Servers: IComm Server 1, Comm Serwj

Comm Channels: |p- NTCIP, LE IP Channel, LE 7 Devices [ Annie Goolahee @ ad Eilly ~ |

N —

1 of 1 b b @ @B - | 100% - |:| Find | Next
Communication Statistics

Time Range:
3172014 9:58:35 AM - 314/2014 10:58:35 AM

Failures Comm Poll Success % Poll Period ‘Content
Success% Avg Failures

Amnie Goolahee @ Bad Bily 0:05.0248
Pratt (504)

Device Manager 1

Comm Server 1

IP-NTCIP

Annie Goolahee @ OlafWay 0:05.0135
=01y

Dievice Manager 1

Comm Server 1

IP-NTCIP

Annie Goolahee @ Sweet Trav 0:05.0248
£02)

Dievice Manager 1

Comm Server 1

IP -NTCIP

Annie Goolahes @ Tofutti Klsin 0-05.0248
e (502)

Device Manager 1

Comm Server 1

IP-NTCIP

Sign @ E astwood Transit Center 0:30.0809
(Skyline)

Device Manager 1

Comm Serer 1

IP-NTCIP

Sign @ 1-25 & Woodmen 0:20.0539

Device Manager 1

Comm Server 1

Serial Channel 7

4 | 1

Note e The “CommStatisticsLogPeriod” Global Setting defines the interval at which
communication statistics are logged, and can affect what you see in this report. For
example, if “CommStatisticsLogPeriod” is set to 15 minutes and you try to see comm stats
for the last ten minutes, the report may not show any data at all, and you must wait until
the comm stats are logged again to run the report. Similarly, if you run the report for the last
hour, keep in mind that the data may or may not include the most recent 15 minutes (or
whatever interval the Global Setting is set to). For more information about this Global

Setting, refer to Overview of Global Settings on page 20-54.
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Detector Fault Status Report

For ASC/2, ASC/3, and Cobalt controllers, the Detector Fault Status report is a printable list
of the existing detector faults, which are also shown on the Detector Fault Status
monitoring window (page 6-48). All detectors are monitored, regardless of whether they
are defined in the Entity Tree.

Note e Detector faults are reported to Centracs only if:

m the “shortAlarmStatus” object is included in the polling packet definition. For
more information, refer to Configuring Polling Packets on page 20-50.

and

m the “ActivateDetectorDiagnostics” Global Setting is set to “true”. Without
this setting, the Detector Fault Status window is disabled. (It may be
necessary to stop and start the Centracs Core service on the server machine
in order for changes to this parameter to take effect.)

The first column shows the date and time at which the detector fault data was last polled.
The polling frequency is determined by the settings in the Polling Packet Editor

(page 20-50) and the Servers/Comms Configuration window (page 20-36). For each
faulted detector, this report also shows the signal name, the detector number (i.e., the
Controller Reference number in the Entity Configuration for the detector), the detector
name (if any), the detector type, and the fault(s) for that detector.

You can sort the report by any column.

[ Detector Fault Status (=11

1

Detector Fault Status

— & EH-LJ "'!" 100% M Find Mext

m

SM1/2011 4:53:17 PR Garden of the Gods @ HZ5 1 Vehicle Vehicle No Activity Fault

1 2

10-22

Note e For a history of all detector faults that have occurred during a specific time range
(both existing and resolved faults), run the System Events report for all the “Detector”
events types (NTCIP controllers only), or run the Signal Detector Events report (NTCIP and
ACT controllers). Refer to System Events Report on page 10-51 or Signal Detector Events
Report on page 10-34.
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Device Configuration Report

The Device Configuration report shows the current communications settings for each field
device defined in the Entity Tree. For descriptions of the fields on this report, refer to
Entity Configuration - Signals on page 3-36.

These devices are not shown in the report:

m Devices without any configured communication settings (on the Entity Configuration
window)

m Devices from external Server-to-Server systems

Note ¢ Toshow CCTV devices, be sure that “None” is selected in the Device Managers and
Port Profile dropdown lists, and that “CCTV Channel” is selected in the Comm Channels
dropdown, and that the CCTV devices are selected in the Devices dropdown.

In addition to the data filter options at the top, you can also select which columns to
include in the report.

You can sort the data by any column.

The last row of the report shows the total number of devices being shown. Using the filter
options at the top, this Total row can be used as a quick way to determine the total
number of devices in Centracs, the total number of devices on a specific channel, the total
number of devices of a specific type, etc.

D Device Configuration @ @
’E Configurable Report Options ]
Columns to Display: IType, Jurisdiction, Channel, Dej Device Managers: IDevice Manager ACT, Device I'vj View Report

Comm Channels: — [ccTy Channel, IP - NTCIP, LE |7 | Part Profile: |centracs |
Type: I.-'-\uhnscope Terra, Autoscope Pj Devices: ICUnh’oIIer 501 (Bennett 5t @ Zj
1 of 1 < IETU-'U - | 100% - l:l Find | Mext
Device Configuration =l
Controller 501 [Bennett St @ | ASC3  |Generd IP-NTCIP Device 127.0.0.1:501 0 10000 /30000 / 3 Online  |Centracs 128073
2nd St) Manager o
NTCIP
Controller 502 (W Carr Ave ASC3  |Generd IP-NTCIP Device 127.0.0.1:502 0 1000 / 30000/ 0 3 Online  |Centracs 128073
@N B St) E_Ia_ncalger
Controller 503 [Bennett St @ | ASC3  |Generd IP-NTCIP Device 127.0.0.1:503 0 1000 / 30000/ 0 3 Online  |Centracs 128073
SBSt) Manager prs
NTCIP
Oasis E Carr Ave @ 2nd 5t) | Oasiz  |Generl Serial - ACT  [Device COM 1 1 1000/ 30000/ 0 3 Online  |Centracs
Manager ACT
Skyline Sign (BennettSt@ S| DOMS  |Generd IP-NTCIP Device 127.0.0.1:181 0 30000 /30000 / 3 Online  |Centracs 00.45.00
ASH Manager 0 09M19/05
NTCIP
Total: 5
-
< | _>l_I
1°=Primary
2°=Secondary
3°=Tertiary

Drop=Serial Drop Address
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Entity Hierarchy Report

The Entity Hierarchy report depicts the relationships between all entities defined in the
Entity Tree. Within each level of the tree, entities are sorted by name. This report is useful

to print a copy of your Entity Tree.

When you open the report, collections of entities are collapsed by default. To expand
them, click the & button next to the collection name. Note that when you print the report,
any entities that are collapsed and hidden from view do not print. In order to print all
entities, make sure you have expanded all the collections first.

[=] Entity Hierarchy

10-24

1 of 1 §

Entity Hierarchy

Entity Relationship
Colorade Springs

PICIEIES

Type
System

100%

Description

BX

Find Mext

Briargate

Section

Briargate Bhvd

COS Traffic Cams

URL

Colorado Springs Traffic Cam Website

New Signals in Testing

Group

Downtown COS

Woodmen

Section

Woodmen Rd

Woodmen-East

Subsection

Eastof 25

Woodmen-West

Subsection

West of 25

Woodmen @ Chapel

Signal

ASC2

Woodmen @ Chapel-1

Wehicle Detectors

Woodmen @ Chapel2

Wehicle Detectors

Woodmen @ Chapel-3

Wehicle Detectors

Woodmen @ Chapel-4

Wehicle Detectors

Woodmen @ Chapels

Wehicle Detectors

Woodmen @ Chapels

Wehicle Detectors

Woodmen @ Chapel7

Wehicle Detectors

Woodmen @ Chapel-8

Wehicle Detectors

Woodmen @ Powers

Signal

Oasis

Woodmen @ Rockrimmen

Signal

W4

Woodmen-West-EB

Link

Eastbound

Woodmen-West-WB

Link

Westbound

VWoodmen CCTV's

Group

Woodmen @ Academy SW

CCcTv

Advanced CCTV

Woodmen @ Chapel NW

CCTV

Axis

Woodmen @ Ranoewood SE

CccTv

Autoscone

(L
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Entity Notes Report

The Entity Notes report is a list of all the entity-related notes that users have added to
Centracs. You can filter the notes by the entity type, entity name, and/or the user who
created the note. You can sort the notes by any column (by default, the report is sorted
by Creation Date/Time); however, if you sort by the Notes column, any HTML formatting
will be removed from the notes.

[=] Entity Notes (=]

Configurable Report Options

Entity Type: |L|'nk, Section, Signal, Vehl-d(j Entity Name: IBrl'a rgate (Briargate Bhed), \.I".j View Report I

User Login: IEca-noIl'te, kam j

M 4 1 of 1 b M |« @& @HJ H- | 100% - Find | Next
Entity Notes
Entity Entity Type Creation Date/Time User Login

Briargate (Briargate Section 120232010 5:30:48 PN Econolite
Bivd) Entity added to system 12/16 by Jebediah Dunphy

Entity name changed 12/28 by Jan M. Vincent

WB Woodmen @ N Unien|Vehicle Detectors [12/2%2010 10:45:14 AN Econolite
3 Entity added to system 12/28 by Phil Dunphy

Entity comms configured 12/29 by Gary Dell'Abate

Woodmen @ Austin Signal 12/2%2010 10:42:38 AN Econolite
Bluffs (ASC/3) Entity added 12/11 by Luke N. Laura

Entity name change 12/28 by Sonny Hooper

Woodmen-West-WB BTI2011 22545 PN
(Westbound) Entity added to Centracs on 7/1 by Irwin Fletcher

Entity name changed on 7/14 by G. Bluth

The User Login column shows the user who added the note (which may or may not be the
last person who edited the note). The Creation Date/Time column shows when the note
was added.

Note e This report does not show notes for entities that have been deleted.

Note e
systers
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Hourly Comm Statistics

10-26

The Hourly Comm Statistics report shows the percentage of communications that were
successful for each signal during each hour of the day.

In the fields at the top, enter the start date and end date for the report (do not enter
times), and select the signal(s) to be included in the report. If the date range you enter
contains more than one day, the report averages the values for each hour of the day for
the entire date range.

Green boxes that show 100% indicate that there were no comm failures during that hour,
or that communications were not attempted during that hour. If any poll attempts failed,
the box shows a number lower than 100% along with the appropriate color:

B Green =good comms
m Yellow = marginal comms
m Red =bad comms

To determine whether the measured comms were “good”, “bad”, or “marginal”, Centracs
uses the FilteredCommMarginal and FilteredCommBad Global Settings. (For details about
these Global Settings, refer to Communications Status on page 20-47.) For example, if
you set FilteredCommMarginal to 95% and FilteredCommBad to 75%, then:

m Green = 95%-100% successful comms

m  Yellow = 75%-95% successful comms-SEEMY-NOTES-ATBOTFOM-OFROLLING-COMMS-
M NOMNPOLUNG-COMMSTERIC

m Red = 0%-75% successful comms

Centracs User Manual
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[=] Hourly Comm Statistics

Configurable Report Options

@&

Start Date: |o/02/2011 i End Date: |01/08/2011 View Report I

Signal Mame(s): IWuu-dmen @ Austin Bluffs (j

)| (B - | 00%

Hourly Communication Statistics
TUT2014 - 11972014

1 of 1 # WM & ':i"

Woodmen @ N Unien Blvd
(ASC/3)

Woodmen @ N Academy
(ASCI3)

(Woodmen @ Chapel (ASC/2)

100%  100%

(Woodmen @ Rockrimmon (W4}

Woodmen @ Powers (Oasis)

Woodmen @ H25 W (ASC/3)

Woodmen @ Rangewood

(Woodmen @ Austin Bluffs
(ASCI3)

4

For more details about a specific hour, click the column header for that hour. The Comm

Statistics report (page 10-20) for that hour opens.

Note e Due to the width of this report, use legal-sized paper when you print it.

Centracs User Manual
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Level of Service Links Report

10-28

The Level of Service Links report is a set of graphs that show historical Volume, Occupancy,
Speed, V+kO, and Level of Service data for a collection of detectors.

Note e In order for Centracs to collect data for this report, you must turn on the Enable
Logging option for the Link (refer to Entity Configuration - Links on page 3-54). If Enable
Logging is turned off, you can only get Link data via the Real-time Link Status window (refer
to page 6-45).

The top of the report shows the detectors included in the Link, and shows the current
settings for Max Volume, Max Speed, Max V+kO, and the occupancy scaling factor (k). For
details about these settings, refer to Entity Configuration - Links on page 3-54. Each page

of the report holds one of these graphs:-whatisthe poeintofshowingthe-eurrentsettings?
they-might-have-been-changedsince-the-data-waswritten

m Volume vs Time

m V+kO vs Time

m  Occupancy vs Time

m Speedvs Time

m Level of Service vs Time

Scroll through the pages of the report to see the various graphs.

Centracs User Manual
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[=] Links - Level of Service Report (=] |

‘Configurable Report Options

StartDate & Time: [09/12/2011 24405 PM ) EndDate & Time: [09/12/2011 25405 PM
Link Name: |Woedmen-West-E8 (Eastbound) _~|

1 of 3 b M |« ] :ﬁnﬂ] = Tma; - |:| Find | Mext
Level of Service Link Report

Link: Woodmen-West-EB
Description:  Eastbound

Detectors:  Woodmen @ Chapel-1, Woodmen @ Chapel-2, Woodmen @ Chapel-4
DefaultSettings

Max V+kO: 1000 Max Speed: 45(mph)  k Constant:

Volume

Yolume (vehicles per hour)

T T
9/12/2011 2:46 PM 9/12/2011 2:50 PM

Volume vs Time
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[=] Links - Level of Service Report

Configurable Report Options

[=I]ES

Start Date & Time: [09/20/2011 1027:04 AM End Date & Time: [09/20/2011 11:27:04 AM )
Link Mame:

4 4 3

o
o
c
]
[is]
-
=]
]
2
o
|

|Woodmen-West-£8 (Eastbound) v |

——
of 2 0 M @ @q; W~ | 100% - I:I Find | Mext

Level of Service

ASARAR A

T T T T T
W28/2011 10:44 AM 9/29/2011 11:03 AM 928/2011 11:19 AM
9/29/2011 10:35 AM 22972011 10:54 AM 9/29/2011 11:11 AM

Time

— Volume Level of Service — Speed Level of Service —— W+kO Level of Service
= Dccupancy Level of Service

m

Level of Service vs Time

View Report I

The Level of Service graph is a visual representation of the efficiency with which the

roadway is serving traffic over time. The link levels defined in your Link Settings window
are shown on the Y axis (the scale of this axis may vary depending on how many levels you
have configured). Low levels indicate free-flowing traffic or no traffic; high levels indicate
traffic congestion.

Note e The sample Level of Service graph shown above does not show realistic real-world
data; it is used only to illustrate the different aspects of the graph.

10-30
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Raw Detector Data Report

The Raw Detector Data report is a list of the raw vehicle data collected from polls to the
signal controllers. This raw detector information is used to calculate volume, occupancy,
speed, volume-to-capacity ratios, etc. You can filter the report data for specific dates,
signals, and/or detectors.

Note e Signals from external Server-to-Server systems are not included in this report.

By default, the report shows up to 500 rows that match your selection criteria. If your
database has a large quantity of raw detector data, select 250 from the “Row Limit”
dropdown to increase the efficiency of the report. If necessary, you can also select a
number larger than 500, or you can choose to show all data.

Note e The Detectors dropdown list contains only those detectors that are found in the
detector log for your system. For example, a detector that is defined in your system but has
never been active is not shown in the dropdown list.

If you want to include data from deleted detectors in the report, enable the “Include
Deleted Detectors” option. Otherwise, deleted detectors are excluded.

D Raw Detector Data

O

’E Configurable Report Options ]

Time Range:

Start Date & Time:  |0g/11/2011 9:58:08 AM it End Date & Time: |0g/12/2011 9:58:08 AM |
Signal: |Woodmen @ Chapel (ASCJEJ Detectors: |Woodmen @ Chapel-1, Wotj
Row Limit: 500 -

1 of 17 b M D | &([Ea - | 100% - Find | Next

Raw Detector Data

8/111/2011 9:58:08 AM - 8/12/2011 9:58:08 AM

m

Woodmen (@ Chapel (ASC/2)

Woodmen @ Chapelb1  |8M11/2011 10:55:00 AM 0 0% &0 Yes oK

Woodmen @ Chapeh1  |8M1/2011 11:00:30 AM 14 % &0 Yes oK

Woodmen @ Chapek1

8112011 11:01:30 AM

42

21.5%

&0

oK

Woodmen @ Chapek1

8112011 11:02:30 AM

5L

27.5%

&0

oK

Woodmen @ Chapek1

8112011 11:03:30 AM

8%

&0

oK

Woodmen @ Chapek1

BM1/2011 11:04:30 AM

15

7.5%

&0

oK

Woodmen @ Chapek1

8112011 11:05:30 AM

51

245%

&0

oK

Woodmen @ Chapek1

8112011 11:06:30 AM

15

8%

&0

oK

Woodmen @ Chapek1

8112011 11:07:30 AM

3z

15.5%

&0

oK

T

0044044 44.00.90 AL

o cor

on

e

Centracs User Manual

The columns on this report are:
m Signal — The signal to which this detector belongs.

m Detector ID — The Controller Reference number for this detector. This is set in the
Entity Configuration for the detector.

m Detector Name — The name defined in Centracs for the detector entity.
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m Date/Time — The date and time of the poll.

m  Volume — The number of vehicles detected since the last poll.

m  Occupancy — The percent of time that a vehicle was present.-what-time-periedHis-oece
a%ef?

m Polling Period — The time between polls (in seconds).

m Valid — Shows whether the system considers the volume, occupancy, and speed data
from this detector to be reliable (in the case of a detector fault, the system considers
the data to be unreliable and does not include it in graphs/calculations).

m Status — Shows any existing detector faults (otherwise, this column shows “0k”).

Below the last row of data for a specific detector, the report shows a total of all the
volume counts for that detector.
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Signal Changes Report

The Signal Changes report is a log of all signal events that have occurred within a specified
period of time. Examples of signal events include Phase Green, Overlap Green, Ped Walk,
Pattern Change, Local Zero, etc.

Note e In order to run this report, your system must collect signal change data. To do so,
turn on the “Signal Change Logging” action via the scheduler, a manual command, or an
action set. (When this action is turned on, Centracs logs a large amount of extra data. For
this reason, it is not meant to run indefinitely. Be sure to monitor the disk space on the
server while logging is turned on.)

You can filter and sort the report by date, signal name, and signal change type. You can
also filter by Entity State, which specifies whether to show only active signals, only deleted
signals, or both in the Signal Name(s) dropdown.

By default, the report shows up to 500 rows that match your selection criteria. If your
database has a large quantity of signal change data, select 250 from the “Row Limit”
dropdown to increase the efficiency of the report. If necessary, you can also select a
number larger than 500, or you can choose to show all data.

[=] Signal Changes

81X

IB Configurable Report Options ]

Start Date & Time: [01/31/20115:15:34 PM EndDate & Time: [01/31/20119:24:14PM View Report |
Entity State: Active - Signal Name(s): |Woodmen @ M Academy (ﬁj
Event(s): |Lc>ca| Zero, Pattern Change_.j Row Limit: 500 -
1 of 3 b Bl % | i .LJ W~ | 100% - Find | Mext
Signal Changes
Time Range:

1/31/2011 5:15:34 PM - 1/31/2011 9:24:14 PM

WI12011 5:15:34 P Woodmen @ N Academy (ASC/3) Pattern Change Pattern; 2
312011 5:15:34 PM Woodmen @ N Academy (ASCI3) Phaze Yellow Phaze #3
WI12011 5:15:34 P Woodmen @ N Academy (ASC/3) Phasze Yellow Phase #7
143142011 5:15:34 PN Woodmen @ N Unien Bivd (ASC/3) Phase Red Phase #3 E
WI12011 5:15:34 P Woodmen @ N Union Bhed (ASCI3) Phase Red Phase #7
143142011 5:15:35 PN Woodmen @ N Academy (ASC/3) Phase Red Phase #3
13142011 5:15:35 PM Woodmen @ N Academy (ASCI3) Phaze Red Phaze #7
143142011 5:15:35 PN Woodmen @ N Unien Bivd (ASC/3) Phase Green Phase #4
13142011 5:15:35 PM Woodmen @ M Union Bhed (ASCI3) Phasze Green Phaze #3
132011 5:15:35 PM VWoodmen @ M Unien Bhed (ASC/3) Ped Walk Phase #4
143142011 5:15:45 PN Woodmen @ N Unien Bivd (ASC/3) Ped Clear Phase #4 L

m

Centracs User Manual
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Note ¢ The Event(s) dropdown list contains only those events that are found in the signal
changes log for your system. For example, if no signals have changed patterns since the last
time the signal changes log was purged, “Pattern Change” is not shown in the dropdown list.

Signal Detector Events Report

The Signal Detector Events report is a historical list of detector-related faults (such as the
Max Presence and No Activity faults for NTCIP controllers) during a specified time period.

You can filter the report by date, signal name, detector event type, and entity state. For
the Entity State option, specify whether to show only active signals, only deleted signals,
or both in the Signal Name dropdown.

Note e In order to run this report, you must first upload the logs from the signal
controller(s). To do so, run the Upload Controller Logs action via the scheduler, a manual
command, or an action set. (Because the Upload Controller Logs action is not supported for
Eagle controllers, the report will not contain any data for Eagle controllers.)

[=] signal Detector Events B

Configurable Report Options

Start Date & Time: 081172011 8:51:57 AM i End Date & Time: [08/12/2011 8:51:57 AM View Report I

Entity State: IActi\.re vI Signal Name: IEagIe_. Garden of the Gods @j

Signal Detector Events: IErratic Counts, Erratic Countj

——

M 41 of2b M| @ |@&[EMa = | 100% - |:| Find | Next
Signal Detector Events

Signal{s):
Woodmen @ N Academy (ASCI3 ), Woodmen @ N Union Blvd (ASCI3), Woodmen @ Powers (ASCI3)

Time Range:

81172011 9:51:57 AM - 81212011 9:51:57 AM

DateiTime Signal Name Detector ID Detector Name Type Phase Phase Event
Direction

8M1/2011 10:58:59 AM Woodmen @ N Academy (ASC/3 ) 1 WVehicle Erratic Counts

8M1/2011 10:58:19 AN Woodmen @ M Union Bivd (ASC/3) 3 WB Woodmen @ N Union 3 Vehicle East No Activity

BM12011 10:59:20 AM Woodmen @ M Academy (A5C/3 ) SB Academy (@ Woodmen Vehicle South No Activity
(Southbound)

B8M1/2011 11:00:47 AN Woodmen @ M Academy (A5C/3 ) SB Academy @ Woodmen Vehicle South No Activity Clear
(Southbound)

8M11/2011 5:05:16 PM Woodmen @ M Academy (ASC/3 ) SB Academy @ Woodmen Vehicle South No Activity
(Southbound)

&M1/2011 5:05:35 PN Woodmen @ N Academy (ASC/3 ) SB Academy @ Woodmen Vehicle South No Activity Clear
(Southbound)

T T 3

With the exception of Eagle controllers, this report includes faults for all other controller
types (ASC/3, Cobalt, W4, Oasis, etc.)
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For each fault, the Type column shows one of these detector types:

m Vehicle

m Pedestrian

m  Not reported (this is shown for detectors that are not defined in the Entity Tree)

You can sort the report by any column.

Note e To see current detector faults for ASC/3, ASC/2, and Cobalt controllers, use the
Detector Fault Status window (page 6-48) or the Detector Fault Status report (page 10-22).
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Signal Events Report

The Signal Events report is a historical list of controller-related events and errors (such as
Local Flash Active and Cycle Fault) during a specified time period.

Note e In order to run this report, you must first upload the logs from the signal
controller(s). To do so, run the Upload Controller Logs action via the scheduler, a manual
command, or an action set. (Because the Upload Controller Logs action is not supported for
Eagle controllers, the report will not contain any data for Eagle controllers.)

You can filter and sort the report by date, signal name, and signal event type. You can also
filter by Entity State, which specifies whether to show only active signals, only deleted
signals, or both in the Signal Name dropdown.

By default, the report shows up to 500 rows that match your selection criteria. If your
database has a large quantity of signal event data, select 250 from the “Row Limit”
dropdown to increase the efficiency of the report. If necessary, you can also select a
number larger than 500, or you can choose to show all data.

[] signal Events =)0

[E Configurable Report Options ]

Start: 021072011 44720 28 End: 0271072011 5:4720 P

Entity State: Active - Signal Name: |Woodmen @ Austin Bluffs (j
Filtered Events: |Automatic Flash Active, Autj Row Limit: 500 A
1 of 1 % | d .U W~ | 100% - Find | Mext
Signal Events
Signal(s):

Woodmen @ Austin Bluffs (ASC/3), Woodmen @ Chapel (ASC/2), Woodmen @ IH25 W (ASC/3), Woodmen @ N Academy (ASC/3)

Time Range:

2110/2011 4:47:29 PM - 210/2011 5:47:29 PM

2102011 04:51:53.8 Woodmen @ N Academy (ASC/3) Power On

202011 04:51:53.8 Woodmen @ N Academy (ASC/3) Battery Low

2M10/2011 04:51:53.8 VWoodmen @ N Academy (ASC/3) Offline

2/10/2011 04:51:53.8 Woodmen @ N Academy (ASC/3) Power On Flagh Active

210/2011 04:51:55.2 Woodmen @ N Academy (ASC/3) Coord Local Free

210/2011 04:51:55.2 Woodmen @ N Academy (ASC/3) Online

2102011 04:51:55.2 Woodmen @ N Academy (ASC/3) Power On Flash Inactive

202011 04:52:00.2 Woodmen @ N Academy (ASC/3) Coordination Active

202011 04:52:19.5 Woodmen @ Austin Bluffs (ASC/3) Power On i
4 il 2

Note e For Oasis controllers, this report contains data from the COORD PLANS,
FUNCTIONS, ALARMS, and EVENTS logs on the controller.
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For selected event types, the Details column contains more information. For example, for
preempt and alarm events, the Details column shows the preempt or alarm number

reported by the controller; for Oasis plan changes and function changes, it shows the
source of the change, the new plan or function, etc.
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Signal MMU Events Report

10-38

This report contains information about events reported by the MMU (Malfunction
Management Unit) for one or more signals. The date and time of the event(s) is shown at
the top of the report.

H-the-eventisa-phase-conflict{asshownbelow);-The Red/Yellow/Green rows show the

current state of each phase at the time of the event. j

’
3 ho aHAe e L

’ 7 7

You can filter the report by date, signal name, and entity state. For the Entity State option,
specify whether to show only active signals, only deleted signals, or both in the Signal(s)
dropdown.
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Note e In order to run this report, you must first upload the logs from the signal
controller(s). To do so, run the Upload Controller Logs action via the scheduler, a manual
command, or an action set. (Because the Upload Controller Logs action is not supported for
Eagle controllers, the report will not contain any data for Eagle controllers.)

(=] signal MMU Events B

’E] Configurable Report Options ]

Start Date & Time:  [2/11/2011 7:51:56 AM fit End Date & Time: |2/12/2011 7:51:56 PM i
Entity State: Im Signals): |Woodmen @ N Academy j
) 1 of 1 ENE] == R Find | Next
Signal MMU Events
Signal: Woodmen @ N Academy Date/Time:  2MM11/2011 12:42:24 PM
Channel 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16
Red - D S . X X
Yellow c
Green X X X X
Output Relay Failure Conflict X
Controller Voltage Red Failure
Maonitor
+24V Mon | Diagnostic Failure X
+24Y Mon Il Min Clearance Failure
+24V Mon Inhibit Port 1 Timeout
Reset Start Up Flash
Red Enable Local Flash i
4 m 2
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Signal Upload and Compare Report

The Signal Upload and Compare report shows the outcome of all “Signal Upload and
Compare” actions during a specified time period. The “Signal Upload and Compare” action
compares the current settings on a controller with the current settings stored in the
Centracs database for that controller. To resolve any differences found, you can upload
the settings from the controller and save them to the Centracs database, or download the
Centracs settings to the controller — whichever is appropriate. The “Signal Upload and
Compare” action is run via a manual command, schedule entry, or action set.

Note e This feature of Centracs is not supported for Eagle EPAC or Tek-TS controllers.

You canfilter the report by date/time range, entity type, entity name, entity state, and the
result of the comparison (Difference Found, No Difference, etc.). For the Entity State
option, specify whether to show only active entities, only deleted entities, or both in the
Entity Name(s) dropdown.

You can sort the report by any column.

BX

[-] signal Upload and Compare

Configurable Report Options

End Date & Time:  |0g/12/2011 10:53:34 AM

IActive j

Results I j

@ | & [E]a =- 1o - [ | Find | Nex
Signal Upload and Compare

Start Date & Time: |w12;2011 9:53:34 AM
Entity Type(s):

IGroup_. Section, Signal, Subsj Entity State:

Entity Name(s): ICoIorado Springs, Con\a\entitj

1 of 1§

Time Range:
BM272011 9:53:34 AM - 811272011 10:53:34 AM

Date/Time Result
BM2/2011 10:44:03 AW
BM2i2011 10:44:12 AN
BM2/2011 10:44:12 AR
BM2/2011 10:44:12 AR
BM2i2011 10:44:12 AN
BM2/2011 10:44:12 AR
BM2/2011 10:44:12 AR
BM2i2011 10:44:12 AN
BM2/2011 10:44:12 AR

BM22011 10:44:12 AN

Entity Name
Colorado Springs
Garden of the Gods @ 25 W4
ASCI3

Description Segment Differences
Request
STMP Met Configured

No Difference

Woodmen @ Powers
Woodmen @ Chapel ASCI2
Woodmen @ H25 W ASCIZ
Woodmen @ N Academy |ASC/3
Woodmen @ Austin Bluffs |ASC/3
Woodmen @ Rockrimmen |ASC/3
Woodmen @ N Union Bivd |ASC/3

Woodmen @ Rangewood |Oasis

No Difference

Mo Difference

No Difference

Difference Found Phase Timing, Overlap, TSP

Difference Found Coordinator, Sequence, Time Base

Difference Found Coaordinator

No Difference

4 |
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The columns on this report are:

Date/Time — The date and time the “Signal Upload and Compare” action ran.
Entity Name — The name assigned to the signal in the Entity Configuration window.

Description — The description assigned to the signal in the Entity Configuration
window.

Result — Information about the success or failure of the “Signal Upload and Compare”
action. For example, Difference Found means that discrepancies were found between
Centracs and the controller; No Difference means that no discrepancies were found;
results such as STMP Not Configured, STMP Bad Packet, and Comm Server Timeout
indicate a communication problem between Centracs and the controller.

The report also includes a Request row for each entity that was specified in the “Signal
Upload and Compare” action —i.e., arow with a Result value of Request. This row tells
you when the action was requested. If you ran the action for a collection of signals,
such as a Section, the report would list one Request row for the Section name, and
then one result row for each signal in the Section. If you ran the action for three
individual signals, the report would list three Request rows and three result rows. In
the example above, the action ran for the “Colorado Springs” System, so there is only
one Request row. This demo System contains nine signals, so there are nine result
rows.

Note that it may take a bit of time for the results to be gathered. In the example above,
the action was requested at 10:44:03AM, and the results were completed after
approximately 10 seconds.

Segment Differences — A list of any segments in which differences were found
between the current settings on the controller and the current settings stored in
Centracs for the controller. For details about which settings are contained in each
segment for ASC/3 and Cobalt controllers, refer to ASC3 and Cobalt Controller
Segments on page A-8.
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Split Monitor Report

The Split Monitor report is divided into three sections. For a specified signal, pattern, and
time period:

m The first section contains summary information, such as the number of cycles that
occurred during this time period, the programmed cycle length, the average of the
actual cycle lengths, and the minimum and maximum cycle lengths during this time
period.

m The second section contains bar graphs that show the programmed and actual phase
times.

m The third section contains a detailed list of the actual splits, programmed splits, actual
cycle length, and programmed cycle length for each cycle and phase during the
selected time period. This section is optional, and can be turned on or off with the
“Show Split Table” option. (Note that if you turn this option on, report generation may
be slower, and the report may be very long.)

For more information about the Split Monitor feature of Centracs, and for a description
of each field on the summary page, refer to Using Split Monitor on page 6-26.

In order to run this report, your system must collect split monitor data. (To do so, turn on
the “Split Monitor Logging” action via the scheduler, a manual command, or an action
set.) The Signal Name dropdown shows only the signals for which split monitor data exists
in Centracs. If there are no signals with data, the messages below are displayed in the
dropdowns:

F ek e o VN N RP P, o

Signal Mame: |No Split Monitor Signals Available j Coordinator Pattern: |Nc> Coord Patterns Available j

Note e The Coordinator Pattern dropdown list includes only the patterns available for the
selected controller.
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Sample of report section 1:

E] Split Monitor @ @
Configurable Report Options

Start Date & IOZ-"WZC'll 8:75:55 PM i End Date & IOzlefZOll 9:25:55 PM B8 || view Report |

Time: Time:

Signal Name: IWucrdmen ® N Union Blvd (ASC/3) j Coordinator Il vl

Show Split Table: & True " False

——
1 of 41 b M | ® @JJ W~ | PageWidth - |:| Find | Mext

Pattern:

Split Monitor
Signal Hame: Woodmen @ N Union Blvd (A SCI3)

Cycle Length Sample Time Pattern
Programmed: 90 zsec Patterns in Sample: Pattern Shown:
Actual Average: 95.44 sec # of Cycles Averaged: 5149

Minimu m: Hsee Duration Viewed:  6.01:00:00

Madmum: - 240 sec Start  206/2011 8:25:55 PM End:  2M2/2011 9:25:55 Pl

The valuesin the Cycle Length section are in seconds. The Duration Viewed value is shown
in days, hours, minutes, and seconds (DD.HH:MM:SS).

Note e For Oasis controllers, in the Coordinator Pattern dropdown list and in the Pattern
Shown field, the offset is shown after the pattern number. For example, ‘63-2’ indicates
pattern 63 and an offset of 2.
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Sample of report section 2:

Actual/Programmed Phase Split Time Averages

Phase(s)

I Avg Green
[y vellow
I ~vg Red Clear
[ Prog Ped Walk
[ Prog Ped Clear

40

Time (sec)

AVP = Actual Vehicle Phases
PVP = Programmed Vehicle Phases
PPP = Programmed Ped Phases

m

For each phase, two or three bars are shown:

m The first bar represents the Actual Vehicle Phases (AVP) average. This is an average of
the actual cycle lengths and the splits (green, yellow, and red clear) for all cycles
included in the analysis. The values are shown in seconds. The numbers shown in each
bar are the average green, yellow, and red times (in seconds) for that phase.

m The second bar represents the Programmed Vehicle Phases (PVP) average. This shows
the programmed spllts for the pattern (m|n green, green, yellow, and red cIear) in
seconds.
averaged-: The entire Iength of the bar (including min green green yeIIow and red
clear) shows the overall split length that is configured in the controller for this phase.
The numbers shown in each bar are the green, yellow, and red times (in seconds)
configured for that phase.

m The third bar, if shown, represents the Programmed Pedestrian Phases. This is the
programmed Ped Walk (darker green) and Ped Clear (lighter green) times for the
pattern, in seconds.-ravldslesatierrsareineluded-inthereparthesresrarmeacd-
tiraesareaveragedh
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Sample of report section 3:

Actual/Programmed Spilit Values

Date/Time

2/8/2011 8:27:05 PM 1015 | TOME0 | 1005 | S/30 | 1015 | T30 (1015

20812011 8:28:44 P 10415 (89/30 | 915 | 11/30 | 10415 | 830 | 815

20812011 8:30:22 PM 1015 | TO/30 | 10M5 [ /30 | 10M15 | T30 (1015

< [ mo 3

Each row in the table represents one cycle. Columns 1-16 represent the phases for that
cycle. Under each phase, the table shows the actual split for that cycle compared to the
programmed split. The last column shows the actual and programmed cycle lengths.

In the first row of the example shown above, the programmed split for phase 2 was 30
seconds, but the actual split was 70 seconds for this particular cycle. The programmed
cycle length was 90 seconds, but the actual was 99 seconds.

You can sort this table in ascending or descending chronological order by clicking on the
Date/Time column header.
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System Activity Report

The System Activity report is an audit trail of all the user activity in the Centracs
application. You can filter the data by date/time range, by entity type, and by user ID.
Optionally, you can also specify which types of actions and operations to include in the
report. You can sort the report by any column (by default, the information is sorted by
date/time).

If you only want to see data for one or more specific signals, set the “Use Signal Filter”
option to Yes, then select the signal(s) from the Signals dropdown list.

Note e The Activity dropdown list contains only those activities that are found in the audit
logs for your system. For example, if no entities have been deleted from your system since
the last time the audit logs were purged, “Deleted Entity” is not shown in the dropdown list.

When you run this report, you must select at least one item from the Activity list. You can
use the (Select All) option as a toggle to turn all options on and off.

[=] System Activity =

IE Configurable Report Options l

Start Date & Time: [12,21/2010 30711 PM 2] EndDate &Time: [12/23/20103:07-11pM

Use Signal Filter:  [ng - Signals: |Old Bitty Ln @ Olaf Way, Ne ~]
User Login: |CDGTR5_. Econolite, Falcon, j Entity Type: |Aries__ CCTV, Centracs, DMS, j
Activity: | Action Set, Added Applicati |

1 of 10 b M % | & -U W~ | 100% - Find | Next

System Activity i}

Time Range:

127212010 3:07:11 PM - 12/29/2010 3:07:11 PM

1202142010 3:09:31 PM System Signal Woodmen @ Chapel (ASC/2) Get Time

1202142010 3:10:06 PM System Signal Woodmen @ Chapel (ASC/2) Assert Phaze Call

1212142010 3:10:06 PH System Signal Woodmen @ Chapel (ASC/2) Assert Ped Call

121212010 3:25:27 PM Econolite WVehicle Detectors. EB Woodmen (@ Academy (Eastbound) |Edited Entity EB Woodmen @ Academy |-
1212142010 4:49:08 PN System Signal Woodmen @ M Union Bhvd (ASC/3) Get Time 1
1212142010 4:45:11 PM System Signal Woodmen @ M Union Bhvd (ASC/3) Assert Phaze Call

1212142010 4:45:11 PM System Signal Woodmen @ M Union Bhvd (ASC/3) Assert Ped Call

122272010 10:40:13 AN |Econolite Centracs Added User Role C2C Administrator

122202010 10:42:17 AN |Econolite Centracs Edited User Role C2C Administrator-Fountain
122202010 10:42:31 AN |Econolite Centracs Added User Role C2C Administrator-Falcon
12222010 10:45:54 AN |Econolite Centracs Added User Falcon, CO

122302010 121737 PR Econolite Signal Woodmen @ Rockrimmon (W4} Edited Entity VWoodmen (@ Rockrimmon
1212302010 51217 PM Econolite Centracs Added Jurisdiction Colorado Springs

121242010 9:38:20 AN Econolite Centracs Edited Traffic Algorithm Algorithm name: Woodmen R~
Fl m L3

Activities that are not associated with an entity (such as changes to Global or Local
Settings) are shown in the report with an Entity Type of “Centracs”. Activities associated
with an entity that has been deleted from the system are shown in the report with an
Entity of “<Entity Deleted/Unknown>".
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System Events Report

The System Events report shows all events that Centracs has logged within a specified
date/time range (if they are enabled on the Events tab of the Alerts and Events window).
This report offers a way to see all signal events, detector events, and Link-related events
in one view.

Note e If an event type is not enabled on the Events tab of the Alerts and Events window
(page 4-2), Centracs does not monitor that event type; therefore, events of that type are not
included in this report. The only exception is if a trigger has been added for the event —
events with triggers are included in the report regardless of whether they are enabled on
the Alerts and Events window.

You can filter the report to include or exclude specific event types, such as communication
problems and signals in flash. You can also filter it to include or exclude specific entities or
specific entity types (signals, links, and/or detectors). You can sort the report by date/
time, entity type, entity name, or event name.

By default, the report shows up to 500 rows that match your selection criteria. If your
database has a large quantity of system event data, select 250 from the “Row Limit”
dropdown to increase the efficiency of the report. If necessary, you can also select a
number larger than 500, or you can choose to show all data.

For an explanation of the event types included in this report, refer to Events on page 4-2.

Note e The Events dropdown list contains only those events that are found in the event
log for your system. For example, if no signals have gone into flash mode since the last time
the event log was purged, “Flash: ANY ON” is not shown in the dropdown list.
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10-52

D System Events @ @

[B Configurable Report Options ]

Start Date & Time: [08/01/2011 9:27:10AM ) End Date & Time: [0g/07/20115:2833 PV (i)

Entity Type(s): |Centrac5_. DMS, Link, Signal_.j Entity Name(s): |WB Woodmen @ Academy j
Events: |Col|ection Pattern Menitor [j Row Limit: 500 -
1 of 15 b b % & [E]aa = | 00% . Find | Next

System Events i

Time Range:

8/1/2011 92710 AM - 8/7/2011 5:28:33 PM

232011 45513 PM Signal Woodmen @ Powers (Oasig) Current Coordination Pattern Coordination Pattern
changed to 2

BI32011 45513 PM Signal ‘Woodmen @ Powers (Oasis) Power Restart

8/3/2011 45513 PN Signal Woodmen @ Powers (Oasis) Transition - OM Transition began at
8132011 45513 PM
to enter new pattern
from current pattern
number 2.

SI32011 45513 PM Signal Woodmen @ Powers (Oasis) Unit Control: Backup Mode - ON MNiA,

8/32011 4:55: 25 PM Signal Woodmen @ Austin Bluffs (ASC/3) Current Coordination Pattern Coordination Pattern
changed to 2

832011 4:55:29 PM Signal Woodmen @ Austin Bluffs (ASC/3) Power Restart

BI32011 4:55:28 PM Signal ‘Woodmen @ Austin Bluffs (ASC/3) Transition - ON Transition began at
832011 45529 PN [ 7

4 11 (3

Note e This report shows detector faults for NTCIP controllers only. To see detector faults
for both NTCIP and ACT controllers, use the Signal Detector Events report (page 10-34). To
see current detector faults for ASC/3, ASC/2, and Cobalt controllers, use the Detector Fault
Status window (page 6-48) or the Detector Fault Status report (page 10-22).

Note e For the numbered preempt events (i.e., Preempt Emergency Vehicle ##, Preempt
Railroad ##, and Preempt Other ## — for example, Preempt Railroad 01), the Details column
shows the preempt description that is currently in effect for that preempt. (If the preempt
description has been changed since the event occurred, the preempt description in the
Details column will not be the same as the preempt description that was in effect when the
event occurred.) If the default preempt descriptions have been overridden for a specific
signal, the override description is shown in the report; if not, the default description is
shown in the report. For more information, refer to Preempts on page 20-5 and Customizing
the Preemptor Descriptions for a Signal on page 3-42.
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Time Drift Report

The

Time Drift report shows the outcome of all Time Drift Check actions during a specified

time period. The Time Drift Check action is run via a manual command, schedule entry, or

acti

on set.

“Time drift” measures any difference between the current time according to Centracs and

the

You
acti

current local time on the field controllers.

can filter the report by date and Entity State, which specifies whether to include only
ve signals, only deleted signals, or both.

E]Tlme[)riﬂ

BX

Configurable Report Options

Start Date & Time:  [08/11/2011 11:10:34 AM iz End Date & Time: [08/11/2011 11:20:34 AM i View Report

Entity State: |

1 of 1

Time Drift

Time Range:
8M172011 11:10:34

Date/Time
BM12011 11:11:51 AR

Active j
.
r M e ® @ | &[E)]aa - | 0% . |:| Find | Mext

AM - 81172011 11:20:34 AM

Signal Hame Description Drift Exceeded  Details

VWoodmen @ N ASCI3 No 0s, Time below Maximum Drift of 15
Academy

112011 11:11:51 AW

VWoodmen @ Austin Dasis No 0s, Time below Maximum Drift of 15
Bluffs

SM12011 11:11:51 AW

Woodmen @ ASCH3 No Os, Time below Maximum Drift of 15
Rangewood

SM12011 11:11:51 AW

Woodmen @ Chapel ASC2 No Oz, Time below Maximum Drift of 15

112011 11:11:51 AW

Woodmen @ IH25 W ASC2 No 0s, Time below Maximum Drift of 15

SM12011 11:11:51 AW

Woodmen @ Wd No Os, Time below Maximum Drift of 15
Rockrimmen

SM12011 11:11:51 AW

Woodmen @ Black W4 No Response
Forest

BM12011 11:11:51 AM

VWoodmen @ N Union 0z, Time below Maximum Drift of 15
Bhed

SM112011 11:11:51 AW

Woodmen @ Powers Os, Time below Maximum Drift of 1s

4 I

The columns on this report are:

m Date/Time — The date and time the Time Drift Check action ran.
m Signal Name — The name assigned to the signal in the Entity Configuration window.
m Description — The description given to the signal in the Entity Configuration window.
m Drift Exceeded — Shows whether the drift on the signal was larger than the “Maximum
drift” value specified when the Time Drift Check action was requested (Yes or No).
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10-54

m Details — The difference between the time on the Centracs server and the time on the
signal controller, in seconds. This column also shows the “Maximum drift” value that
was specified when the Time Drift Check action was requested. Results such as STMP
Not Configured, STMP Bad Packet, and Comm Server Timeout indicate a
communication problem between Centracs and the controller.

You can sort the report by any column.

Note that the following signals are not included in a Time Drift Check, and therefore not
included in this report:

m Signals without any configured communication settings (on the Entity Configuration
window)

m Signals from external Server-to-Server systems
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Traffic Responsive Report

Note ¢ To see real-time traffic algorithm data as the algorithm runs, use the Traffic
Responsive monitoring window (page 13-16).

You can use the Traffic Responsive report to monitor threshold-based Traffic Responsive
performance on the system.

To run the report, specify the time period and the traffic algorithm to analyze. You can
also specify which columns to include in the report. (Some columns are not shown on the
sample report below.)

Optionally, set the “Only Show Pattern Change” option to Yes to only include rows that
have the Pattern Set column set to Yes (i.e., where a new pattern was sent to the
controllers). Set the “Only Show Change Recommended” option to Yes to only include
rows that have the Change Recommended column set to Yes (i.e., where TR made a
recommendation to change the pattern (regardless of whether the pattern was actually
sent to the controllers)).

The report is sorted by Date/Time.

[=] Traffic Responsive BX
Configurable Report Options
Start Date & Time: Io]joﬁ,fzon 8:25:46 AM | End Date & Time: |m.foe,fzo11 8:25:46 PM | View Report I
Traffic Algerithm IWDdeen Rd Cordor ¥ Columns to Display: IRaw Inbound, Raw Qutbour 'I

Only Show Pattern Change: Iyes - Only Show Change Recommended Mo -

——

H 41 of 5 b M|« 6] @:u - | 100% - |:| Find | Mext
Traffic Responsive

Time Range: 1/6/2011 8:25:46 AM - 1/6/2011 8:25:46 PM
Algorithm Name: Woodmen Rd Corridor

Raw Raw Smoothed | Smoothed |Smoothed | Smoothed | Smoothed | Smoothed | Cycle % Cycle Offset Split
Inbound | Outbound Inbound | Outbound | Sidestreet Occt DOcc2 Arterial Level Level Level
MIT 24454 o.00 o.00 0.00 24454 456 100 2 1 1 1 1 No

182011 245.00 1187 4391

8:30:01 AM

TBIZ011 12.05 245.00 11.87 24480 0.00 0.00 0.00 24490 48.98 486 100 2 1 1 1 1 No
3:40:02 AM

11612011 1214 243.98 1211 24417 0.00 0.00 0.00 24447 48.83 472 100 2 1 1 1 1 Ho
8:50:03 AN

TBIZ011 11.96 24229 11.99 24287 0.00 0.00 0.00 24287 48.53 47 100 2 1 1 1 1 No
5:00:05 AM

11612011 1198 245.00 11.95 24453 0.00 0.00 0.00 24453 4391 488 100 2 1 1 1 1 Ho
9:10:03 AN

182011 11638 24359 1174 24409 o.00 o.00 0.00 24409 4882 458 100 2 1 1 1 1 No
9:20:02 AM

Az 4402 na4oe 44n4 | masee nan nnn ann | masee aon4 acos 4nn n S

« [ m ] »
Smoothed Occl = Smoothed Occupancy Override 1
Smoothed Occ2 = Smoothed Occupancy Override 2
Occ Ovrrd 1 Level = Occupancy Override 1 Level
Occ Ovrrd 2 Level = Occupancy Override 2 Level

Sareraeredetats

Note e Due to the width of this report, use legal-sized paper when you print it.
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Travel Time Links Report

Note e This report contains historical link data. To get current link data, use the BlueTOAD
Link Pair Status window (refer to page 14-13).

For a specific BlueTOAD link pair, the Travel Time Link report graphs speed and travel time
data for multiple date ranges. You can use this report to see changes in trends over time.
You can plot data points every hour, every half hour, every quarter hour, or every 5
minutes within the specified date ranges.

Note ¢ The data for this report is logged in the database at five-minute intervals; this
interval is not configurable.

E] Travel Time Link Report

O

’E] Configurable Report Options

|

10-56

Links: IPairing (9287) {Colonial Blvd & Metro Plwry to Daniels Plry & Metra Phey) j Series 1 Start Date: |6,|’10.l’2012 || view Report
Starting Hour: [0:00 | Series 1 End Date: [6110/2012 11:59:59 P it
Mumber of Hours: [74 - Series 2 Start Date: |6,|’9,|’2012 ]
Inkerval: [60 min | Series 2 End Date: [6iarz012 11:59:59 Fm it
MNumber of Ranges: |2 vl Show Series Average: Yes -
Show Speed: Yes - Shews Travel Time Log Table: [ -
Shaw Travel Time:  fyag -
1 of 1 % & G Ao H- | 100% - Find | Next

»"\/\/\/\’-

To generate the report:

1
2

In the Links dropdown, select a BlueTOAD link pair.

Enter the hour of the day at which to start plotting points. For example, if you select
13:00, the first data point will be for 1pm.

Enter the number of hours to plot for each day. For example, if you select 13:00 as the
Starting Hour and 6 for the Number of Hours, the graph will include data for 1pm to
7pm.

Select the interval at which data points will be plotted during the date ranges (5
minutes, 15 minutes, 30 minutes, or 60 minutes).

Toinclude more than two date ranges, select the total number of ranges (up to 8) from
the dropdown. The report will use the pattern of the first two ranges you specified to
calculate the other date ranges. If Series 1 is earlier than Series 2, any other ranges go
forward in time; if Series 1 is later than Series 2, any other ranges go backwards in
time. For example, if you select 4 from the dropdown, and if the first two ranges you
specified are:

Series 1: 1/29/2016 - 1/31/2016
Series 2: 1/26/2016 - 1/28/2016
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the report will set the other two ranges to be:
1/23/2016 - 1/25/2016

and

1/20/2016 - 1/22/2016

If the first two ranges are reversed:

Series 1: 1/26/2016 - 1/28/2016
Series 2: 1/29/2016 - 1/31/2016

the report will set the other two ranges to be:
2/1/2016 - 2/3/2016

and

2/4/2016 - 2/6/2016

Each series will be represented on the graphs by a separate line. For example, if you
select four series, each graph will have four lines.

6 Specify which graphs to generate:

® Show Speed — For each series of dates, this graph shows the average speed at
different times of the day on this section of roadway.

® Show Travel Time — For each series of dates, this graph shows the average travel
time at different times of the day on this section of roadway.

7 Inthe Series 1 and Series 2 fields, enter the start and end dates for the first two date
ranges (or use the calendar pop-ups to select dates from the calendar). For best
results, set each range to contain the same number of days.

8 For the “Show Series Average” option, specify whether to include a line to show the
average of the other lines.

9 Forthe “Show Travel Time Log Table” option, specify whether to show a table that lists
the data used to generate the graphs.

10 Click View Report.

On the graphs, if the date ranges contain more than one day, then each data point
represents the average of all the days in the range for that time of the day (hour, half hour,
etc.).

Note e If aninterval does not have data (for example, if there was a communications
problem during that time), a point is not plotted on the graphs for that interval.
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Sample Graphs
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Travel Time Links Report =

Travel Time

Centracs User Ma
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Time
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A downward spike indicates a lack of data at that time, for any of the reasons below:
m  None of the passing vehicles had a Bluetooth™-enabled device

B There were no passing vehicles (because traffic was stopped or because no cars were
present)

m  Communications were down

Note e A straight horizontal line on the graphs often indicates stale data (for example, if
no vehicles with Bluetooth devices have been detected for an extended period of time).
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User Login Report

The User Login report is a historical list of all logins, logouts, and failed login attempts to
Centracs for the date/time range you specify.

You can filter this list for one or more specific users, or you can see all users. You can
specify whether you want to see logins, logouts, and/or failed login attempts. You can sort
the information by Date/Time, User Login, Full Name, or Details (by default, the report is
sorted by Date/Time).

For failed login attempts, the Details column shows the name of the machine from which
the login was attempted, the user ID that was attempted, and the reason the login failed.

Note ¢ To see a list of only those users who are currently logged into the system, use the
Monitoring P Current Users option from the main menu. For details, refer to Monitoring
Users on page 20-31.

E] User Login @ g

Configurable Report Options

Start Date & Time: |0?;19g2{:11 9:23:14 AM i End Date & Time: |ﬁ?fl‘3.-"2011 9:23:14 PM \iiew Report |
User(s): IEconoIite_. EMorthman, lcam_.j Login Type: IUser Legged In, User Login Ij

M 41 of1) M|e ®®|&EW@A- imﬁ%l | Find | Next
User Login

Time Range:

71972011 9:23:14 AM - 711972011 9:23:14 PM

Date/Time User Login Full Name Details
TAW2011 10:01:05 AW LafeyetteR Lafayette Reynolds User Logged In
THAN2011 10:02:47 AN kam K Mac User Logged In
THS2011 10:03:29 AM 5] Sue Syhvester User Logged Out
TAW2011 10:18:10 AN ptp Phineas T. Prune User Logged In
THAW2011 11:30:53 AN LafeyetteR Lafayette Reynolds User Logged Out

THA2011 1:01:53 PW EMorthman Eric Morthman User Logged In
< |

Note e This report can also be launched for a specific user from the Users and Recipients
report (page 10-61). To return to the parent report, click the “Back to Parent Report” icon.
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Users and Recipients Report

The Users and Recipients report is a list of all the people {ardremoete S2Sand-£26
systems;f-anyrthat are configured as users and/or recipients in your database. For each
person, the report shows all of the contact information that has been entered into the
system, the assigned security roles and jurisdictions, and the last date/time they logged
into Centracs.

For details about user/recipient configuration, refer to Defining Users on page 20-24 and
Defining Recipients on page 20-73.

You can sort the report by any column except Phone 1/Phone 2.

E] Users and Recipients @] @
M41 o2k M|« @@ | @[E[HAAA-| w00 Find | Mext
Users and Recipients

First Name Last Name User Role Application Roles Jurizdiction Roles Email / SMS Recipient Last Login
Jurisdictions

Chips OToole Supervisor- Supervisor App Role |TELLER Email: Teller County 21072011 10:11:22 PM

TEL User Role COT@econolte.com

David 5t. Hubbins Supervisor- Supervisor App Role |COS, DEN, TELLER  |Email: Phone 1: Al BM10/2011 10:14:11 PM
ALL User Role dsh@econolite.com §70-483-2722

Eric Horthman Supervisor- Supervisor App Role (COS Email: Phone 1: Colorado Springs  (8/10/2011 10:11:44 PM
COS User Role enorth@econolte.com | 718-253-8427
Emil Schaufhausen |COS Admin-  [Administrator App cos Email: Phone 1: Colorado Springs  (8/10/2011 10:11:50 PM
Black Forest  [Role dr.emil@econolte.com  970-232-9308
Forrest Lawrenceton |Supervisor- Supervizor App Role |COS, DEN, TELLER  |Email: Al 2/11/2011 3:24:48 PM
ALL User Role ForrLawr@econolte.com
James Jesenfen Administrator | Administrator App COS, DEM, TELLER  |Email: Colorado Springs  [2/M0/2011 10:13:04 PM
User Role Role jamesjes@econolite.com
James Josephson COS Admin- Administrator App cos Email: Phone 1: Al B8M10/2011 10:10:36 PM
Woodland Park [Role jamesjos@econolite.com |888-374-6080
SMS: Phone 2:

3139874039@tmobile.net | 970-768-0021
Lafayette Reynolds Supervisor- Supervisor App Role |DEN Email: Phone 2: Denver
DEN User Role lafayette@econolite.com |970-382-3128

Lawrence Jamison Administrator | Administrator App COS, DEN, TELLER  [SMS: Al BM0/2011 10:14:19 PM
User Role Role B8883746090@vz.net

M | b

The Recipient Jurisdictions column shows the jurisdiction(s) assigned to the Recipient
record for this person.

Note ¢ To see a list of logins and logouts for a specific user, click the user ID in the first
column. The User Login report opens, and shows you their activity during the last 24 hours.
You can change the start date to see older activity. To return to the Users and Recipients
report, click the “Back to Parent Report” icon.
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VOS Daily Report

For one or more vehicle detectors, the VOS Daily report graphs volume, occupancy, and
speed data for a specified time period. You can plot data points every day, week, or month
within the specified date range.

Note e This report contains historical detector data. To get current detector data, use the
Real-Time Detector Status window (page 6-42).

(=] vos Daily Report B

[E] Configurable Report Options ]

First Day: [ri12iz014 i Group, Signal, etc. [3th & Fontanero, &'s 6 & § (F 7|
Last Day: 711712014 11:59:59 P iz Series 1 |504 Det 1 (Call Phase(s) 1), 507 |

Interval: m Series 21 [504 et 2 (call Phase(s) 2), 50,7 ]

Show Total Yolume per Series: Yes - Series 3: I(None) j

Show dwg Occupancy per Series: Ves - Series 4 I(None) j

Show Awvg Speed per Seties: Yas - Series 5 I(None) j

Show Stacked Yalume of All Series: [y, - Series 6 I(None) j

Show Data Table: ™ = Series 7 I(None) j

Include Avg of All Series: Ma - Series 8 I(None) j

Include Sum of All Series: o -

1 of 1 P& EaH- | 100% - Find | Next
W

To generate the report:

1 Enter the start and end dates for the report, or use the calendar pop-ups to select
dates from the calendar.

2 Select the interval at which data points will be plotted during this date range (1 Day, 1
Week, or 1 Month).

3 Specify which graphs to generate:

® Show Total Volume per Series — For each series of detectors, this graph shows the
total number of vehicles detected during the specified date range.

® Show Avg Occupancy per Series — For each series of detectors, this graph shows the

percent of time the detectors were occupied (this is an average of all detectors in
the series).

® Show Avg Speed per Series — For each series of detectors, this graph shows the
average calculated vehicle speed (this is an average of all detectors in the series).
For more details, refer to Speed Calculations in Reports on page 10-78. Note that if
the volume/occupancy reported by the detector has an occupancy of zero, that
data is not included in the calculations for the Speed graph.
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® Show Stacked Volume of All Series — This graph shows the total volume for each
detector series, stacked on top of one another in order to illustrate the total volume
of all series combined.

For the “Show Data Table” option, specify whether to show a table that lists the data
used to generate the graphs.

For the “Include Avg of All Series” option, specify whether to include a line on the Total
Volume, Average Occupancy, and Average Speed graphs to show the average of the
other lines.

For the “Include Sum of All Series” option, specify whether to include a line on the
Total Volume graph to show the sum of the other lines.

In the “Group, Signal, etc.” dropdown, select one or more signals and/or groups of
signals. When you do, the Series dropdowns are populated with the detectors for
those signals only.

In the Series dropdowns, select the detectors to be included in the report. Each series
will be represented on the graphs by a separate line. For example, if you select four
series, each graph will have four lines{erfive-ifyouenable-thetneludeSeriesAve-
eptien}. Each series you configure can contain one or more detectors. For example,
you can configure one series for Eastbound detectors and a different one for
Westbound detectors. For each series you enter, make sure that the None box is
unchecked.

Click View Report.

Scroll through the pages of the report to see the various graphs.

Note e If an interval does not have data (for example, if there was a communications
problem between the controller and the detectors during that time), a point is not plotted
on the graphs for that interval.
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Sample Graphs
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The Stacked Volume graph is just a different presentation of the data in the Total Volume
graph. In the Stacked Volume example above, the combined volume for all four series on
July 15th is approximately 250,000 vehicles. In the Total Volume example, if you add the
values for all four points on July 15th, you get the same result — approximately 250,000
vehicles for that day.
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VOS Hourly Report

For one or more vehicle detectors, the VOS Hourly report graphs volume, occupancy, and
speed data for a specified time period. You can plot data points every hour, every half
hour, every quarter hour, or every 5 minutes within the specified date range.

Note e This report contains historical detector data. To get current detector data, use the
Real-Time Detector Status window (page 6-42).

[=] vos Hourly Report =1
IE] Configurable Report Options ]
First Day: [1111jz015 i Group, Signal, etc. f30th & Fontaners, @s & &1 (F 7 |

Last Day: [L17212015 11:59:50 Pm il Series 1: fitione) =l

Starting Hour: lm Seties 2: I(None) j

Mumber of Hours: >4 - Series 3: I(None) j

Inkerval: m Seties 4 I(None) j

Shaw Tokal Volume per Seties: Yas - Series 5t I(None) j

Shaw Awg Occupancy per Series: Yes - Series 6! I(None) j

Show vy Speed per Series: Yes - Seties 7: I(None) j

Shiw Stacked Valurne of All Series: [yae - Seties 8: I(None) j

Shaw Data Table: ™ - Include Sum af All Series: [p, -

Include Awg of all Series: Ma -

1 of 1 % & E g H- | 1w0% - Find | Next
-
W

To generate the report:

1

Centracs User Manual

Enter the start and end dates for the report, or use the calendar pop-ups to select
dates from the calendar.

Enter the hour of the day at which to start plotting points.
Enter the number of hours to plot for each day.

Select the interval at which data points will be plotted during this date range (5
minutes, 15 minutes, 30 minutes, or 60 minutes).

Specify which graphs to generate (select Yes or No for each):

® Show Total Volume per Series — For each series of detectors, this graph shows the
total number of vehicles detected during the specified date/time range. (Note that
if you select more than one day, the report averages the values for each hour of the
day for the entire date range.)

® Show Avg Occupancy per Series — For each series of detectors, this graph shows the

percent of time the detectors were occupied (this is an average of all detectors in
the series).
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® Show Avg Speed per Series — For each series of detectors, this graph shows the
average calculated vehicle speed (this is an average of all detectors in the series).
For more details, refer to Speed Calculations in Reports on page 10-78. Note that if
the volume/occupancy reported by the detector has an occupancy of zero, that
data is not included in the calculations for the Speed graph.

® Show Stacked Volume of All Series — This graph shows the total volume for each
detector series, stacked on top of one another in order toillustrate the total volume
of all series combined.

For the “Show Data Table” option, specify whether to show a table that lists the data
used to generate the graphs.

For the “Include Avg of All Series” option, specify whether toinclude a line on the Total
Volume, Average Occupancy, and Average Speed graphs to show the average of the
other lines.

In the “Group, Signal, etc.” dropdown, select one or more signals and/or groups of
signals. When you do, the Series dropdowns are populated with the detectors for
those signals only.

In the Series dropdowns, select the detectors to be included in the report. Each series
will be represented on the graphs by a separate line. For example, if you select four
series, each graph will have four lines{erfive-ifyou-enable-thetneludeSeriesAve-
eptien}. Each series you configure can contain one or more detectors. For example,
you can configure one series for Eastbound detectors and a different one for
Westbound detectors. For each series you enter, make sure the None box is
unchecked.

For the “Include Sum of All Series” option, specify whether to include a line on the
Total Volume graph to show the sum of the other lines.

Click View Report.

Scroll through the pages of the report to see the various graphs. If the date range contains
more than one day, each data point represents the average of all the days in the range for
that time of the day (hour, half hour, etc.).

Note e If an interval does not have data (for example, if there was a communications
problem between the controller and the detectors during that time), a point is not plotted
on the graphs for that interval.
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VOS Hourly Report

Sample Graphs

Average of Total Volume per Series

3000

4000—
3000

2000+
1000+

(| sd@iu | Jad SN0 D) awnos, e

Average Occupancy per Series

.

K2

T
%f% o % %
% =]

T
.e
%

B

%

“ " “
~7

B

]
23‘0
/‘} /{9 Fs
% @

R
Lo
r%va a&%
T%ao\am%
T@@a\a%
..%r.u_o H_%%
T%%\%%
..o;@o o;.%

40 —

=
[an)

[
= =
o —

{o5,) Aouednoo o abedany

10-67

Centracs User Manual

Software Version 2.x - March 2018



Generating Reports

= VOS Hourly Report

Average Speed per Series
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The Stacked Volume graph is just a different presentation of the data in the Total Volume
graph. In the Stacked Volume example above, the combined volume for all three series
between 17:00 and 18:00 (5:00pm and 6:00pm) is approximately 10,000 vehicles. In the
Total Volume example, if you add the values for all three points at 17:00-18:00, you get
the same result — approximately 10,000 vehicles during that hour.
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VOS Multi-Date Hourly Report

For one or more vehicle detectors, the VOS Multi-Date Hourly report graphs volume,
occupancy, and speed data for multiple date ranges. You can use this report to see
changes in trends over time. You can plot data points every hour, every half hour, every
guarter hour, or every 5 minutes within the specified date ranges.

Note e This report contains historical detector data. To get current detector data, use the
Real-Time Detector Status window (page 6-42).

[=] vOS Multi-Date Hourly Report BX

[E] Configurable Report Options ]

Groups, Signals, etc, ISDth & Fontanero, @'s 6 & 1 (Fj Seties 1 Start Date: |1.1'26,I'2016 _E
Detectars: [S04 Det 1 (Call Phases) 1), 50,7 Series 1 End Date [uiz8jz016 11:50:59 P |
Starting Haur: Im Sefies 2 Stark Date: |1,l'29,l'2016 EH
Mumber of Hours: 24 - Series Z End Date: |1,1'31,l'2016 11:59:59 PM EH
Interval: Im Mumber of Ranges: m
Shaw Tatal Yolume per Series: Yas = Include Awg of Al Series: MG =
Shaow Avg Occupancy per Series: Yas = Include Sumn of All Series: [y -
Show Avwg Speed per Series: Yas = Show Detector List: Na -
Shows Stacked Yolume of Al Series: [vas = Shows Table Data: Mo v
1 of 1 P & Bl o HE- | w0 - Find | Next

To generate the report:

1 Inthe “Group, Signals, etc.” dropdown, select one or more signals and/or groups of
signals. When you do, the Detectors dropdown is populated with the detectors for
those signals only.

2 Inthe Detectors dropdown, select one or more detectors to include in the report. If
you select multiple detectors, their values will be averaged together.

3 Enter the hour of the day at which to start plotting points. For example, if you select
13:00, the first data point will be for 1pm.

4 Enter the number of hours to plot for each day. For example, if you select 13:00 as the
Starting Hour and 6 for the Number of Hours, the graph will include data for 1pm to
7pm.

5 Select the interval at which data points will be plotted during the date ranges (5
minutes, 15 minutes, 30 minutes, or 60 minutes).
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6 Specify which graphs to generate:

10-70

® Show Total Volume per Series — For each series of dates, this graph shows the total

number of vehicles detected by the specified detectors.

Show Avg Occupancy per Series — For each series of dates, this graph shows the
percent of time the detectors were occupied (this is an average of all the selected
detectors).

Show Avg Speed per Series — For each series of dates, this graph shows the average
calculated vehicle speed (this is an average of all the selected detectors). For more
details, refer to Speed Calculations in Reports on page 10-78. Note that if the
volume/occupancy reported by the detector has an occupancy of zero, that data is
not included in the calculations for the Speed graph.

Show Stacked Volume of All Series — This graph shows the total volume for each
date series, stacked on top of one another in order to illustrate the total volume of

all series combined.

In the Series 1 and Series 2 fields, enter the start and end dates for the first two date
ranges (or use the calendar pop-ups to select dates from the calendar). For best
results, set each range to contain the same number of days.

Toinclude more than two date ranges, select the total number of ranges (up to 8) from
the dropdown. The report will use the pattern of the first two ranges you specified to
calculate the other date ranges. If Series 1 is earlier than Series 2, any other ranges go
forward in time; if Series 1 is later than Series 2, any other ranges go backwards in

time. For example, if you select 4 from the dropdown, and if the first two ranges you

specified are:
Series 1: 1/29/2016 - 1/31/2016
Series 2: 1/26/2016 - 1/28/2016

the report will set the other two ranges to be:

1/23/2016 - 1/25/2016

and

1/20/2016 - 1/22/2016

If the first two ranges are reversed:
Series 1: 1/26/2016 - 1/28/2016
Series 2: 1/29/2016 - 1/31/2016

the report will set the other two ranges to be:

2/1/2016 - 2/3/2016
and

2/4/2016 - 2/6/2016

Centracs User Manual
Software Version 2.x - March 2018



Generating Reports

VOS Multi-Date Hourly Report =

Each series will be represented on the graphs by a separate line. For example, if you
select four series, each graph will have four lines.

9 Forthe “Include Avg of All Series” option, specify whether to include a line on the Total
Volume, Average Occupancy, and Average Speed graphs to show the average of the
other lines.thi i : :

10 For the “Include Sum of All Series” option, specify whether to include a line on the
Total Volume graph to show the sum of the other lines.

11 For the “Show Detector List” option, specify whether to print the list of detectors at
the top of the report.

12 For the “Show Table Data” option, specify whether to show a table that lists the data
used to generate the graphs.

13 Click View Report.

Scroll through the pages of the report to see the various graphs. If the date ranges contain
more than one day, then each data point represents the average of all the days in the
range for that time of the day (hour, half hour, etc.).

Note e If an interval does not have data (for example, if there was a communications
problem between the controller and the detectors during that time), a point is not plotted
on the graphs for that interval.

Sample Graphs
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Stacked Volume for All Series

1400

Stacked Volume {(Courts per Intervaly

The Stacked Volume graph is just a different presentation of the data in the Total Volume
graph. In the Stacked Volume example above, the combined volume for all three series
between 17:00 and 18:00 (5:00pm and 6:00pm) is approximately 1380 vehicles. In the
Total Volume example, if you add the values for all three points at 17:00-18:00, you get
the same result — approximately 1380 vehicles during that hour.
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For one or more vehicle detectors, the VOS Multi-Date Daily report graphs volume,
occupancy, and speed data for multiple date ranges. You can use this report to see
changes in trends over time. You can plot data points as frequently as each day within the
specified date ranges.

Note e This report contains historical detector data. To get current detector data, use the
Real-Time Detector Status window (page 6-42).

[=] VOS Multi-Date Daily Report ]

IE] Configurable Report Options l

Group, Signial, ete. ISDth & Fontanero, &'s 6 & 1 (Fﬂ Seties 1 Start Date: |12|,'1|,'2|315 iz
Detectars: |504 Det 1 {Call Phassfs) 1), 5Uj Series 1 End Date |12||'5||'2|315 11:59:59 PM _‘E
Inkerval: Im Seties 2 Start Date: |12|,'5|,'2|315 s
Show Tokal Yolume per Series: Yas - Seties 2 End Date: |12."10."2015 11:53:5a PM HH
Shaow Avg Occupancy per Series: Ves = Murmber of Ranges: Iﬁ
Show Avg Speed per Series: Yes = Include Avg of All Seriss: [y -
Show Stacked Wolume of all Series: Yas - Include Sum af all Series: ™ =
Show Detector Lisk: Mo = Show Table Data: ™ -
1 of 1 P & E Ao H- | 0% - Find | Next

To generate the report:

1 Inthe “Group, Signal, etc.” dropdown, select one or more signals and/or groups of
signals. When you do, the Detectors dropdown is populated with the detectors for
those signals only.

2 In the Detectors dropdown, select one or more detectors to include in the report. If
you select multiple detectors, their values will be averaged together.

3 Select the interval at which data points will be plotted during the date ranges (1 Day,
1 Week, or 1 Month).

4 Specify which graphs to generate:

® Show Total Volume per Series — For each series of dates, this graph shows the total
number of vehicles detected by the specified detectors.

® Show Avg Occupancy per Series — For each series of dates, this graph shows the

percent of time the detectors were occupied (this is an average of all the selected
detectors).

® Show Avg Speed per Series — For each series of dates, this graph shows the average
calculated vehicle speed (this is an average of all the selected detectors). For more
details, refer to Speed Calculations in Reports on page 10-78. Note that if the
volume/occupancy reported by the detector has an occupancy of zero, that data is
not included in the calculations for the Speed graph.
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® Show Stacked Volume of All Series — This graph shows the total volume for each
date series, stacked on top of one another in order to illustrate the total volume of
all series combined.

5 For the “Show Detector List” option, specify whether to print the list of detectors at
the top of the report.

6 Inthe Series 1 and Series 2 fields, enter the start and end dates for the first two date
ranges (or use the calendar pop-ups to select dates from the calendar). For best
results, set each range to contain the same number of days.

7 Toinclude more thantwo date ranges, select the total number of ranges (up to 8) from
the dropdown. The report will use the pattern of the first two ranges you specified to
calculate the other date ranges. If Series 1 is earlier than Series 2, any other ranges go
forward in time; if Series 1 is later than Series 2, any other ranges go backwards in
time. For example, if you select 4 from the dropdown, and if the first two ranges you
specified are:

Series 1: 1/29/2016 - 1/31/2016
Series 2: 1/26/2016 - 1/28/2016

the report will set the other two ranges to be:
1/23/2016 - 1/25/2016

and

1/20/2016 - 1/22/2016

If the first two ranges are reversed:

Series 1: 1/26/2016 - 1/28/2016
Series 2: 1/29/2016 - 1/31/2016

the report will set the other two ranges to be:
2/1/2016 - 2/3/2016

and

2/4/2016 - 2/6/2016

Each series will be represented on the graphs by a separate line. For example, if you
select four series, each graph will have four lines.

8 Forthe “Include Avg of All Series” option, specify whether to include a line on the Total
Volume, Average Occupancy, and Average Speed graphs to show the average of the
other lines.thi i j j

9 For the “Include Sum of All Series” option, specify whether to include a line on the
Total Volume graph to show the sum of the other lines.

10 For the “Show Table Data” option, specify whether to show a table that lists the data
used to generate the graphs.

11 Click View Report.
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Scroll through the pages of the report to see the various graphs.

Note e If aninterval does not have data (for example, if there was a communications
problem between the controller and the detectors during that time), a point is not plotted
on the graphs for that interval.
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Sample Graphs
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The numbers on the X-axis indicate the day number within each date range. In this
particular example, the report parameters were:

Series 1 Start Date: 12/01/2015
Series 1 End Date: 12/05/2015
Series 2 Start Date: 12/06/2015
Series 2 End Date:  12/10/2015
Number of Ranges: 3

Interval: 1 Day

Therefore, Day 1 on the X-axis is December 1st for Series 1 (purple), December 6th for
Series 2 (blue), and December 11th for Series 3 (green).

The Stacked Volume graph is just a different presentation of the data in the Total Volume
graph. In the Stacked Volume example above, the combined volume for all three series on
Day 3 is approximately 175,000 vehicles. In the Total Volume example, if you add the
values for all three points on Day 3, you get the same result — approximately 175,000
vehicles for that day.

Speed Calculations in Reports

For Centracs reports that include vehicle speed calculations:
Average Speed = ((Volume * (Loop Length + Average Vehicle Length)) /
((Occupancy / 200) * Sample Time (in sec))) * Speed Unit
where Speed Unit for feet = 3600 seconds / 5280 feet (i.e., 1 hour / 1 mile)

Or
where Speed Unit for meters = 3600 seconds / 1000 meters (i.e., 1 hour / 1 kilometer)

Note e The percent Occupancy is divided by 200 instead of 100 due to the way Occupancy
values are logged, according to the “detectorOccupancy” object in the NTCIP 1202 standard,
“Object Definitions for Actuated Traffic Signal Controller (ASC) Units”.
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The optional MOE (Measure of Effectiveness) reports feature in Centracs calculates
detailed statistics about the performance of traffic signals and shows these calculations
graphically for easy interpretation by the user. Calculations are made from data collected
by ASC/3 and Cobalt signal controllers. The MOE reports include:

m  MOE Arrival On Green Report — graphs the percentage of vehicles that arrived at the
signal during the green interval. Refer to page 11-6.

m  MOE Cycle Length Report —graphs the actual length of each cycle run by the controller
during the day. Refer to page 11-8.

m  MOE Flow Rate Report — graphs the volume of vehicles detected per hour during each
time of the day for each phase. Refer to page 11-10.

m  MOE Green Times Report — graphs the actual length of the green time for each cycle
during the day for each phase. Refer to page 11-12.

m  MOE PCD Report — graphs the arrival time of each vehicle in relation to the actual
green, red, and yellow times for the selected phase. Refer to page 11-14.

m  MOE Percentage Pedestrian Calls Report — graphs the percentage and number of
cycles during which a pedestrian call occurred. Refer to page 11-17.

m  MOE Split Failures Report — graphs the number of times during the day that the
volume-to-capacity ratio was larger than or equal to the user-specified Failure
Threshold. Refer to page 11-19.

m  MOE Volume-to-Capacity Report — graphs the volume-to-capacity ratio for each time
of the day for each phase. Centracs uses this ratio to determine when split failures
occur. Refer to page 11-21.

Each report represents a user-specified 24-hour period (from 00:00:00 to 23:59:59). You
can run the reports for any 24-hour period for which data was collected. All MOE reports
have an option to print the graphs to a local or network printer.

Note e You must get a license key from Econolite Technical Support in order to use the
MOE reports feature.
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Settings

To configure the MOE report settings for a signal:
1 From the Entity Tree, right-click the signal and select MOE Settings. The MOE Settings
window opens.

[=] MOE Setiings

B

Signal Settings

Signal Mame Woodmen @ N Union

Bin Time {min} 30
Counis to Avg. 20
R1Coord. Phase (2 |

R2 Coord. Phase |6 |

Phase Seltings

Phase 1 ~|

Saturation Rate {veh/hry 1000

Failure Threshold 1

[ Save ][Cancﬂi]

2 Set values for the fields below and click Save:

11-2

Bin Time — The number of minutes represented by each data point in the graphs for
the Percentage Pedestrian Calls report (page 11-17) and each bar in the bar graphs
for the Split Failures report (page 11-19). For example, because each graph on these
two reports represents a 24-hour period, if you enter a value of 60 in the Bin Time
field, there will be 24 bars or points on each graph (where each one represents a
period of 60 minutes). With a value of 30, there will be 48 bars/points. As you
increase the Bin Time, the number of bars/points on each graph decreases; as you
decrease the Bin Time, the number of bars/points increases.

Counts to Avg. — This is used for the Flow Rate report (page 11-10), Green Times
report (page 11-12), and Volume-to-Capacity report (page 11-21), when the Show
Average option is turned on (which shows the moving average of the data points).
This setting indicates the frequency with which the average values will be
calculated — i.e., it is the number of data points that will be averaged together to
create each section of the moving average line. As you decrease the Counts to Avg
number, the average line becomes more jagged; as you increase the Counts to Avg
number, the line becomes flatter. For example, if you enter 1, the line for the data
points and the line for the moving average are identical. The default is 20.

R1 Coord. Phase — The Ring 1 coordination phase, used to calculate cycle lengths for
the Cycle Length report. This value is populated automatically using the
coordinated phase programmed on the controller for Ring 1. That phase number
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then becomes an option in the dropdown list on the Cycle Length report (refer to
page 11-8). (If the controller settings have not been uploaded to Centracs, these
fields are disabled, and you must upload the settings from the controller.)

® R2 Coord. Phase —The Ring 2 coordination phase, used to calculate cycle lengths for
the Cycle Length report. This value is populated automatically using the
coordinated phase programmed on the controller for Ring 2. That phase number
then becomes an option in the dropdown list on the Cycle Length report (refer to
page 11-8). (If the controller settings have not been uploaded to Centracs, these
fields are disabled, and you must upload the settings from the controller.)

® Phase — The phase to which the next two settings (Saturation Rate and Failure
Threshold) will apply.

® Saturation Rate —For the Split Failures report (page 11-19) and Volume-to-Capacity
report (page 11-21), the maximum capacity of vehicles per hour for the specified
phase (for all lanes combined). Centracs uses this number to calculate the volume-
to-capacity ratio. To determine the saturation rate, you can use the maximum
vehicle count observed during the peak hours for that phase.

® Failure Threshold — For the Split Failures report (page 11-19), the point at which the
ratio of volume to capacity is considered a split failure (from 0 to 1) for the specified
phase. For example, if the Saturation Rate is set to 1000 vehicles per hour and the
Failure Threshold is set to 0.9 (i.e., 90%), then a split failure is written if the actual
volume of cars for that phase reaches 900 in an hour (900 = 90% of 1000).

You can customize these settings for each signal. In the case of the Saturation Rate and
Failure Threshold, you can also customize them for each phase of a signal.

To turn on MOE data collection in Centracs:

Before you can run the MOE reports, data must be collected on the controllers, then
uploaded to Centracs.

IMPORTANT e After time, MOE data can consume a large quantity of storage space
and cause performance problems in your system. It is recommended that you monitor
your storage space, and archive and purge the MOE logs periodically. For details, refer
to Viewing Database Statistics on page 20-99, Archiving and Restoring Data on

page 20-89 and Purging Report Data from the System on page 20-94.

1 Inthe Entity Configuration window for the signal(s), make sure that the Enable MOE
Logging option is turned on. This activates the MOE logging on the controller. Refer to
Entity Configuration - Signals on page 3-36.

2 From the main menu, select Control » Scheduler... The Scheduler Entries window
opens.

3 Click Add... The New Schedule Entry window opens.

4 Inthe Action dropdown list, expand the “Common” list of actions, then select Upload
MOE Logs.
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Enter a name for this schedule entry, such as “Upload MOE Data from Controllers”.
Make sure that the Enabled checkbox is checked.
Click [ to the right of the “Entities” box. The Entity Selection window opens.

You can select one or more Systems, Sections, Subsections, Groups, and/or signals. For
instructions on how to use the Entity Selection window, refer to page 3-18. After you
have made your selections, click OK.

On the New Schedule Entry window, specify the date range for this schedule entry.
You can select the “No end” option to run it indefinitely.

Specify the Start time for the upload. (The End time can be any time after the Start
time.)

In the Recurrence box, specify how frequently to upload the logs from the
controller(s). Because the controllers keep only 24 hours of data, it is recommended
that you upload at least a few times per day (but no more frequently than one time
per hour).

To enter any exceptions, such as holidays or vacation dates, expand the “Exceptions”
section of the window and specify the days or dates. For details on how to add
exceptions, refer to Using the Scheduler on page 7-11.

Click OK.

Your new MOE log upload schedule is now shown in the Scheduler Entries table.
Optionally, you can configure an alert for the “MOE Upload Failed” event so you can
be notified automatically if an upload problem occurs. For instructions, refer to Using
Triggers on page 4-25.

Note e You can also upload MOE logs on demand via a manual command or an action set,
or from the Entity Tree (right-click the signal and select Upload MOE Logs).

Note e The MOE log upload is an FTP-based upload. If the FTP username and password
have been changed on the controller, you must change them in Centracs to match. You can
change them for all controllers on the Default Comm Parameters window (page 20-10) or
for a single controller on the Device Communication Configuration window (page 3-44).
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To run an MOE report:
1 From the Entity Tree, right-click a signal and select MOE Reports.

Or

From the Monitoring menu, select MOE Reports...

A sub-menu is shown with a list of the reports that are available.
2 Select one of the available MOE reports.

3 When the report window opens, specify the date for which to graph the performance
statistics. You can type the date in the Date box, or you can select a date from the
dropdown calendar.

4 If you launched the report from the Monitoring window, click [&] to the right of the
Signal field and select a signal from the Entity Selection window. For details, refer to
Using the Entity Selection Window on page 3-18.

5 |If available, specify any other options, such as the Phase or the type of graph to show.
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Arrival On Green Report

11-6

The Arrival On Green report graphs the percentage of vehicles that arrived at the signal
during the green interval.

The time of day (in 24-hour format) is plotted on the X-axis, and the percentage of arrivals
on green is plotted on the Y-axis. You can choose to plot each data point separately
(scatter plot), or plot a continuous line to connect the points (line plot).

A separate graph is shown for each phase of a standard eight-phase controller.

To use this report:

If a signal is not already selected, click [ to the right of the Signal field and select a
signal from the Entity Selection window. For details, refer to Using the Entity Selection
Window on page 3-18.

Enter a date, or click the calendar icon to select a date.

To change between a line graph and a scatter plot of the data points, click the Line or
Points radio button.

To see data for detectors at the stop bar, click the Call Detectors radio button; to see
data for upstream/advance detectors, click the Extend Detectors radio button. (To
determine whether a detector is a Call detector or an Extend detector, Centracs uses
the “Distance from Stop Bar” value in the Detector Configuration. If the detector is
configured in the controller as a midblock detector that does not call or extend a phase
(i.e., does not have a phase assigned), Centracs considers it an Extend detector for the
purposes of the MOE reports.)
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Cycle Length Report

The Cycle Length report graphs the actual length of each cycle run by the controller during
the day, in chronological order.

The time of day (in 24-hour format) is plotted on the X-axis, and the length of each cycle
in seconds is plotted on the Y-axis. You can choose to plot each data point separately
(scatter plot), or plot a continuous line to connect the points (line plot).

The blue vertical lines indicate the times of signal pattern changes.

To use this report:

If a signal is not already selected, click [ to the right of the Signal field and select a
signal from the Entity Selection window. For details, refer to Using the Entity Selection
Window on page 3-18.

Enter a date, or click the calendar icon to select a date.

To change between a line graph and a scatter plot of the data points, click the Line or
Points radio button.

From the dropdown list, specify what to base the cycle length calculations on: local
zero, the termination of the Ring 1 coordination phase, or the termination of the Ring
2 coordination phase. (The R1 Coord Phase and R2 Coord Phase options on the MOE
Settings window control the values shown in the dropdown list; refer to page 11-2.)

[=] cyele Length Report

X

Woodmen @ M Union Bivd (ASC/3) =

0012612011 fi3] |k

Termination of Cocrd Phase 2

Sample line graph
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Flow Rate Report

The Flow Rate report graphs the volume of vehicles detected per hour during each time
of the day for each phase. Centracs uses the volumes of vehicles shown in this graph to
calculate the ratios for the Volume-to-Capacity report (page 11-21). A separate graph is
shown for each phase of a standard eight-phase controller.

The time of day (in 24-hour format) is plotted on the X-axis, and the number of vehicles
per hour is plotted on the Y-axis. You can choose to plot each data point separately
(scatter plot), or plot a continuous line to connect the points (line plot).

The blue vertical lines indicate the times of signal pattern changes.

To use this report:

m If asignal is not already selected, click [ to the right of the Signal field and select a
signal from the Entity Selection window. For details, refer to Using the Entity Selection
Window on page 3-18.

m Enter a date, or click the calendar icon to select a date.

m  Tochange between a line graph and a scatter plot of the data points, click the Line or
Points radio button.

m Toshowaline that represents the moving average of the data points, enable the Show
Average checkbox. The frequency with which the average values are calculated is
determined by the “Counts to Avg” setting on the MOE Settings window (refer to
page 11-2).

B To see data for detectors at the stop bar, click the Call Detectors radio button; to see
data for upstream/advance detectors, click the Extend Detectors radio button. (To
determine whether a detector is a Call detector or an Extend detector, Centracs uses
the “Distance from Stop Bar” value in the Detector Configuration. If the detector is
configured in the controller as a midblock detector that does not call or extend a phase
(i.e., does not have a phase assigned), Centracs considers it an Extend detector for the
purposes of the MOE reports.)

Note e Ifthe data extends past the top of the graph, increase the Saturation Rate value on
the MOE Settings window (refer to page 11-3).
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Green Times Report

The Green Times report graphs the actual length of the green interval for each cycle
during the day, in chronological order. A separate graph is shown for each phase of a
standard eight-phase controller.

The time of day (in 24-hour format) is plotted on the X-axis, and the length of the green
time in seconds is plotted on the Y-axis.

The blue vertical lines indicate the times of signal pattern changes.

You can choose to plot each data point separately (scatter plot), or plot a continuous line
to connect the points (line plot).

To use this report:

m If asignal is not already selected, click [ to the right of the Signal field and select a
signal from the Entity Selection window. For details, refer to Using the Entity Selection
Window on page 3-18.

m Enter a date, or click the calendar icon to select a date.

m  Tochange between a line graph and a scatter plot of the data points, click the Line or
Points radio button.

m Toshowaline that represents the moving average of the data points, enable the Show
Average checkbox. The frequency with which the average values are calculated is
determined by the “Counts to Avg” setting on the MOE Settings window (refer to
page 11-2).
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The Purdue Coordination Diagram (PCD) report graphs the arrival time of each vehicle in
relation to the actual green, red, and yellow times for the selected phase. After you
determine whether the majority of vehicles arrive on green, yellow, or red, you can decide
whether coordination is warranted and whether the current offsets are effective.

The time of day is plotted on the X-axis, and the Y-axis indicates a point of time within the
cycle length; 0 on the Y-axis indicates the start of the cycle (i.e., the start of red) for the
selected phase. The blue vertical lines indicate the times of signal pattern changes.

For each cycle, the graph shows green, yellow, and red lines — these indicate the start of
the green, yellow, and red for the selected phase. Black dots indicate the detected arrival
of vehicles at the signal for the selected phase. The Y coordinate of each black dot
indicates the number of seconds after the cycle began that the vehicle was detected.

To use this report:

m If a signal is not already selected, click [ to the right of the Signal field and select a
signal from the Entity Selection window. For details, refer to Using the Entity Selection
Window on page 3-18.

m Enter a date, or click the calendar icon to select a date.
m Select a phase from the dropdown list.

m To change between a line graph and a scatter plot of the data points, click the Line or
Points radio button.

B To see data for detectors at the stop bar, click the Call Detectors radio button; to see
data for upstream/advance detectors, click the Extend Detectors radio button. (To
determine whether a detector is a Call detector or an Extend detector, Centracs uses
the “Distance from Stop Bar” value in the Detector Configuration. If the detector is
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configured in the controller as a midblock detector that does not call or extend a phase
(i.e., does not have a phase assigned), Centracs considers it an Extend detector for the
purposes of the MOE reports.)

BX
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Sample scatter plot
The section of the graph shown below explains how to interpret the vehicle arrival dots.

In this example, the vehicle counts are highest after the start of green.
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Percentage Pedestrian Calls Report

The Percentage Pedestrian Calls report graphs the number and percentage of cycles
during which a pedestrian call occurred. After you monitor how frequently the pedestrian
phases are serviced during the day, you can assess their impact on coordination. A
separate graph is shown for each phase that has a programmed walk time, including
exclusive ped phases.

If you turn on the Show Counts option, the graph shows the number of cycles that had a
ped call; if you turn it off, the graph shows the percentage of cycles that had a ped call.

For each graph, the time of day (in 24-hour format) is plotted on the X-axis, and the
percentage or number of cycles in that phase that had a ped call is plotted on the Y-axis.

The blue vertical lines indicate the times of signal pattern changes.

The “Bin Time” value on the MOE Settings window (page 11-2) determines the number of
minutes represented by each data point on the graphs. For example, because each graph
on this report represents a 24-hour period, if you enter a value of 60 in the Bin Time field,
there will be 24 points plotted on each graph (where each point represents a period of 60
minutes). With a value of 30, there will be 48 points. As you increase the Bin Time, the
number of points on each graph decreases; as you decrease the Bin Time, the number of
points increases.

To use this report:

m If asignal is not already selected, click & to the right of the Signal field and select a
signal from the Entity Selection window. For details, refer to Using the Entity Selection
Window on page 3-18.

m Enter a date, or click the calendar icon to select a date.
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Split Failures Report

The Split Failures report graphs the number of times during the day that the volume-to-
capacity ratio was larger than or equal to the user-specified Failure Threshold (page 11-3).
A separate graph is shown for each phase of a standard eight-phase controller.

The time of day is plotted on the X-axis, and the number of split failures is plotted on the
Y-axis. The blue vertical lines indicate the times of signal pattern changes.

The Bin Time value on the MOE Settings window (page 11-2) determines the number of
minutes represented by each bar in the bar graphs. For example, because each graph on
this report represents a 24-hour period, if you enter a value of 60 in the Bin Time field,
there will be 24 bars on each graph (where each bar represents a period of 60 minutes).
With a value of 30, there will be 48 bars. As you increase the Bin Time, the number of bars
on each graph decreases; as you decrease the Bin Time, the number of bars increases.

Note e If the bars extend past the top of the graph, decrease the Bin Time value.

To use this report:

m If asignal is not already selected, click & to the right of the Signal field and select a
signal from the Entity Selection window. For details, refer to Using the Entity Selection
Window on page 3-18.

m Enter a date, or click the calendar icon to select a date.

m Tosee data for detectors at the stop bar, click the Call Detectors radio button; to see
data for upstream/advance detectors, click the Extend Detectors radio button. (To
determine whether a detector is a Call detector or an Extend detector, Centracs uses
the “Distance from Stop Bar” value in the Detector Configuration. If the detector is
configured in the controller as a midblock detector that does not call or extend a phase
(i.e., does not have a phase assigned), Centracs considers it an Extend detector for the
purposes of the MOE reports.)

Centracs User Manual 11-19
Software Version 2.x - March 2018



Using the MOE Reports

= Split Failures Report

[=] split Failures Report B

E ‘Woodmen @ N Union Bivd (ASC/3) [

11-20 Centracs User Manual
Software Version 2.x - March 2018



Using the MOE Reports

Volume-to-Capacity Report =

Volume-to-Capacity Report

This report graphs the volume-to-capacity ratio for each time of the day for each phase.
Centracs uses this ratio to determine when split failures occur (refer to the Split Failures
Report on page 11-19). It is calculated as:

Volume-to-Capacity = actual number of detected vehicles in an hour /
capacity

Capacity is calculated as:

Capacity = saturation (green time for the phase / cycle length)

where saturation is the user-specified Saturation Rate (i.e., the maximum capacity of
vehicles per hour for the specified phase, refer to page 11-3).

A separate graph is shown for each phase of a standard eight-phase controller.

The time of day (in 24-hour format) is plotted on the X-axis, and the volume-to-capacity
ratio is plotted on the Y-axis. You can choose to plot each data point separately (scatter
plot), or plot a continuous line to connect the points (line plot).

The blue vertical lines indicate the times of signal pattern changes.

To use this report:

m If a signal is not already selected, click [ to the right of the Signal field and select a
signal from the Entity Selection window. For details, refer to Using the Entity Selection
Window on page 3-18.

m Enter a date, or click the calendar icon to select a date.

B To change between a line graph and a scatter plot of the data points, click the Line or
Points radio button.

m Toshow a line that represents the moving average of the data points, enable the Show
Average checkbox. The frequency with which the average values are calculated is
determined by the “Counts to Avg” setting on the MOE Settings window (refer to
page 11-2).

m Tosee data for detectors at the stop bar, click the Call Detectors radio button; to see
data for upstream/advance detectors, click the Extend Detectors radio button. (To
determine whether a detector is a Call detector or an Extend detector, Centracs uses
the “Distance from Stop Bar” value in the Detector Configuration. If the detector is
configured in the controller as a midblock detector that does not call or extend a phase
(i.e., does not have a phase assigned), Centracs considers it an Extend detector for the
purposes of the MOE reports.)
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With the Server-to-Server feature (S2S, for short), you can exchange real-time traffic data
with the Centracs systems of other agencies. You can configure the permissions for the
neighboring agencies such that they can only view your entities, or such that they can also
issue commands to your entities. You can also control which entities are shared with other
agencies.

Note ¢ For information about how Centracs resolves scheduling conflicts when multiple
commands try to control the same signal at the same time, refer to Scheduling Conflicts on
page 7-2.

Configuring Server-to-Server (S2S)

To set up two-way communications between two Centracs systems, the procedures
below must be performed on both of the shared servers (i.e., your server and the other
agency’s server).

IMPORTANT e All shared S2S servers must run the same version of Centracs. If one
agency upgrades to a new version, all shared S2S servers must upgrade at the same
time.

1 Setting Permissions for the External Agency. To configure S2S, the first step is to
decide the levels of permissions to grant to users from the other agency. For example,
you can grant view-only access, or you can also grant the ability to issue commands to
your entities. These permissions are defined as they would be for any Centracs user in
your own organization — i.e., with roles.

a Configuring Roles. For instructions on how to add and assign roles, refer to these
sections:

Overview of Security on page 20-11
Defining Jurisdiction Roles on page 20-14
Defining Application Roles on page 20-19
Defining User Roles on page 20-23

Note e Itisirrelevant which Jurisdiction you assign to the external agency’s
Jurisdiction Role, because you will select which entities you want to share with the
external agency in step 4 on page 12-4.
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Note e Regardless of their permissions, users on remote systems cannot edit the
Entity Configuration properties of your entities.

Adding a Centracs User. After the necessary roles have been set up in Centracs,
open the Users window (Management » Users...) and add a Centracs user account
to be assigned to the external agency. For example, a user name similar to
agencynameS2S (e.g., LittletonS2S) or S2Sagencyname (e.g., S2SLittleton) would be
appropriate. When you select a User Role from the Role dropdown, you are
selecting the role permissions that will be given to that agency. For details on the
Users window, refer to Defining Users on page 20-24.

Note ¢ You can also set up individual people at the other agency as “Recipients” so
that they can receive offline alerts. For details, refer to Defining Recipients on
page 20-73.

Adding a Windows User. After the necessary permissions have been set up in
Centracs, you must define a local (non-domain) Windows user name and password
for the external server:

— On the Centracs Core machine, open either the Computer Management screen
or the Server Manager screen in Windows, then go to Local Users and Groups.
(The method to open these screens depends on your Windows version.)

— Add a new user, such as agencyname (e.g., Littleton). Refer to your Windows
documentation for instructions.

When you define the user, turn off the “User must change password at next
logon” option, and turn on the “User cannot change password” and “Password
never expires” options.

— Provide the new user name and password to the administrator of the external
server; the administrator must configure the Server-to-Server Settings window
on their Centracs system with this user name and password.

2 Defining the External Centracs Server You Want to Access.

a From the main menu, select Management » Server-to-Server... The Server-to-

12-2

Server Settings window opens.

[=] server-to-Server Settings [=I1ES

Specify external servers from which entities will be accessed and shown locally.

(o) [Eot ] (3 peee ]

MName Location URL Username
Englewood | net.bop://172.20.96.68:5012 | IM3-0405 14\ Denver
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b To define a new server, click + Add. The Edit Connection window opens.

¢ Enter a name for the external server (this can be the host name, IP address, or any
unique name), the location URL, and the user name and password given to you by
the administrator of the external server.

d To save your changes, click OK.

E] Senver-to-Server Settings [E] @

Lecation URL Username
net.top:ff172.20.96.155:5012 | IM2-040514\Denver
net.top:f/172.20.96.68:5012 | IM3-040514\Denver

3 Assigning Credentials to the External Server. You must associate the external server
with its Windows/Centracs credentials:

a From the main menu, select Management » External Connections... The External
Connections window opens.

b Click +Add. The Add Connection window opens.
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c Select Server-to-Server and click OK.

[ Extemal Connections [=I1E|

Server Littleton
e Servar-to-Server Littleton

Server-to-Server Englewood

Server-to-Server

d Inthe Name field, change the default name to a unique name for the external
agency’s S2S server.

e Under the Connection Credentials section, use the Credentials field to select the
Centracs user account you created earlier.

f Use the Windows User field to enter the Windows user name you created earlier.
This is case-sensitive.

g Click Save.

4 Sharing Entities with the External Server. You must specify the entities that the
external agency can see and/or control:

a From the main menu, select Management » External Connections... The External
Connections window opens.
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b On the left side of the window, select the external server to share entities with:

[ Extemal Connections [=I1E|

erver-to-Server Littleton
5 = Server-to-Server Littleton

Server-to-Server Englewood

Server-to-Server

¢ Under the Entity Sharing section, click + Share... The Entity Selection window
opens.

d Select one or more entities (Signals, Sections, etc.) to share with the external server.
For details, refer to Using the Entity Selection Window on page 3-18.

Note that all child entities of the entities you select are also shared. For example, if
you share a Section, all Subsections, Groups, Signals, Detectors, etc. under that
Section are also shared. If it is necessary to share a parent entity but not all of its
child entities, you can add a new Group entity that contains only the entities you
want to share. Then select the new Group entity on this window.
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[] Extemal Connections =]

Servar-to-Server Littleton

Server-to-Server Englewood
Server-to-Server

The window shows the entities to be shared.

e Click Save.
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Using Server-to-Server (S2S)

After the Server-to-Server settings have been configured, you can:
m View the status of the connection to an external server
m View the status of each external device on the Device Status window (page 6-23)

m Send “Set Pattern” and “Set Time” commands to the external server (if permitted by
the other agency) using manual commands or the scheduler

m View the other agency’s shared entities in the Entity Tree
m View the other agency’s shared entities on the map

Entities that have been shared with you by another agency are shown in the Entity Tree
along with your own local entities. You can easily identify the external entities by the
symbol below:

[—] Entity Tree =1
oL AL UL
Search free_ . @
» j,{! Systemn Denver (Local System) E
" = Zystem

Systemn External System
i | !"'li_ Sarver To Semver - Littleton E'

- ﬁg Section Morth Litleton Signals,

Signal Joan Wilder Ln (@ Jack T Colton
d asc/3 50501 O =

| Signal Zele Dr @ Angelina Blvd
v i as0'3 50502 o=
7% Vehicle Detector 3 Det 2 =
Call Phase(s) 2
% Vehicle Detector 3 Det 3 =

Call Phase(s) 3

Hold the mouse over the symbol to see the name of the external system that owns the
entity.

As with local entities, you can right-click an external entity to see a list of available
commands. For example, if the external agency has granted you permission to send
manual commands to their entities, the Manual Command option is available in the list.
You can also double-click an external entity to open its status window.

Note e In order to perform actions (such as manual commands) on external entities in
your system, the Jurisdiction Role assigned to your User ID must have permissions for the
Jurisdiction that is configured as the default jurisdiction in your local Centracs system.
Otherwise, you can only view them.

External entities are automatically integrated into your local map. In the Map Viewer, you
can see both your own local entities and the external entities without any further
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configuration. As with local entities, you can right-click an entity and “zoom” to it on the
map.

You are permitted to see the properties of external entities, but not to edit them.

For information on how to see the status of a S2S connection, refer to Viewing S2S
Systems Status on page 12-9.

You can also use the tools below for external entities:
m Comm Test (page 6-16)

m Device Status (page 6-23)

®  Manual Commands (page 7-8)

m Notes (page 3-14)

m Device Collection Monitor (page 6-19)

m Traffic Algorithms (page 13-5)

Note e External entities are not included in the Centracs reports.
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Viewing S2S Systems Status

Each external server is represented by a separate icon in the Centracs status bar. If
you have multiple external servers, roll your mouse over each icon to see the server name:

To get more details:

» click the Server-to-Server Status icon in the status bar. The Server-to-Server Status
window opens:

E] Server-to-Server Status @] E

Status

Mame : Littieton
Connected : True

Organization Information
Mame : Colorado Springs

Lecation : Fillmore & Professional Place
Function : Dewvelopment

Or

» From the main menu, select Monitoring » Server-to-Server Status... The Systems
Status window opens.

E] Systems Status @ E

Mame Crganization Connected
Littleton |Littleton True ‘

Fillmore & Professional Plaza

Development

Both of these windows show whether your system is currently connected to the external
server (True or False), and show some basic information about the external server. Note
that the first Name field is populated from the Server-to-Server Settings window

on your system; the Organization information is populated from the Organization
Information window (accessed via the File » Settings option) on the external system.
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Introduction to Traffic Responsive (TR)

The Centracs Traffic Responsive (TR) algorithm offers real-time traffic flow assessment
and pattern selection. Based on the threshold-based algorithm specifications from the
U.S. Department of Transportation, Centracs TR uses multiple user-specified traffic flow
threshold levels to make pattern selections. System detector counts are grouped by
location and direction to obtain the level of detail necessary to apply the data to three
classifications of thresholds. These three threshold classifications identify different types
of traffic patterns, including:

m degree of arterial saturation (cycle threshold)
®m inbound verses outbound demand, such as north verses south (offset threshold)

m arterial verses side street demand, such as north-south verses east-west (split
threshold)

Also, there are two occupancy override options to identify over-saturated conditions and
apply specific patterns to give priority to the saturated movements.

O e

o H
Ly
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13-2

Unlike adaptive algorithms, such as those in Centracs Adaptive, TR does not change
programmed controller values, like split times or offsets. Rather, from the group of
patterns that have been configured, TR selects the pattern best suited to the current
conditions (you must set up these patterns before the algorithm runs). In order for TR to
operate to its fullest potential, you must design these pre-programmed patterns to
handle the conditions that TR identifies when it runs. For example, high demand in a
specific direction requires the selected pattern to address the heightened demand,
perhaps with more split time allocated to the movement(s) in question. If patterns are not
configured correctly to address the traffic conditions identified by the algorithm, TR does
not have the ability to enhance the pattern or change any other timing parameters.

Usually, scheduled time-of-day-based pattern selection can accommodate predictable
traffic variations, and TR is not necessary. TR is best suited to changing, unusual, or
unpredictable traffic situations, such as:

m sporting events

m day-of-the-week variations
m  holidays/special days

m adverse weather

m crashes/incidents

TR also helps you to achieve more precise time-of-day pattern changes during normal
traffic conditions.

You can configure each TR algorithm to control a Section, Subsection, and/or Group of
intersections. For the sake of brevity, the TR documentation uses the term “Section” to
refer to all three of these entity types that TR can control.

Because you can use the Centracs scheduler to turn TR on and off for a Section, you can
configure TR to run at specific times of the day, on specific days of the week, for specific
date ranges, etc. This gives you flexibility in your operations.
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Detector Data

Good detection is critical to the successful operation of TR. The goal in detector placement
is to measure flow characteristics. Usually, advanced detection is most effective at least
40 to 60 feet from the stop bar. In some circumstances it may be necessary to identify
excessive queue lengths so that you can apply special patterns to decrease those queues.
Detectors installed at the upstream queue locations can feed occupancy data to
dedicated override channels that can then select a specific pattern to address the
situation.

TR is flexible in that you can include detectors in the algorithm even if they are not
connected to controllers within the Section that is under TR control. You can use any
correctly configured, functioning system detector in any TR algorithm, any number of
times. If you use the Server-to-Server interface to connect to other systems/agencies, the
detectors from those systems are also available for use.

To minimize the effects of detector malfunctions and/or intermittent communication
problems, Centracs replaces missing or bad system detector data while it does its
calculations. To do so, it:

1 Averages all good records for the last half hour.
If this is not possible, then it...

2 Averages all good records for 15 minutes before and up to 15 minutes after the
missing data time for the same day of the week; it can go back four weeks if necessary.

If this two-step procedure fails, that record is not used in the calculations.
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Channels

13-4

A channel is a way to group detectors. Detectors are assigned to channels based on their
location or purpose. After detectors have been assigned, channels aggregate the detector
data such that the end values can be associated in threshold levels for pattern selection.

There are six channels:

Inbound — Used to group detectors for one of the main thru or coordinated directions,
such as Northbound.

Outbound — Used to group detectors for the opposite main/coordinated direction,
such as Southbound.

Sidestreet — Usually used to group detectors for the opposing thru directions, such as
Eastbound-Westbound. But if necessary, you can use Sidestreet (if configured
correctly) for protected turn phases on the main street or side street (but not both).

Arterial — A pseudo-channel made of Inbound plus Outbound values. You do not assign
detectors to the Arterial channel; rather, you use this channel to specify the maximum
V+kO value. This maximum is the highest V+kO value expected for the Section in one
direction only (Inbound or Outbound). Centracs uses this value to change the other
channel output values into a percentage value.

Occupancy Override 1 & 2 — These two channels are intended to group detectors
whose occupancy values are used to identify highly congested movements or queues
that interfere with flow. When the override is in effect, the pattern selected takes
precedence over normal TR operation. When both overrides are in effect, the second
override takes precedence over the first.

After you assign system detectors to channels, then Centracs:

1

Calculates a scaled volume plus weighted occupancy (Scale * (V+kO)) for each channel
based on the detectors assigned to the channel.

Combines the channel values mathematically to derive a cycle value, offset value, and
split value.

Compares the derived cycle/offset/split values to the programmed thresholds and
determines cycle/offset/split percentages:

® Cycle % = Arterial V+kO / Max V+kO
® Offset % = Inbound V+kO / Arterial V+kO

® Split % = Arterial V+kO / (Arterial V+kO + Side Street V+kO)
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Creating a Traffic Algorithm

To add a new traffic algorithm:
1 From the main menu, select Configuration » Traffic Algorithms...

E] Traffic Algorithms @ E

Enfity Configuration State

(=] Algerithm Configuration (=1

Type | Tiafiic Responsive (Threshold)
Enities

3 Enter a name for the algorithm.

4 From the Type dropdown list, specify Traffic Responsive or Centracs Adaptive.

5 In the Entities field, click [ and select one or more Sections, Subsections, or Groups
from the Entity Selection window. For instructions on how to use the Entity Selection
window, refer to page 3-18.

6 Click OK. The new algorithm is shown in the table with a Configuration State of “Not
Configured”.

E] Traffic Algorithms @ E

Enfity Configuration State

Woodmen Rd Corridur| Traffic Responsive {'I'hrﬂhnld}| ﬂ Woodmen Rd | Mot Configured
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7 Select the new algorithm in the table and click the Configure Algorithm icon ., or
right-click the algorithm and select the Configure... option.

For TR algorithms, the Threshold Traffic Responsive window opens. Set values on the
various tabs and click OK. For details about this window, refer to Configuring
Channels, Thresholds, and Patterns on page 13-8.

For Adaptive algorithms, the Adaptive Controller Settings window opens. For details
about this window, refer to Configuring Adaptive Controller Settings on page 18-8.

Optionally, to change the values for the matrix you chose from the “Threshold and
Pattern Matrix” dropdown (or to add a new matrix), you can click [ to the right of the
dropdown, or you can select the algorithm from the Traffic Algorithms table and click

the Configure Thresholds icon H The Thresholds and Pattern Matrices window
opens.

[=] Thresholds and Pattern Marices =114

'? 5 . Cycle Level Ofizet Level Spiit Level Pattern
Cycle percent is arterial VkO divided by Max V+kO

366 - = %61 ¥ 1_"oFreel[oFlasn”oLocal"QNuPaﬂem]
2 33 -6 %22 4O 1 "OFme”OFlasn”OLocal”ONoPaﬂem|
ROSUE 33 ¥ 17"OFree”OFlash”OLocﬂ”ONuPaﬂem|
Offset Levels (inbound vs. outbound bias)

Cffset percent is mbound +kO divided by inbound plus outbound V+kO. Higher values impty . ”OFIBBI[O Flash ’O Local ][ONupaﬂem]

heavier inbound traffic; lower values imply heavier outbound traffic.

3 66 - 100 % 61 & [ 1 ”C)Free”(jﬂash“{jlocal”C}Nupaﬂem|
233 -6 %23 ¥ OE 1_”OFree][OFlasnl[OLocal"ONuPaﬂem]

10 -33 % (B
Split Levels (arterial vs. sidestreet bias)

A e e e L = 1 ][O Free ][ Frasn |[ ) Local |[ © o pattem |

10 - 100 % 1 "(‘)Freel[oﬂash][oLocal"QNuPaﬂem]

1 "(_}Free”OFlash”OLocal”ONuPaﬂem]

Decreaging Hysteresis (%) S
Amount that will be subtracted from the low end of 2 level's range when the cycle. offset, or split
value is decreasing. This reduces the possibility of bouncing to and from a level.

For more details about this window, refer to Configuring Channels, Thresholds, and
Patterns on page 13-8.

8 After you have set all the necessary values, click Save, then click Close.

E Traffic Algorithms @ (]

MName Algorithm Entity Configuration State

‘Woodmen Rd Corridcl-r‘ Traffic Respensive {Thrshold}‘ EW{)MM Rd |Complete
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The algorithm is shown in the Traffic Algorithms table with a Configuration State of
“Complete” (unless you did not select a value for the “Threshold and Pattern Matrix”
field or you did not specify at least one detector for at least one of the channels; in this
case, the algorithm is shown with a Configuration State of “Incomplete”).

As an alternative to the icons, you can right-click a row in this table to show a pop-up
menu with options to edit, monitor, configure, and delete the algorithm.

To copy an existing traffic algorithm:
1 From the main menu, select Configuration » Traffic Algorithms...

E Traffic Algorithms @ E

Algorithm Entity Configuration State

‘Woodmen Rd Corridcl-r‘ Traffic Respensive {Thrshold}‘ EW{)MM Rd |Complete

2 Select the algorithm you want to copy.

3 Click the Copy Algorithmicon ! The Algorithm Configuration window opens, where
you can enter a name for the copy. You can also add or remove entities, if needed, but
you cannot change the algorithm type.

4 Click OK. The new algorithm copy is shown in the table, and includes all the same
configuration settings as the original algorithm you copied.
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Configuring Channels, Thresholds, and Patterns

To configure the Traffic Responsive (TR) thresholds and pattern matrices:
1 Open the Threshold Traffic Responsive window from the Traffic Algorithms window

(select an algorithm in the table and click the Configure Algorithm icon , or right-
click the algorithm and select the Configure... option).

E] Threshold Traffic Responsive - Woodmen Rd Corridor @ [E

Disable Logging
Do not bog TR computaticns to the database.

Interval (mins) 10
Frequency with which TR runz on this Section, in minutes.
Reference Time 00:00

Time at which TR will increment its interval, in 24-hour format. This is not 3 start time. For example, 3 Referenca Time of 15:20 and an Interval of 15 minutes.
will caus= TR to compute at 15:08, 15:20, 15:35, 15:50, 18:05, and 50 on.

Min Pattern Execution Time 0
Mumber of minutes that must pass before TR will send a pattern change. A value of 0 sends pattern changes as they are computed.

Threshold and Pattem Matix | =[]

Threshold and pattern definitions to use.

k ifrom V=kO as %) 25

Oecupancy scaling factor in the Wk equation, as a percent. For example, 3 value of 100 uses the full occupancy in the equation, 25 uses 1/4 occupancy, 0
uses no occupancy, and 300 uses three times the cccupancy.

Immediate Update Threshold (%)

If the change between the previous channel value and the new value [befo thing} ds this threshold. TR skips threshold levels and goes directly o
the one that coresponds to the new channel value. Mormally, threshold levels can only change by one.

Cycle Levels (%) 20

Offset Levels (3%) 20

Split Levels (%) 20

2 Use the first tab to specify general settings for TR:

® Disable Logging — Permits Centracs to calculate the algorithm, but the results are

not saved for use in the Traffic Responsive report (page 10-55). You can only see the
results in the real-time monitoring window (page 13-16).

® Interval —Indicates how frequently Centracs will calculate the algorithm, in minutes
(from 1 to 120).

® Reference Time — Sets a reference point in time from which the calculation interval
is measured (from 00:00 to 23:59). This is not the time at which calculations will
start — by default, calculations start as soon as the algorithm is fully configured
(unless you manually disable them). For example, if you set the Interval to 10
minutes and the Reference Time to 13:15, and if you complete the configuration of
the algorithm at 12:00, Centracs does not wait until 13:15 to start calculations.
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Rather, the algorithm is computed at 12:05, 12:15, 12:25, 12:35, 12:45, 12:55,
13:05, 13:15, 13:25, and so on. Calculations continue indefinitely, unless you turn
on the “Disable TR on Section” option.

Min Pattern Execution Time — Specifies when pattern selections will be sent to the
controllers (from 0 to 300 minutes). For example, if set to 0, a patternis sent as soon
as it is selected by TR; if set to 10, Centracs waits ten minutes before it sends the
newly selected pattern to the controllers. This is used to avoid frequent pattern
changes because of minor changes in values. This is similar to the Decreasing
Hysteresis option (described below). Min Pattern Execution Time should either be
0, or be greater than the Interval time.

Threshold and Pattern Matrix — You can select a previously configured matrix from

a dropdown list, or you can click [ to add a new one. (Refer to the instructions
below.)

k — The factor to use (from 0 to 100000%) to scale the occupancy value when
Centracs calculates V+kO (weighted volume-plus-occupancy). For example:

If set to 100 (%), the true occupancy value is added to the volume.

If set to 25 (%), one-quarter of the occupancy value is added to the volume.

If set to 0 (%), the occupancy is essentially removed from the equation.

If set to 300 (%), the occupancy value is multiplied by 3 before it is added to the
volume.

Immediate Update Threshold —When these three options are set to 0, TR does not
permit threshold levels to be skipped when traffic conditions change; rather, the
levels must be stepped-through consecutively, one at a time. For this reason, when
TR is started or restarted (for example, if the Core service is restarted on the server
machine), it can take some time to step through the levels and stabilize. The
Immediate Update Threshold options can override this behavior and permit levels
to be skipped if the difference between the prior values and the new values is
higher than a specified percentage. To use this feature, enter a percentage from 1
to 100% for Cycle Levels, Offset Levels, and Split Levels. If the numbers are low,
levels will be skipped more frequently; if the numbers are high, levels will be
skipped less frequently.
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3 click the Inbound, Outbound, Sidestreet, and Occupancy Override tabs to configure
the computational channels. For example:

[=] Threshold Traffic Responsive - Woodmen Rd Corridor (=11

Wolume Scaling % Cccupancy Scaling %%

On each of these tabs, to assign detectors to the channel, click Add... and select the
detectors from the Entity Selection window. For instructions on how to use the Entity
Selection window, refer to page 3-18.

4 click the Arterial tab and set the parameters accordingly:

E Threshold Traffic Responsive - Woodmen Rd Cormridor @ E
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You do not assign detectors to the Arterial channel; rather, you use this channel to
specify the maximum V+kO value. This maximum is the highest V+kO value expected
for the Section in one direction only (Inbound or Outbound). It does not need to be
exact, as it is only used to change the other channel output values into a percentage
value, and does not impact the final algorithm results.

Itis easiest to select a maximum V+kO value when historical detector data is available.
Centracs has an estimator tool that finds the highest value in the historical log data.
This value is usually a reasonable starting point, and usually does not need
adjustment. Adjustment may be necessary if threshold percent values are above 100
percent, or are consistently low.

If historical data is not available, manual selection of a maximum V+kO value does not
need to be precise. To yield a fairly accurate value, estimate volume during the busiest
15-minute span. If volume is not known at all, start with a value of 100; then when the
algorithm runs, monitor the threshold percent levels:

® ifthe threshold percentis regularly higher than 100 percent, increase the maximum
V+kO value.

® if the largest threshold percent value reached is far below 100 percent, decrease
the maximum V+kO value.

In the Max V+kO field, enter a number. Or, to make an estimate based on the logs from
the last two weeks, click [&:

[] Estimate Meax \/+k0 =[B!

Click Start Estimation. When the calculation is done, the result is shown:

[—] Estimate Meax \/+k0

To use the calculated Max value, click Apply Current; to enter a different value, click
Cancel.

Centracs User Manual 13-11
Software Version 2.x - March 2018



Using Traffic Responsive

= Configuring Channels, Thresholds, and Patterns

5 To save all settings and go back to the Traffic Algorithms table, click OK.
6 Select the algorithm and click the Configure Thresholds icon E The Thresholds and
Pattern Matrices window opens.
[=] Thresholds and Pattern Matrices B

Cycle Levels

Cycle Level Offzet Level Split Level Pattern

Cycle percent is arterial V+k0 divided by Max V+kO
366 - = %el & ([ 1 [-@ Patten "OFree Qﬂasn”omw I(}NoPaﬂeml

2 33 -8 %2 4 OHE 1 ’g) Paltern "Oﬁee”OFlash”-QLucal”QNuPaﬂem|

10 -33 % (8]
Offset Levels (inbound vs. outbound bias)

1 ’-@ Pattern “ C-Free”OFlash”OLew”ONoPaﬂem|

Offset parcent is Inbound VKO divided by inbound plus utbound k. Higher values | © Pattern F IE 5
T e e mmmplgmumm & ey 1 ’ @ Pa ” () Free || () Flash ” ) Local | () No Pattern l

366 -10% 61 ¥ @ [-@) Pattern ”C-Free”QHash“OLow”GNoPaﬂem|

23 -6 %2 ¥ UE [@ Pattern ”C-Free][OFlaanOLocal“ONoPaﬂeml

10 -33 % O

Split Levels (arterial vs. sidestreet bias)
Spiit percent is arterial V+k0 divided by arterial plus sidestreet V+kD. Higher values imply heavier

[@ Patten ][oﬁee”onash”ouw IC)NoPaﬂeml

arierial traffic; lower values imgly heavier sidestreet traffic. ’ @ Pattern " () Free ” ) Flash ” ) Local ” () No Pattern |

10 - 100 %

[ patiem (0 Free ][O Fiash ][ ) Locar [ ) o Pattem |

Decreaging Hysteresis (36) S

Amount that will be subiracted from the low end of 2 level's rangs when the cycle, offs=t, or split
value is decreasing. This reduces the pessisiity of bouncing o and from a fevel.

13-12

Cycle, offset, and split levels are configured in the Thresholds part of the window. As
you add or delete levels, the number of rows in the Pattern Matrix part of the window
changes accordingly. Each row in the Pattern Matrix maps a cycle, offset, and split
level combination to a pattern for the Section/Subsection/etc. to run.

The Hysteresis value is used to avoid bouncing back and forth between levels because
of minor changes in values. In the example above, cycle level 3 starts at 66%. Without
hysteresis, if the calculated percent over four calculation periods changes from 67 to
65 to 67 to 65, the pattern will bounce between levels 2 and 3. But with a hysteresis
value of 5%, when the value decreases below 66, the pattern does not change to level
2 until the value goes below 61%. This is similar to the Min Pattern Execution Time
option (described above).
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7 Optionally, to add a new matrix, click New... or Copy... at the top of the window. If
you select the Copy option, a window opens where you can set the name of the new
copy. If you select the New option, this window opens:

[ Threshold and Patiem Matrix Hame [=]]ES

Specify a name for the new matrix, and the number of threshold levels to start with.
Click OK.

Make the necessary changes to the values. You can also:

e click @ to add another cycle, offset, or split level
o click (2 to delete a level

® click Rename to assign a new name to the matrix

If you enter values in the Occupancy Overrides section on the left half of the window,
the overrides shown in the Occupancy Overrides section on the right half of the
window become enabled.

8 To save your settings, click Save.
9 To go back to the Traffic Algorithms table, click Close.

If you added a new matrix, you can go back to the Settings tab of the Threshold Traffic
Responsive window to select the new matrix.
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Running a Traffic Algorithm

13-14

When a traffic algorithm has been fully configured, including its channels, thresholds, and
patterns, TR automatically starts its calculations (unless the “Disable TR on Section”
option on the Settings tab of the Threshold Traffic Responsive window (page 13-8) has
been turned on). This ensures that the calculations are always up-to-date. But TR does not
automatically send pattern selections to the field controllers based on its calculations. You
must enable this function via the scheduler (for details, refer to “To permit an algorithm
to send pattern changes on page 13-15"). You can schedule TR control to run
continuously, or only at specified times of the day, week, month, etc.

After a new algorithm has been configured, it is recommended that you run the algorithm
for a period of time without sending patterns to the controllers. Monitor the calculations,
and make sure that the patterns selected by TR are valid for the conditions at the time. If
necessary, make adjustments to the configuration and repeat the verification. When TR is
making the expected pattern selections, enable TR to send patterns to the controllers (for
details, refer below).

Note ¢ When TRis started or restarted (for example, if the Core service is restarted on the
server machine), it can take some time to step through the levels and stabilize, unless you
have the Immediate Update Threshold options configured to permit threshold levels to be
skipped as traffic conditions change. For more information about the Immediate Update
Threshold options, refer to Configuring Channels, Thresholds, and Patterns on page 13-8.

Itis recommended that you add an alert trigger for the “Threshold TR Fault” event, which
tells you if a TR-related problem occurs. “New Traffic Algorithm Pattern” is another TR-
related event that you can log in the database for reporting purposes and/or generate
alerts for. For more information, refer to Events on page 4-2 and Using Triggers on
page 4-25.

To run TR calculations for an algorithm without sending pattern changes

1 Onthe Settings tab of the Threshold Traffic Responsive window (page 13-8), make
sure that the “Disable TR on Section” option is not turned on.

2 Either:

® Make sure that the algorithm is not scheduled to run via the scheduler or manual
command.

Or

® Onthe Settings tab of the Threshold Traffic Responsive window (page 13-8), turn on
the “Disable Pattern Output” option, then click OK or Apply to save your changes.
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To permit an algorithm to send pattern changes

1 On the Settings tab of the Threshold Traffic Responsive window (page 13-8), make
sure that the “Disable TR on Section” and “Disable Pattern Output” options are not
enabled.

2 Inthe scheduler, add a new schedule entry and select the “Traffic Algorithm” action.
For instructions, refer to Using the Scheduler on page 7-11.

3 The Algorithm dropdown contains a list of all the traffic algorithms that have been
configured. Select the algorithm for which to enable pattern changes.

4 Set the scheduling options. For example, it may be necessary to enable pattern
changes at only specific times of the day or specific days of the week.

When the “Traffic Algorithm” action runs, the pattern selected by the most recent
calculations is sent to the controllers for the associated Section, Subsection, and/or
Group. When the action completes, the TR-selected pattern is stopped and the
controllers go back to their prior operation mode. TR continues to run its calculations
in the background to keep its pattern selections up-to-date.

To disable TR calculations and pattern changes for an algorithm

1 On the Settings tab of the Threshold Traffic Responsive window (page 13-8), turn on
the “Disable TR on Section” option.

2 To save your changes, click OK or Apply.

With this option turned on, no calculations are made, nothing is logged to the
database, and no pattern changes are sent to the controllers.

To prevent an algorithm from logging its calculations to the database:

(for the Traffic Responsive report)

1 On the Settings tab of the Threshold Traffic Responsive window (page 13-8), turn on
the “Disable Logging” option.

2 To save your changes, click OK or Apply.

With this option turned on, you can see TR calculations in real time via the TR
monitoring window (page 13-16), but Centracs does not save the calculations to the
database, so you cannot see them afterwards on the Traffic Responsive report
(page 10-55).
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Monitoring Real-time TR Calculations

Note e To get historical data for a specific time period (rather than real-time data), run the
Traffic Responsive report (page 10-55).

To monitor Traffic Responsive statistics as they are calculated:

»

From the main menu, select Monitoring » Threshold Traffic Responsive
Monitor » {algorithm name}.

Or

From the main menu, select Configuration P Traffic Algorithms... The Traffic
Algorithms window opens.

E] Traffic Algorithms @ @

Name Algorithm Entity Configuration State

Woodmen Rd Corridcl-r‘ Traffic Responsive {Thnshuld}| ﬁ\ﬂﬁ;m"ﬂq Rd |Complete |

click the algorithm to monitor then click the Monitor Algorithm icon m, or right-click
the algorithm and select the Monitor... option.

Real-time calculations for the algorithm are shown. A new row is added to the table
each time the algorithm runs:

[ Traffic Respansive - Waodmen Rd Carnidor BX

Timestamp
12/2972010 2:00:01 PM
1202972010 2:50:01 PM
1202972010 2:40:01 PM
1202972010 2:30:01 PM
1202972010 2:20:01 PM
12/29/2010 2:10:01 PM
12/29/2010 2:00:01 PM

un 4o s

4mmAmnAn s oe0a

13-16

Raw Inbound Raw Outbound Smoothed Inbound Smecthed Qutbound Smoocthed Arterial Cycle % Offeet % Cycle Level Offset Level Split Level Pattern Offset Pattern Set Meassage Algerithm Failed '

10.84
11.49
12.40
11.94
11.54
11.94
11.85

4 e

24193 11.00 24204 242.04 453.4% 43% 2 1 1 1 No
241.92 11.65 24249 242.49 435% 48% 2 No
24423 2.3 24475 24475 49.0% 42% 2z No
24767 11.94 246.59 24859 49.3% 46% 2 No
24226 11.84 24228 24228 4535% 47% 2 No
24260 11.94 242.40 242.40 43.5% 47% 2 No
2 No
~ e

11.91 L 433% 47%
inin . anoans s oor

The Time Remaining field at the top counts down to the next time the algorithm will
run. (The Interval field on the Settings tab of the Threshold Traffic Responsive window
(page 13-8) sets the amount of time between calculations.) To run the algorithm on
demand, you can click Run Now at any time. (The Run Now option is also available on
the Section/Subsection Status display; refer to page 6-10.)

To remove the statistics from prior runs of the algorithm, click Clear.

To configure the columns shown in the monitoring window, right-click in the data area
of the window.
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A menu is shown with a list of all available fields:

E] Traffic Responsive - Woodmen Rd Corridor

Timestamp
12/29/2010 2:00:01 PM
12/29/2010 2:50:01 PM
1202972010 2:40:01 PM
1202972010 2:30:01 PM
1202972010 2:20:01 PM
1202972010 2:10:01 PM
12/29/2010 2:00:01 PM

Raw Inbound Raw Outbound Smoothed Inbound Smoothed Outbound Smoothed Arterial Cycle % Offsst

1034
11.49
1240
11.94
1194
1184

24193
241.92
24425
247 67
24228
24260
24192

Ao o

11.00
11.65
1231
11.94
11.94
11.94

24204
242,49
24475
246,59
24229
24240
24161

Aunno

24204
24249
24475
246.59
24229
24240

45.4%
43.5%
43.0%
43.3%
43.5%
43.5%

4.3%
46%
43%
46%
47%
47%

Click the fields to toggle them on or off.

v Raw Outhound

v Smoothed Inbound
Smoothed Outbound
Smoothed Sidestrest

Smoothed Occupancy Ovel

Smoothed Occupancy Overide 2

Smoothed Arterial
Cycle %
Offset %
Spiit %
Cytle Level
Offset Level
Spiit Level
Occupancy Override 1 Level
Occupancy Override 2 Level
Immediate Update Made
v Pattemn
v Offset
v Pattern Set
v Message
v Algorithm Failed

Buffer Size.

tern Offset Pattern Set Message Algorithm Failed -]

1

To specify the maximum number of rows to show in the window, click the “Buffer Size”

option:

When this number is reached, the oldest row will be deleted each time a new row is

added.
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Monitoring Historical TR Calculations

Note ¢ To see real-time traffic algorithm data as the algorithm runs, use the Traffic
Responsive monitoring window (page 13-16).

You can use the Traffic Responsive report to monitor threshold-based Traffic Responsive
performance on the system.

[5] Traffic Responsive (=]

Configurable Report Options

Start Date & Time: 01/06/2011 82546 AM | End Date & Time: [owos/2011 82506 P00 ) View Report |
Traffic Algerithm: Woodmen Rd Corrider vl Celumns te Display: IRaw Inbound, Rew Cutbour 'I
Only Show Pattern Change:  [ves - Only Show Change Recommended: | -

——

M 41 of 5 b M |« (2] nghCL'l - | 100% - |:| Find | Next
Traffic Responsive

Time Range: 1/6/2011 8:25:46 AM - 1/6/2011 8:25:46 PM

Algorithm Name: Woodmen Rd Corridor
Raw Raw Smoothed | Smoothed |Smoothed | Smoothed | Smoothed | Smoothed |Cycle % |Offset® | Split% Cycle Offset Split Pattern Pattern |Message
Inbound ‘Outbound Inbound Outbound | Sidestreet Oce1 Occ2 Arterial Level Level Level Set
10612011 1197 245.00 1167 24454 .00 0.00 0.00 244 54 4391 4.56 100 2 1 1 1 1 Mo
8:30:01 AM
10612011 12.05 245.00 11.97 24490 .00 0.00 0.00 24490 43.98 4.66 100 2 1 1 1 1 Mo
8:40:02 AM
10612011 1214 24388 1211 24417 0.00 0.00 0.00 24417 48.83 472 100 2 1 1 1 1 Mo
8:50:03 AM
10612011 11.96 242329 11.99 24287 .00 0.00 0.00 24287 48.53 471 100 2 1 1 1 1 Mo
9:00:05 AM
10612011 11.86 245.00 1186 24453 0.00 0.00 0.00 24453 4891 466 100 2 1 1 1 1 No
9:10:03 AM
10612011 11.68 24399 1174 24409 0.00 0.00 0.00 24409 48.82 459 100 2 1 1 1 1 No
9:20:02 AM
For details about this report, refer to Traffic Responsive Report on page 10-55.
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Using the Travel Time Module for
Vehicle Detection

Centracs offers three types of vehicle detection:

Level of Service Links — A Level of Service (LOS) link is a collection of vehicle detectors
(often loop detectors) that are associated with consecutive intersections on a section
of road. A Level of Service link offers a convenient way to monitor and analyze the
volume, speed, and occupancy data for these detectors collectively. It can be shown
on the map, and it uses color-coding to indicate current traffic conditions. Also,
historical link data can be viewed in reports for further analysis.

Autoscope DCMS — The optional Data Collection Management System (DCMS) module
of Centracs collects real-time vehicle detection data from Autoscopes and RTMS
devices. It allows users to view streaming video and snapshot images from the
Autoscope video vehicle detectors, view the locations of the field devices on a map,
monitor real-time communications between Centracs and the field devices, generate
reports and graphs to analyze the detection data, and compare the data for different
devices, different detectors, and/or different dates.

Travel Time —The optional Travel Time module of Centracs uses BlueTOAD™ to detect
anonymous Bluetooth™ signals broadcasted from wireless mobile devices (such as
phones, headsets, and music players) inside moving vehicles, and calculates speed and
travel time for these vehicles.

This chapter describes the Travel Time module. For detailed information about Level of
Service links, refer to Entity Configuration - Links on page 3-54 and Real-Time Link Status
on page 6-45. For information about DCMS, refer to Chapter 17, Using DCMS for Data
Collection.

BlueTOAD Detection of Speed and Travel Time

BIUETOAD- by TRAFFICAST

BlueTOAD™ (Bluetooth™ Travel-time Origination And Destination) by TrafficCast provides
real-time Bluetooth™ detection of current travel times and speeds for specific sections of
road. BlueTOAD detects anonymous Bluetooth™ signals broadcasted from wireless
mobile devices (such as phones, headsets, and music players) inside moving vehicles.
When a particular Bluetooth device in a moving vehicle passes a BlueTOAD checkpoint

Centracs User Manual 14-1
Software Version 2.x - March 2018



Using the Travel Time Module for Vehicle Detection

= Overview of Travel Time

(called a Data Collection Station), BlueTOAD records the current time; when the same
device/vehicle passes the next checkpoint, BlueTOAD records the travel time, and uses
the distance between the two checkpoints to calculate the speed of the vehicle.

Though BlueTOAD is a separate system, Centracs offers an optional Travel Time module
that allows you to integrate your BlueTOAD data into the user interface of your Centracs
system. Centracs communicates with your BlueTOAD web server to retrieve the latest
information, then shows it in maps, reports, and status displays in Centracs.

For more information about the BlueTOAD system, visit http://www.trafficcast.com.

Overview of Travel Time

Maps

With the Travel Time module, you can quickly see the current status of your roadways at
a glance:

E]Map‘ﬂewer @@@

& Braman dwe T
]
: [

=

5

Wletro Powy

Blvd

h)
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Each section of road between two Data Collection Stations is a “link”. In this example,

green indicates that traffic is free-flowing, yellow indicates moderate traffic congestion,
red and black indicate problem areas.

Note ¢ The colors used to represent different link statuses are configurable. You can
configure up to 10 different status colors. The colors on the map display get refreshed with

the frequency specified by the Data Poll Interval field on the BlueTOAD Settings window
(refer to page 14-9).

To see more details about a link, you can hold the mouse pointer over the link on the map:

(™ Map Viewer

!
=
i~
-
-

B

A pop-up window shows the names of the two Data Collection Stations for the link, and
the current average speed and travel time for this section of road.
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If data is unavailable for a link, the map shows the link as gray:

[—] west side ]34

gray = no data received
for these links

Note ¢ The Travel Time module in Centracs uses the Link Visuals map layer (refer to
page 20-83). The locations and shapes of the links on the map are defined by the shape file
imported into Centracs during initial BlueTOAD setup.
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Entity Tree

After BlueTOAD has been configured in Centracs, the Entity Tree shows the Data

Overview of Travel Time =

Collection Stations (i.e., the detection devices), the Link Pairings, and the Routes that are
defined on the BlueTOAD web server:

[=] Enity Tree
Search fres. .

XBEX

v !,l{ System Colorado Springs

- :_1 Group BlueTOAD™

% :. Group BlueTOAD™ Link Pairs

v :. Group BlueTOAD™ DCS Devices

= Data Collection Station Device (213)
""" Caseade Rd & Mew Hope Rd

= Data Collection Station Device (210)
* " Cascade Rd & Dianforth Rd

= Data Collection Station Device (220)
**" Caseade Rd & Fairbum Rd

= Data Collection Station Device (215)
“ " Cascade Rd & Hwy 285

= Data Collection Station Device (1258
“ % Martin Luther King Jr Dr & Fultion Indusrial Bhd

= Data Collection Station Device (193)
* ' Campbehon Rd & Fulton Industrial Shd

22 NMata Collectinn Statinn Davice (17EM

[=] Enity Tree

Search free. .

XEX

v !,l{ System Colorado Springs

- :_1 Group BlueTOAD™

¥ % Group BlueTQAD™ Link Pairs
[%)

Ty Link Pairing (574)
Cascade Rd & Danforth Rd to Cascads Rd & Mew Hope Rd

&y, Link Pairing (578)
Cascade Rd & Fairbumn Rd to Cascade Rd & Hwy 285

Ty Link Pairing (579)
Cascade Rd & bbHwy 285 to Cascade Rd & Fairbum Rd

Gy Link Pairing (2415)
Cascade Rd & Hwy 285 to Cascade Rd & Fairbumn Rd

Gy, Link Pairing (3306)
ER-82 & 5R-154 to Campbelton Rd & Fulton Industris] Bivd
g, Link_Pairing (3314)

g, Link_Pairing (3321)

@y, Link Paiting (2416)

Bakers Femy & Fulion Industrial Bivd to Patton Dr & Fulton Induwstrizl Bled I

Cascade Rd & Mew Hope Rd to Cascade Rd & Fulton Industrial Bhed

S

o|®

Note e Centracs does not show Data Collection Stations that are Inactive on the BlueTOAD
web server (or their associated link pairs).

Each link represents traffic in one direction only. To indicate the direction of travel, one of
the two Data Collection Stations (DCS) is designated as the Origin, the other as the
Destination (these designations are made in the BlueTOAD web server). The same DCS can

be the Origin of multiple links, and can also be the Destination of other links.
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Status Displays

To see more information about a link, DCS, or route, you can double-click it in the Entity
Tree or the Map Viewer to open the Status display. For example:

(] Pairing {579} - Cascade Rd & Hwy 285 to Cascade Rd & Fairbum Rd (Travel Time) 3=

Link Summary Link Status

Ohriggin Cascade Rd & Hwy 285
Destination Cascade Rd & Fawbum Rd i
Awg Speed {mph) 21 Drata Aamilable
Travel Time 1 min 14 s

Last Lipdate B11/2012 8:23:58 PM

Comm Status
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(] Pairing {579} - Cascade Rd & Hwy 285 to Cascade Rd & Fairbum Rd (Travel Time) (8 (<]

Ll

Link Summary Link Status

Ohrigin Cascade Rd & Hwy 285 Coamm Status
Diestination Cascade Rd & Farbum Rd
Awg Speed [mph} 21

Trawel Time 1 min 14 5

Last Lipdate BM12012

Drata Aamilable

These graphs show data for a link pair for the last 24 hours. The details at the bottom of
the window show the most recent data retrieved from the BlueTOAD web server.
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Speed (mph)

14-8

354

304

254

204

131

10 4

Reports

The Travel Time Links report shows historical data for your BlueTOAD link pairs. The report
includes graphs for both speed and travel time. You can run the report for multiple date
ranges at one time in order to compare the performance of the roadway during different
time intervals.

Speed

Travel Time

144

124

1
B G B G G w
N

0;%%%%%@ E 084
E

= 06
[
[

— 0&M0IZ =044

024

0 T T T T 1

= 08102012 - DBM 02012 = DBIDZ2012 - DBI0S2012 = Avg All Series

For more information, refer to Travel Time Links Report on page 10-56.

BlueTOAD Events

The Travel Time module generates these events in Centracs:
m  BlueTOAD Server Connected

m  BlueTOAD Server Disconnected

m Link Threshold Increased / Link Threshold Decreased

Optionally, you can add triggers for these events to generate alerts. For more information,
refer to Events on page 4-2 and Using Triggers on page 4-25.
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Configuring BlueTOAD Entities

If you have a license key from Econolite for the Travel Time module of Centracs, the
procedure below describes how to configure the communications between Centracs and
the BlueTOAD web server.

Note e Before you configure the Travel Time module in Centracs, you must configure your
devices, link pairings, and routes on the BlueTOAD web server. Also, if you are not hosting
your own BlueTOAD server, your Centracs server must have an active internet connection

in order to communicate to the BlueTOAD server.

hitps:/f

bluetoad.trafficcast.com

fuserlogin
application/s-www-form-urlencoded
fxmliet_locations

fxmlitraveldata

fxmlipairings_raw

fxmliroutes

e
.
ossoeeeeess |
s
(s |

ess

 bhucload traffccastcom |

Juserlogin

spplcation/xunwi-fom-urencoded |

hanitocaions________________|
pmiraveidata
papaitings_qaw
anbboutes
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14-10

To configure the Travel Time module in Centracs:

1
2

From the main menu, go to File P Settings.

click the BlueTOAD Settings tab. (To access the BlueTOAD Settings tab of the Settings
window, you must have the System Config permission in your Application Role (refer
to page 20-19).)

Turn on the “Enabled” checkbox.

If you want the BlueTOAD entities in Centracs to always reflect the entities on the
BlueTOAD web server, turn on the “Reflect Server” checkbox. Or if you want the ability
to delete BlueTOAD entities from Centracs, turn off “Reflect Server”.

Enter the user name and password provided to you by TrafficCast to log in to the
BlueTOAD web server.

For the Inventory Poll Interval, specify how often Centracs checks the BlueTOAD web
server for newly configured devices/link pairings/routes, and for changes to existing
ones. The recommended interval is 5 minutes.

For the Data Poll Interval, specify how often Centracs requests speed and travel time
information from the BlueTOAD server. This information is used to update the map
display, the real-time link status display, the real-time DCS status display, the route
status display, and to generate Link Threshold events. The recommended interval is 5
minutes.

If your BlueTOAD web server is hosted by TrafficCast, accept the defaults that are
already configured in the Advanced section of the window. If you host your own
BlueTOAD server, change the Advanced settings as needed to access your server.

Click Save.

Centracs then connects to the BlueTOAD web server to get information about all the
defined devices, link pairings, and routes, and then adds four new Groups to the Entity
Tree to contain them (as shown below). This may take a few minutes.

[<] Entity Tree =1
cL TR "

Search free... E]

- |,!! System Colorado Springs
r —

- G. Group BlueTOAD™

. ':. Group BlueTOAD™ Link Pairs

> :. Group BlueTOAD™ DCS Devices
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Note e If there are multiple System entities in the Entity Tree, Centracs adds the
BlueTOAD Groups to the first System it finds.

Centracs also adds colored bars to the map to show the locations of the link pairings
along the roadway:

(] Map Viewer | =]

o

Newhalem s e | = 10

10 If the BlueTOAD server did not report the configured Max Speed for a link pairing,
Centracs assigns a default value of 0. Therefore, you must verify the Max Speed on the
Entity Configuration window for each link pairing that was added to the tree. To do so,
right-click the link in the tree and select Edit Properties. Max Speed is the speed
considered to be the maximum or “free flow” speed (usually a number slightly higher
than the speed limit for that stretch of roadway). Centracs uses this number to
determine whether the Link has exceeded any of the Speed thresholds specified on
the Link Settings window (refer to page 3-59). The calculation is:

average detected speed / Max Speed = Speed %

Hint: To see or change the properties for multiple links, it is not necessary to open and
close the Entity Properties window for each link — with the window open, simply click
a different link in the tree to populate the window with the properties for that link. (If
you make changes to the properties for a link, you must first save or discard the
changes before you can switch to a different link.)
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11 Optionally, on the Entity Configuration window, you can change the names and other
properties of the BlueTOAD entities in the tree. For details, refer to Changing
Properties for a DCS on page 14-12 and Entity Configuration - Links on page 3-54.

12 If necessary, you can move the BlueTOAD entities to other locations within the Entity
Tree.

Changing Properties for a DCS

BlueTOAD Data Collection Stations (DCS) are not added to the tree manually like most
other entities. However, you can use the Entity Configuration window to change certain
properties of a DCS entity, as described below. (For information on how to add BlueTOAD
entities to Centracs, refer to Configuring BlueTOAD Entities on page 14-9.)

To edit the properties of a DCS:
1 Right-click a Data Collection Station in the Entity Tree.

2 Select the Edit Properties option. The Entity Configuration window opens.

(5] Entity Configuration XBEX

Device (215)
Cascade Rd & Hwy 255

-
—

Note e Because the fields on the Entity Configuration window are configurable, your
screen may look different than the sample shown here. For details, refer to Using the
Type and Field Definitions Window on page 19-5.

3 Make changes as needed to the name, description, and/or Jurisdiction (refer to
page 20-12.). Note that any changes to this window only affect Centracs; they do NOT
change anything on the BlueTOAD web server.

4 Optionally, to add notes for this entity, click i to the right of the Notes field. For more
information, refer to Adding Notes to Entities on page 3-14.

5 Click OK.
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Note e BlueTOAD Data Collection Stations cannot be added to the map.

Status Display for BlueTOAD Data Collection Stations

To display the BlueTOAD DCS Status display:

» Double-click a BlueTOAD Data Collection Station (DCS) in the Entity Tree, or right-click
it and select Show Status...

Device (220) - Cascade Rd & Fairburn Rd .
s =1 OrginDC5 E &
Cascade Rd & Hwy 233 2 min 24 5

Cascade Rd & Danforth Rd 0 min 44 2

Destination DCSs

This window shows a list of the destination Data Collection Stations with which this DCS is
paired as the origin, and shows the current travel time for each link pair. The example
above shows two link pairs: in both cases, “Device (220) - Cascade Rd & Fairburn Rd” is the
origin DCS, indicating the direction of travel for these link pairs. For more information
about origins and destinations, refer to Overview of Travel Time on page 14-2.

This window is updated in real time, at the frequency specified by the Data Poll Interval
setting on the BlueTOAD Settings window (refer to page 14-9).

Status Display for BlueTOAD Link Pairs

The BlueTOAD Link Pair status display shows real-time data about the average speed and
travel time calculations collected for a BlueTOAD Link Pair, i.e., a section of road between
two BlueTOAD Data Collection Stations. It shows a summary of the current link status, plus
historical information for the last 24 hours (if available) in the form of line graphs.

Note e To get historical data older than 24 hours, run the Travel Time Link report
(page 10-56).

To open the Link Pair Status display:

» From the Entity Tree or Map Viewer, double-click a Link, or right-click it and select
Show Status...
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The Link Pair Status display includes two tabs: Avg Speed and Travel Time. Each tab shows
a graph of the data reported by the BlueTOAD web server. The graphs are visual
representations of the efficiency with which this roadway section is serving traffic. High
average speeds and low travel times indicate free-flowing traffic; low average speeds and
high travel times indicate traffic congestion.

The Link Pair Status display is updated in real time, at the frequency specified by the Data
Poll Interval setting on the BlueTOAD Settings window (refer to page 14-9). The window
shows a maximum of 24 hours of data at a time.

Sample Graphs

(-] Pairing (579) - Cascade Rd & Hwy 285 to Cascade Rd & Fairburn Rd (Travel Time) =11

Link Summary Link Status

Oriagin Cascade Rd & Hwy 285
Destination Cascade Rd & Fawbum Rd .
Avg Spead {mph) 1 Drata Amilable
Travel Time 1 min 14 s

Last Lipdate 112012

Comm Status

Average Speed
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(] Pairing (579) - Cascade Rd & Hwy 285 to Cascade Rd & Fairburn Rd (Travel Time) =11

Link Summary Link 5tatus

Oiragin Cascade Rd & Hwy 285 Comm Status
Destination Cascade Rd & Faiwrbum Rd
FAwpg Speed (mph) 21

Trawel Time 1 min 14 5

Last Lipdate BM1112012 8:23:56 PM

Data Aymilable

Travel Time

Note e A straight horizontal line on the graphs often indicates stale data (for example, if
no vehicles with Bluetooth devices have been detected for an extended period of time).

These sample graphs show that within the last 24 hours, the average speed ranged from
approximately 20 mph to approximately 35 mph, and the travel time ranged from 45
seconds to 75 seconds. The downward spike at approximately 10:00 AM indicates a lack
of data at that time, for any of the reasons below:

m None of the passing vehicles had a Bluetooth™-enabled device

m There were no passing vehicles (because traffic was stopped or because no cars were
present)

m  Communications were down
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= Status Display for BlueTOAD Link Pairs

14-16

The sections at the bottom of the window show the most recent speed and travel time
data:

Link Summary

Origin / Destination — The two Data Collection Stations (DCS) that mark the beginning
and end of this section of roadway. Because each Link Pair has a specific direction of
travel, the Origin is the first DCS that a motorist passes, and the Destination is the
second. Note that a single DCS can be both the Origin in one Link Pair and the
Destination in another Link Pair.

Avg Speed — The most recent average speed calculation reported by the BlueTOAD
web server.

Travel Time — The most recent travel time calculation reported by the BlueTOAD web
server.

Last Update — The date and time at which the reported speed and travel time were
received from the web server, in MM/DD/YYYY HH:MM:SS format.

Link Status

Comm Status — Shows “Active” if Centracs is communicating successfully with the
BlueTOAD web server; shows “Inactive” if Centracs cannot communicate with the
BlueTOAD web server or if BlueTOAD has been disabled in Centracs.

Data Available — If “Yes”, this indicates that valid data is being received from the
BlueTOAD web server; if “No”, this indicates that the web server is reporting average
speeds and travel times of zero.
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Status Display for BlueTOAD Routes =

Status Display for BlueTOAD Routes

The BlueTOAD Route Status display shows real-time data about the average speed and
travel time calculations collected for a BlueTOAD Route. A Route is composed of two or
more BlueTOAD Link Pairs. The status display shows a summary of the current route
status, plus historical information for the last 24 hours (if available) in the form of line
graphs.

Note e To get historical data older than 24 hours, run the Travel Time Link report
(page 10-56).

To open the Route Status display:

» From the Entity Tree, double-click a Route, or right-click it and select Show Status...

The Route Status display includes three tabs: Avg Speed, Travel Time, and Links. The first
two tabs show a graph of the data reported by the BlueTOAD web server. The graphs are
visual representations of the efficiency with which this roadway section is serving traffic
— high average speeds and low travel times indicate free-flowing traffic; low average
speeds and high travel times indicate traffic congestion. The third tab shows a list of the
Link Pairs included in this Route.

The Route Status display is updated in real time, at the frequency specified by the Data
Poll Interval setting on the BlueTOAD Settings window (page 14-9). The window shows a
maximum of 24 hours of data at a time.
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Sample Screens

E] 4169 - Daniels WE {Route) @ E

Route Summary Route Status
Avp Spead (mph)} 37 Comm Status
Trawel Time G min 46 5 .
Last Update 2172012 2:00-00 PM Data Aumilable
Average Speed
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E] 4169 - Daniels WE {Route) @ E

N

Route Summary Route Status
FAwg Speed {mph) 37 Comm Status
Trawel Time 6 min 48 5 .
Last Update 2172012 2:00-00 PM Data Aumilable
Travel Time
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(-] 4169 - Daniels WE (Route)

[ AvgSpeed || TravelTime | Llinks |

B

Link | Origin

Destination I Travel Time |

Pairing (4073} Daniels Pkwy & Treeline Ave

Route Summary

Awp Speed (mph} 37
Trawel Time 6 min 48 5
Last Lipdate B21/2012 2:00:00 PM

Pairing (4071) Daniels Pkwy & Cross Creek Blvd Daniels Pkwy & Metro Plwy

2 min 26 =
Daniels Pkwy & Cross Creek Blvd 4 min 20 =

Route Status

Comm Status  [FTET—
Data Aamilable INSEETEE—

Links

Note e A straight horizontal line on the graphs often indicates stale data (for example, if
no vehicles with Bluetooth devices have been detected for an extended period of time).

These sample graphs show that within the last 24 hours, the average speed ranged from
approximately 12 mph to approximately 45 mph, and the travel time ranged from 6

minutes to 21 minutes.

A downward spike to the zero baseline indicates a lack of data at that time, for any of the

reasons below:

m None of the passing vehicles had a Bluetooth™-enabled device

m There were no passing vehicles (because traffic was stopped or because no cars were

present)

m  Communications were down
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The sections at the bottom of the window show the most recent speed and travel time
data:

Route Summary

Field Description

Avg Speed The most recent average speed calculation reported by the BlueTOAD
web server.

Travel Time | The most recent travel time calculation reported by the BlueTOAD web
server.

Last Update |The date and time at which the reported speed and travel time were
received from the web server, in MM/DD/YYYY HH:MM:SS format.

Route Status

Field Description

Comm Status | Shows “Active” if Centracs is communicating successfully with the
BlueTOAD web server; shows “Inactive” if Centracs cannot communicate
with the BlueTOAD web server or if BlueTOAD has been disabled in

Centracs.
Data If “Yes”, this indicates that valid data is being received from the
Available BlueTOAD web server; if “No”, this indicates that the web server is

reporting average speeds and travel times of zero.
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Changing the Controller Settings

Note e For information about the Oasis controller editor, refer to the online help in the
Oasis Editor, or to the Centracs online help.

Maintaining Controller Settings Remotely

The configuration of the signal controllers can be done locally at the field controllers via
the front panel, or in Local Edition via the Signal Editor or via the remote
front panel emulator (available only for ASC/3 and Cobalt controllers):

m Signal Editor - When you change controller settings using the Signal Editor,
you must upload the current controller settings into Centracs, make the necessary
changes, then download them back to the controller. The Signal Editor offers some
utilities and features not available in the remote front panel, such as comparing
databases, importing/exporting Synchro files, and custom print templates.

m  Remote Front Panel - When you change controller settings using the remote
front panel emulator, your changes are made directly to the controller. This is a
guicker and more direct way to make controller changes, and the interface is identical
to what you would see on the actual field controller front panel. When using the
remote front panel, you also have access to the status displays, where you can see
what is happening on the controller at any moment.

Both methods offer online help for each field.
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= Overview of the Signal Editor

Overview of the Signal Editor

In the Signal Controller Editor, you can:

upload the current controller settings from a field controller into CentracsLocal Edition
medit the settings and time-of-day plans for a controller

download new or changed settings to a field controller

revert a controller to a previously saved configuration

copy settings from one controller to another

compare the current settings on a controller with the settings stored in CentracsLocal
Edition

export settings to or import settings from UTDF format for use in Synchro™

print a copy of the current controller settings

Note ¢ The terms Controller Editor, Signal Editor, and Database Editor all refer to the
Editor discussed above.

The graphic below outlines the exchange of data between the field controllers and the
Centracs Local Edition database by way of the Signal Editor:

storein =
Centracs < database Controller
Database Editor
> ’
load fram
database A
download to upload from
controller controller
A 4

15-2

________--‘-

Controller
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In most situations, the settings stored on the field controllers should be considered the
master copy, and the settings stored in the Local Edition database should be
considered a backup copy. To ensure accurate controller data management, it is
important to make sure that the remote configurations in Local Edition are the
same as the local configurations in the controllers. When you use the Signal Controller
Editor to make changes, you must also save those changes to the Local Edition
database and download them to the controller in order to keep the data consistent. If a
technician makes changes in the field directly through the controller front panel, or if
someone makes changes through the remote front panel emulator, you must upload
those changes to the Local Edition database via the Signal Controller Editor to
keep the databases in agreement.

To open the Signal Editor workspace:
» From the Entity Tree, right-click a Signal and select Launch Signal Editor...
Or

» From the Signal Status display, hold your mouse over the wrench icon near the right
edge of the window and select Edit from the slide-out menu.

Or
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= Overview of the Signal Editor

154

@

The Editor workspace opens. (Depending on the controller type, your Editor
workspace may be different. The sample below is from the ASC/3 Editor.) As shown
below, this window contains a main menu, a controller menu, a toolbar, and multiple
tabs containing the various parameters that you can configure for a controller.

signal name

Edit Ufiliies Communication main menu

s @y o HE 2 vid 224

nuajy Jajjonuon)

1
2
3
4
5
6
7

toolbar shortcuts
Configuration Controller Coordination Preempt Time Base Detectors
nce and nment (MM) 1-1-1
Hardware Alternate Sequence Enable
13 14 15 16 1 2 3
Ring [ NI B
o 0 9 10

Ring SN I =

Rin " controller menu o B

Ring = 0 0o 0

Ring4 0 0 0 0 0 parameter tabs

Phasze Compati Administration (MM) 1-7-1
16 15 14 1: Enable Controller/Cabinet Inferiock CRC

CRC (16 bit) |5A1D

Enable Automatic Backup to Datakey

parameters

consistency checks

Phase Seq - Pg 1 “hase Seq-Pg2 (SDLC) Communications Logging / Display Logic Proc - Pg 1 Logic Proc - Pg 2 Phase Directions

Comparisons "compare" differences

Ermror List Compare List

enabled by the

LP STMTS:
70

The toolbar gives you easy one-click access to most functions. To see a description of
a toolbar icon, hold your mouse pointer over that option.

The Controller Menu allows you to quickly navigate to a particular page in the
controller settings, much like a ‘table of contents’.

When the Signal Editor is launched from the Entity Tree or Map Viewer, it
automatically loads the settings that are currently stored in the CentracsLocal Edition
database for the selected controller — it does NOT automatically upload the settings
from the field controller. If the controller’s settings have never been saved to the
CentracsLocal Edition database, the Editor loads a set of default values.

For a description of a field, hover your mouse pointer over the field.
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Overview of the Signal Editor =

To close the Signal Editor workspace:
» From the File menu, select Exit.
Or
» Click the X in the upper-right corner of the window.

Note e You must close the Signal Editor before you can close Local Edition. If you
try to close Local Edition first, a message is shown to remind you that the Signal
Editor is still open.

You can use the “Auto Logout Time Warning” Global Setting to warn you before

Local Edition logs you out due to inactivity, which could cause you to lose your
changes in the Signal Editor. For more information, refer to Overview of Global Settings on
page 20-54.
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= Overview of the Remote Front Panel (ASC/3, Cobalt)

| Overview of the Remote Front Panel (ASC/3, Cobalt)

Note e You must have the “Remote Front Panel” permission in your Jurisdiction Role in
order to use this feature. Any use of the remote front panel is logged in the system.

You can use the remote front panel emulator to view the status displays (which show you
| what is happening on the controller in near real time), or to change the controller settings.

The remote front panel emulator works the same as the front panel on the field controller.
| For example, you have full front panel programmability, and can use the number keypad
on your keyboard to navigate through the screens. And for online help on a field, you can
| move your cursor to that field and click Help. Please refer to your controller manual for
full instructions and details about the interface.

To open the remote front panel from Centracs:

» From the Entity Tree, right-click a Signal and select Launch ASC/3 Front Panel or
Launch Cobalt Front Panel.

Or

» From the Signal Status display, hold your mouse over the Wrench - icon near the
right edge of the window and select FP from the slide-out menu.

Or
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The Main Menu of the controller front panel opens:

3 Front Panel 062 - Front S5t @ Liggett Rd - 50503 on 27

MATN MEWU

i DISPFLAY
. UTILITIES
4. PREEMPTO 3 5. DIA

. TIME BASE

KEYS 1...9 TO SELECT

Sub Mext Mext
Menu Daa Scraen u H H

odoc 229
5 ©0©

oema 999
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Controller Editor Main Menu

From the Controller Menu tab of the ASC/3 or Cobalt Controller Editor, you can quickly
navigate to specific parameter sets. To expand the menus, click the p signs. When you find
the parameter set you want, double-click it to open that tab or sub-tab.

@

File Edit Utilities Communication

L4 @'u - |

Controlier Menu

¥ Configuration
¥ Phase Seq-Pg1
Phase Ring Sequence and Assignment (MI
Phase Compatibility (MM)
Administration (MM} 1-7-

nuapy Jajjenuo)

»
»

» Communications
» Logging / Display
» Logic Proc-Pg 1
» Logic Proc-Pg2
» Phase Directions
Controller

» Timing Plan

» Vehicle Overlaps
» Veh/Ped Overlaps
» Start Flash

» Options
Coordination
Preempt

Time Base

Detectors

15-8

= =

Preempt

nable

Time Base

Y@ 283

Detectors

12 13 14 15 16 1 2
Ring FENE

0
0
0
0

0
0
0
0

] 9
Ring

0 U

0

0

Administration (|

Enable Contro

CRC (16 bif)

abinet Interlock CRC

Enable Automatic Backup to Datakey

Communications

Logging / Display Logic Proc - Pg 1 Logic Proc -

Pg2 Phase Directions
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Adding and Changing Controller Settings Using the Editor

Note ¢ You must define the signal controller in the Entity Tree before you can manage it
with the Signal Editor. Refer to Adding Entities via the Entity Tree on page 3-8.

When you configure a new signal controller remotely, the general workflow is:

1

2
3
4
5

Load the default parameter values for the new controller from the CentracsLocal
Edition database, or copy the parameter values from a different controller that has
already been configured.

Make the necessary changes on the various tabs and sub-tabs.
Save the changes to the CentracsLocal Edition database.
Download the changes to the field controller.

Close the Editor workspace for that controller.

When you change existing controller parameters, the general workflow is:

1

vui A W N

Upload the current parameter values from the field controller.

IMPORTANT e Evenif you think the valuesinthe CentracsLocal Edition database are
the same as the values on the field controller, it is a good idea to always use the
master copy on the controller as the basis for your changes.

Make the necessary changes on the various tabs and sub-tabs.
Save the changes to the CentracsLocal Edition database.
Download the changes to the field controller.

Close the Editor workspace for that controller.

Note e Any changes you make to parameter values in the Signal Editor do not take effect
until you download them to the field controller and save them to the CentracsLocal Edition
database.

For more details, read the procedures in Using the Controller Editor Workspace on
page 15-10.

Centracs User Manual 15-9
Software Version 2.x - March 2018



Changing the Controller Settings

= Using the Controller Editor Workspace

Using the Controller Editor Workspace

This section gives an overview on how to use the ASC/3, ASC/2, Cobalt, and Eagle editors.
Depending on your controller type, your editor may be different than the sample screens
shown below. These samples are from the ASC/3 Editor.

File Edit Uliliies Communication

bt @y

Note e For details about specific tabs and parameters in the ASC2, ASC/3, and Cobalt
Editors, refer to the “ASC/2 Controller Editor” and “ASC/3 and Cobalt Controller Editor”
sections in the Centracs online help.

The table below identifies the options available in the Signal Controller Editor:

[ Icon | Option Description Refer to...

| Load Controller Loads controller parameters from the Local Edition page 15-14
From Database database into the Controller Editor workspace where you can
see them and/or change them. If the controller settings have
never been saved to the Local Edition database, the

Editor loads a set of default values which you can use as a
starting point when you configure a new controller.

IMPORTANT e Usually, this option is only used to make the
initial configuration for a controller, or to see the current
settings for a controller. To change the current settings for a
controller, it is recommended that you upload the settings
from the controller rather than loading them from the

Local Edition database.

Store Controller | Saves controller parameters from the Controller Editor page 15-15
In Database workspace to the Local Edition database.

Manage Database | Opens the Manage Database Versions window. You can Edit
Version(s) Controller Properties (e.g., change the name or add comments)
or delete a saved database.

N

virtual controller.

Export Data File | Saves the controller settings to a .DB file which you can use, for | page 15-19

| E Import Data File | Imports controller settings from a .DB file, for example, from a | page 15-19
E example, to test a virtual controller.

Export Synchro Opens the UTDF Export window where you can select from
Files timing data and phasing data to export.
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Icon ‘ Option Description
Import Synchro Opens the UTDF Import Wizard where you can browse and
Files import timing files.
E Print Prints the controller settings. You can specify which settings to | page 15-19
print, and how you want the printout to look.
Undo Undo the previous action. You can click the Undo icon page 15-17
repeatedly if you want to undo multiple steps.
Redo Redo the previous action. You can click the Redo icon
repeatedly if you want to Redo multiple steps.
Copy Controller Copies all parameter values to the clipboard.
Paste Controller | Pastes some or all of the parameter values from the clipboard
(you can select which ones to paste, or you can paste all).
B Cut 27?7
Copy 777
ﬁ Paste 2?7
Compare Compares the controller settings saved in the database with the | page 15-19
“* | Database settings currently loaded in the Editor.
= Quick Compare Compares the controller settings saved in the database with the | page 15-18
settings saved on the controller. This option is available in the
ASC/2, ASC/3, and Cobalt Editors.
Merge Database | Openthe Merge Database window. You can merge with Signals,
Stored Versions, Stored Templates, or Database Files.
Restore Database :fiReloads controller parameters from the Local Edition page 15-17
Data database into the Controller Editor workspace. If you have
made changes in the Editor that you do not want to save, you
can use this option to “undo” your changes.
IMPORTANT e This option reloads the values from the
Local Edition database — NOT from the field
controller. To reload the values from the field controller, use
the “Upload From Controller” option.
Centracs User Manual 15-11
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Export UTDF Data:}:Saves the controller settingstoa.CSV file in UTDF format, which sfpage 15-25
you can open in the Synchro™ signal timing application orina z:(NTCIP)

spreadsheet application such as Microsoft Excel. For general page 15-29
information about the Synchro interface module, refer to (ACT)

page 1-20; for instructions on how to use the module, refer to

page 15-24,

Import UTDF Data:’Imports Synchro™ signal timing data from a UTDF-formatted page 15-26
.CSV file. For general information about the Synchro interface :{:(NTCIP)
module, refer to page 1-20; for instructions on how to use the page 15-30

module, refer to page 15-24. (ACT)
Run Asc3 Looks for conflicting parameter values in the controller page 15-19
Consistency configuration.
Check
Load Previously page 15-18
Saved Data from the Local Edition database into the Controller
Editor workspace.
t Upload From Uploads controller parameters from the database on the field | page 15-12
Controller controller to the Controller Editor workspace where you can see
them and/or change them.
= Download To Downloads controller parameters from the Controller Editor page 15-15
Controller workspace to the database on the field controller. This action
overwrites the prior values that were stored on the controller.
§§ ‘Closes the Controller Editor wor space displa for a controller. page 15-18
Note e You may not have access to all of these options, depending on the permissions
specified in your Jurisdiction Role.
To upload controller parameter values from a field controller:
1 From the Communication menu, select Upload From Controller.
Or
From the Database Editor, click the Upload From Controller icon.
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2 Specify the segments to upload:

@ Upload

Segment Based File Based

Sequencer * « | System Info
Load Switch « | Other
Configuration * TSP
Communication Ports *

Enable Logging

Logic Processor

Phase Timing *

Overlap

Coordinator

Preemptor

Time Base

Detectors *

o
o
o
o
o
o
o
L4
o
L4
o
L

Select / Unselect All Select Differences

Upload Cancel

Note ¢ Depending on the options you select, Centracs may do an FTP-based upload. If
the FTP username and password have been changed on the controller, you must change
them in Centracs to match. You can change them for all controllers on the Default Comm
Parameters window (page 20-10) or for a single controller on the Device Communication
Configuration window (page 3-44).

A list of segments is shown; any segments that are different on the controller than in
CentracsLocal Edition are shown in bolded letters. You can select specific segments to
upload, you can click Select All, or you can click Select Diff to upload only the
segments that are different (this is the quickest upload option). For details about
which settings are contained in each segment for ASC/3 and Cobalt controllers, refer
to ASC/3 and Cobalt Controller Segments on page A-8.

Note e If you click Select Diff, the window shows checkmarks for the changed segments.

3 Click OK.

A progress bar is shown while the controller data is loaded into the Editor workspace.
After it is loaded, the controller name is shown in the controller list on the left side of
the Editor workspace, and the parameter values are shown on various tabs and sub-
tabs in the right side of the workspace.

Note ¢ The upload of settings into the Editor workspace does not automatically save them
to the CentracsLocal Edition database. To do so, you must use the Store Controller In
Database option (page 15-15).
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To load controller parameter values from the CentracsLocal Edition database:

IMPORTANT e Usually, this option is only used to make the initial configuration for a
controller, or to look at the current settings for a controller. To change the current
settings for a controller, it is recommended that you upload the settings from the
controller rather than loading them from the CentracsLocal Edition database.

1 From the File menu, select Load Controller.

Or

From the Database Editor window, click the Load from Centracs Database f=| icon.

The Load Controller window opens. This window shows all the controllers currently
defined in the database, sorted by name. (To sort by a different column, right-click in
the window and select an option from the Sort By list.)

@ Load Controller

Hame

* 2M472018 10:11:29 AM

21142015 10:07:09 AM

21472018 §:43:21 AM

2i11472018 83:36:30 AM

20202018 1:57:29 PM

120672017 10:15:50 AM

12062017 10:07:02 AM

1111572016 15108 Baseline

* Defauli Controller DB

Comment Saved

2/14/2018 10:11:41 AM
Richland DB
AK Test Copy
AK Test
Test
test changes AT 11:16:05 AM
Initial Upload N7 11:07:47 AM

Initial Upload new intersection

2 Double-click the controller to load, or select it and click Load.

A progress bar is shown while the controller data is loaded into the Editor workspace.
After it is loaded, the controller name is shown in the controller list on the left side of
the Editor workspace, and the parameter values are shown on various tabs and sub-
tabs in the right side of the workspace.

Note e If the controller settings have never been saved to the CentracsLocal Edition
database, the Editor loads a set of default values which you can use as a starting point when

you configure a new controller.
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To save controller parameter values to the Local Edition database:
1 Highlight the controller to save.

2 Fromthe File menu, select Store Controller or click the Store in Centracs Database
icon.

3 On the Store Controller window, enter a name and comment for this version of the
controller settings. By default, the name is set to the current date and time.

4 If you want this version to be the default version shown when the Editor is launched
for this controller, turn on the Default checkbox.

5 Click Save.

Note e If the database consistency check finds a problem with the settings, a window is
shown with details about the problem(s). You can click Override to save anyway, or click
Cancel to return to the Editor to fix the problems.

A progress bar is shown while the controller data is saved.

To download controller parameter values to a field controller:
1 Highlight the controller to download.

2 Fromthe Communication menu, select Download To Controller or click the Download

to Controller icon.

3 If you have not saved the data to the Local Edition database yet, you will get
a prompt to Store Unsaved Controller. To save the data to Local Edition, click
Yes.

Note e Depending on the options you select, Centracs may do an FTP-based download.
If the FTP username and password have been changed on the controller, you must
change them in Centracs to match. You can change them for all controllers on the
Default Comm Parameters window for a single controller on the Device Communication
Configuration window.

4 Onthe Download window, specify the segments to download. Any segments that are
different on the controller than in Centracs are shown with an asterisk (*). You can
select specific segments to download, you can click Select All, or you can click Select
Differences to download only the segments that are different (this is the quickest
download option).
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15-16

@® Downiload
Segment Based
Sequencer « | Sysiem Info
Load Switch « | Other
Configuration * TSP *
Communication Ports *
Enable Logging
Logic Processor *
Phase Timing
Overlap
Coordinator
Preemptor
Time Base
Detectors *

L
L
v
L
v
o
L
L
L
v
L
v

Select f Unselect All Select Differences

1

Comment:

Download Close

Enter a comment about this download in the comments field.

Click Download. A progress bar is shown while the controller data is sent to the
controller

You are asked to specify the segments to download:

Any segments that are different on the controller than in CentracsLocal Edition are
shown in bolded letters. You can select specific segments to download, you can click
Select All, or you can click Select Different to download only the segments that are
different (this is the quickest download option). For details about which settings are
contained in each segment for ASC/3 and Cobalt controllers, refer to ASC3 and Cobalt
Controller Segments on page A-8.

Note e IfyouclickSelect Differences, the window shows checkmarks for the changed
segments.

Click OK.

A progress bar is shown while the controller data is sent to the controller. After the
download has completed, you can make more changes to the controller if necessary,
or you can close it.
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To undo the changes you made in the Signal Editor:

» Click the Undo icon in the toolbar or use the keyboard shortcut Ctrl-Z. This will
undo you most recent change. Repeat as many times as needed to undo prior changes.

To copy parameter values from one controller to another:

Note e The controllers must be the same type.

1 Launch two instances of the Editor: one for the controller you want to copy (herein
called Controller A), and one for the controller you want to overwrite (herein called
Controller B).

2 For Controller A, make sure the settings you want to copy are currently shown in the
Editor. For example, you may need to upload from the controller, or load a version
from the Centracs database.

3 From the Edit menu, select Copy Controller.
4 In the Editor for Controller B, select Paste Controller from the Edit menu.

5 On the Controller Copy window, select the parameter set(s) you want to paste from
Controller A, then click Paste.

6 Save Controller B to the Local Edition database using the Store Controller
option.

7 Download Controller B to the field controller with the Download To Controller option.
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To load a previous set of parameter values from the CentracsLocal Edition
database:

1 Highlight the controller to reload.

2 From the Utilities menu, select Load Previously Saved Data. The Load Saved Data
selection window opens. This window contains a list of all prior configurations that
have been saved to the CentracsLocal Edition database for this controller, and the
date/time at which they were saved.

=1 Load Saved Data =B X

Pleaze select the time of the zave to load.

10/29/2010 2:50:13 AM
10429420010 1:35:42 P
10/29/2010 4:31:48 PM
11/1/2010 35317 &M
11./1/2010 2:12:45 PM
11/1/2010 4:02:58 PM
11142010 4:34:51 PM

Load Cancel

3 Highlight the prior configuration to load, then click Load.

A progress bar is shown while the controller data is reloaded into the Editor
workspace.

To compare the settings saved in the Centracs database with the settings saved
on the controller:

» From the Utilities menu, select Quick Compare or click the Quick Compare icon.

When the comparison is complete, a results window tells you whether the data are the
same or different. If different, an asterisk is shown on any tabs/sub-tabs containing
differences
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To compare the settings saved in the Centracs database with the settings
loaded in the Editor:

1 From the Utilities menu, select Compare Database or click the Compare Database
icon. The Editor is now in comparison mode, and any differences between the settings
loaded in the Editor and the settings saved in the Local Edition database are
highlighted in yellow. Also, an asterisk is shown on any tabs/sub-tabs containing
differences.

2 Click the Compare List tab in the Comparisons section at the bottom of the window.
This tab shows details about any differences found. The Current column shows the
current value in the Editor; the Database column shows the current value in the

Local Edition database.

3 Click on an item to be taken to the appropriate screen for that setting. In most cases,
the new and old values are shown side-by-side, where the value in yellow indicates the
value in the Local Edition database.

4 To turn off the comparison and go back to edit mode, select Compare Database again
from the Utilities menu.

To find conflicting parameter settings:

» The Editor automatically performs consistency checks on the data. To view the results
of these checks at any time, click the Error List tab at the bottom of the window. If any
conflicts have been found in the configuration of the controller, this tab shows details
about the conflict(s). For example, this tab might display that the preempt dwell
yellow time is greater than the programmed yellow time.

To print the controller settings:

1 From the File menu, select Print, or click the Print E icon. The Print window opens.

2 From the Custom Print Configurations list, select a print template. For more
information about print templates, refer to page 15-20.

3 Using the checkboxes, select the parameter sets to include.

4 Click Print. (Or click Print Preview to view it first). If you select Print Preview first, you
can change the page setup for printing, such as Portrait vs Landscape layout, margins,
etc.

To export settings to a .DB file:
1 From the File menu, select Export.
2 On the Export window, specify the location and name for the export file, then click

Save.

To import settings from a .DB file:
1 From the File menu, select Import.
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2 Onthe Import window, locate the .DB file that contains the settings to be imported.
These settings will overwrite the settings currently loaded into the Editor for the
controller.

3 Click Open.

Note e To put the newly imported settings into effect, be sure to save them to the
database (page 15-15) and download them to the controller (page 15-15).

To close a controller from the Controller Editor:
1 From the File menu, select Close Controller.

2 If changes have been made to this controller but not saved to the Local
Edition database, you are prompted to save your changes first. To save the changes,
click Yes, or to discard the changes, click No.

Note ¢ The Controller Editor workspace display is closed for this controller. Any other
loaded controllers stay open in the workspace.

Custom Printouts of the Controller Settings

15-20

Note e This feature is available for ASC/3, Cobalt, and Eos controllers.

In the Signal Editor, if you want to print a signal’s controller settings, you can use the
default printout format, or you can create your own custom printing templates. Custom
print templates are maintained in the main Centracs user interface, not in the Editor.

The printing functions in the Editor use XML, CSS, and XSLT files to determine which data
will be printed, and in what format. You will want to be familiar with these file formats
before creating your own print templates in Centracs.

To define a custom print template to be used in the Editor:

1 Onany machine where the Centracs client is installed, go to
C:\ProgramData\Econolite\Prints. This folder contains all the files needed for
printing from the Editor. The ECPI subfolder contains all the files for the Default print
template.

2 Make a copy of the ECPI folder, and name it appropriately (for example, your agency
name).

3 Optionally, open the .CSS file and make changes to fonts, font sizes, text alignment,
etc., then save the file. The default CSS uses Arial for all fonts.

4 Optionally, make changes to any of the XSLT files, then save them.

Centracs User Manual
Software Version 2.x - March 2018



Changing the Controller Settings

Custom Printouts of the Controller Settings =

5 Optionally, you can change the header image that appears at the top of your printouts.
For example, you may want to change this to your agency logo. The image file can be
a JPG, PNG, BMP, etc. Simply put a copy of the image file into the folder you created
in step 2 above, and rename it Headerlmage (with no file extension).

From the Centracs main menu, select File P Settings.
click the “Controller Editor Printouts” tab on the left side of the window.

Click Add. The Add Print Template window opens.

O 0 N o

Select the controller type for which this template will be available (ASC3/Cobalt or
Eos).

10 Enter a name and description (optional) for your new template, such as Timing Plans.

11 If you want this to be the default print template in the Editor (for all users), turn on the
Default checkbox.

12 Click Load Directory.
13 In the Browse window, go to the folder you created in step 2 and click OK.

14 Select the files to include in your template. For example, if this template will only print
timing plans, select the timingplan.xslt file, and deselect all other XSLT files. If you
changed the CSS file or the header image, be sure to select those as well.

15 Click Save.

Your template is ready to be used in the Editor. Note that if you make further changes to
the CSS, XSLT, or image files, these will not be loaded into Centracs automatically. You
must follow the steps below to load these additional changes into your template.

You can create any number of templates from the same folder of CSS/XSLT files. For
example, you can create one template that only includes the timingplan.xslt file, another
template that only includes the coordinationoptions.xslt file, and another template that
includes all the timebase files.

Note e Do not make changes to any of the file names. These must remain unchanged in
order for Centracs to recognize them.

To change an existing print template:
1 Inthe folder you created in step 2 above, make any additional changes to the CSS,
XSLT, or image files.

From the Centracs main menu, select File b Settings.
click the “Controller Editor Printouts” tab on the left side of the window.

Select the template to change, then click Edit. The Edit Print Template window opens.

vui A W N

Make any needed changes to the controller type, name, description, or default
checkbox.

6 Click Reload Directory.
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7 Inthe Browse window, go to the folder where your template files are located and click
OK.

8 Selectthefilestoinclude in your template. For example, if this template will only print
timing plans, select the timingplan.xslt file, and deselect all other XSLT files. If you
changed the CSS file or the header image, be sure to select those as well.

9 Click Save.
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Samples

The samples below show some of the changes you can incorporate into your print
templates:

m  Thesample on the left uses the default CSS file and default header image, but has been
changed to show only Timing Plan data.

m  The sample on the right shows only Coordination Options, the header image has been
changed, and some of the fonts have been changed.

Castle Rock, CO
mEm CONTROL PRODUCTS, INEC.
065 - Front St @ Sam Walton Ln - 50510 on .22 - Econolite Type - ASC/3
Controller Timing Plan (MM) 2-1
Plan 4 astie Roc
Phase 2 s ’
Direction
Min Green 5 5 5
Bk Min Green 0 0 0
CS Min Green 0 0 0
Delay Green 0 0 0
e o 065 - Front $t@ Sam Walton Ln - 50510 on .22 - Econolite Type - ASG/3
al

[Walk Max 0 0 0
Ped Clear 0 16 0 Coordination Options
Ped Clear 2 0 0 0 Options (MNM) 3-1
Ped Clear Max__ |0 0 0 Manual Pattern Auto ECPICoord Yes
Ped CO 0 0 0 System Source TBC System Format 3D
Vehicle Ext 5.0 5.0 5.0 Splits In Seconds Offsets In Seconds
Vehicle Ext 2 0.0 0.0 0.0 Transition Smooth Max Select MAXINH
Max1 35 35 35 Dwell / Add Time 0
Max2 40 40 40 Delay Coord Wk-LZ No Force Off Float
Max3 0 0 0 Offset Reference Lead Use Ped Time Yes
DYM Max 0 0 0 Ped Recall No Ped Reservice No
Dym Step 00 00 0.0 Local Zero Override No FO Added Ini Green No
Yellow 3.0 3.0 30 Re-sync Count 0 Multisync No
Red Clear 1.0 1.0 1.0
Red Max 00 jo0  Jo0 Auto Perm Minimum Green (Seconds) (MM) 3-4
R Phase 1 [2[sJaJs[e[1[s[oJw][n[r][na][ul]®
oAl 00 00 00 Minimum Green 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0
Max Int 0 0 0
Time B4 0 0 0 :
T 5 5 5 Split Dem and (MM) 3-5
S o Too—Too Phase 1|23 ]a]s6s 6|78 ]9 |1w|n|er|]B|ua|1]®6
TTReduc 0 0 0 Demand 1
Min Gap 0.0 0.0 0.0 Demand 2

Demand 1 2

Detector 0 0

Call Time (Sec) 0 0

Cycle Count 0 0
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Using the UTDF Interface Module

You can use the UTDF (Universal Traffic Data Format) interface module to:

Save controller timing and phase settings to a .CSV file in UTDF format, which you can
open in the Synchro™ signal timing application or in a spreadsheet application such as
Microsoft Excel.

Import Synchro™ signal timing plans and coordination data from a UTDF-formatted
.CSV file.

For general information about this module, refer to Synchro™ UTDF Interface Module on
page 1-20.

For NTCIP controllers, the UTDF interface is accessed through the Signal Editor. For
instructions on how to access the Signal Editor, refer to Overview of the Signal Editor on
page 15-2.

For ACT controllers, the UTDF interface is accessed through the Entity Tree (page 3-1)

Note e You must get a license key from Econolite Technical Support in order to use the
UTDF interface.

Overview of the Export Process

When you export controller data from Centracs, you can choose to export timing data,
phasing data, or both:

m Timing data = the basic coordination data for the controller. This includes, for each

15-24

programmed coordinator pattern, the pattern number, controller ID number, splits
for up to 16 phases, cycle length and offset (in seconds), coordinated phases, and
other reference data.

Because Synchro only supports split and offset values in seconds, if the controller has
been configured to use percentages, the percentage values are changed to seconds
during export. Small inaccuracies may occur due to rounding of the changed values.

For ASC/3 and Cobalt controllers, if a timing plan is not assigned, Centracs exports
timing plan 1 by default.

Phasing data = the basic phase timing data for the controller. This includes, for up to
8 phases (ASC/2 and W4 controllers) or 16 phases (ASC/3, Cobalt, Oasis, and Eagle
controllers), such information as the ring structure (labeled ‘BRP’ in the export file)
and times for Min/Max Green, Yellow, Walk, Extension, etc.
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Overview of the Import Process

You can use the UTDF interface to import timing data that has been analyzed and
optimized in Synchro back into Local Edition. (You cannot import phasing data
from Synchro into Local Edition; you must manually enter phasing data into the
Signal Editor, then download it to the controller.)

Because Synchro only supports split and offset values in seconds, if the controller has
been configured to use percentages, the values in seconds are changed to percentages
during import. Small inaccuracies may occur due to rounding of the values.

NTCIP Controllers

Exporting Data to UTDF Format (NTCIP)

To export controller settings to a UTDF-formatted CSV file:
(to open in Synchro or other application)

1 Optionally, in the Signal Editor, load the controller settings to export (you can load
them from the Local Edition database or upload them from the controller).

2 From the File menu of the Signal Editor, select Export Synchro files.
The UTDF Export window launches displaying the Controller to export.
@ UTDF Export: Controller "VC 15103" ID: 256
Select from timing data and phasing data to export

Select Desired Format

Sync 5

=

Synchro & or higher
Synchro 1D

Select Data to be Exporied

o | Timing
Timing Folder: | cyjsers\tfeamiey\Documents Browse

« | Phasing

Phasing Folder: | ¢y jcersitfeamiey\Documents Browse

Export Cancel

3 Select the desired format to export to; Synchro 5 or Synchro 6 or higher.
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4

The Sychro ID field shows the number that will be exported as the intersection ID
(INTID) for the signal. To change this number, if needed, double-click the signal and
enter a different number to export as the INTID (up to five digits).

Specify the type(s) of data to export.

If you selected to export both Timing and Phasing data, separate files will be made for
each data type. Use the Browse options to specify the location(s) to save the export
files, then click Next.

File names are automatically assigned by the program, in this format:
TimingDataXXxX.csv Of PhasingDataXXxX.csv, Where xxxis the signal name.

Click Export.

The files are added to the location(s) you specified, with a file extension of .csv
(comma-separated values). If you exported more than one controller, separate files
are made for each controller. These files can then be imported into Synchro, or
opened in any application that supports .csv files (such as Microsoft Excel).

Importing Data from UTDF Format (NTCIP)

IMPORTANT e When you import a file back into CentracsLocal Edition, the INTID value
(which is the intersection ID or controller number) must be the same as the INTID value
that was originally exported from CentracsLocal Edition.

To import controller settings from a UTDF-formatted file:

1

From the File menu of the Signal Editor, select Import Synchro files.

The UTDF Import Wizard launches.

@® UTDF Import Wizard

2

15-26

Timing File:

PLANID INTID 51 52

>

Import Cancel

On the Timing File field, click Browse and find the UTDF-formatted .csv file to be
imported.
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When you select the file, a preview of the data is shown.

@ UTDF Import Wizard

Timing File: | C:\TimingDataWWoodman @ M Union.cs

PLANID INTID = S1

[ ]

(213 ][20](s0][20][s0][2o]

[5 |1 |[2s][s0] (5] s0][25][30][25][30][ 0|

I:IIEI|E|£|, :

R

Cancel

3 Click Import.

The imported values are shown in the Editor, in comparison mode, where you can
easily find the differences between the imported data and the data stored in the
CentracsLocal Edition database. For details about comparison mode, refer to
page 15-18.

4 Carefully review the Coordinator pages to find any differences between the imported
data and the current CentracsLocal Edition data. When you are ready to activate the
imported settings, select Compare Controller from the Utilities menu to turn off
comparison mode.

5 Save the new settings to the database. For details, refer to page 15-15.

6 Download the new settings to the controller to activate the new timing settings. For
details, refer to page 15-15.
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Notes About Imported/Exported Data

ASC/3 and Cobalt controllers

The export of each pattern uses the default sequence (sequence 1) in the controller.
There are 2 reasons for this: the sequence being run is not known at export time, and
the UTDF format does not have a way to specify which sequence is active.

Import of leading phases is problematic. There is no way to represent the correct
sequencing on a pattern-to-pattern basis. Import of timing data uses the default
sequence (sequence 1). Synchro does not know about sequence assignments, so an
import to multi-mapped patterns does not accurately represent the data from
Synchro. Importing the leading phases updates to the default sequence but this leaves
room for error. If two or more patterns have different leading phases, the last one is
used. At this point the user must adjust phase sequences to pattern mappings to
accurately represent the lead/lag phases for a specific pattern.

ASC/2 & ASC/2 NTCIP controllers

Import of leading phases is currently set up to enable alt sequence for the barrier of
the phase being imported if the phase is not in position 1. This is the best way for
Synchro to optimize phase lead/lag. These alt sequence enables are on a per pattern
basis and conform to possible outputs from Synchro. The one problem is that Synchro
seems to have the ability to make changes to a ring in a barrier such that enabling an
alt sequence does not correctly reflect the changes.

The alt sequences that are observed are the main ones on the coordination page.
There seem to be other ways to alter sequencing; these are ignored in favor of
maintaining a generic representation of data to and from Synchro.

The split values that are used to and from Synchro are the values for the actual pattern
on the coordinator page. XArtPattern remapping of splits, or any other method, is not
observed. There is no way to maintain this additional information in UTDF for Synchro
to understand a proprietary controller setup. Additional mapping of this type of setup
must be done by the user manually.
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ACT Controllers

Exporting Data to UTDF Format (ACT)

To export controller settings to a UTDF-formatted CSV file
(to open in Synchro or other application):

1

Check the value of the “UseAssetIDForACTSynchro” Global Setting. If set to true,
Centracs exports the asset ID / serial drop address to the INTID column in the export
files. If set to false, Centracs exports the entity ID. If the export files will later be
imported back into Centracs, the “UseAssetIDForACTSynchro” setting at the time of
import must match the setting at the time of export. For instructions on how to check
and/or change this setting, refer to Viewing and Editing Global and Local Settings on
page 20-61.

From the Entity Tree or Map Viewer, right-click a signal and select Synchro Export...

[] Export Synchro Traffic Data Format =[B!

Timing File

Phasing File

Patiern [E]
Timing Page

Click [ and specify the location(s) to save the export files (or type the paths and
filenames into the fields). The two files must have different names.

Select a Pattern to export.
Select a Timing and Functions page to export.
Click Export.

Separate files are made for each data type. The files are added to the location(s) you
specified, with a file extension of .csv (comma-separated values). These files can then
be imported into Synchro, or opened in any application that supports .csv files (such
as Microsoft Excel).

You can repeat these steps to export more patterns and timing pages.

Note e The Timing Page option is not shown for Oasis controllers.
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Importing Data from UTDF Format (ACT)

To import controller settings from a UTDF-formatted file:

1

N o un b

10

Check the value of the “UseAssetIDForACTSynchro” Global Setting. If set to true,
Centracs treats the imported intersection ID (INTID) value as the asset ID / serial drop
address. If set to false, Centracs treats the imported INTID value as the entity ID. This
setting must match the type of INTIDs in the file you are importing. For example, if you
exported data from Centracs using the entity ID and then processed it in Synchro,
when you import it back into Centracs, “UseAssetIDForACTSynchro” must be set to
false. On the other hand, if you want to import a file that was exported from a system
that uses asset IDs, “UseAssetIDForACTSynchro” must be set to true. For instructions
on how to check and/or change this setting, refer to Viewing and Editing Global and
Local Settings on page 20-61.

From the Entity Tree or Map Viewer, right-click a signal and select Synchro Import...

[ import Synchro Traffic Data Format (=]

Timing File

Phasing File

Pafttern [E]
Timing Page

Click & and find the UTDF-formatted .csv files to import (or type the paths and
filenames into the fields).

Select the Pattern being imported.
Select the Timing and Functions page being imported.
Click Import.

If the import was successful, Centracs gives you the option to open the Signal Editor in
order to see the imported values and download them to the controller. Click Yes.

In the Editor, carefully review the new values. When you are ready to activate the
imported settings, download the new settings to the controller.
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11 If necessary, you can repeat these steps to import more patterns and timing pages.

Note e The Timing Page option is not shown for Oasis controllers.

Sample Files

Sample Timing File

[

Timing Plans

PLANID INTID 51 52 53 54 55 56 57 58 59 510 511 S12 513 514 515 516 CL OFF LD REF CLR
1153015230152301530 0 0 0 O O O 0 90 5 1357 26+ 0
120 20 20 20 20 30 20 30 0 100 35 1357 26+
125 30 25 30 25 30 25 30 0 110 0 1357 26+
1 30 30 30 30 30 30 30 30 0 120 0 1357 26+
1 30 35 30 35 30 35 30 35 0 130 0 1357 26+

La fa

4
5
6
7

(]
PLANID = Coordinator Pattern #
INTID = intersection ID or signal controller number
S1 - 516 = split values
CL = Cycle Length
OFF = Offset Value
LD = leading phase
REF = reference (+ indicates start of green; the number 26 in the sample above indicates phases 2 and 6)

0 B A &6to106 tHo; A d &o ROt d A PO P o+t ROWHA
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Phasing Data
RECORDMAME INTID
BRP

MinGreen
Maxlnitial
AddedMin
MinActuation
MaxActuation
MaxGreen

il MinSplit
MaxExtension
VehExt
TimeBeforeReduce
ReduceBy
ReduceEvery
TimeToReduce
MinGap
Yellow

AllRed
DualEntry
Recall
InhibitMax
Start

End

Yield170
LocalStart
LocalYield
LocalYield170
Walk
DontWalk

I8 PedCalls

o

4 4 bk M

INTID = intersection ID or signal controller number

D1 - D8 = phase numbers

BRP = Barrier/Ring/Position phase sequencing (for example, 122 indicates Barrier 1, Ring 2, Position 2;
211 indicates Barrier 2, Ring 1, Position 1)

etefrhesecernefrom Centrelleral/ Thming Plantab?)
For more information about the data types in these files, refer to your Synchro
documentation.
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Exchanging Data with ‘Local Edition’

Merging Entity Data

You can use the Merge Data function to synchronize entities (signals, detectors, etc.) and
their associated channel/controller data between the main Centracs database and a Local
Edition database, or between two Local Edition databases. For example, if you are driving
out to a controller with your Local Edition laptop, it saves time to copy all the necessary
data from Centracs before you leave the office, rather than to configure it from scratch in
Local Edition.

In simple terms, the merge function populates Database B with the settings that have
already been configured in Database A. If the settings have already been populated in
Database B from a prior merge, a subsequent merge overwrites them.

Note ¢ To save time, it is recommended that you configure all the necessary connection
profiles for each signal before you merge data. For example, if you use Local Edition in
conjunction with a central Centracs database, and if the method to connect to Signal 1 via
central (for example, over an IP channel) is different than the method to connect to Signal
1 via Local Edition (for example, through a serial connection), configure the tabs on the
Device Communication Configuration window (page 3-44) in Centracs before you merge
Signal 1 to Local Edition. This way Centracs acts as a master copy of the connection profiles:
you only have to add them one time, then you can merge them to multiple Local Edition
databases if necessary. If you only configure the Local Edition tab(s) in the Local Edition
database and not in the master database, you risk overwriting the data in those tabs the
next time you do another merge from the master database.

Note e Do not run the Centracs client and the Local Edition client on the same machine at
the same time.

Note ¢ When the Merge Data function is used for an Entity Tree that contains multiple
copies of an entity, only the original entity gets merged. Any copies of that entity are
ignored during the merge process.

In the procedure that follows, the “receiving” database is the database you will copy data
to, and the “sending” database is the database you will copy data from.
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